Keysight M8000 Series of BER Test Solutions

J-BERT M8020A High-Performance BERT
M8030A Multi-Channel BERT
M8040A High-Performance BERT

User Guide
Notice

© Keysight Technologies 2018

No part of this manual may be reproduced in any form or by any means (including electronic storage and retrieval or translation into a foreign language) without prior agreement and written consent from Keysight Technologies as governed by United States and international copyright laws.

Trademarks

PCI Express® and PCIe® are registered trademarks of PCI-SIG.

Manual Part Number

M8020-91030

Edition

Edition 13.0, August 2018

Keysight Technologies Deutschland GmbH
Herrenberger Strasse 130,
71034 Böblingen, Germany

Technology Licenses

The hardware and/or software described in this document are furnished under a license and may be used or copied only in accordance with the terms of such license.

U.S. Government Rights

The Software is “commercial computer software,” as defined by Federal Acquisition Regulation (“FAR”) 2.101. Pursuant to FAR 12.212 and 27.405-3 and Department of Defense FAR Supplement (“DFARS”) 227.7202, the U.S. government acquires commercial computer software under the same terms by which the software is customarily provided to the public. Accordingly, Keysight provides the Software to U.S. government customers under its standard commercial license, which is embodied in its End User License Agreement (EULA), a copy of which can be found at http://www.keysight.com/find/sweula. The license set forth in the EULA represents the exclusive authority by which the U.S. government may use, modify, distribute, or disclose the Software. The EULA and the license set forth therein, does not require or permit, among other things, that Keysight: (1) Furnish technical information related to commercial computer software or commercial computer software documentation that is not customarily provided to the public; or (2) Relinquish to, or otherwise provide, the government rights in excess of these rights customarily provided to the public to use, modify, reproduce, release, perform, display, or disclose commercial computer software or commercial computer software documentation. No additional government requirements beyond those set forth in the EULA shall apply, except to the extent that those terms, rights, or licenses are explicitly required from all providers of commercial computer software pursuant to the FAR and the DFARS and are set forth specifically in writing elsewhere in the EULA. Keysight shall be under no obligation to update, revise or otherwise modify the Software. With respect to any technical data as defined by FAR 2.101, pursuant to FAR 12.211 and 27.404.2 and DFARS 227.7102, the U.S. government acquires no greater than Limited Rights as defined in FAR 27.401 or DFAR 227.7103-5 (c), as applicable in any technical data.

Warranty

THE MATERIAL CONTAINED IN THIS DOCUMENT IS PROVIDED “AS IS,” AND IS SUBJECT TO BEING CHANGED, WITHOUT NOTICE, IN FUTURE EDITIONS. FURTHER, TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, KEYSIGHT DISCLAIMS ALL WARRANTIES, EITHER EXPRESS OR IMPLIED WITH REGARD TO THIS MANUAL AND ANY INFORMATION CONTAINED HEREIN, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. KEYSIGHT SHALL NOT BE LIABLE FOR ERRORS OR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH THE FURNISHING, USE, OR PERFORMANCE OF THIS DOCUMENT OR ANY INFORMATION CONTAINED HEREIN. SHOULD KEYSIGHT AND THE USER HAVE A SEPARATE WRITTEN AGREEMENT WITH WARRANTY TERMS COVERING THE MATERIAL IN THIS DOCUMENT THAT CONFLICT WITH THESE TERMS, THE WARRANTY TERMS IN THE SEPARATE AGREEMENT WILL CONTROL.

Safety Notices

CAUTION

A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in damage to the product or loss of important data. Do not proceed beyond a CAUTION notice until the indicated conditions are fully understood and met.

WARNING

A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in personal injury or death. Do not proceed beyond a WARNING notice until the indicated conditions are fully understood and met.
Safety Summary

The following general safety precautions must be observed during all phases of operation of this instrument. Failure to comply with these precautions or with specific warnings or operating instructions in the product manuals violates safety standards of design, manufacture, and intended use of the instrument. Keysight Technologies assumes no liability for the customer's failure to comply with these requirements. Product manuals are provided with your instrument on CD-ROM and/or in printed form. Printed manuals are an option for many products. Manuals may also be available on the Web. Go to www.keysight.com and type in your product number in the Search field at the top of the page.

General

This product is a Safety Class 1 instrument (provided with a protective earth terminal). The protective features of this product may be impaired if it is used in a manner not specified in the operation instructions.

All Light Emitting Diodes (LEDs) used in this product are Class 1 LEDs as per IEC 60825-1.

Environment Conditions

This instrument is intended for indoor use in an installation category II, pollution degree 2 environment. It is designed to operate at a maximum relative humidity of 95% and at altitudes of up to 2000 meters.

Refer to the specifications tables for the ac mains voltage requirements and ambient operating temperature range.

Before Applying Power

Verify that all safety precautions are taken. The power cable inlet of the instrument serves as a device to disconnect from the mains in case of hazard. The instrument must be positioned so that the operator can easily access the power cable inlet. When the instrument is rack mounted the rack must be provided with an easily accessible mains switch.

Ground the Instrument

To minimize shock hazard, the instrument chassis and cover must be connected to an electrical protective earth ground. The instrument must be connected to the ac power mains through a grounded power cable, with the ground wire firmly connected to an electrical ground (safety ground) at the power outlet. Any interruption of the protective (grounding) conductor or disconnection of the protective earth terminal will cause a potential shock hazard that could result in personal injury.

Do Not Operate in an Explosive Atmosphere

Do not operate the instrument in the presence of flammable gases or fumes.

Do Not Remove the Instrument Cover

Operating personnel must not remove instrument covers. Component replacement and internal adjustments must be made only by qualified personnel.

Instruments that appear damaged or defective should be made inoperative and secured against unintended operation until they can be repaired by qualified service personnel.
### Safety Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>⚠️</td>
<td>Indicates warning or caution. If you see this symbol on a product, you must refer to the manuals for specific Warning or Caution information to avoid personal injury or damage to the product.</td>
</tr>
<tr>
<td>⚡️</td>
<td>Frame or chassis ground terminal. Typically connects to the equipment’s metal frame.</td>
</tr>
<tr>
<td>⚡️</td>
<td>Indicates hazardous voltages and potential for electrical shock.</td>
</tr>
<tr>
<td>⚡️</td>
<td>Indicates that antistatic precautions should be taken.</td>
</tr>
<tr>
<td>⚡️</td>
<td>Indicates hot surface. Please do not touch.</td>
</tr>
<tr>
<td>⚡️</td>
<td>Indicates laser radiation turned on.</td>
</tr>
<tr>
<td>✅</td>
<td>CSA is the Canadian certification mark to demonstrate compliance with the Safety requirements.</td>
</tr>
<tr>
<td>✅</td>
<td>CE compliance marking to the EU Safety and EMC Directives. ISM GRP-1A classification according to the international EMC standard. ICES/NMB-001 compliance marking to the Canadian EMC standard.</td>
</tr>
</tbody>
</table>
### Compliance and Environmental Information

<table>
<thead>
<tr>
<th>Safety Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Safety Symbol" /></td>
<td>This product complies with WEEE Directive (2002/96/EC) marking requirements. The affixed label indicates that you must not discard this electrical/electronic product in domestic household waste.</td>
</tr>
<tr>
<td><img src="image" alt="Safety Symbol" /></td>
<td>Product Category: With reference to the equipment types in WEEE Directive Annex I, this product is classed as a “Monitoring and Control instrumentation” product. Do not dispose in domestic household waste.</td>
</tr>
<tr>
<td><img src="image" alt="Safety Symbol" /></td>
<td>To return unwanted products, contact your local Keysight office, or see <a href="http://about.keysight.com/en/companyinfo/environment/takeback.shtml">http://about.keysight.com/en/companyinfo/environment/takeback.shtml</a> for more information.</td>
</tr>
</tbody>
</table>
About This Guide

Here is how the information in this document is organized.

Introduction
This chapter provides an overview of this manual.

Know Your Hardware
This chapter provides an information on the various modules of M8020A/M8030A/M8040A, their setup and the provided accessories.

Exploring M8070A User Interface
This chapter describes the M8070A user interface and the functionality provided by its common GUI elements.

Configuring Your System
This chapter describes how to configure the M8020A/M8030A/M8040A system using the Module View, Group View and System View.

Setting up Generator
This chapter provides information on settings provided by the M8020A/M8030A/M8040A Generator.

Setting up Analyzer
This chapter provides information on settings provided by the M8020A/M8030A/M8040A Analyzer.

Setting up Patterns
This chapter describes the functionality provided by the M8070A Pattern Editor and Sequence Editor.

Working with Measurements
This chapter describes the setup, execution, monitoring and results of the measurements supported by M8070A system software.

Utilities
This chapter describes the utilities provided by the M8070A system software.

Licenses
This chapter provides information on the M8020A/M8030A/M8040A and M8070A licenses and their installation procedure.

Appendix
This chapter provides information about basic troubleshooting and factory patterns.
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safety Summary</td>
<td>3</td>
</tr>
<tr>
<td>Compliance and Environmental Information</td>
<td>5</td>
</tr>
<tr>
<td>About This Guide</td>
<td>6</td>
</tr>
<tr>
<td>1 Introduction</td>
<td></td>
</tr>
<tr>
<td><strong>Overview</strong></td>
<td>24</td>
</tr>
<tr>
<td>J-BERT M8020A high-performance BERT</td>
<td>24</td>
</tr>
<tr>
<td>M8030A Multi-Channel BERT</td>
<td>25</td>
</tr>
<tr>
<td>M8040A High-Performance BERT</td>
<td>26</td>
</tr>
<tr>
<td>Document History</td>
<td>28</td>
</tr>
<tr>
<td>Related Documents</td>
<td>29</td>
</tr>
<tr>
<td>Abbreviations used in this Document</td>
<td>29</td>
</tr>
<tr>
<td>2 Know Your Hardware</td>
<td></td>
</tr>
<tr>
<td><strong>M8020A Overview</strong></td>
<td>32</td>
</tr>
<tr>
<td><strong>M9505A AXle Chassis</strong></td>
<td>33</td>
</tr>
<tr>
<td>AXle Embedded System Module (USB ESM)</td>
<td>34</td>
</tr>
<tr>
<td><strong>Host Computer</strong></td>
<td>35</td>
</tr>
<tr>
<td><strong>M8030A Overview</strong></td>
<td>36</td>
</tr>
<tr>
<td><strong>M9514A AXle Chassis</strong></td>
<td>37</td>
</tr>
<tr>
<td>AXle System Module (ASM)</td>
<td>38</td>
</tr>
<tr>
<td>Keysight M9537A AXle Embedded Controller Module</td>
<td>39</td>
</tr>
<tr>
<td><strong>M8020A / M8030A Modules</strong></td>
<td>40</td>
</tr>
<tr>
<td>J-BERT M8041A Generator-Analyzer-Clock Module</td>
<td>40</td>
</tr>
<tr>
<td>M8041A Front Panel Connector Inputs/Outputs</td>
<td>43</td>
</tr>
</tbody>
</table>
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>J-BERT M8051A Generator-Analyzer</td>
<td>45</td>
</tr>
<tr>
<td>M8061A 32 Gb/s Multiplexer with De-emphasis Module</td>
<td>48</td>
</tr>
<tr>
<td>M8061A Front Panel Connector Inputs/Outputs</td>
<td>50</td>
</tr>
<tr>
<td>M8062A 32Gb/s Front-end for J-BERT M8020A High-Performance BERT</td>
<td>51</td>
</tr>
<tr>
<td>M8062A Features</td>
<td>51</td>
</tr>
<tr>
<td>M8062A Module Components</td>
<td>52</td>
</tr>
<tr>
<td>M8062A Front Panel Pattern Generator Connectors</td>
<td>53</td>
</tr>
<tr>
<td>M8062A Front Panel Analyzer Connectors</td>
<td>54</td>
</tr>
<tr>
<td><strong>M8020A Module Setup</strong></td>
<td>55</td>
</tr>
<tr>
<td>Setting up a Single Channel System</td>
<td>55</td>
</tr>
<tr>
<td>Setting up a Multi-Channel System</td>
<td>55</td>
</tr>
<tr>
<td><strong>M8030A Module Setup</strong></td>
<td>57</td>
</tr>
<tr>
<td>M8030A Modules Arrangement Example</td>
<td>58</td>
</tr>
<tr>
<td><strong>M8040A Overview</strong></td>
<td>59</td>
</tr>
<tr>
<td><strong>M8040A Modules</strong></td>
<td>60</td>
</tr>
<tr>
<td>M8045A High-Performance BERT Pattern Generator-Clock Module</td>
<td>60</td>
</tr>
<tr>
<td>M8046A High-Performance BERT Analyzer Module</td>
<td>64</td>
</tr>
<tr>
<td>M8057A Pattern Generator Remote Head</td>
<td>66</td>
</tr>
<tr>
<td><strong>M8040A Module Setup</strong></td>
<td>69</td>
</tr>
<tr>
<td><strong>AWG Modules Supported by M8070A System Software</strong></td>
<td>70</td>
</tr>
<tr>
<td>M8195A 65 GSa/s Arbitrary Waveform Generator</td>
<td>70</td>
</tr>
<tr>
<td>M8196A 92 GSa/s Arbitrary Waveform Generator</td>
<td>71</td>
</tr>
<tr>
<td><strong>Other Supported Hardware(s)</strong></td>
<td>72</td>
</tr>
<tr>
<td>Keysight N1076A/N1077A DCA-M Clock Recovery</td>
<td>72</td>
</tr>
<tr>
<td>Keysight Real Time Oscilloscopes</td>
<td>73</td>
</tr>
<tr>
<td><strong>Hardware Setup for M8046A and M8062A Modules</strong></td>
<td>74</td>
</tr>
<tr>
<td>Limitations</td>
<td>75</td>
</tr>
<tr>
<td><strong>ESD Protection</strong></td>
<td>76</td>
</tr>
</tbody>
</table>
3 Quick Tour with M8070A User Interface

Overview  82

Launching M8070A User Interface  83
  Messages while launching M8070A GUI  83
  Load Setting  85
  Get Module Information  87

Exploring M8070A User Interface  89
  Title Bar  89
  Menu Bar  89
  Main Window  109
  Status Bar  110

Other GUI Features  115

Recall/Save Instrument State  122
  Recall Instrument State  122
  Save Instrument State  123

4 User Interface - M8070A Display Views

Overview  126

Module View  127
  How to Launch Module View  127
  Input and Output Ports  130
  Show Module Information  136
  Selecting Single/Multiple Ports  137
  Parameters Window  137
  Creating Groups in the Module View  155

System View  156
  Using the Zoom Tool  157
  Understanding the System View  158
  System View with M8061A Integration  162
  System View with M8062A Integration  169
  M8040A System View  173
Impairment Setup View 175
How to Access the Impairment Setup View 175
Features of the Impairment Setup View 176
Viewing Options in the Impairment Setup View 178
How to set parameters in Impairment Setup View 180
How to Use Filters 182

Group View 185
How to Launch Group View 185

Setup View 191
How to Access the Setup View 191
Understanding Setup View 192
GUI Elements Description 195
How to perform a basic measurement 197

Adjustable Intersymbol Interference 198
Using System View for ISI Configuration 198
How to Launch Adjustable ISI Window: 199
Toolbar 200
Adjustable ISI Graph 201
ISI Parameters 201
Intersymbol Interference (ISI) Setup 202

Controlling AWG(s) from M8070A User Interface 203
AWG(s) in Module View 203
M819xA Configuration 204
Configuring AWG(s) Parameters 207
Simultaneous Injection of CMSI and DMSI Using M819xA AWGs 209
AWG as External Level Interference (RI/SI) Source 211
System View with AWG(s) Integration 213
Signal Generation in AWG 214
Using AWG Frequency Response Calibration for Improved Signal
Performance 215
Selecting Line Coding 215
Contents

Why Incorrect Terminations Could Damage Your Device  258
AC Coupling and Bias Tees  258
Setting up Terminations  261
DC Check (Unbalanced/Balanced Termination) for M8040A  262
Adjust Output Levels (optional)  265
De-Emphasis Signal Generator  266
M8045A De-Emphasis  269
Setting Up Data Out Port Parameters  272
Setting up Output Timing  274
Line Coding  275

Bit Rate  277
   When to Use an External Clock Source?  277
   Bit Rate Range  277
   Spread Spectrum Clocking  279
   Setting the Bit Rate  280
   External Clock Divider  281
   External PLL Clock Divider and Multiplier  281

Trigger Output  282

FEC Error Insertion  284

Error Insertion  288

FEC Error Insertion  290

Interference  294
   Common Mode Interference (CMI)  294
   Differential Mode Interference (DMI)  295

Jitter Setup  296
   High Frequency Jitter (HF Jitter)  296
   Low Frequency Jitter (LF Jitter)  296
   Global Jitter State On/Off Switch  296
   How to Enable Global Jitter State  297
   Set Jitter Configuration  297
6 Setting up Analyzer

Overview 310

M8020A/M8030A/M8040A Analyzer Ports 311
  Data In Port Termination 312
  Why Can Wrong Terminations Damage Your Device? 312
  Setting Up Termination 313

Clock Setup 318
  How does Clock Data Recovery Work? 318
  Phase Locked Loop 318
  CDR Setup in M8020A/M8030A 320
  CDR Setup for M8040A 321

Sampling Point Setup 323
  How Does the Sampling Point Setup Work? 323
  Auto Alignment 323
  Threshold Center Alignment 324
  Delay Center Alignment 325
  Canceling Auto Align 326
  Alignment BER Threshold 326
  Sampling Point Setup Window 326

Equalization 332
  Equalization in M8041A/M8051A Data In 332
  Equalization in M8062A Data In 333
  Equalization in M8046A Data In 334

Pattern Synchronization 344
  Introduction to Pattern Synchronization 344
  What Type of Synchronization Should You Use? 347
  What is False Synchronization? 348
  How Can You Tell if Your Synchronization is False? 349
  How to Synchronize an Incoming Pattern 351
7 Setting up Patterns

Pattern Overview 358

Sequence Editor 359

Overview 359
When to Use a Sequence 359
How a Sequence is Defined 359
How to Launch a Sequence Editor 360
Toolbar 361
Creating New Sequence 362
Importing a Sequence 363
Exporting a Sequence 365
Creating a Loop 365
Loop Within Sequences 366
Modifying the Existing Sequences 366
Sequence Setting Window 367
Editing a Pattern in a Sequence Editor 387
Sharing Sequences 388

User-Defined Sequences 389

Sequence Block Display 389
Sequence Block Parameters 389
Select Pattern Dialog 390

Application Specific Patterns 393

OIF CEI 393
IEEE 802.3 393
**Pattern Editor** 395
- How to Launch Pattern Editor 395
- Toolbar 396
- Settings Window 412
- Pattern Edit Pane 414
- Bit Coding 419
- 8B/10B Coding 421
- 128B/130B Coding 423
- 128B/132B Coding 425

**Pattern Capture** 428
- How to Launch Pattern Capture Window 428
- Toolbar 429
- Parameters Window 430
- How to Capture a Pattern 431
- Pattern Capture Pane 432
- Saving a Captured Pattern 433
- Capture Results Pane 433

**Interactive Link Training** 435
- PCI Express 3.0/4.0 Testing 435
- Link Training PCIe 3.0 and PCIe 4.0 Parameters 440
- Link Training for USB 3.0 and USB 3.1 443

**Using M8062A Data Out Squelch Feature** 455
- Limitations 455
- Hardware Requirements 455
- Hardware Setup 455
- Software Usage 455

8 Working with Measurements

**Overview** 460

**Exploring Measurement User Interface** 461
- Launching the Measurement User Interface 461
- Toolbar 462
### Contents

- **Status Indicator** 463
- **Measurement History Window** 463
- **Copy Measurement History Properties** 464
- **Measurement Graph** 464
- **Parameters Window** 465
- **Calculated Results Pane** 465

#### Error Ratio Measurement 467

- **Overview** 467
- **Launching Error Ratio Measurement** 467
- **Acquisition and Evaluation Parameters for Error Ratio** 469
- **How to Run a Measurement** 470
- **Error Ratio Measurement with PAM4 Symbols** 471
- **How to Stop a Measurement** 472
- **Measurement Graph** 472
- **Test Times and Confidence Levels** 473
- **Calculated Results** 474
- **Error Ratio Measurement for a Group of Analyzers** 477

#### Output Timing Measurement 479

- **Overview** 479
- **Output Timing Characteristics** 479
- **Jitter Characteristics** 479
- **Example Results** 479
- **Understanding the Jitter Calculation** 480
- **Explanation of the Fast Total Jitter Measurement** 483
- **Evaluation Parameters** 485
- **Launching the Output Timing Measurement** 487
- **Parameters Pane** 488
- **How to Run Output Timing Measurement** 489
- **How to Stop Output Timing Measurement** 489
- **Measurement Graph** 490
- **How an Output Timing Measurement Works** 490
- **Calculated Results** 491
- **Fast Total Jitter Measurement Results** 493
- **Calculated Results for Fast Total Measurement** 493
Output Level Measurement  495
Overview  495
Launching the Output Level Measurement  495
Parameters Window  496
Changing the Measurement Setting  499
Available Views  499
How to Execute Output Level Measurement  500
How to Stop Output Level Measurement  500
Measurement Graph  500
How to Improve the Output Levels Display  502
How to Change the Output Levels Properties  502
Calculated Results  503

Jitter Tolerance Measurement  508
Overview  508
Understanding Jitter Tolerance  508
Types of Jitter  510
BER Setup  511
Graph Setup  511
Instrument Setup  512
Measurement Setup  512
Launching Jitter Tolerance Measurement  518
How to Run Jitter Tolerance Measurement  519
How to Stop/Abort Jitter Tolerance Measurement  519
Measurement Graph  520
Viewing the Jitter Tolerance Results  521
Saving Jitter Tolerance Measurement Results  522
Using the Jitter Tolerance Template Editor  522
Template Editor Toolbar  523
Template Editor Functions  524
Contents

Eye Diagram Measurement 525
   What is an Eye Diagram? 525
   Methods of Representation of Eye Diagram 526
   Eye Diagram Measurement Parameters 528
   Launching the Eye Diagram Measurement 530
   How to Start/Abort an Eye Diagram Measurement 530
   How to Change the Default Settings 531
   Calculated Eye Diagram Results 532

Parameter Sweep Plugin 534
   Launching Parameter Sweep Plugin 534
   Parameter Sweep Plugin Parameters 535
   How to Run Parameter Sweep Measurement 537
   How to Stop Parameter Sweep Measurement 537
   Measurement Graph for Parameter Sweep 537
   Measurement Data for Parameter Sweep 539

9 Utilities

Overview 542
Script Editor 543
   Launching the Script Editor 544
   Toolbar 545
   Editor Pane 547
   Output Pane 548
   Console 549
   Settings Window 549
   Find and Replace 551
   Creating a Script 552
   Saving a Script 552
   Importing a Script 552
   Exporting a Script 553
   Running a Script 553
   Stopping a Script 554
   Adding Duplicate Row/Selection in the Code 554
Contents

Licenses Window  601
   Launching the Licenses Window  601

Settings Window  602
   Display Tab  603
   Channel Tab  603
   Hints Tab  604

Logger Window  605

SCPI Server Information  606

Plug-in Manager  607
   How to Launch Plug-in Manager  607
   How to Install a Plug-in  608
   How to Uninstall a Plug-in  609
   How to Update a Plug-in  610
   How to Access an Installed Plug-in Through M8070A User Interface  612

10 Licenses

Overview  614

Supported Licenses  615
   Node-Locked (Uncounted) Licenses  615
   Floating Licenses  617
   Module-Specific Licenses  617

M8020A/M8030A Licenses  618
   M8070A System Software for M8000 Series of BER Test Solutions  618
   M8041A - High-Performance BERT Module  618
   M8041A - License Upgrades for M8041A High-Performance BERT Module  620
   M8051A - High-Performance BERT Module  622
   M8051A - License Upgrades for M8051A High-Performance BERT Module  623
M8061A Multiplexer 2:1 with De-emphasis 624
M8062A 32Gb/s Front-end for J-BERT M8020A High-Performance
BERT 624

M8040A Licenses 626
M8045A Pattern generator and clock module, 32/64 Gbaud 626
M8046A Analyzer Module, 32/64 Gbaud 627

Keysight License Manager 628

Keysight License Service 629

Installing the Licenses 630
Software Requirements 630
Installing M8070A-OTP License (not required for M8020A-BU1 and
M8030A-BU1) 630
Installing Temporary License (Trial License) for the M8000 Series 630
Installing M8070A-ONP Floating/Networked License 631
Installing the FlexNet License Manager 633
Creating a New License Service using lmadmin.exe 642
Installing and Setting up Client PC Floating Licenses 643
Installing Module Licenses (not required for M8020A-BU1 and
M8030A-BU1) 644
Transporting an M8070A License 645

11 Appendix

Basic Troubleshooting 648
Upgrading software components 648
The chassis does not power up 648
Module is exceptionally hot 648
Contacting Keysight Technologies 648

M8070A Factory Patterns 649

Index
1 Introduction

J-BERT M8020A high-performance BERT / 24
M8030A Multi-Channel BERT / 25
M8040A High-Performance BERT / 26
Document History / 28
Related Documents / 29
Abbreviations used in this Document / 29
Overview

J-BERT M8020A high-performance BERT

The Keysight J-BERT M8020A high-performance BERT enables fast, accurate receiver characterization of single- and multi-lane devices running up to 16 or 32 Gb/s.

With today’s highest level of integration, the M8020A streamlines your test setup. In addition, automated in situ calibration of signal conditions ensures accurate and repeatable measurements.

Figure 1 Typical base M8020A instrument configuration

Key Features

- Data rates up to 8.5 and 16 Gb/s expandable to 32 Gb/s
- 1 to 4 BERT channels in a 5-slot AXIe chassis
- Integrated and calibrated jitter injection: RJ, RJ1, RJ2, SJ, BUJ, sinusoidal level interference (common-mode and differential-mode), SSC (triangular and arbitrary, residual) and Clock/2
- 8 tap de-emphasis, positive and negative
- Integrated and adjustable Intersymbol Interference
- Interactive link training for PCI Express
- Built-in clock recovery and equalization
- All options and modules are upgradeable
M8020A Applications

The J-BERT M8020A is designed for R&D and test engineers who characterize and verify compliance of chips, devices, boards and systems with serial I/O ports up to 16 Gb/s and 32 Gb/s in the consumer, computer, mobile computing, data center and communications industry.

The J-BERT M8020A can be used to test popular serial bus standards, such as PCI Express®, SATA/SAS, DisplayPort, USB Super Speed, MIPI M-PHY, SD UHS-II, Fibre Channel, QPI, memory buses, backplanes, repeaters, active optical cables, Thunderbolt, 10/40 GbE/SFP+/QSFP, 100 GbE/CFP2.

M8030A Multi-Channel BERT

The M8030A Multi-Channel BERT extents the J-BERT M8020A platform to a real multi-channel BERT solution supporting up to 10 pattern generators and 10 error detectors (EDs) to allow multi-channel application tests like, PCIe and PON. Wherever multi-channel measurements are required in order to speed up throughput or test under real application conditions, the M8030A is a perfect solution.
1 Introduction

Key Features

- Data rates up to 8.5 and 16 Gb/s
- 1 to 10 BERT pattern generator and analyzer and channels in a 14-slot AXIe chassis
- Clock synchronization between all modules
- 8 tap de-emphasis, positive and negative
- Integrated and adjustable ISI
- Built-in clock recovery and equalization

M8030A Applications

The M8030A multi-channel BERT is designed for R&D and test engineers who characterize and verify compliance for electronic chips, devices, boards, systems with multiple I/O ports (up to 16 Gb/s) in various industry segments dealing with basic consumer goods, computer devices, communication equipments, etc. Typical applications are:

- PCIe multi-channel test
- PON applications
- XAUI and GAUI multi-lane test

M8040A High-Performance BERT

The Keysight Technologies M8040A is a highly integrated BERT for physical layer characterization and compliance testing.

With support for pulse amplitude modulation 4-level (PAM4) and non-return-to-zero (NRZ) signals, and symbol rates up to 64 Gbaud (corresponds to 112 Gbit/s) it covers all flavors of the emerging 400 GbE and CEI-56G standards.

The M8040A BERT’s true error analysis provides repeatable and accurate results, optimizing the performance margins of your devices.

Key Features

The M8040A provides the following features:

- Data rates from 2 to 32 and 64 Gbaud
- PAM4 and NRZ selectable from M8070A user interface
- Built-in 4 tap de-emphasis to compensate loss
- Integrated and calibrated jitter injection: RJ, RJ1, RJ2, SJ, BUJ, and Clk/2 Jitter
• Two pattern generator channels per module to emulate aggressor
• Linearity tests with adjustable PAM4 levels
• Short connections to the DUT with remote heads for the pattern generator
• True PAM4 error detection in real-time for low BER levels
• Graphical user interface and remote control via M8000 system software
• Scalable and upgradeable with options and modules
• Clock recovery with N1076A and N1077A

M8040A Applications

The M8040A is designed for R&D and test engineers who characterize chips, devices, transceiver modules and sub-components, boards and systems with serial I/O ports operating with data rates up to 32 Gbaud and 64 Gbaud in the data center and communications industries.

The M8040A can be used for receiver (input) testing for many popular interconnect standards, such as:
• 400 Gigabit Ethernet (IEEE 802.3bs)
• 200/100/50 Gigabit Ethernet
• OIF CEI - 56G (NRZ and PAM4 versions)
• 64G/112G Fibre Channel
• Infiniband-HDR
• CDAUI-8
• Proprietary interfaces for chip-to-chip, chip-to-module, backplanes, repeaters, and active optical cables, operating up to 64 Gbaud.

Figure 3 Typical M8040A instrument configuration
1 Introduction

Document History

<table>
<thead>
<tr>
<th>Edition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edition 1.0, June 2014</td>
<td>Edition 1.0 of the M8000 Series User Guide is in accordance to the M8070A version 1.0.</td>
</tr>
<tr>
<td>Edition 2.0, October 2014</td>
<td>Edition 2.0 of the M8000 Series User Guide is in accordance to the M8070A version 1.5.</td>
</tr>
<tr>
<td>Edition 4.0, August 2015</td>
<td>Edition 4.0 of the M8000 Series User Guide is in accordance to the M8070A version 2.5.</td>
</tr>
<tr>
<td>Edition 8.0, December 2016</td>
<td>Edition 8.0 of the M8000 Series User Guide is in accordance to the M8070A version 3.5.</td>
</tr>
<tr>
<td>Edition 10.0, October 2017</td>
<td>Edition 10.0 of the M8000 Series User Guide is in accordance to the M8070A version 4.0.</td>
</tr>
</tbody>
</table>
Edition Description

Related Documents

<table>
<thead>
<tr>
<th>Document Part No.</th>
<th>Document Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>M8000-91010</td>
<td>Tips for Preventing Damage</td>
</tr>
<tr>
<td>M8000-91020</td>
<td>M8020A Start Here Document</td>
</tr>
<tr>
<td>M8030-91010</td>
<td>M8030A Start Here Document</td>
</tr>
<tr>
<td>M8020-91010</td>
<td>M8000 Series BER Test Solutions Installation Guide</td>
</tr>
<tr>
<td>M8020-91020</td>
<td>M8020A/M8030A Getting Started Guide</td>
</tr>
<tr>
<td>M8020-91030</td>
<td>M8000 Series BER Test Solutions User Guide</td>
</tr>
<tr>
<td>M8020-91040</td>
<td>M8000 Series BER Test Solutions Programming Guide</td>
</tr>
<tr>
<td>M8070-91010</td>
<td>M8000 Series BER Test Solutions Plug-ins</td>
</tr>
<tr>
<td>M8040-91010</td>
<td>M8040A Start Here Document</td>
</tr>
<tr>
<td>M8040-91020</td>
<td>M8040A Getting Started Guide</td>
</tr>
</tbody>
</table>

Abbreviations used in this Document

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Extended Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>AXIe</td>
<td>AdvancedTCA Extensions for Instrumentation and Test</td>
</tr>
<tr>
<td>AWG</td>
<td>Arbitrary Waveform Generator</td>
</tr>
<tr>
<td>BER</td>
<td>Bit Error Ratio</td>
</tr>
</tbody>
</table>
### Abbreviation

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Extended Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>CDR</td>
<td>Clock Data Recovery</td>
</tr>
<tr>
<td>CTLE</td>
<td>Continuous-Time Linear Equalizer</td>
</tr>
<tr>
<td>DUT</td>
<td>Device Under Test</td>
</tr>
<tr>
<td>ESD</td>
<td>Electrostatic Discharge</td>
</tr>
<tr>
<td>ESM</td>
<td>Embedded System Module</td>
</tr>
<tr>
<td>GB</td>
<td>Gigabyte</td>
</tr>
<tr>
<td>GUI</td>
<td>Graphical User Interface</td>
</tr>
<tr>
<td>J-BERT</td>
<td>Jitter-Bit Error Ratio Tester</td>
</tr>
<tr>
<td>LED</td>
<td>Light-Emitting Diode</td>
</tr>
<tr>
<td>MB</td>
<td>Megabyte</td>
</tr>
<tr>
<td>MIPI</td>
<td>Mobile Industry Processor Interface</td>
</tr>
<tr>
<td>PC</td>
<td>Personal Computer</td>
</tr>
<tr>
<td>PCIe</td>
<td>Peripheral Component Interconnect Express</td>
</tr>
<tr>
<td>PLL</td>
<td>Phase Locked Loop</td>
</tr>
<tr>
<td>PRBS</td>
<td>Pseudorandom Binary Sequence</td>
</tr>
<tr>
<td>PXI</td>
<td>PCI eXtensions for Instrumentation</td>
</tr>
<tr>
<td>R &amp; D</td>
<td>Research &amp; Development</td>
</tr>
<tr>
<td>SAS</td>
<td>Serial Attached SCSI</td>
</tr>
<tr>
<td>SATA</td>
<td>Serial Advanced Technology Attachment</td>
</tr>
<tr>
<td>SCPI</td>
<td>Standard Commands for Programmable Instruments</td>
</tr>
<tr>
<td>SMA</td>
<td>SubMiniature Version A</td>
</tr>
<tr>
<td>SSC</td>
<td>Spread Spectrum Clock</td>
</tr>
<tr>
<td>TCP</td>
<td>Transmission Control Protocol</td>
</tr>
<tr>
<td>USB</td>
<td>Universal Serial Bus</td>
</tr>
<tr>
<td>VCO</td>
<td>Voltage Controlled Oscillator</td>
</tr>
</tbody>
</table>
2  Know Your Hardware

M8020A Overview / 32
M9505A AXIe Chassis / 33
Host Computer / 35
M8030A Overview / 36
M9514A AXIe Chassis / 37
M8020A / M8030A Modules / 40
M8020A Module Setup / 55
M8030A Module Setup / 57
M8040A Overview / 59
M8040A Modules / 60
M8040A Module Setup / 69
AWG Modules Supported by M8070A System Software / 70
Other Supported Hardware(s) / 72
Hardware Setup for M8046A and M8062A Modules / 74
ESD Protection / 76
M8020A Overview

The Keysight's J-BERT M8020A High-Performance BERT is a modular instrument which supports the following modules:

- M8061A multiplexer 2:1 with de-emphasis 32 Gb/s.
- M8062A 32Gb/s Front-end for J-BERT M8020A High-Performance BERT
- In addition to above J-BERT modules, it also supports M8195A and M8196A Arbitrary Waveform Generator modules. Details of these modules can be found at www.keysight.com/find/m8195a and www.keysight.com/find/m8196a

M8020A being a modular product includes different sets of modules which are hosted in an AXI chassis. Each module and its features have their own license. You need to install these options in your instrument in order to use the modules or features. For details, refer to the chapter Licenses on page 613. However, if you have ordered M8020A-BU1, no license is required.

The M8041A module must be installed in slots 1 through 3 in the AXIe chassis unless the M9536A AXIe Embedded Controller is installed. The following configurations are possible in an M9505A 5-slot chassis:

- 1 or 2-channel, 16 Gb/s - (1) M8041A
- 3 or 4-channel, 16 Gb/s - (1) M8041A + (1) M8051A
- 1-channel, 32 Gb/s (Pattern Generator only) - (1) M8041A + (1) M8061A
- 1-channel, 32 Gb/s (Pattern Generator only or full BERT) - (1) M8041A + (1) M8062A
- M8195A/M8196A module can more or less arbitrarily be added into the 5 slot module

Additionally, the M8061A, M8062A and M8195A/M8196A modules can be installed and operated in a 2 slot frame.

**NOTE**

In case an AWG module (M8195A/M8196A) is used in a combined system with M8020A modules, ensure that the AWG modules should be always be mounted in a slot number higher that M8020A modules in the AXIe chassis. In other words, an AWG module always has to mounted last in the chassis.
For details on the features and hardware components of each of the above-mentioned modules, refer to M8020A / M8030A Modules on page 40.

M9505A AXIe Chassis

The M9505A AXIe Chassis is a modular instrument chassis that supports complex and high density testing. The chassis provides slots for installing multiple AXIe based instrument modules such as the M8041A, M8051A, M8061A and M8062A modules. Besides providing a frame for the installation of these instrument modules, the M9505A AXIe Chassis also provides power, a cooling system, a PCIe Gen2 local data bus, a Gigabit LAN interconnect, and a cabled USB (USB option required) and PCIe connection for external host computer connectivity.

The following model of the M9505A AXIe Chassis supports the M8020A modules:

- M9505A - a 5-Slot AXIe chassis

**NOTE**

The USB connection is recommended when using a laptop or desktop PC as an external controller. The PCIe connection is recommended for use with a desktop PC as an external controller only.

Refer to the Keysight M9505A AXIe Chassis Startup Guide to get detailed information about the AXIe chassis.
AXIe Embedded System Module (USB ESM)

The bottom slot of the AXIe chassis is reserved for the Embedded System Module (ESM) which is factory-installed. The ESM has a USB 2.0 interface as well as a PCIe x8, Gen1 and Gen2 compliant interface to connect an external host computer to the chassis. The following figure shows the PCIe Port and USB Port in ESM.

The ESM:
- runs the chassis embedded operating system which manages all internal tasks and communications.
- tracks inserted modules and manages power requirements.
- monitors chassis temperature and controls variable-speed chassis fans.
- monitors module sensors and reports component failures to a system log.
- acts as a Gigabit Ethernet switch; forwards frames along the backplane.
- connects an external host computer to the chassis.
- synchronizes timing across all modules through the Keysight Trigger Bus, using an internal or external clock source.
- LAN connector on AXIe ESM is not used. Only use LAN connection on the host computer.
- Either the PCIe (desktop only) or USB (desktop or laptop) port can be used in this ESM but not both simultaneously. When you use the PCIe port, the USB port is automatically disabled until the PCIe port is no longer in use.
Host Computer

A host computer is used to:
- host all the software components of the instrument modules needed to control, configure, and use the modules.
- communicate with the ESM of the M9505A AXIe Chassis to allow you to monitor and control the chassis.

A host computer can be:
- the M9537A AXIe Embedded Controller module.
- a laptop with a USB port or with PCIe port.
- a desktop PC with a USB port or x8 or wider PCIe slot for the cabled PCIe adapter card.

Keysight M9537A AXIe Embedded Controller Module

The M9537A AXIe Embedded Controller is a one slot module that you can install in the M9505A AXIe Chassis like any other instrument module. This module acts as a host computer when installed in the M9505A AXIe Chassis. It is always installed in slot 1 of the M9505A AXIe Chassis.

The following figure displays this module.
M8030A Overview

The M8030A is a modular instrument which supports the following modules.

- M8041A high-performance BERT generator-analyzer-clock 8/16 Gb/s
- M8051A high-performance BERT generator-analyzer 8/16 Gb/s
- M8092A Multi-channel synchronization module

The modules must be installed in the M9514A AXIe 14-slot chassis in the following way:

<table>
<thead>
<tr>
<th>Slot Number</th>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td># 1</td>
<td>M8030A-BU1 AXIe embedded controller. For M8030A-BU2 this slot is empty and covered with filler front-plane</td>
</tr>
<tr>
<td># 2, 3 &amp; 4</td>
<td>M8041A module</td>
</tr>
<tr>
<td># 5 &amp; 6</td>
<td>M8051A module</td>
</tr>
<tr>
<td># 7</td>
<td>M9521A AXIe system module, always included in M8030A-BU1 or M8030A-BU2, must be in this slot</td>
</tr>
<tr>
<td># 8 &amp; 9</td>
<td>M8051A module</td>
</tr>
<tr>
<td># 10 &amp; 11</td>
<td>M8051A module</td>
</tr>
<tr>
<td># 12 &amp; 13</td>
<td>M8051A module</td>
</tr>
<tr>
<td># 14</td>
<td>M8192A multi-channel synchronization module, always required in this slot</td>
</tr>
</tbody>
</table>

For details on the features and hardware components of each of the above mentioned modules, refer to M8020A and M8030A Getting Started Guide.
M9514A AXIe Chassis

The Keysight M9514A AXIe 14-slot chassis (one slot for the AXIe System Module plus 13 instrument module slots) is a modular instrument chassis fully compatible with the AXIe 1.0 Hardware specifications. It allows multiple application-specific instrument modules to share a common chassis frame, power supply, cooling system, PCI Express (PCIe) Gen 2 data bus, Gigabit LAN hub, local bus for module-to-module signaling, and host PC connections.

Multiple chassis may be interconnected for scalability. The chassis provides 13 general purpose peripheral slots that accept 1U AXIe instrument modules. Each module slot has a Gen 2 x4 link (maximum of 2 GB/s data rate per module) to the chassis primary data ‘fabric’ hub—a x8 PCIe switch and data bus.

The chassis requires a full module height AXIe System Module (ASM) such as the Keysight M9521A, to manage chassis functions.

**NOTE**

The USB connection is recommended when using a laptop or desktop PC as an external controller. The PCIe connection is recommended for use with a desktop PC as an external controller only.

**NOTE**

PCIe connectivity between the M9514A AXIe Chassis and an external desktop PC controller is recommended when full channel plus large patterns need to be downloaded.

Refer to the Keysight M9514A AXIe Chassis Startup Guide to get detailed information about the AXIe chassis.
The M9521A AXIe System Module (ASM) is installed in the system slot of the M9514A (slot 7). It provides the system communication and synchronization functions required in an AXIe chassis including:

- Trigger bus and clock routing.
- Managing clocks, including internal or external reference sources.
- Gigabit LAN switching with front panel RJ45 LAN connections.
- AXIe Fabric 1 switching (Gen 2 x4 lanes to each module slot).
Keysight M9537A AXIe Embedded Controller Module

The M9537A AXIe Embedded Controller is a one slot module that you can install in the M9505A/M9514A AXIe Chassis like any other instrument module. This module acts as a host computer when installed in the M9505A/M9514A AXIe Chassis. It is always installed in slot 1 of the M9505A AXIe Chassis. It may be installed in any slot of the M9514A AXIe chassis except for Slot 7 which is reserved for the ASM. However, to eliminate interference with the local bus used for E-Keying (if your AXIe modules use E-Keying), you should install the controller in one of the outside slots; e.g., 1 or 14 first, then 2 or 13, etc.

The following figure displays this module:

![M9537A AXIe Embedded Controller Module](image)

The ESM:
- runs the chassis embedded operating system which manages all internal tasks and communications.
- tracks inserted modules and manages power requirements.
- monitors chassis temperature and controls variable-speed chassis fans.
- monitors module sensors and reports component failures to a system log.
- acts as a Gigabit Ethernet switch; forwards frames along the backplane.
- connects an external host computer to the chassis.
- synchronizes timing across all modules through the Keysight Trigger Bus, using an internal or external clock source.

LAN connector on AXIe ESM is not used. Only use LAN connection on the host computer.

Either the PCIe (desktop only) or USB (desktop or laptop) port can be used in this ESM but not both simultaneously. When you use the PCIe port, the USB port is automatically disabled until the PCIe port is no longer in use.
M8020A / M8030A Modules

The M8020A/M8030A modules are recognized by the model number and name located on their front panel.

Each BERT module can be configured for 8 Gb/s or 16 Gb/s operation, as generator-only or as full BERT. Some upgraded features/components of a module are licensed and are only available when you purchase a license for that option. The M8062A module supports 32 Gb/s and the M8195A as a BERT module can support higher speeds than 16 Gb/s. The M8195A cannot be used as a full BERT. It has no analyzer.

The following sections describe each of the M8020A/M8030A instrument modules in detail.

J-BERT M8041A Generator-Analyzer-Clock Module

The J-BERT M8041A is a BERT module that can be installed into an Keysight M9505A 5-slot AXIe chassis. This module occupies three slots.

The M8041A is a two channel bit error ratio tester with built-in clock and data generator for performing compliance and characterization measurements. The second channel requires a license.

M8041A Features

The M8041A module provides the following features:

- Two channel pattern generator (option 0G2) and two channel error detector (option 0A2)
- Data rate from 256 Mb/s to 16.2 Gb/s (option G16 or C16) for pattern generation and error detection
- Built in jitter injection (option OG3)
Know Your Hardware

- Adjustable ISI offered for M8041A and M8051A (option 0G5), software 2.0 and serial number >= DE55300500
- Built in 8 tap de-emphasis (option 0G4)
- Built in receiver equalization (CTLE, option 0A3)
- Built in reference clock multiplier for pattern generator (option 0G6)
- Simultaneous common mode and differential mode level interference (option 0G7)
- Interactive link training (option 0S1, Software 1.5)
- Four universal control inputs with adjustable threshold
- Three universal control outputs with adjustable levels
- 2 Gb pattern memory per channel (requires software 1.5)

M8041A Module Components

The following figure displays the front panel of the M8041A module with its various components labeled.
The M8041A module has the following components.

### Table 7  Insertion/Extraction and Retaining

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retaining screws</td>
<td>The screws on both ends of the module are used to retain the module tightly inside the M9505A AXIe Chassis slot once you have fully placed it inside the chassis. To remove the module, you first need to loosen these screws ensuring that these screws disengage completely.</td>
</tr>
<tr>
<td>Module Insertion/Extraction Handles</td>
<td>The handles on both sides of the module to insert or eject the module from the slot of the M9505A AXIe Chassis.</td>
</tr>
</tbody>
</table>

### Table 8  Front Panel LEDs

<table>
<thead>
<tr>
<th>Connector Name</th>
<th>Active when...</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fail</td>
<td>power-up fault condition</td>
<td>red</td>
</tr>
<tr>
<td>Access</td>
<td>power-up ready state</td>
<td>green</td>
</tr>
<tr>
<td>Data In x</td>
<td>input is overloaded</td>
<td>red</td>
</tr>
<tr>
<td>Data Out x</td>
<td>output is overloaded</td>
<td>red</td>
</tr>
<tr>
<td>Data Mod In x</td>
<td>input is active</td>
<td>green</td>
</tr>
<tr>
<td>Ctrl In A/Ctrl In B</td>
<td>logic level is detected</td>
<td>green</td>
</tr>
<tr>
<td>Ctrl Out A</td>
<td>output is active</td>
<td>green</td>
</tr>
<tr>
<td>Clk In</td>
<td>signal is detected</td>
<td>green</td>
</tr>
<tr>
<td>Ref Clk In</td>
<td>signal is detected</td>
<td>green</td>
</tr>
<tr>
<td>Ref Clk Out</td>
<td>output is active</td>
<td>green</td>
</tr>
<tr>
<td>Aux In</td>
<td>not used</td>
<td>n/a</td>
</tr>
<tr>
<td>Clk Out</td>
<td>output is active</td>
<td>green</td>
</tr>
<tr>
<td>Trig Out</td>
<td>output is active</td>
<td>green</td>
</tr>
<tr>
<td>Clk Mod In</td>
<td>input is active</td>
<td>green</td>
</tr>
<tr>
<td>Sys Out A/Sys Out B</td>
<td>output is active</td>
<td>green</td>
</tr>
<tr>
<td>Sys Ctrl In A/Sys Ctrl In B</td>
<td>logic level is detected</td>
<td>green</td>
</tr>
</tbody>
</table>
M8041A Front Panel Connector Inputs/Outputs

CAUTION

The inputs of the M8041A module are sensitive to static electricity. Therefore, take necessary anti-static precautions, such as wearing a grounded wrist strap, to minimize the possibility of electrostatic damage.

Table 9  Channel x Data Inputs/Outputs

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Out and /Data Out</td>
<td>Differential data outputs (3.5 mm, female).</td>
</tr>
<tr>
<td>Data In and /Data In</td>
<td>Differential data inputs (3.5 mm, female).</td>
</tr>
<tr>
<td>Data Mod In</td>
<td>Accepts an external source for data out delay modulation (SMA, female).</td>
</tr>
</tbody>
</table>

Table 10  Clock Inputs/Outputs

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clk In</td>
<td>External clock input in the range of 8.1 to 16.2 GHz. This input is used as a direct clock for all channels in forwarded clock applications (SMA, female).</td>
</tr>
<tr>
<td>Ref Clk In</td>
<td>Reference clock input for applications that provide a host reference clock in the range of 10 MHz to 16 GHz. The clock signal may be SSC modulated and is used as the reference for the system clock of all Tx and Rx channels. A SSC tolerant PLL is used to multiply the reference clock to the system clock (SMA, female).</td>
</tr>
<tr>
<td>Ref Clk Out</td>
<td>The reference clock output is used to provide a 10 MHz or 100 MHz reference clock to the DUT or other test equipment (SMA, female).</td>
</tr>
<tr>
<td>Clk Out and /Clk Out</td>
<td>Differential clock output (3.5 mm, female).</td>
</tr>
<tr>
<td>Trig Out and /Trig Out</td>
<td>This output is used to send a trigger signal to another connected device, such as an oscilloscope (3.5 mm, female). It can also be used as a sub rate clock.</td>
</tr>
<tr>
<td>Clk Mod In</td>
<td>Input for delay modulation of the Trig Out and Clk Out channel. Both outputs are always affected (SMA, female).</td>
</tr>
</tbody>
</table>
### Table 11  Sync In/Sync Out

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sync In</td>
<td>This input is used to synchronize two or more modules to a common system clock. It is connected to the Sync Out of the other module.</td>
</tr>
<tr>
<td>Sync Out</td>
<td>This output is used to synchronize two or more modules to a common system clock. It is connected to the Sync In of the other module.</td>
</tr>
</tbody>
</table>

### Table 12  System Inputs/Outputs

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sys Out A/Sys Out B</td>
<td>System level control outputs used to signal events to the DUT or external instruments (SMA, female).</td>
</tr>
<tr>
<td>Sys In A/Sys In B</td>
<td>System level control inputs used to generate sequencer events (SMA, female).</td>
</tr>
</tbody>
</table>

### Table 13  Control Inputs/Output

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
</table>
| Ctrl In A/Ctrl In B | The module has two control inputs at the font panel each with the following selectable functionality (SMA, female):  
  **Error Add Input**  
  Every rising edge at the input generates a single error in the output data stream by flipping a single bit. The maximum repetition rate is data rate divided by 4 times the vector size.  
  **Output Blanking**  
  If the input level is above the threshold level the pattern generator stops and only 0's are sent on data output. Normal operation resumes when the input level is below the threshold.  
  **Electrical Idle**  
  If the input level is above the threshold level the output amplifier enters electrical idle. Normal operation resumes when the input level is below the threshold.  
  **Gating Input**  
  If a logical high is applied to the gating input the error detector will ignore the incoming bits during a BER measurement. The ignored bit sequence is always a multiple of the vector size. For measuring data in bursts of bits, rather than a continuous stream of bits, a special operating mode is used. This mode is the burst sync mode. In this case, the signal at the gating input controls the synchronization and the error counting for each burst. |
| Ctrl Out A   | The module has one control output at the front panel with the following functionality (SMA, female):  
  **Error Output**  
  This signal can be used to trigger an external instrument to help in error analysis. If an error occurs, a single RZ pulse is generated. Continuous errors will result in a clock signal. |
J-BERT M8051A Generator-Analyzer

The J-BERT M8051A is an instrument module that can be installed into the M9505A 5-slot AXiLe Chassis. This module occupies two slots and requires the M8041A module for proper operation.

The M8051A is a two channel Generator and two channel Analyzer for performing compliance and characterization measurements.

M8051A Features

The main M8051A features are the same as the M8041A features. For details, refer to J-BERT M8041A Generator-Analyzer-Clock Module on page 40.

M8051A Module Components

The following figure displays the front panel of the M8051A module with its various components labeled.
The M8051A module has the following components.

### Table 14 Insertion/Extraction and Retaining

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retaining screws</td>
<td>The screws on both ends of the module are used to retain the module tightly inside the M9505A AXIe Chassis slot once you have fully placed it inside the chassis. To remove the module, you first need to loosen these screws ensuring that these screws disengage completely.</td>
</tr>
<tr>
<td>Module Insertion/Extraction Handles</td>
<td>The handles on both sides of the module to insert or eject the module from the slot of the M9505A AXIe Chassis.</td>
</tr>
</tbody>
</table>

### Table 15 Front Panel LEDs

<table>
<thead>
<tr>
<th>Connector Name</th>
<th>Active when...</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fail</td>
<td>power-up fault condition</td>
<td>red</td>
</tr>
<tr>
<td>Access</td>
<td>power-up ready state</td>
<td>green</td>
</tr>
<tr>
<td>Data In x</td>
<td>input is overloaded</td>
<td>red</td>
</tr>
<tr>
<td>Data Out x</td>
<td>output is overloaded</td>
<td>red</td>
</tr>
<tr>
<td>Data Mod In x</td>
<td>input is active</td>
<td>green</td>
</tr>
<tr>
<td>Ctrl In A/Ctrl In B</td>
<td>logic level is detected</td>
<td>green</td>
</tr>
</tbody>
</table>

**M8051A Front Panel Connector Inputs/Outputs**

**CAUTION**

The inputs of the M8051A module are sensitive to static electricity. Therefore, take necessary anti-static precautions, such as wearing a grounded wrist strap, to minimize the possibility of electrostatic damage.
Table 16  Channel x Data Inputs/Outputs

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Out and /Data Out</td>
<td>Differential data outputs (3.5 mm, female).</td>
</tr>
<tr>
<td>Data In and /Data In</td>
<td>Differential data inputs (3.5 mm, female).</td>
</tr>
<tr>
<td>Data Mod In</td>
<td>Accepts an external source for data out delay modulation (SMA, female).</td>
</tr>
</tbody>
</table>

Table 17  Sync In

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sync In</td>
<td>This input is used to synchronize two or more modules to a common system clock. It is connected to the Sync Out of the other module or to the clock distribution module if more than two modules are installed. The sync cable is required if M8051A is connected with M8041A module.</td>
</tr>
</tbody>
</table>

Table 18  Control Inputs/Output

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
</table>
| Ctrl In A/Ctrl In B | The module has two control inputs at the front panel each with the following selectable functionality (SMA, female):  
  **Error Add Input**  
  Every rising edge at the input generates a single error in the output data stream by flipping a single bit. The maximum repetition rate is data rate divided by 4 times the vector size.  
  **Output Blanking**  
  If the input level is above the threshold level the pattern generator stops and only 0's are sent on data output. Normal operation resumes when the input level is below the threshold.  
  **Electrical Idle**  
  If the input level is above the threshold level the output amplifier enters electrical idle. Normal operation resumes when the input level is below the threshold.  
  **Gating Input**  
  If a logical high is applied to the gating input the error detector will ignore the incoming bits during a BER measurement. The ignored bit sequence is always a multiple of the vector size. For measuring data in bursts of bits, rather than a continuous stream of bits, a special operating mode is used. This mode is the burst sync mode. In this case, the signal at the gating input controls the synchronization and the error counting for each burst. |
| Ctrl Out A | The module has one control output at the front panel with the following functionality (SMA, female):  
  **Error Output**  
  This signal can be used to trigger an external instrument to help in error analysis. If an error occurs, a single RZ pulse is generated with the width of half a vector length. Continuous errors will result in a clock signal. |
M8061A 32 Gb/s Multiplexer with De-emphasis Module

The M8061A is an instrument module that can be installed into the M9502A 2-slot or M9505A 5-slot AXiE Chassis. This module occupies two slots.

The M8061A is used to characterize serial interfaces of up to 32 Gb/s. The M8061A provides four calibrated de-emphasis taps, which can be extended to eight taps, built-in superposition of level interference, and Clock/2 jitter injection.

M8061A Features

- Expands data rate of M8041A and M8051A generators up to 32 Gb/s enabling accurate and complete receiver stress testing
- Integrated and calibrated 4-tap de-emphasis, expandable to 8 taps
- Internal superposition of interference for common mode and differential mode
- Transparent to jitter generated by the J-BERT M8020A, Clock/2 jitter can be added
- Supports electrical idle
- Control from J-BERT M8020A user interface via USB.

M8061A Module Components

The following figure displays the front panel of the M8061A module with its various components labeled.
The M8061A module has the following components.

### Table 19  Insertion/Extraction and Retaining

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retaining screws</td>
<td>The screws on both ends of the module are used to retain the module tightly inside the M9505A AXIe Chassis slot once you have fully placed it inside the chassis. To remove the module, you first need to loosen these screws ensuring that these screws disengage completely.</td>
</tr>
<tr>
<td>Module Insertion/Extraction Handles</td>
<td>The handles on both sides of the module to insert or eject the module from the slot of the M9505A AXIe Chassis.</td>
</tr>
</tbody>
</table>

### Table 20  Front Panel LEDs

<table>
<thead>
<tr>
<th>Connector Name</th>
<th>Active when...</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fail</td>
<td>power-up fault condition</td>
<td>red</td>
</tr>
<tr>
<td>Access</td>
<td>power-up ready state</td>
<td>green</td>
</tr>
</tbody>
</table>
M8061A Front Panel Connector Inputs/Outputs

The inputs of the M8061A module are sensitive to static electricity. Therefore, take necessary anti-static precautions, such as wearing a grounded wrist strap, to minimize the possibility of electrostatic damage.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrical Idle In</td>
<td>This input is used to enable/disable the output signal by an external control signal. If the input level is above the threshold level, the module enters electrical idle. Normal operation resumes when the input level is below the threshold (SMA, female).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clk Out</td>
<td>Reference clock output used in clean clock mode to provide the synthesizer signal to the J-BERT without external splitter (3.5 mm, female).</td>
</tr>
<tr>
<td>Clk In</td>
<td>Reference clock input used in clean clock mode, the synthesizer should be connected to this port (3.5 mm, female).</td>
</tr>
<tr>
<td>Aux Clk In</td>
<td>External clock input in the range of 150 MHz to 14.2 GHz. This input is used with the J-BERT’s internal clock. In presence of jitter, this provides the same jitter as the data outputs (3.5 mm, female).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DMI In</td>
<td>Differential mode interference input independent of ground (SMA, female).</td>
</tr>
<tr>
<td>CMI In</td>
<td>Common mode interference input relative to ground (SMA, female).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Out and /Data Out</td>
<td>Differential or single-ended data output (2.4 mm, female).</td>
</tr>
<tr>
<td>Data In x</td>
<td>Single-ended data input (3.5 mm, female).</td>
</tr>
</tbody>
</table>
M8062A 32Gb/s Front-end for J-BERT M8020A High-Performance BERT

The M8062A extends the data rate of the J-BERT M8020A Bit Error Ratio Tester to the speeds required for testing devices with lane rates in the 25-28 Gb/s range. When combined with a two channel M8041A, the system provides data pattern generation and full-rate error analysis for users and systems with lane rates up to 32.4 Gb/s.

M8062A Features

- Extends maximum data rate of J-BERT M8020A up to 32.4 Gb/s
- Seamless control of pattern generator and error analyzer
- Integrated 8-tap de-emphasis
- Built in ISI generator for channel emulation
- Analyzer equalization eliminates errors resulting from closed eyes in loop back path
- Built in CDR for data rates up to 32 Gb/s

**NOTE**
The CDR license (M8062A-0A4) is required to enable the CDR feature. M8062A modules with serial numbers < MY55400300 may also require a hardware upgrade in order to enable this feature.

Refer to the Online Help installed and integrated into the M8070A software to learn about how to use this module.

**NOTE**
Phase-matched cables must be used when connecting the M8041A data and clock outputs to the M8062A data and clock inputs. The provided cable set, Keysight M8062-61643, meets this requirement.
M8062A Module Components

The following figure displays the front panel of the M8062A module with its various components labeled.

The M8062A module has the following components.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retaining screws</td>
<td>The screws on both ends of the module are used to retain the module tightly inside the M9505A AXIe Chassis slot once you have fully placed it inside the chassis. To remove the module, you first need to loosen these screws ensuring that these screws disengage completely.</td>
</tr>
<tr>
<td>Module Insertion/Extraction Handles</td>
<td>The handles on both sides of the module to insert or eject the module from the slot of the M9505A AXIe Chassis.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Connector Name</th>
<th>Active when...</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fail</td>
<td>power-up fault condition</td>
<td>red</td>
</tr>
<tr>
<td>Access</td>
<td>power-up ready state</td>
<td>green</td>
</tr>
</tbody>
</table>

CAUTION

The inputs and outputs of the M8062A module are sensitive to static electricity. Therefore, take necessary anti-static precautions, such as wearing a grounded wrist strap, to minimize the possibility of electrostatic damage.
### Table 27  Sync In/Clean Clk Out

<table>
<thead>
<tr>
<th>Connector Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sync In</td>
<td>This input is used to synchronize two or more modules to a common system clock. It is connected to the Sync Out of the other module. The sync cable is required if M8062A is connected with M8041A module.</td>
</tr>
<tr>
<td>Clean Clk Out</td>
<td>Half-rate, or divided, clock output with no applied jitter.</td>
</tr>
</tbody>
</table>

### M8062A Front Panel Pattern Generator Connectors

### Table 28  Electrical Idle Input

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrical Idle In</td>
<td>This input is used to enable/disable the output signal by an external control signal. If the input level is above the threshold level the module enters electrical idle. Normal operation resumes when the input level is below the threshold (SMA, female).</td>
</tr>
</tbody>
</table>

### Table 29  Pattern Generator Clock Inputs/Output

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clk Out</td>
<td>Half-rate Pattern Generator clock output. Carries the same jitter as the full-rate data output.</td>
</tr>
<tr>
<td>Clk In</td>
<td>Pattern Generator clock input (half-rate). Connect to clock output of M8041A.</td>
</tr>
<tr>
<td>Aux Clk In</td>
<td>Alternate Pattern Generator clock input (half-rate). Typically unused.</td>
</tr>
</tbody>
</table>

### Table 30  DMI/CMI Inputs

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DMI In</td>
<td>Differential Mode Interference input. Applies a single-ended, external interference source differentially to the data output (SMA, female).</td>
</tr>
<tr>
<td>CMI In</td>
<td>Common Mode Interference input. Applies a single-ended, external interference source to both the normal and complement data output signals (SMA, female).</td>
</tr>
</tbody>
</table>
### Table 31  Pattern Generator Data Inputs/Outputs

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Out and /Data Out</td>
<td>Differential or single-ended, full-rate data output to the device under test. Unused outputs must be terminated into 50 Ω. (2.4 mm, female).</td>
</tr>
<tr>
<td>Data In 1 and Data In 2</td>
<td>Single-ended, half-rate data inputs from the M8041A module (3.5 mm, female).</td>
</tr>
</tbody>
</table>

### M8062A Front Panel Analyzer Connectors

### Table 32  Error Analyzer Data Inputs/Outputs

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data In and /Data In</td>
<td>Differential or single-ended, full-rate data input from the device under test. Unused input should be terminated into 50 Ω. (2.4 mm, female). These ports are AC coupled.</td>
</tr>
<tr>
<td>Data Out 1 and Data Out 2</td>
<td>Single-ended, half-rate data outputs to the M8041A module (3.5 mm, female).</td>
</tr>
</tbody>
</table>

### Table 33  Error Analyzer Clock Inputs/Output

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clk Out</td>
<td>Half-rate Error Analyzer clock output, synchronous with analyzer sampling.</td>
</tr>
<tr>
<td>Clk In</td>
<td>Half-rate, Error Analyzer clock input. Allows external clocking of the Error Analyzer.</td>
</tr>
</tbody>
</table>
M8020A Module Setup

M8020A being a modular product includes different sets of modules which are hosted in an AXI chassis. It comprises of exactly one M8041A generator-analyzer-clock module and optionally one additional M8051A generator-analyzer module. The M8041A generator-analyzer-clock module is a true superset of the M8051A generator-analyzer module.

Setting up a Single Channel System

The single channel system is the smallest configuration consisting of one M8041A generator-analyzer-clock module within a 5-slot frame. You can upgrade it to a 2 channel system by adding the two channel options (second channel generator and second channel analyzer).

Setting up a Multi-Channel System

The multi-channel system is comprised of exactly one clock / data module and one or more data channels mounted in an AXIe frame.

The multi-channel system can be:

2-Channel System

A two-channel system consists of one clock/data module.

The following figure illustrates a two-channel system.
4-Channel System

A four-channel system consists of one clock module and one data modules.

The following figure illustrates a four-channel system.

For more details on how to establish connections between the M8020A modules, refer to the M8020A/M8030A Installation Guide.
M8030A Module Setup

The M8030A is a modular test solution which can be tailored to your specific needs from two channels with one M8041A to up to 10 channels. The modules must be installed in the M9514A AXIe 14-slot chassis as described in Table 34 on page 57:

<table>
<thead>
<tr>
<th>Slot Number</th>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td># 1</td>
<td>M8030A-BU1 AXIe embedded controller.</td>
</tr>
<tr>
<td># 2, 3 &amp; 4</td>
<td>M8041A module</td>
</tr>
<tr>
<td># 5 &amp; 6</td>
<td>M8051A module</td>
</tr>
<tr>
<td># 7</td>
<td>M9521A AXIe system module</td>
</tr>
<tr>
<td># 8 &amp; 9</td>
<td>M8051A module</td>
</tr>
<tr>
<td># 10 &amp; 11</td>
<td>M8051A module</td>
</tr>
<tr>
<td># 12 &amp; 13</td>
<td>M8051A module</td>
</tr>
<tr>
<td># 14</td>
<td>M8192A multi-channel synchronization module</td>
</tr>
</tbody>
</table>
M8030A Modules Arrangement Example

The following figure shows the M8030A modules arrangement in the M9514A AXIe 14-slot chassis:

<table>
<thead>
<tr>
<th>Slot #1</th>
<th>Slot #2</th>
<th>Slot #3</th>
<th>Slot #4</th>
<th>Slot #5</th>
<th>Slot #6</th>
<th>Slot #7</th>
<th>Slot #8</th>
<th>Slot #9</th>
<th>Slot #10</th>
<th>Slot #11</th>
<th>Slot #12</th>
<th>Slot #13</th>
<th>Slot #14</th>
</tr>
</thead>
</table>
M8040A Overview

The M8040A is a modular instrument which supports the following modules:

- M8045A High-Performance BERT Pattern Generator-Clock
- M8046A High-Performance BERT Analyzer
- M8057A Pattern Generator Remote Head

M8040A being a modular product includes different sets of modules which are hosted in an AXI chassis. Each module and its features have their own license. You need to install these options in your instrument in order to use the modules or features. For details, refer to the chapter Licenses on page 613. However, if you have ordered M8040A-BU1, no license is required.

For details on the features and hardware components of each of the above mentioned modules, refer to M8040A Getting Started Guide.

**NOTE**

In case an AWG module (M8195A/M8196A) is used in a combined system with M8040A modules, ensure that the AWG modules should be always be mounted in a slot number higher that M8040A modules in the AXIe chassis. In other words, an AWG module always has to mounted last in the chassis.
M8040A Modules

M8045A High-Performance BERT Pattern Generator-Clock Module

The M8045A module can be a one or two data channel system (a second channel can be added with license). A one channel instrument has to be returned to the factory for installing the second channel (hardware) and license. It occupies three slots of the 5-slot M9505A AXIe chassis.

M8045A Features

- Up to two Pattern Generator channels per 3-slot-module
- Symbol rate 2 to 64 Gbaud
- NRZ and PAM4 format is software-selectable
- PAM4 up to 64 Gbaud
- Built in de-emphasis
- Built in and calibrated jitter generation
- External jitter modulation per channel
- Remote head to get close to the DUT
- Pattern memory, PRBS, pattern sequencing
- Sequencing control by external control signals

Refer to the Online Help installed and integrated into the M8070A software to learn about how to use this module.

M8045A Module Components

The following figure displays the front panel of the M8045A module (2 data channel system):
The M8045A module has the following components.

### Table 35 Insertion/Extraction and Retaining

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retaining screws</td>
<td>The screws on both ends of the module are used to retain the module tightly</td>
</tr>
<tr>
<td></td>
<td>inside the M9505A AXIe Chassis slot once you have fully placed it inside the</td>
</tr>
<tr>
<td></td>
<td>chassis. To remove the module, you first need to loosen these screws ensuring</td>
</tr>
<tr>
<td></td>
<td>that these screws disengage completely.</td>
</tr>
<tr>
<td>Module Insertion/Extraction Handles</td>
<td>The handles on both sides of the module to insert or eject the module from the slot of the M9505A AXIe Chassis.</td>
</tr>
</tbody>
</table>

### Table 36 Front Panel LEDs

<table>
<thead>
<tr>
<th>Connector Name</th>
<th>Active when...</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fail</td>
<td>power-up fault condition</td>
<td>red</td>
</tr>
<tr>
<td>Access</td>
<td>power-up ready state</td>
<td>green</td>
</tr>
<tr>
<td>Data Mod In 1/2</td>
<td>signal is detected</td>
<td>green</td>
</tr>
<tr>
<td>Clk Out 1/2</td>
<td>output is active</td>
<td>green</td>
</tr>
<tr>
<td>Ctrl Out 1/2</td>
<td>output is active</td>
<td>green</td>
</tr>
<tr>
<td>Ctrl In 1/2</td>
<td>logic level is detected</td>
<td>green</td>
</tr>
<tr>
<td>P &amp; N 1/2</td>
<td>output is active</td>
<td>green</td>
</tr>
<tr>
<td>Clk In</td>
<td>signal is detected</td>
<td>green</td>
</tr>
<tr>
<td>Ref Clk In</td>
<td>signal is detected</td>
<td>green</td>
</tr>
<tr>
<td>Ref Clk Out</td>
<td>Outputs a 10 and 100 MHz clock, 1 Vpp single ended into 50 Ohm</td>
<td>green</td>
</tr>
<tr>
<td>Aux In</td>
<td>not used</td>
<td>n/a</td>
</tr>
<tr>
<td>Clk Out</td>
<td>output is active</td>
<td>green</td>
</tr>
<tr>
<td>Trig Out</td>
<td>output is active</td>
<td>green</td>
</tr>
</tbody>
</table>
Know Your Hardware

M8045A Front Panel Input/Output Ports

<table>
<thead>
<tr>
<th>Connector Name</th>
<th>Active when...</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clk Mod In</td>
<td>input is active</td>
<td>green</td>
</tr>
<tr>
<td>Sys Out A/Sys Out B</td>
<td>output is active</td>
<td>green</td>
</tr>
<tr>
<td>Sys In A/Sys In B</td>
<td>logic state is detected</td>
<td>green</td>
</tr>
</tbody>
</table>

CAUTION
The inputs/outputs of the M8045A module are sensitive to static electricity. Therefore, take necessary anti-static precautions, such as wearing a grounded wrist strap, to minimize the possibility of electrostatic damage.

Table 37  M8045A Front Panel Input/Output Ports

<table>
<thead>
<tr>
<th>Connector Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clk Out 1, 2</td>
<td>• Low Jitter (~150fs) Clk out. Baud-rate / 1,2,4,8,16</td>
</tr>
<tr>
<td></td>
<td>• Same Jitter as Data out or clean clk</td>
</tr>
<tr>
<td></td>
<td>• Typ 1.5 V pp</td>
</tr>
<tr>
<td></td>
<td>• Used for Analyzer as external clock</td>
</tr>
<tr>
<td>P and N</td>
<td>P and N must be connected to M8057A remote head.</td>
</tr>
<tr>
<td>Remote Head 1, 2</td>
<td>Remote Head Control. This output provides power and control signals for the</td>
</tr>
<tr>
<td></td>
<td>remote head amplifier</td>
</tr>
<tr>
<td>Data Mod In 1, 2</td>
<td>This input is used for data out delay modulation by an external source.</td>
</tr>
</tbody>
</table>
Ctrl In A, B

- **Error Add Input**
  Every rising edge at the input generates a single error in the output stream by flipping a single bit. The maximum repetition rate is data rate divided by 4 times the vector size.
- **Output Blanking**
  If the input level is above the threshold level pattern generation stops and only 0's are sent on data out. Normal operation resumes when the input level is below the threshold.
- **Electrical Idle**
  If the input level is above the threshold level the output amplifier enters electrical idle. Normal operation resumes when the input level is below the threshold.

Ctrl Out A, B

- **Error Output**
  This signal can be used to trigger an external instrument to help in error analysis. If an error occurs a single RZ pulse is generated with the width of half a vector length. Continuous errors will result in a clock signal.

Sync Out A, B

This output is used to synchronize two or more modules to a common system clock. It is connected to the SYNC IN of the other module or to the M8192A if more than two modules are used.

Clk In

Clock not used for M8045A.

Ref Clk In

Reference clock input for applications that provide a host reference clock in the range of 10 MHz ... 16 GHz. It may be SSC modulated and is used as the reference for the system clock of all TX and RX channels. A SSC tolerant PLL is used to multiply the reference clock to the system clock.

Ref Clk Out

The reference clock output is used to provide a 10 MHz or 100 MHz reference clock to the DUT or other test equipment.

Aux In

Port not in use.

Clk Out

Differential clock output.

Trig Out

This output is used to send a trigger signal to another connected device, such as an oscilloscope.

Clk Mod In

Input for delay modulation of TRIG OUT and CLK OUT channel, always affects both outputs.

Sys In A, Sys In B

These are control inputs at system level and can be used to generate events for the sequencer. The granularity is the vector size.

Sys Out A, Sys Out B

These are control outputs at system level and can be used to signal events to the DUT or external instruments. The granularity is the vector size.

<table>
<thead>
<tr>
<th>Connector Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl In A, B</td>
<td>The data module has 2 control inputs at the front panel. The functionality of each individual input can be selected.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Error Add Input</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Output Blanking</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Electrical Idle</strong></td>
</tr>
<tr>
<td>Ctrl Out A, B</td>
<td>The data module has 2 control output at the front panel. The functionality of this output can be selected.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Error Output</strong></td>
</tr>
<tr>
<td>Sync Out A, B</td>
<td>This output is used to synchronize two or more modules to a common system clock. It is connected to the SYNC IN of the other module or to the M8192A if more than two modules are used.</td>
</tr>
<tr>
<td>Clk In</td>
<td>Clock not used for M8045A.</td>
</tr>
<tr>
<td>Ref Clk In</td>
<td>Reference clock input for applications that provide a host reference clock in the range of 10 MHz ... 16 GHz. It may be SSC modulated and is used as the reference for the system clock of all TX and RX channels. A SSC tolerant PLL is used to multiply the reference clock to the system clock.</td>
</tr>
<tr>
<td>Ref Clk Out</td>
<td>The reference clock output is used to provide a 10 MHz or 100 MHz reference clock to the DUT or other test equipment.</td>
</tr>
<tr>
<td>Aux In</td>
<td>Port not in use.</td>
</tr>
<tr>
<td>Clk Out</td>
<td>Differential clock output.</td>
</tr>
<tr>
<td>Trig Out</td>
<td>This output is used to send a trigger signal to another connected device, such as an oscilloscope.</td>
</tr>
<tr>
<td>Clk Mod In</td>
<td>Input for delay modulation of TRIG OUT and CLK OUT channel, always affects both outputs.</td>
</tr>
<tr>
<td>Sys In A, Sys In B</td>
<td>These are control inputs at system level and can be used to generate events for the sequencer. The granularity is the vector size.</td>
</tr>
<tr>
<td>Sys Out A, Sys Out B</td>
<td>These are control outputs at system level and can be used to signal events to the DUT or external instruments. The granularity is the vector size.</td>
</tr>
</tbody>
</table>
M8046A High-Performance BERT Analyzer Module

The M8046A is an instrument module that can be installed into the M9505A 5-slot AXIe chassis. This module occupies one slot.

The M8046A supports symbol rates up to 32.4 Gbaud, the default is NRZ format.

The analyzer module can be used for error analysis in conjunction with the M8045A pattern generator, the M8195A/M8196A Arbitrary Waveform generators or as stand-alone.

With M8070A software version 5.0, the M8046A can also be used in conjunction with M8041A + M8062A.

NOTE

The three or four channel configuration requires a cable (provided with the M8046A) that connects the M8045A Sync Out to the M8046A Sync In to synchronize the two modules to a common system clock. The M8046A Analyzer module can also be used with an external clock coming from CR (e.g. N1076A) or Generator output (M8045A channel 1/2 Clock Output or M8195A/M8196A Data Output).

M8046A Features

- Symbol rates 2 to 32.4 Gbaud
- One channel per 1-slot module
- 70 mV input sensitivity
- Supports NRZ and PAM4
- Built-in equalization
- Real-time bit error and symbol error analysis

M8046A Module Components

The following figure displays the front panel of the M8046A module with its various components:
The M8046A module has the following components.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retaining screws</td>
<td>The screws on both ends of the module are used to retain the module tightly inside the M9505A AXiChassis slot once you have fully placed it inside the chassis. To remove the module, you first need to loosen these screws ensuring that these screws disengage completely.</td>
</tr>
<tr>
<td>Module Insertion/Extraction Handles</td>
<td>The handles on both sides of the module to insert or eject the module from the slot of the M9505A AXiChassis.</td>
</tr>
</tbody>
</table>

### Table 39  Front Panel LEDs

<table>
<thead>
<tr>
<th>Connector Name</th>
<th>Active when...</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fail</td>
<td>power-up fault condition</td>
<td>red</td>
</tr>
<tr>
<td>Access</td>
<td>power-up ready state</td>
<td>green</td>
</tr>
<tr>
<td>Clk In</td>
<td>on when output active and CLK detected</td>
<td>green</td>
</tr>
<tr>
<td>Ctrl Out</td>
<td>on when output active</td>
<td>green</td>
</tr>
<tr>
<td>Ctrl In</td>
<td>logic state is detected</td>
<td>green</td>
</tr>
<tr>
<td>Data In</td>
<td>data received</td>
<td>green</td>
</tr>
</tbody>
</table>
M8046A Front Panel Inputs/Outputs Ports

**CAUTION** The inputs of the M8046A module are sensitive to static electricity. Therefore, take necessary anti-static precautions, such as wearing a grounded wrist strap, to minimize the possibility of electrostatic damage.

<table>
<thead>
<tr>
<th>Connector Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data In and /Data In</td>
<td>Differential data inputs (3.5 mm, female)</td>
</tr>
<tr>
<td>Clk In</td>
<td>Clock input to sample the incoming data. Full/half and quarter-rate clock. Single ended.</td>
</tr>
<tr>
<td>Sync In</td>
<td>This input is used to synchronize two or more modules to a common system clock. It is connected to the Sync Out of the other module or to the clock distribution module if more than two modules are installed. The sync cable is required if M8046A is connected with M8045A Pattern Generator module. Not needed if external clock is used.</td>
</tr>
<tr>
<td>Ctrl Out A</td>
<td>Outputs a pulse in case of an error. Generates a pulse or static high/low if used from sequencer.</td>
</tr>
<tr>
<td>Ctrl In A</td>
<td>This input can be used as sequence trigger or pattern capture event.</td>
</tr>
</tbody>
</table>

M8057A Pattern Generator Remote Head

The M8057A remote head is an external box which must be connected to each channel of M8045A module. The three cables are fixed on the back side of M8057A which need to be connected to M8045A remote head, P and N connectors. It helps in minimizing signal degradations caused by lossy channels.

**NOTE** Please note that it is mandatory to connect M8057A remote head with each channel of M8045A module. Operation without M8057A remote head will not allow you to receive data.
M8057A Remote Head Components

The following figure displays the front panel of the M8057A remote head with its various components:

![M8057A Remote Head Components](image)

The M8057A remote head has the following components.

### Table 41  Front Panel LEDs

<table>
<thead>
<tr>
<th>Connector Name</th>
<th>Active when...</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ready</td>
<td>remote head is operation</td>
<td>green</td>
</tr>
</tbody>
</table>

### Table 42  M8057A Front Panel Inputs/Outputs Ports

<table>
<thead>
<tr>
<th>Connector Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Out and /Data Out</td>
<td>Connected to DUT</td>
</tr>
</tbody>
</table>
The following figure displays the back panel of the M8057A remote head with its various components:

The back panel of M8057A remote head has cables which connects with each channel of M8045A remote head controls (P and N). The length of these cables are 85 cm.

Ensure that the chassis is NOT powered up or connected to a power source while making connections to M8057A.

Also, make sure NOT to remove the M8057A connections when it is powered on. However, if you wish to remove the M8057A connections, ensure that the instrument is powered off.
M8040A Module Setup

The M8040A 64Gbaud BERT is based on individual modules that are controlled by the M8070A software. The modules must be hosted in the 5-slot AXI chassis as described below:

- The M8045A module occupies three slots of the 5-slot M9505A AXIe chassis. It must be installed in slots 1 through 3 in the AXIe chassis unless the M9537A AXIe Embedded Controller is installed. The M9537A AXIe Embedded Controller must be installed in slot 1.
- The M8046A module occupies a single slot of the 5-slot M9505A AXIe chassis.
- The M8057A remote head is an external box which must be connected to each channel of M8045A module. Three cables are fixed on the back side of M8057A which need to be connected to M8045A remote head, P and N connectors.

The following figure shows a typical setup of M8045A, M8046A and M8057A.
AWG Modules Supported by M8070A System Software

In addition to the BERT modules, the M8070A system software also supports the following AWG modules:

- **M8195A 65 GSa/s Arbitrary Waveform Generator** - Currently supported by M8070A Rev 3.5.104.4 or above and M8195A Rev 3.2.0.0 or above.
- **M8196A 92 GSa/s Arbitrary Waveform Generator** - Currently supported by M8070A Rev 3.5.104.4 or above and M8196A Rev 2.0.39.0. or above.

**NOTE**

In case an AWG module (M8195A/M8196A) is used in a combined system with either M8020A or M8040A modules, ensure that the AWG modules are always mounted in a slot number, higher that M8020A or M8040A modules in the AXIe chassis. In other words, an AWG module always has to be mounted, last in the chassis.

**M8195A 65 GSa/s Arbitrary Waveform Generator**

The Keysight M8195A is a 65 GSa/s Arbitrary Waveform Generator with highest bandwidth and channel density. Flexible signal generation at up to 32 Gbaud. Clean and distorted signal to stress the device to the limits. High speed AWG with up to 65 GSa/s sample rate and 20 GHz bandwidth on up to 4 channels per module. The M8195A arbitrary waveform generator offers an output amplitude of up to 2 Vpp (diff.) and adjustable DC offset.

The M8195A module has 4 channels and up to 5 modules can be inserted in a 5 slot AXI chassis to provide the maximum of 20 channels. This is valid for channels which are not synchronized across module boundaries. To synchronize these modules, a sync module is added in the frame. Since the sync module occupies a single slot, only 4 AWG modules can now be added thereby providing a maximum of 16 channels in a frame.

The M8195A AWG gives you the versatility to create the signals you need for digital applications, optical and electrical communication and advanced research.

The basic functionality of the M8195A is controlled from a soft front panel application running on the AXIe embedded controller or external PC or laptop. However, the M8195A can also be integrated into the M8070A system software for M8000 Series of BER test solutions.

Details of M8195A module can be found at [www.keysight.com/find/M8195A](http://www.keysight.com/find/M8195A).
M8196A 92 GSa/s Arbitrary Waveform Generator

The Keysight M8196A is a 92 GSa/s Arbitrary Waveform Generator with highest bandwidth and channel density. It offers up to 4 x 512 kSa waveform memory. It is a high speed AWG with up to 96 GSa/s sample rate and 32 GHz bandwidth on up to 4 channels per module. The M8196A arbitrary waveform generator offers an output amplitude of up to 2 Vpp (diff.) and adjustable DC offset.

The M8196A provides high speed, precision, and flexibility which is ideally suited for digital applications, optical, aerospace/defense, and electrical communication.

The basic functionality of the M8196A is controlled from a soft front panel application running on the AXIe embedded controller or external PC or laptop. However, the M8196A can also be integrated into the M8070A system software for M8000 Series of BER test solutions.

Details of M8196A module can be found at www.keysight.com/find/M8196A.
Other Supported Hardware(s)

Keysight N1076A/N1077A DCA-M Clock Recovery

The N1076A electrical clock recovery and N1077A electrical/optical clock recovery provide necessary clock signals to trigger an 86100D, N109x-series DCA-M oscilloscopes, or the error detector in a M8070A.

You can use an N1076/7A when:
- Access to appropriate clock signals from the Device Under Test (DUT) is not possible. The clock is recovered from the data stream.
- The existing clock has excessive intrinsic jitter that prevents accurate measurements. The N1076/7A can act as clean-up PLL for the clock.
- Input data is between 50 MBd and 16 GBd (32 GBd with option 232).

Detailed description of N1076A/N1077A can be found at:
www.keysight.com/find/N1076A
www.keysight.com/find/N1077A
Keysight Real Time Oscilloscopes

The M8070A system software (version 4.0 and above) supports certain real-time oscilloscopes to measure BER of NRZ signals and BER as well as SER of PAM4 signals. The real-time oscilloscope is completely controlled from M8070A to capture a signal and convert into a pattern stream that is then uploaded into the M8070A for comparison with an expected pattern and provide BER/SER measurements.

Nevertheless, it is possible to stop measuring BER on the integrated oscilloscope and therefore allow interactive tweaking of oscilloscope settings before continuing the BER measurements.

Currently, the following oscilloscopes are supported:

- DSOZ634A
- DSAZ634A
- DSOX96204Q
- DSAX96204Q
- DSAZ594A
- DSOZ594A

Detailed description of the above oscilloscopes can be found at: http://www.keysight.com/find/oscilloscopes

The following licenses are required on the oscilloscope:

- N5384A Serial Data Analysis (SDA)
- N8827A PAM4 Measurement (PM4)
- N5461A Equalization (DEQ)

**NOTE**

The minimum supported Infiniium version is 06.10.00616.

For details on how to control a real-time scope from M8070A, refer to the section Controlling a Real-Time Oscilloscope from M8070A on page 233.
Hardware Setup for M8046A and M8062A Modules

The M8046A module and the M8062A module can be used in the same setup. The following are the supported configurations:

1. Two M9505A 5-slot AXIe chassis controlled via USB
   - **Chassis 1:**
     - Slot 1: M8041A
     - Slot 4: M8062A
   - **Chassis 2:**
     - Slot 1: M8046A
   USB control ports of both chassis connected to the controlling PC

2. Two M9505A 5-slot AXIe chassis using an embedded controller
   - **Chassis 1:**
     - Slot 1: M8041A
     - Slot 4: M8062A
   - **Chassis 2:**
     - Slot 1: Embedded Controller (M9536A or M9537A)
     - Slot 2: M8046A
   USB control port of chassis 1 is connected to a USB 2.0 port of the embedded controller

3. M9514A 14-slot chassis controlled from external computer
   - Slot 1: M8041A
   - Slot 4: M8062A
   - Slot 6: M8046A
   - Slot 7: M9521A AXIe System Module

4. M9514A 14-slot chassis controlled from embedded controller
   - Slot 1: Embedded Controller (M9536A or M9537A)
   - Slot 2: M8041A
   - Slot 5: M8062A
   - Slot 7: M9521A AXIe System Module
   - Slot 8: M8046A
The M8046A may be used with a N1076A external clock recovery.
Limitations

The following are the limitations while using the M8046A and M8062A modules in the same setup:

- The M8046A does not support all sequencer word width settings of a M8041A/M8062A combination.

- Even though M8041A/M8062A and M8046A support a common sequencer word width of 1, they internally work with a different granularity and therefore cannot be used in the same sequence. Instead individual sequences need to be defined for M8062A Data Out, Data In and M8046A.

- In order to run the M8062A Data Out and M8046A Data In at the same symbol rate, the CLK IN frequency of M8046A needs to be specified manually. To do this, disable 'Follow SYS CLK' under Clock and specify CLK IN frequency and multiplier as required for the setup.
ESD Protection

Electrostatic discharge (ESD) can damage the circuits of the components on M8020A/M8030A/M8040A modules (M8041A, M8051A, M8061A, M8062A, M8045A, M8046A and M8057A). Avoid applying static discharges to the front-panel connectors. Before connecting any coaxial cable to the connectors, momentarily short the center and outer conductors of the cable together. Avoid touching the front-panel connectors without first touching the frame of the instrument. Be sure the instrument and all connected devices (DUT, etc.) are properly earth-grounded (to a common ground) to prevent buildup of static charge and electrical over-stress. Take necessary anti-static precautions, such as wearing a grounded wrist strap, to minimize the possibility of electrostatic damage.

Electrostatic discharge (ESD) can damage or destroy electronic components. All work on electronic assemblies should be performed at a static-safe work station. The following list and figure shows an example of a static-safe work station using two types of ESD protection. Purchase acceptable ESD accessories from your local supplier.

- Conductive table-mat and wrist-strap combination.
- Conductive floor-mat and heel-strap combination.
Both types, when used together, provide a significant level of ESD protection. Of the two, only the table-mat and wrist-strap combination provides adequate ESD protection when used alone. To ensure user safety, the static-safe accessories must provide at least 1 MW of isolation from ground.

**WARNING**

These techniques for a static-safe work station should not be used when working on circuitry with a voltage potential greater than 500 volts.
Discharging Cables

Loose cables are like a capacitor and can hold electrostatic charges. The free end of a cable touching surfaces that have voltage levels will cause product damage. Before connecting any cable to product connector, short the center and outer conductors of the cable together to ground momentarily.

You should use the cable discharger provided with the initial product shipment and shown in the following figures.
While discharging a cable, make sure to ground the box appropriately, via the "GND" connector of the box, to the ground connector of the AXIe chassis as shown in the figure.

That is either directly using the accessories provided with the discharger like the grounding cable, or via an ESD mat, which is connected to the ground connector of the AXIe chassis.

Discharge your cables using the matching connector e.g. 2.40 mm (also for 1.85 mm), 3.50 mm (also for 2.92 mm) and Mini-Coax. You may stick the cable discharger box to your instrument/AXIe chassis e.g. using the fastener tape provided.

Fixture made of plastic can store charges, and probing powered devices can subject inputs to damaging voltage and power levels. Poor AC power supply connected to product or DUT may create AC transients, insufficient grounding, floating neutral lines which cause damaging currents to flow into or out of the instrument.

For more information about electrostatic discharge, contact the Electrostatic Discharge Association www.esda.org.
3 Quick Tour with M8070A User Interface

Overview / 82
Launching M8070A User Interface / 83
Exploring M8070A User Interface / 89
Other GUI Features / 115
Recall/Save Instrument State / 122
Overview

The M8070A system software for the M8000 Series of BER Test Solutions is required to control M8020A/M8030A/M8040A modules (M8041A, M8051A, M8061A, M8062A, M8045A, M8046A and M8057A) and other modules from M8000 family (M8190A, M8195A and M8196A). It provides a user-friendly experience that can be used with standard or touchscreen enabled computers. It is fully supported by the Microsoft Windows 7 (64 bit) SP1, Windows 8 (64 bit), Windows 8.1 (64 bit) and Windows 10 (Version 1607, Anniversary Update or newer) operating systems. The M8070A software also supports an off-line version, that does not require any license to operate.

The M8070A user interface provides an interactive graphical display in multiple windows containing controls, that enable you to perform the tasks. The GUI components include menus, tool bars, dialog boxes, toggle buttons, standard windows buttons, drop-down lists, sliders, and many more which are further discussed in this manual.

NOTE

Depending upon the M8020A/M8030A/M8040A bundle with of chassis/controller pre-installation, you may have to install the M8070A software. Refer to Installation Guide and follow the given instructions to install the M8070A software.
Quick Tour with M8070A User Interface

Launching M8070A User Interface

To launch the M8070A user interface, go to Start menu and then click All Programs > Keysight M8070A > Keysight M8070A.

The splash screen will be displayed as shown in the following figure:

![M8070A Software Splash Screen](image)

Messages while launching M8070A GUI

Whenever there is a change in the M8070A software version, the following message appears:
Whenever, an old workspace data (Agilent/M8070A) is detected, the following message will appear:

- Clicking on “Keep Existing Data” will migrate the old data from Agilent/M8070A folder to Keysight/M8070A folder. Now, the user will use data from Keysight/M8070A folder. Also, it will keep the old existing data (Agilent/M8070A) in case a user wants to down-grade M8070A again.
- Clicking on “Delete Existing Data” will delete the Agilent/M8070A folder and the user will use data from Keysight/M8070A.
Load Setting

Before the M8070A software is launched, a **Load Setting** dialog will appear which allows you to load settings.

The **Load Setting** dialog provides the following settings:

- **Last Used**: Launches the M8070A user interface with the last used settings.
- **Factory Preset**: Launches the M8070A user interface with factory default settings.
- **Select...**: Opens the **Recall Instrument State** dialog which allows you to load the M8070A user interface with the stored settings. For details, refer to **Recall Instrument State** on page 122.
- **Exit Application**: Terminates the M8070A application.

**NOTE**

The **Load Setting** dialog will appear each time the M8070A software is launched.

**NOTE**

A warning message will appear on the top of **Load Setting** dialog if the modules are offline. In this case, the results are simulated.
Once the settings are loaded, the M8070A software launches. The following figure shows the M8070A user interface when there is only one module connected to the M8020A/M8030A system.

However, if there are two modules connected to the M8020A/M8030A system, the M8070A user interface will appear as shown in the following figure:
Get Module Information

You can get the module information that is connected to the M8020A/M8030A by clicking the icon present at the right side of each module. If properly connected, the module information will be shown as depicted in the following figure:
It provides the following information about the module:

- **Address** - Address of module, e.g. USB-PXIO::11::0::INSTR
- **Product Number** - Product no. of the module, e.g. M8041A
- **Serial Number** - Serial no. of the module, e.g. DE53C00061
- **Hardware Revision** - Hardware revision of module, e.g. 0

However, if you unable to get the module information, we suggest you to restart the M8070A software.

In the off-line mode, the 🛠️ icon will appear in the M8070A GUI.
Exploring M8070A User Interface

The M8070A user interface consists of the following GUI elements:

- Title Bar
- Menu Bar
- Main Window
- Status Bar

The detailed information on these GUI elements are described in the following sections.

Title Bar

The title bar contains an application icon, title, a context-sensitive help icon and standard buttons to minimize, maximize or to close the window.

The context-sensitive help icon provides information about the M8070A user interface relative to the task a user performs.

The title bar is shown in the following figure.

Menu Bar

The menu bar consists of various drop-down menus which provide access to different functions, and launch interactive GUI controls.

The menu bar includes the following drop-down menus:

- File
- Application
- System
- Clock
- Generator
- Analyzer
- Patterns
- Measurements
- Utilities
- Window
- Help
Each drop-down menu and their options are described in the following sections.

File Menu

The **File** menu provides the following selection:

- **Preset Instrument State...** - Opens the **Preset Instrument State** dialog.

![Preset Instrument State dialog](image)

This dialog allows you to:

- **Soft Preset** - For a *Soft Preset*, select the check box and then click **Preset** button. This option resets the instrument state to factory default settings. However, it retains current symbol width, opened windows and data stored in current setting such as patterns, templates and scripts.

- **Preset** - Resets the parameters to their default values. You can also perform a soft preset/preset to the instrument by sending *RST command in the SCPI panel. For details on *RST command, refer to **M8000 Series Programming Guide**.

- **Recall Instrument State...** - Opens the **Recall Instrument State** dialog which allows you to retrieve the user-defined settings or the factory settings.

For more details, refer to **Recall Instrument State** on page 122.
• **Save Instrument State...** - Opens the Save Instrument State dialog which allows you to save the current instrument state. For more details, refer to Save Instrument State on page 123.

• **Exit** - Closes the M8070A user interface.

**Application Menu**

The Application menu allows you to select application specific features for the following:

- PCI Express
- USB
- SATA
- MIPI C-PHY/D-PHY (included in separately available MIPI plug-in)
- 10 GBASE KR Link Training (For details, refer to the 10 GBASE KR Link Training User Guide)

On selecting any of these standards from the Application menu, a standard specific dialog or plug-in interface will appear.

**System Menu**

The System menu allows you to launch the various display views provided by M8020A/M8030A/M8040A. It provides the following selections:

- **Module View** - Opens the Module View user interface as shown in the following figure:
The Module View is a graphical representation of the input/output ports that are present on the front panel of the modules, connected to the M8020A/M8030A. You can use the Module View to configure the properties of a single port or a group (combination of multiple ports). For details, refer to Module View on page 127.

- System View - Opens the System View user interface as shown in the following figure:

![System View](image)

The System View displays the block representation of the currently selected channel of the M8020A/M8030A/M8040A. In addition, it also allows you to interactively modify the configuration settings for each channel. For details, refer to System View on page 156.
• **Groups View** - Opens the **Group View** user interface as shown in the following figure:

![Groups View](image)

The **Group View** allows you to create a group of ports and re-program their properties. For details, refer to **Group View** on page 185.

• **Ctrl In/ Ctrl Out** - Opens the **Module View** with the Ctrl In/Ctrl Out ports selected and the corresponding parameters are reflected in the **Properties** window.

• **Sys In/Out A/B** - Opens the **Module View** with the Sys In/Out ports selected and the corresponding parameters are reflected in the properties window.

**Clock Menu**

The **Clock** menu provides the following selections:

• **Clock Generator** - Allows you to configure **Clk Gen** port.

• **Clock Output** - Allows you to configure **Clk Out** port.

Once you make a selection, the **Module View** appears with the **Clk Gen/Clk Out** ports selected and the corresponding parameters are reflected in the **Properties** window.
The following figure shows the Module View with the Clk Gen port selected:

![Module View with Clk Gen port selected](image)

The generator's output ports are used to supply a clock signal and trigger for another device (for example, analyzer), and an arbitrary data signal for testing your device. For details, refer to Setting up Generator on page 249.

To change bit rate, go to the Properties window and then click on the Synthesizer function block.

**Generator Menu**

The Generator menu provides the following selections:

- **Data Output** - Allows you to configure Data Out port.
- **Trigger Out** - Allows you to configure Trig Out port.

Once you make a selection, the Module View shows the Data Out/Trig Out ports selected and the corresponding parameters are reflected in the Properties window.
The following figure shows the Module View with the Data Out port selected:

![Module View with Data Out port selected](image)

The generator's ports are used to set the clock frequency and the output signal with respect to jitter, error insertion and signal output. For details, refer to Setting up Generator on page 249.

To change amplitude/offset, go to Properties window and then click the Amplifier function block.

**Analyzer Menu**

The Analyzer menu provides the following selections:
- Data Input - Allows you to configure Data In port.

Once you make a selection, the Module View shows the Data In ports selected and the corresponding parameters are reflected in the Properties window.
The following figure shows the **Module View** with the **Data In** port selected:

![Module View](image)

The analyzer’s ports are used for running tests and for connecting external equipment. For details, refer to Setting up Analyzer on page 309.

**Patterns Menu**

The **Patterns** menu provides the following selections:
- **Select Pattern...** - Opens the **Select Sequence Pattern** dialog. It allows you to override all sequences with a single block loop. For details refer to Pattern Editor on page 395.
- **Pattern Editor** - Opens the **Pattern Editor** user interface as shown in the following figure:
The pattern editor provides an interactive user-interface for creating, editing and importing patterns. For details, refer to Pattern Editor on page 395.

- **Sequence Editor** - Opens the Sequence Editor user interface as shown in the following figure:
The **Sequence Editor** allows you to create and maintain sequences. In addition to this, it also allows you to edit the memory patterns. For details, refer to **Sequence Editor** on page 359.

**Measurements Menu**

The **Measurements** menu provides the following selections:

- **Error Ratio** – Opens the **Error Ratio** measurement user interface as shown in the following figure:

The error ratio measurement allows you to collect measurement data over a specific period. This can be used to create test scenarios that are reproducible and comparable. Also, you can let tests run over long times and then evaluate the results afterwards. For details, refer to **Error Ratio Measurement** on page 467.

- **Output Timing** – Opens the **Output Timing** measurement user interface as shown in the following figure:
The output timing measurement is used to measure the timing and jitter behavior for a device under test (DUT). It uses a bit error rate (BER) measurement to evaluate the shape of the eye for the output signal of the DUT. It also analyzes the jitter, separates the random jitter and deterministic jitter components, and estimates the total jitter. For details, refer to Output Timing Measurement on page 479.

- **Output Level** - Opens the **Output Level** measurement user interface as shown in the following figure
The **Output Levels** measurement allows you to characterize the behavior of the output levels of a device under test (DUT). The sampling delay is fixed. The analyzer’s decision threshold is automatically swept within a user-defined range.

For details, refer to **Output Level Measurement** on page 495.

- **Jitter Tolerance** - Opens the **Jitter Tolerance** measurement user interface as shown in the following figure:
Jitter Tolerance measurement is used to determine the ability of a device or system to maintain communication quality in the presence of jitter. It comes in two varieties:

- **Jitter Tolerance Characterization** determines the jitter levels where the device under test can no longer maintain a desired bit error ratio (BER).

- **Jitter Tolerance Compliance** verifies that the device under test is able to maintain a BER level at pre-defined jitter levels and jitter frequencies, as defined by a standard.

For details, refer to Jitter Tolerance Measurement on page 508.

- **Eye Diagram** Measurement - Opens the Eye Diagram measurement user interface as shown in the following figure:
The M8070A System Software provides quick design analysis with the Eye Diagram capability. The Eye Diagram allows a quick check for the DUT’s signal output, and determines the signal quality. The eye contour lines display the measured eye at a deeper BER level, for accurate results.

For details, refer to Eye Diagram Measurement on page 525.

Utilities Menu

The **Utilities** menu provides the following selections:

- **Script Editor** - Opens the **Script Editor** user interface as shown in the following figure:
The **Script Editor** provides flexibility to the programmers to automate their plug-ins thus allowing them to do everything they want in the measurements. For details, refer to **Script Editor** on page 543.

- **SCPI Editor** – Opens the **SCPI Editor** user interface as shown in the following figure:
• The SCPI Editor lists all SCPIs that can be used to program M8020A/M8030A/M8040A and also provides a platform to execute them. For details, refer to SCPI Editor on page 588.

• Self Test - Opens the Self Test utility user interface as shown in the following figure:

The Self Test utility checks the specific system information of the hardware components for basic functionality. On execution, the following results are displayed:

• System related information such as connected modules, serial no. and hardware revision.
• Module related information such as calibration, power supplies and memory controller.

For details, refer to Self Test Utility on page 596.

• Licenses... - Opens the Licenses window user interface as shown in the following figure:
The **Licenses** window displays the license information currently installed in the modules or host. For details, refer to Licenses Window on page 601.

- **Settings...** - Opens the **Settings** window which allows you to set the display and channel settings in the user interface. For details, refer to Settings Window on page 602.

- **Logger** - The **Logger** window displays errors, warnings and information messages along with their respective descriptions, applications from where they are generated and their time stamps. For details, refer to Logger Window on page 605.

- **Plug-in Manager** - The **Plug-in Manager** simplifies all the tasks related to plug-in management. It displays list of plug-ins that are installed in the software. In addition, the **Plug-in Manager** also allows you to install, uninstall and update the plug-ins. For details, refer to Plug-in Manager on page 607.
Window Menu

The Window menu allows you to change the layout/arrangement of various open windows. It includes the following selections:

- **Cascade** - Arranges the multiple opened windows in a docked view so that you can see all or part of each window; consisting of individual tabs for each window.

The following figure shows the docked/tabbed view of three different windows.

- **Tile Horizontally** - Aligns the multiple opened windows in a horizontal sequence. The following figure shows the horizontal sequence of three different windows.
• **Tile Vertically** - Aligns open windows in a vertical sequence. The following figure shows the vertical sequence of three different windows.
• **Focus Center Content** - Minimizes or hides additional dialog boxes or property sheets of the multiple open windows to focus on the center content.

• **Close All** - Closes all the open windows.

**Help Menu**

The **Help** menu includes the following selections:

• **View Help** - Opens the online help that provides you with the information you need for working with the Keysight M8070A GUI.

• **About** - Shows product information of M8070A including version number, build date, build info and web links for M8070A information and support.
Increase/Decrease Splitter Size

The Splitter option allows you to either increase or decrease the divided space between the windows forms used in the user interface. This icon is located on the right side of the menu bar. The splitter functionality provides an easy navigation to the users who are using a touchscreen interface.

Main Window

The main window refers to the middle area of the M8070A user interface that allows you to launch different display views (e.g. Module View, Group View, System View, etc.). You can use the menu bar to launch these views on the main window. Each view can be configured through the Parameters window. The detailed description of different views, their parameter settings, controls and dialogs are described in the subsequent sections in this manual.

When you launch the M8070A software, by default, it shows the Module View on the main window.

The following figure shows how the main window appears:
Status Bar

The status bar is located at the bottom of the M8070A user interface. The status bar is shown in the following figure:

It provides the following functions:

- Button to show/hide the **Status Indicator** window. For details, refer to Status Indicators Window on page 111.
- Button to show/hide the **Logger** window that displays errors, warnings and information messages which are generated from the M8020A/M8030A/M8040A system. For details, refer to Logger Window on page 113.
- Button to show/hide the **Show Link Training Log** window. For details, refer to Link Training Log Window on page 114.
- Error indicator for the clock loss. When there is any clock loss, the respective indicator turns red.
- Toggle button to enable/disable the **Output** and check-boxes to enable/disable the **Impairments** and **SSC** state.
• **Progress Indicator** to visualize the progression of multiple GUI operations and/or background operations in a single bar. However, if the process takes too long to complete, you have an option to terminate that process by clicking on the **Abort** button which appears on the **Status Bar**.

**NOTE**

The behavior of progress indicator depends upon the number of process involved in any operation. It displays progress of each individual process in a single bar. Time for each operation may vary and sometimes may be very quick. Therefore, at some instance, it may display a progress to be complete (100%) and then suddenly switch to incomplete (50%).

• **Insert Error** button to insert a single bit error on each Data Out location of the connected modules.

• **Preset All** button opens the **Preset Instrument** dialog that allows to reset the instrument state to factory default settings.

**Status Indicators Window**

The **Status Indicators** window displays the status indicators for the generator and analyzer ports of each channel of the connected modules. This includes:

• Setup information such as **Bit Rate** for each channel of the connected module.

• Generator port information such as:
  - Data information that shows the name/type of the pattern downloaded to that data block and its indicator shows which data block is currently transmitting the sequence.
  - State information of generator such as **Output**, **Jitter** and **SSC** (indicated by green LED).
  - Error indicator for the current GUI state. When the current GUI is stopped, the respective indicator turns red.

**WARNING**

You will see a warning sign on the status bar if the “Global Output State” is off. In this case, all data outputs will be disabled until the “Global Output State” is turned on. Click the “Output” button present on the status bar to turn on the “Global Output State”.

**NOTE**

The behavior of progress indicator depends upon the number of process involved in any operation. It displays progress of each individual process in a single bar. Time for each operation may vary and sometimes may be very quick. Therefore, at some instance, it may display a progress to be complete (100%) and then suddenly switch to incomplete (50%).
• Analyzer port information such as:
  • Data information that shows the name/type of the pattern downloaded to that data block and its indicator shows which data block is currently transmitted the sequence.
  • State information of analyzer such as BRM (indicated by green LED).
  • Error indicators of analyzer such as CDR Unlock, Data Loss, Symbol Loss and Sync Loss (indicated by red LED).
  • Error indicator for the current GUI state. When the current GUI is stopped, the respective indicator turns red.
  • Calculated BER
  • Alignment BER Threshold button to start BER threshold auto alignment.

The Status Indicator window always appears whenever you launch the M8070A user interface. However, you can open/close this window by clicking on the Status Indicator button, present on the status bar.
The Logger window displays errors and warnings messages along with their respective descriptions, applications from where they are generated and their time stamps.

The Logger window always appears whenever you launch the M8070A user interface. However, you can open/close this window by clicking on the Logger button, present on the status bar.

The Logger window allows you to:

- **Message Selection** - Use this option to choose whether you want to view errors, warnings or information message.
- **Copy** - Use this option to copy a message. You need to select a message in order to enable copy feature.
- **Select All** - Use this option to select all messages. It also enables copying all messages.
- **Clear Messages** - Use this option to delete all messages.
- **Auto Scroll** - Use this option to enable/disable auto scroll option. When the Auto Scroll option is enabled, it will automatically scroll you to the new message without using the scroll bar.
- **Open On Message** - Turn this button OFF if you don’t want the Logger window to automatically pop-up whenever a message is received.
- **Column Option** - Use this button to filter the messages either from Log From column or Date and Time column.
- **Search Messages** - Use this option to search messages by providing an input in the Search Messages search box.
Link Training Log Window

The **Link Training Log** window displays the logs for link training PCIe 3.0. You can open/close the **Link Training Log** window by clicking on the **Link Training Log** button present in the status bar. The **Link Training Log** button with orange background indicates an update or new entry in the link training log.

The following figure shows the **Link Training Log** window:

![Link Training Log Window](image)

The **Link Training Log** window provides the following options:

- **Export Log** - Click the **Export Log** button to save the link training log.
- **Clear Logs** - Click the **Clear Logs** button to delete all link training logs.

For more details on link training, refer to Interactive Link Training on page 435.
Other GUI Features

Following are the GUI elements that make the M8070A user interface interactive.

**Tooltip**

The tooltip is a small pop-up window that concisely describes the object being pointed to, such as descriptions of toolbar controls, icons, graphics, links, menu items and taskbar buttons.

The following example shows the tooltip providing a description of toolbar buttons.

Here is another example where the tooltip provides information to the user on the minimum and maximum values the parameter can hold.

**Toggle Button**

The toggle button allows you to toggle between the two features. For example, in the following figure, we are using the toggle button to either expand or collapse the parameter list.
**ON/OFF Switch**

The ON/OFF switch enables or disables a given feature.

The following figure shows how a ON/OFF switch is used to turn the state feature ON.

![ON/OFF Switch](image)

However, at some instances in the GUI, the ON/OFF switch will be enabled when you select the corresponding check box.

**Execute Button**

The *Execute* button allows you to perform an activity, once you click on it.

The following figure shows an *Execute* button that is used to perform pattern synchronization.

![Execute Button](image)

**Drop-Down List**

The drop-down list allows you to choose either one or sometimes multiple selections from the provided list.

The following shows the drop-down list to choose the *Re-Sync* mode.

![Drop-Down List](image)
Numeric Entries

Most numeric entries have a pre-defined maximum, minimum, and default value displayed in their corresponding pop-up menu.

Numeric values in numeric entries can be changed using the on-screen numeric keypad. For details, refer On-Screen Numeric Keypad on page 119.

Window Option

The window options allow you to float or dock anywhere in the application window. It provides quick access to logically grouped features from one location. For example, you can select and generate various layouts from the single window.

You can move a window anywhere on the screen or to a different monitor. You can also use the auto-hide feature of the windows to show or hide them on the desktop. You can also close the floating windows.

Auto Hide Feature

The automatic hiding functionality gives you the ability to imitate the behavior of the dock windows in the M8070A user interface. When it's enabled for a dock panel, this panel is automatically hidden when the mouse pointer leaves its area. Dock panels are hidden at the nearest form's edge. For example, if a panel is docked to the right edge of the form, it will be hidden at the right edge.

End-users can enable the automatic hiding functionality by clicking the auto hide button displayed within the panel's caption.
The image below illustrates how the automatic hiding functionality can be enabled and how to show the hidden dock panel.

Copying Parameter Window

The copying feature creates a replica of parameters window to enhance the usability. It allows you to work on two different instances of the application. The changes you make in one window display immediately in the other window.

The following figure shows the copied parameters window.
Once copied and then enabling the auto hide feature, the cloned parameters window is docked to the right edge of the main user interface. The copied parameters window pops up once you click on it.

The following figure shows the copied parameters window docked to the right edge of the main user interface.

![Image of parameters window docked]

**On-Screen Numeric Keypad**

The on-screen numeric keypad makes it easier to enter the numbers, units, etc., specially if you are using a touchscreen monitor. The on-screen numeric keypad pops up whenever you tap mouse pointer or touch (in case of touchscreen) in a text field or other area where user inputs are required.

**NOTE**

Remember to unselect the **Disable Keypad** option in the **Settings** window in order to enable the on-screen numeric keypad. For details, refer to **Settings Window** on page 602.

The following screen shows how to use an on-screen numeric keypad to provide a value to a parameter.
The on-screen numeric keypad contains the following buttons:

![On-screen numeric keypad](image)

Table 43  On-screen numeric keypad

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Buttons</td>
<td>Press these buttons to enter a numeric value. The acceptable range of a parameter is shown at the top of the keypad.</td>
</tr>
<tr>
<td>.</td>
<td>Decimal</td>
<td>Press this button to enter a decimal numeric value.</td>
</tr>
<tr>
<td>+/-</td>
<td>Function</td>
<td>Press this button to toggle between the addition (+) and subtraction (-) function.</td>
</tr>
<tr>
<td>▲▼</td>
<td>UP/DOWN</td>
<td>Press these buttons to increase or decrease the numeric values, respectively.</td>
</tr>
<tr>
<td>Button</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Backspace</td>
<td>Button</td>
<td>Press this button to delete any character before the current position of the pointer.</td>
</tr>
<tr>
<td>LEFT/RIGHT</td>
<td>Button</td>
<td>Press these buttons to move the pointer one position left or right, respectively.</td>
</tr>
<tr>
<td>Exponent</td>
<td>Button</td>
<td>Press this button to enter exponents.</td>
</tr>
<tr>
<td>Enter</td>
<td>Button</td>
<td>Press this button to apply the value.</td>
</tr>
<tr>
<td>mV Button</td>
<td></td>
<td>Press this button to assign units to the numeric value. Please note that the units may change depending on the parameter.</td>
</tr>
<tr>
<td>Clear Field</td>
<td>Button</td>
<td>Press this button to clear the text field.</td>
</tr>
<tr>
<td>Minimum/Def</td>
<td>Max Button</td>
<td>Press this button to insert either minimum, or default, or maximum numeric value of the parameter.</td>
</tr>
</tbody>
</table>
Recall/Save Instrument State

Recall Instrument State

To recall an instrument state, do the following:

- Go to **File** menu and then click **Recall Instrument State...** The **Recall Instrument State** dialog will appear as shown in the following figure.

1. Select the folder (User or Factory) to view the files.
2. Select the file which is to be recalled.
3. Click **Recall**.
4. To rename a file, select the file and click **Rename**. The filename will become editable.
5. To delete a file, select the file and click **Delete**.
6. To add new folder, select location you want to create your folder and then click **New Folder**.
7. To rename a folder, select the folder and click **Rename**. The folder name will become editable.
8. To delete a folder, select the folder and click **Delete**.
Save Instrument State

To save an instrument state, do the following:

1. Go to File menu and then click **Save Instrument State**... The **Save Instrument State** dialog will appear as shown in the following figure.

2. Enter a file name and click **Save**. The current settings will be saved under the filename.

3. To rename a file, select the file and click **Rename**. The filename will become editable.

4. To delete a file, select the file and click **Delete**.

5. To add new folder, select location you want to create your folder and then click **New Folder**.

6. To rename a folder, select the folder and click **Rename**. The folder name will become editable.

7. To delete a folder, select the folder and click **Delete**.
4 User Interface - M8070A Display Views

Overview / 126
Module View / 127
System View / 156
Impairment Setup View / 175
Group View / 185
Setup View / 191
Adjustable Intersymbol Interference / 198
Controlling AWG(s) from M8070A User Interface / 203
Extended Sequencing Capabilities in AWGs / 222
Controlling N1076A/77A from M8070A / 227
Controlling a Real-Time Oscilloscope from M8070A / 234
Overview

The M8070A system software provides the following types of views:

- Module View
- System View
- Impairment Setup View
- Group View
- Setup View
- Adjustable Intersymbol Interference

In addition, it also provides the following functionalities:

- Controlling AWG(s) from M8070A User Interface
- Controlling N1076A/77A from M8070A
- Controlling Real-Time Oscilloscope from M8070A
Module View

The Module View is a graphical representation of the input/output ports that are present on the front panel of the modules, configured into the M8020A/M8030A/M8040A. The M8020A/M8030A supports the M8041A (8.5/16G Generator, Analyzer, Clock Module), M8051A (Generator-Analyzer), M8061A (32 Gb/s Multiplexer with De-emphasis) and M8062A modules that are installed into an Keysight M9505A 5-slot AXIe chassis. The M8040A supports the M8045A and M8046A modules that are installed into an Keysight M9505A 5-slot AXIe chassis. These modules have a different set of input/output ports depending upon their functionality e.g. generator, analyzer or clock. Each module consists of two channels (channel 1 and channel 2) depending upon the licenses, you have ordered. Each channel contains Data Out (Generator) and Data In (Analyzer) ports.

The modules are identified as M1, M2, M3 and so on in the GUI.

You can use the Module View to configure the properties of a single port or a group (combination of multiple ports). For details, refer to Group View on page 185.

How to Launch Module View

The Module View is launched by-default whenever you launch the M8070A user interface. However, if it is not available or is closed, you still can launch it.

To do so:
- Go to the Menu Bar > System and then select Module View.

The following figure shows an example of Module View when M8041A (M1) and M8051A (M2) modules are connected:
The left side shows the connected modules and the right side shows the **Parameters** window. Each module has input and output ports which can be configured through the **Parameters** window. For details on inputs and output ports, refer to *Input and Output Ports* on page 130. When you click on the port, the respective configurable parameters are displayed in the **Parameters** window. For details, refer to *Parameters Window* on page 137.
The following figure shows an example of **Module View** when M8041A (M1), M8051A (M2) and M8061A(M3) modules are connected:
The following figure shows an example of Module View when M8045A (M1) and M8046A (M2) modules are connected:

Input and Output Ports

**M8041A and M8051A Modules**

The M8041A (8.5/16G Generator, Analyzer, Clock Module) and M8051A (Generator-Analyzer) modules can have the following input and output ports:

- **Clock Gen**: Clock can be generated from the internal oscillator or an external source.
- **Data Out**: Data Out acts as the output port for the Generator which may be connected to the DUT. The data outputs serve as device stimuli and can be set up so that they are compatible with a variety of logic families.
- **Data In**: Data In acts as the input port for the Analyzer. This port is connected to the data signal which is the output of the DUT. Here the signal received and the signal generated internally is compared for calculating the bit error ratio.
• **Ref Clk Out**: The reference clock output is used to provide a 10 MHz or 100 MHz reference clock to the DUT or other test equipment (SMA, female).

• **Clock Out**: The clock out port serves as frequency (bit rate) references. If we want to operate the external device at the system clock frequency then the device operating frequency can be set up using the clock out.

• **Trig Out**: Trig Out serves as an output port of the Generator. It allows you to connect a trigger for another device which can be used to provide a 10 MHz or 100 MHz reference clock to the DUT or other test equipment.

• **Sys Out A/Sys Out B**: System level control outputs used to signal events to the DUT or external instruments.

• **Ctrl Out A**: The module has one control output at the front panel with the following selectable functionality of Error Output.

• **Sys In A/Sys In B**: System level control inputs used to generate sequencer events.

• **Ctrl In A/Ctrl In B**: The M8041A and M8051A modules have two control inputs at the front panel each with the following selectable functionality of Error Add Input, Output Blanking, Electrical Idle and Gating Input.

### M8061A Module

The M8061A (32 Gb/s Multiplexer with De-emphasis) module has the following input and output ports:

• **Data In**: The M8061A has two Data In ports; Data In 1 and Data In 2 which are used to receive data from M8041A.

• **Data Out**: The M8061A Data Out port is used to provide the signals to DUT.

• **Elect Idle In**: This port is used to enable/disable the output signal by an external control signal. If the input level is above the threshold level the module enters electrical idle.
The M8061A Configuration dialog provides configuration settings for M8061A. To open the M8061A Configuration dialog:

- Go to Menu Bar > System and then click Module View.
- Locate the M8061A module.
- Click Configuration... button.

The M8061A Configuration dialog will appear as shown in the following figure:

This dialog provides the following setting options:

- **Integration Mode**: Allows you to select the integration mode. The default mode is Standalone Mode. The other modes you can select are Mux Only mode, Demux Only mode and Mux and Demux mode.
• **Data Module**: Allows you to specify the data module to which the M8061A module is connected.

• **Demux Visa Resource**: Allows you to provide the visa resource string for N4877A. This is required to connect N4877A instrument with M8020A.

In addition, this dialog displays the connection diagram and connection instructions for each mode.

• **Click Apply**. Depending upon the configuration settings, the ports which in which settings can be done do not ayou will see the changes in the **Module View**. Some ports that are used by the data module and M8061A modules will be disabled. For the block diagram representation and interactively modify the settings of the currently mode, switch to **System View**. For details, refer **System View with M8061A Integration** on page 162.

**M8062A Module**

The M8062A (32Gb/s Front-end for J-BERT M8020A High-Performance BERT) module has the following ports on its front panel:

**On Pattern Generator Side**

• **Data In 1 and Data In 2 (Half Rate)** - Single-ended, half-rate data inputs from the M8041A module (3.5 mm, female).

• **Data Out and Data Out** - Differential or single-ended, full-rate data output to the device under test. Unused outputs must be terminated into 50 Ω (2.4 mm, female).

• **DMI In** - Differential Mode Interference input. Applies a single-ended, external interference source differentially to the data output (SMA, female).

• **CMI In** - Common Mode Interference input. Applies a single-ended, external interference source to both the normal and complement data output signals (SMA, female).

• **Clk Out** - Half-rate Pattern Generator clock output. Carries the same jitter as the full-rate data output.

• **Clk In** - Pattern Generator clock input (half-rate). Connect to clock output of M8041A.

• **Aux Clk In** - Alternate Pattern Generator clock input (half-rate). Typically unused.

• **Electrical Idle In** - This input is used to enable/disable the output signal by an external control signal. If the input level is above the threshold level the module enters electrical idle. Normal operation resumes when the input level is below the threshold (SMA, female).
On Analyzer Side

- **Data In and /Data In** - Differential or single-ended, full-rate data input from the device under test. Unused input should be terminated into 50 Ω (2.4 mm, female). These ports are AC coupled.

- **Data Out 1 and Data Out 2** - Single-ended, half-rate data outputs to the M8041A module (3.5 mm, female).

- **Clk Out** - Half-rate Error Analyzer clock output, synchronous with analyzer sampling.

- **Clk In** - Half-rate, Error Analyzer clock input. Allows external clocking of the Error Analyzer.

M8062A Configuration

The **M8062A Configuration** dialog provides configuration settings for M8062A. To open the **M8062A Configuration** dialog:

- Go to **Menu Bar > System** and then click **Module View**.
- Locate the **M8062A** module.
- Click **Configuration...** button.

The **M8062A Configuration** dialog will appear as shown in the following figure:
This dialog displays the connection diagram and connection instructions.

- Click **Enable**. In the 32G mode, access to some M8041A user controls are disabled to facilitate software control of this configuration. For the block diagram representation and to interactively modify the settings of the currently 32G mode, switch to **System View**. For details, refer System View with M8062A Integration on page 169.

### M8045A Module

The M8045A module has the following ports on its front panel:

- **Remote Head - P and N Ports** - The P and N ports of each channel must be connected to the M8057A.

- **Clk Out 1 and Clk Out 2** - These are the Clk Out ports of channel 1 and 2, respectively. It can generate either a Clean Clk or all timing impairments like Data Out.

- **Ref Clock In** - The Ref Clk In input can be used as reference frequency or as external system frequency directly for the instrument. An external provided signal can be measured at that input. This input is tightly involved in the system frequency generation.
• **Ref Clock Out** - The Ref Clk Out is used to provide a 10 MHz or 100 MHz reference clock to the DUT or other test equipment.

• **Clock Out and Clock Out** - The differential clock output serve as frequency (bit rate) reference and can be set up so that they are compatible with a variety of logic families. With respect to Clock Out, Clock Out \has inverted logic.

• **Trigger Out and Trigger Out** - This port allows you to trigger another device (for example, an oscilloscope) and can be set up so that they are compatible with a variety of logic families. Trigger Out has more modes, e.g. sub rate clock to be used as ref clock for a DUT. With respect to Trigger Out, Trigger Out \has inverted logic.

• **Sys Out A/B** - The system level control outputs used to trigger events to the DUT or external instruments.

• **Ctrl Out A** - The control output port provides the Error Output functionality.

Show Module Information

You can get the module information that is connected to the M8020A by clicking the icon present at the right side of each module. The module information will be shown as depicted in the following figure:

It provides the following information about the module:

- **Address** - Address of module, e.g. USB-PXI::11::0::INSTR
- **Product Number** - Product no. of the module, e.g. M8041A
- **Serial Number** - Serial no. of module, e.g. DE53C00061
- **Hardware Revision** - Hardware revision of module, e.g. 0
Selecting Single/Multiple Ports

You can select either single or multiple ports by pressing the toggle button, available on the top of the main window. It provides the following modes selection:

- **Single Selection Mode** - allows you to select only one port at a time from the connected modules.

- **Multiple Selection Mode** - allows you to select multiple ports from the connected modules.

Parameters Window

The **Parameters** window displays the functional blocks of the selected port/port groups. Each functional block has a set of parameters. The **Parameters** window also allows you to set the parameters of the selected port/port groups.

If you try to set a parameter which conflicts with other parameter or in other words is dependent on other parameter, a **Auto Correct Confirmation** dialog appears. For details, see **Auto Correction Confirmation Dialog** on page 140.

The **Parameters** window is shown in the following figure:
The Parameters window has the following sections:

- Tool bar
- Display Grid
- Parameters Description Pane

The Parameters window tool bar includes the following icons:

- **Expand/Collapse All Group**: Click this icon to expand or collapse the functional blocks.

- **Show Search Option**: Allows you to filter and customize your results by using the following options:
  - By Location
  - By Functional Block
  - By Property

- **Copying Parameter Window**: Creates a replica of Parameters window to enhance the usability. It allows you to work on two different instances of the application. The changes you make in one window display immediately in the other window. The icon present on the copied parameter window loads all properties of the module. The following figure shows the copied Parameters window.

Once copied and then enabling the auto hide feature, the copied parameters window is docked to the right edge of the main user interface. The copied parameters window pops up once you click on it.
The following figure shows the copied parameters window docked to the right edge of the main user interface.

- **Display Grid**: Displays the parameters of the selected port/port groups within a grid. The left column contains the parameter names; the right column contains the parameter values. In addition, it also allows you to set the parameters of the selected port/port groups. The naming convention used for the port/port group is explained with the help of following example:
  M1.DataIn1
  Where,
  - M1 stands for Module1
  - DataIn stands for DataIn port
  - 1 for channel 1

  The functional blocks use the different color schemes to represent different channels. You can set the color schemes of each channel from the Setting window. For details, refer to Settings Window on page 602.

- **Parameter Description Pane**: Provides the description and related SCPI of the currently selected parameter. The following figure shows the Parameter Description Pane providing the description and the related SCPI when the line coding parameter is selected.
Auto Correction Confirmation Dialog

There are several parameters in the M8070A GUI which are interdependent on the settings of other parameters. For details of these parameters, refer to Table 44 on page -141 and Table 45 on page -148.

An Auto Correct Confirmation dialog appears if you try to set a parameter which conflicts with other parameter or in other words is dependent on the settings of other parameter. This dialog display the conflicts encountered and also provides the recommended setting to overcome those conflicts. If you click Apply button, the recommended settings will be applied on the M8070A GUI. However, if you click Discard button, the previous settings will be applied. The following figure shows an Auto Correct Confirmation dialog which is displayed when a user tries to set a ClkGen frequency and it conflicts with ClkOut Output Timing Divider.
Dependent Parameters

There are several parameters in the M8070A GUI which are interdependent on the settings of other parameters. Refer to Table 44 on page -141 and Table 45 on page -148 for details of these parameters. For details on the related/dependent SCPIs of these parameters, please refer to M8070A Programing Guide.

Table 44  M8020A/M8030A Dependent Parameters

<table>
<thead>
<tr>
<th>Functional block / Parameter</th>
<th>Identifier Location</th>
<th>Dependent Parameters</th>
<th>Description</th>
<th>Related /Dependent SCPI</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>High</td>
<td>Depends on amplitude and offset value</td>
<td>&quot;SOURce:VOLTage:HIGH:SOURce:VOLTage:AMPLitude:SOURce:VOLTage:OFFSet&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Low</td>
<td>Depends on amplitude and offset value</td>
<td>&quot;SOURce:VOLTage:LOW:SOURce:VOLTage:AMPLitude:SOURce:VOLTage:OFFSet&quot;</td>
</tr>
<tr>
<td>Offset</td>
<td></td>
<td>Offset</td>
<td>Depends on termination voltage</td>
<td>&quot;SOURce:VOLTage:OFFSet:OUTPut:VOLtage&quot;</td>
</tr>
<tr>
<td>Amplitude Range (if Auto-range enabled)</td>
<td></td>
<td>DataOut maximum amplitude will become limited to the selected amplitude range value</td>
<td>&quot;SOURce:VOLTage:AMPLitude:SOURce:VOLTage:RANGe:AUTO:SOURce:VOLTage:RANGe:SELect:OUTPut:STATe&quot;</td>
<td></td>
</tr>
<tr>
<td>Coupling</td>
<td></td>
<td>Selecting incorrect coupling enables output protection, and as a result DataOut state could not be enabled</td>
<td>&quot;OUTPut:STATe:OUTPut:COUPLing&quot;</td>
<td></td>
</tr>
<tr>
<td>Termination Model</td>
<td></td>
<td>Only available when coupling is selected as DC</td>
<td>&quot;OUTPut:COUPLing:OUTPut:CONfig&quot;</td>
<td></td>
</tr>
<tr>
<td>Termination Voltage</td>
<td></td>
<td>Available only when coupling is selected as DC and termination model is selected as unbalanced</td>
<td>&quot;OUTPut:COUPLing:OUTPut:CONfig:OUTPut:TVOLtage&quot;</td>
<td></td>
</tr>
<tr>
<td>CMI State</td>
<td></td>
<td>CMI value depends only if CMI state is enabled</td>
<td>&quot;SOURce:INTerference:LEVel:CMODe:STATe:SOURce:INTerference:LEVel:CMODe:AMPLitude&quot;</td>
<td></td>
</tr>
<tr>
<td>Functional block / Parameter</td>
<td>Identifier Location</td>
<td>Dependent Parameters</td>
<td>Description</td>
<td>Related /Dependent SCPI</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------</td>
<td>----------------------</td>
<td>-------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>CMI Amplitude</td>
<td></td>
<td>DataOut maximum amplitude will be limited to 900mV if CMI state is enabled</td>
<td>``SOURce:VOLTage:AMPLitude :SOURce:INterference:LEVel:CMODe:STATe :SOURce:INterference:LEVel:CMODe:AMPLitude :OUTPut:STATe``</td>
<td></td>
</tr>
<tr>
<td>DMI State</td>
<td></td>
<td>Depends on DataOut Amplitude maximum value</td>
<td>``SOURce:INterference:LEVel:DMODe:STATe :SOURce:INterference:LEVel:DMODe:AMPLitude``</td>
<td></td>
</tr>
<tr>
<td>DMI Amplitude</td>
<td></td>
<td>On applying DMI amplitude as maximum value (360mV) then maximum value of DataOut1 Amplitude will become 840mV</td>
<td>``SOURce:VOLTage:AMPLitude :SOURce:INterference:LEVel:DMODe:STATe :SOURce:INterference:LEVel:DMODe:AMPLitude :OUTPut:STATe``</td>
<td></td>
</tr>
<tr>
<td>LF Jitter</td>
<td>M1.DataOut1</td>
<td>RJ State Value doesn't applicable if state is Off</td>
<td>``SOURce:JITTer:LFRequency:PERiodic:STATe``</td>
<td></td>
</tr>
<tr>
<td>rSSC State</td>
<td></td>
<td>Value doesn't applicable if state is Off</td>
<td>``SOURce:JITTer:LFRequency:RSSClocking:STATe``</td>
<td></td>
</tr>
</tbody>
</table>
### User Interface - M8020A Display Views

<table>
<thead>
<tr>
<th>Functional block / Parameter</th>
<th>Identifier Location</th>
<th>Description</th>
<th>Related /Dependent SCPI</th>
</tr>
</thead>
</table>
| rSSC Frequency               |                     | rSSC frequency depends on rSSC amplitude, RJ amplitude, RJ state and RJ frequency | "SOURce:JITTer:LFRequency:PERiodic:STATe  
SOURce:JITTer:LFRequency:PERiodic:AMPLitude  
SOURce:JITTer:LFRequency:PERiodic:FREQuency  
SOURce:JITTer:LFRequency:RSSClocking:STATe  
SOURce:JITTer:LFRequency:RSSClocking:AMPLitude  
SOURce:JITTer:LFRequency:RSSClocking:FREQuency" |
| Unit                         |                     | If unit is selected as 'sec', the jitter amplitude min/max values also depends on Data rate (synthesizer frequency) | "SOURce:JITTer:LFRequency:UNIT  
SOURce:FREQuency" |
| Data rate (Synthesizer frequency) |                     | If unit is selected as 'sec', the jitter amplitude min/max values also depends on Data rate (synthesizer frequency) | "SOURce:JITTer:LFRequency:UNIT  
SOURce:FREQuency" |
| HF Jitter                    | M1.DataOut1         | Value doesn't applicable if state is Off | "SOURce:JITTer:HFRequency:PERiodic1:STATe  
SOURce:JITTer:HFRequency:PERiodic1:AMPLitude  
SOURce:JITTer:HFRequency:BUNCorrelate:AMPLitude  
SOURce:JITTer:HFRequency:RANDom:AMPLitude  
SOURce:JITTer:HFRequency:SPECtrally:AMPLitude1  
SOURce:JITTer:HFRequency:SPECtrally:AMPLitude2" |
| R1 State                     |                     | "Depends on R2 amplitude, BUJ amplitude, RJ amplitude, sRJ amp1 and sRJ amp2 (User can choose either sRJ Or combination of BUJ and RJ)" | "SOURce:JITTer:HFRequency:PERiodic2:AMPLitude  
SOURce:JITTer:HFRequency:BUNCorrelate:AMPLitude  
SOURce:JITTer:HFRequency:RANDom:AMPLitude  
SOURce:JITTer:HFRequency:SPECtrally:AMPLitude1  
SOURce:JITTer:HFRequency:SPECtrally:AMPLitude2" |
| R2 State                     |                     | Value doesn't applicable if state is Off | "SOURce:JITTer:HFRequency:PERiodic2:STATe  
SOURce:JITTer:HFRequency:PERiodic2:AMPLitude  
SOURce:JITTer:HFRequency:BUNCorrelate:AMPLitude  
SOURce:JITTer:HFRequency:RANDom:AMPLitude  
SOURce:JITTer:HFRequency:SPECtrally:AMPLitude1  
SOURce:JITTer:HFRequency:SPECtrally:AMPLitude2" |
| R2 Amplitude                 |                     | "Depends on R1 amplitude, BUJ amplitude, RJ amplitude, sRJ amp1 and sRJ amp2 (User can choose either sRJ Or combination of BUJ and RJ)" | "SOURce:JITTer:HFRequency:PERiodic1:AMPLitude  
SOURce:JITTer:HFRequency:BUNCorrelate:AMPLitude  
SOURce:JITTer:HFRequency:RANDom:AMPLitude  
SOURce:JITTer:HFRequency:SPECtrally:AMPLitude1  
SOURce:JITTer:HFRequency:SPECtrally:AMPLitude2" |
| BUJ State                    |                     | "Value doesn't applicable if state is Off Also depends on sRJ state" | "SOURce:JITTer:HFRequency:BUNCorrelate:STATe  
SOURce:JITTer:HFRequency:BUNCorrelate:AMPLitude  
SOURce:JITTer:HFRequency:RANDom:AMPLitude  
SOURce:JITTer:HFRequency:SPECtrally:AMPLitude1  
SOURce:JITTer:HFRequency:SPECtrally:AMPLitude2" |
<table>
<thead>
<tr>
<th>Functional block / Parameter</th>
<th>Identifier Location</th>
<th>Dependent Parameters</th>
<th>Description</th>
<th>Related /Dependent SCPI</th>
</tr>
</thead>
<tbody>
<tr>
<td>RJ State</td>
<td></td>
<td></td>
<td>&quot;Value doesn't applicable if state is Off Also depends on sRJ state&quot;</td>
<td>~SOURce:JITTer:HFRequency:RANDom:STATe ~SOURce:JITTer:HFRequency:SPECtrally:STATe</td>
</tr>
<tr>
<td>sRJ State</td>
<td></td>
<td></td>
<td>&quot;Value doesn't applicable if state is Off Also depends on RJ and BUJ state&quot;</td>
<td>~SOURce:JITTer:HFRequency:SPECtrally:STATe ~SOURce:JITTer:HFRequency:RANDom:STATe ~SOURce:JITTer:HFRequency:BUncorrelate:STATe</td>
</tr>
<tr>
<td>sRJ State</td>
<td>M1.DataOut1</td>
<td>BUJ State (Data Out)</td>
<td>If sRJ is ON, then BUJ state cannot be enabled</td>
<td>~SOURce:JITTer:HFRequency:SPECtrally:STATe ~SOURce:JITTer:HFRequency:BUncorrelate:STATe</td>
</tr>
<tr>
<td>RJ State (Data Out)</td>
<td></td>
<td></td>
<td>If sRJ is ON, then RJ state cannot be enabled</td>
<td>~SOURce:JITTer:HFRequency:SPECtrally:STATe ~SOURce:JITTer:HFRequency:RANDom:STATe</td>
</tr>
<tr>
<td>BUJ State (Clock Out)</td>
<td></td>
<td></td>
<td>If sRJ is ON, then BUJ state cannot be enabled</td>
<td>~SOURce:JITTer:HFRequency:SPECtrally:STATe ~SOURce:JITTer:HFRequency:BUncorrelate:STATe</td>
</tr>
<tr>
<td>Functional block / Parameter</td>
<td>Identifier Location</td>
<td>Dependent Parameters</td>
<td>Description</td>
<td>Related / Dependent SCPI</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------</td>
<td>----------------------</td>
<td>-------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>RJ State (Clock Out)</td>
<td></td>
<td>sRJ State (Data Out)</td>
<td>If sRJ is ON, then RJ state cannot be enabled</td>
<td><code>:SOURce:JITTer:HFRequency:SPECtrally:STATe</code> <code>:SOURce:JITTer:HFRequency:RANDom:STATe</code></td>
</tr>
<tr>
<td>RJ State (Data Out)</td>
<td></td>
<td>sRJ State (Data Out)</td>
<td>If RJ state is ON, then ClockOut sRJ cannot be enabled</td>
<td><code>:SOURce:JITTer:HFRequency:SPECtrally:STATe</code> <code>:SOURce:JITTer:HFRequency:BUNCorrelate:STATe</code></td>
</tr>
<tr>
<td>RJ State (Clock Out)</td>
<td></td>
<td>sRJ State (Data Out)</td>
<td>If RJ state is ON, then ClockOut sRJ cannot be enabled</td>
<td><code>:SOURce:JITTer:HFRequency:SPECtrally:STATe</code> <code>:SOURce:JITTer:HFRequency:BUNCorrelate:STATe</code></td>
</tr>
<tr>
<td>RJ Low Pass Filter as 1000 MHz</td>
<td>M1.DataOut1</td>
<td></td>
<td>Depends on Data Rate (Synthesizer frequency)</td>
<td>Can only be selected is Data Rate is above 7.5 GHz</td>
</tr>
<tr>
<td>Jitter Sweep State</td>
<td>M1.DataOut1</td>
<td>RJ State (Data Out)</td>
<td>If Jitter Sweep state is ON, then DataOut RJ cannot be enabled</td>
<td><code>:SOURce:JITTer:SWEep:STATe</code> <code>:SOURce:JITTer:HFRequency:RANDom:STATe</code></td>
</tr>
<tr>
<td>R2 State (Data Out)</td>
<td></td>
<td>R2 State (Data Out)</td>
<td>If Jitter Sweep state is ON, then DataOut R2 cannot be enabled</td>
<td><code>:SOURce:JITTer:SWEep:STATe</code> <code>:SOURce:JITTer:HFRequency:PERiodic2:STATe</code></td>
</tr>
<tr>
<td>R2 State (Clock Out)</td>
<td></td>
<td>R2 State (Clock Out)</td>
<td>If Jitter Sweep state is ON, then ClockOut R2 cannot be enabled</td>
<td><code>:SOURce:JITTer:SWEep:STATe</code> <code>:SOURce:JITTer:HFRequency:PERiodic2:STATe</code></td>
</tr>
<tr>
<td>Functional block / Parameter</td>
<td>Identifier Location</td>
<td>Dependent Parameters</td>
<td>Description</td>
<td>Related /Dependent SCPI</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------</td>
<td>----------------------</td>
<td>-------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Jitter Sweep Step Distance</td>
<td>M1.DataOut1</td>
<td>Jitter sweep mode</td>
<td>Jitter sweep step distance parameter is re-programmable only if Mode is selected as Variable amplitude</td>
<td>~SOURce:JITTer:SWEep:STATe ~SOURce:JITTer:SWEep:AMPLitude:MODE ~SOURce:JITTer:SWEep:STEP:DISTance*</td>
</tr>
<tr>
<td>CMI Amplitude</td>
<td>M1.DataOut1</td>
<td>CMI State</td>
<td>Value doesn't applicable if state is Off</td>
<td>~SOURce:VOLTage:AMPLitude ~SOURce:INterference:LEVel:CMODe:STATe ~SOURce:INterference:LEVel:CMODe:AMPLitude*</td>
</tr>
<tr>
<td>Amplifier Amplitude</td>
<td></td>
<td></td>
<td>The max value of CMI amplitude depends on amplifier amplitude</td>
<td>~SOURce:VOLTage:AMPLitude ~SOURce:INterference:LEVel:CMODe:STATe ~SOURce:INterference:LEVel:CMODe:AMPLitude*</td>
</tr>
<tr>
<td>Amplifier Offset</td>
<td></td>
<td>Depends on DataOut amplifier offset, high and low values</td>
<td></td>
<td>~SOURce:VOLTage:AMPLitude ~SOURce:INterference:LEVel:CMODe:STATe ~SOURce:INterference:LEVel:CMODe:AMPLitude ~SOURce:VOLTage:LOW ~SOURce:VOLTage:HIGH ~SOURce:VOLTage:OFFSet*</td>
</tr>
<tr>
<td>DMI Amplitude</td>
<td>M1.DataOut1</td>
<td>DMI State</td>
<td>Value doesn't applicable if state is Off</td>
<td>~SOURce:VOLTage:AMPLitude ~SOURce:INterference:LEVel:DMODe:STATe ~SOURce:INterference:LEVel:DMODe:AMPLitude*</td>
</tr>
<tr>
<td>Amplifier Amplitude</td>
<td></td>
<td></td>
<td>The max value of DMI amplitude depends on amplifier amplitude</td>
<td>~SOURce:VOLTage:AMPLitude ~SOURce:INterference:LEVel:DMODe:STATe ~SOURce:INterference:LEVel:DMODe:AMPLitude*</td>
</tr>
<tr>
<td>Amplifier Offset</td>
<td></td>
<td>Depends on DataOut amplifier offset, high and low values</td>
<td></td>
<td>~SOURce:VOLTage:AMPLitude ~SOURce:INterference:LEVel:DMODe:STATe ~SOURce:INterference:LEVel:DMODe:AMPLitude ~SOURce:VOLTage:LOW ~SOURce:VOLTage:HIGH ~SOURce:VOLTage:OFFSet*</td>
</tr>
<tr>
<td>Error Insertion Ratio</td>
<td>M1.DataOut1</td>
<td>Error Insertion Mode</td>
<td>Error ratio of 1E-1 or 1E-2 are selectable only if error insertion mode is selected as Variable spacing</td>
<td>~OUTPut:EINSertion:MODE ~OUTPut:EINSertion:RAIto*</td>
</tr>
<tr>
<td>Inter-Symbol Interference Mode</td>
<td>M1.DataOut1</td>
<td>Depends on selected Preset value</td>
<td>ISI mode as Two-Point only available when Preset is selected as Custom</td>
<td>~SOURce:INterference:ISYMbol:MODE ~SOURce:INterference:ISYMbol:PRESet*</td>
</tr>
<tr>
<td>Functional block / Parameter</td>
<td>Identifier Location</td>
<td>Dependent Parameters</td>
<td>Description</td>
<td>Related / Dependent SCPI</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------</td>
<td>----------------------</td>
<td>-------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>De-emphasis Preset Register Number</td>
<td>M1.DataOut1</td>
<td>State of Preset Enable button</td>
<td>Re-programmable only if state of Preset Enable button is ON</td>
<td><code>.OUTPut:DEEMphasis:PRESet:ENABLE</code> <code>.OUTPut:DEEMphasis:PRESet</code></td>
</tr>
<tr>
<td>Bit Recovery Mode State</td>
<td>M1.DataIn1</td>
<td>Depends on CDR State</td>
<td>BRM mode can only be enabled if CDR state is ON</td>
<td><code>.INPut:CDR:JTF:STATe</code> <code>.INPut:DATA:BRMode</code></td>
</tr>
<tr>
<td>CDR State</td>
<td>M1.DataIn1</td>
<td>Depends on CDR Control type</td>
<td>If CDR control type is Sequence controlled, then CDR state will be controlled by Analyzer sequence block settings</td>
<td><code>.INPut:CDR:CTRL</code></td>
</tr>
<tr>
<td>CDR Loop Bandwidth</td>
<td>M1.DataIn1</td>
<td>Depends on Data Rate</td>
<td>Maximum value of CDR loop bandwidth depends on Data rate (Synthesizer frequency)</td>
<td><code>.INPut:CDR:JTF:STATe</code> <code>.SOURce:FREQuency</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Depends on Loop Order</td>
<td>Depends on type of the selected loop order</td>
<td><code>.INPut:CDR:JTF:STATe</code> <code>.INPut:CDR:JTF:LORDer</code></td>
</tr>
<tr>
<td>Comparator Compare Mode</td>
<td>M1.DataIn1</td>
<td>Depends on Termination Configuration</td>
<td>Available only if Termination configuration is selected as Unbalanced</td>
<td><code>.INPut:TCONfig</code></td>
</tr>
<tr>
<td>Termination Voltage</td>
<td>M1.DataIn1</td>
<td>Depends on Termination Configuration</td>
<td>Available only if Termination configuration is selected as Unbalanced</td>
<td><code>.INPut:TCONfig</code> <code>.INPut:TVOLTage</code> <code>.INPut:CMODE</code></td>
</tr>
<tr>
<td>SSC Profile Shape</td>
<td>M1.ClkGen</td>
<td>Depends on SSC Profile</td>
<td>Available only if SSC profile is selected as Arbitrary</td>
<td><code>.SOURce:SSCLocking:STATe</code> <code>.SOURce:SSCLocking:PROFile</code> <code>.SOURce:SSCLocking:SHAPE</code></td>
</tr>
</tbody>
</table>
### M8040A Dependent Parameters

<table>
<thead>
<tr>
<th>Functional block / Parameter</th>
<th>Identifier Location</th>
<th>Dependent Parameters</th>
<th>Description</th>
<th>Related /Dependent SCP</th>
</tr>
</thead>
<tbody>
<tr>
<td>M8046A Follow Sys Clock Option</td>
<td></td>
<td></td>
<td>Depends on amplitude and offset value</td>
<td>&quot;SOURce:VOLTage:HIGH :SOURce:VOLTage:AMPLitude :SOURce:VOLTage:OFFSet&quot;</td>
</tr>
<tr>
<td>Amplifier</td>
<td>M1.DataOut1</td>
<td>Amplitude</td>
<td>Depends on termination voltage and synthesizer frequency</td>
<td>&quot;SOURce:VOLTage:AMPLitude :OUTPut:TVOLtage :SOURce:FREQuency&quot;</td>
</tr>
<tr>
<td>High</td>
<td></td>
<td></td>
<td>Depends on amplitude and offset</td>
<td>&quot;SOURce:VOLTage:HIGH :SOURce:VOLTage:AMPLitude :SOURce:VOLTage:OFFSet&quot;</td>
</tr>
<tr>
<td>Low</td>
<td></td>
<td></td>
<td>Depends on amplitude and offset</td>
<td>&quot;SOURce:VOLTage:LOW :SOURce:VOLTage:AMPLitude :SOURce:VOLTage:OFFSet&quot;</td>
</tr>
<tr>
<td>Offset</td>
<td></td>
<td></td>
<td>Depends on termination voltage</td>
<td>&quot;SOURce:VOLTage:OFFSet :OUTPut:TVOLtage&quot;</td>
</tr>
<tr>
<td>Coupling</td>
<td></td>
<td></td>
<td>Selecting incorrect coupling enables output protection, and as a result DataOut state could not be enabled</td>
<td>&quot;OUTPut:STATE :OUTPut:COUPling&quot;</td>
</tr>
<tr>
<td>Termination Model</td>
<td>Only available when coupling is selected as DC</td>
<td>Termination Model</td>
<td>Available only if coupling is selected as unbalanced</td>
<td>&quot;OUTPut:COUPling :OUTPut:TCOnfig&quot;</td>
</tr>
<tr>
<td>Termination Voltage</td>
<td>Available only if coupling is selected as DC to termination model is selected as unbalanced</td>
<td>Termination Voltage</td>
<td></td>
<td>&quot;OUTPut:COUPling :OUTPut:TCOnfig :OUTPut:TVOLtage&quot;</td>
</tr>
</tbody>
</table>
Clock Gen Frequency

- Maximum amplitude will be 900mV if synthesizer frequency is below 32.414GHz, but if synthesizer frequency is above 32.414GHz, then maximum amplitude will be 600mV
- `:SOURce:VOLTage:AMPLitude` :SOURce:FREQuency`}

De-emphasis Co-efficient 2

- M1.DataOut1 Automatic main cursor state
- Re-programmable only if Automatic main cursor state is disabled

De-emphasis Co-efficient

- M1.DataOut1 Depends on Coefficient 0, 1 and 3 state
- De-emphasis coefficient values are interdependent and sum of all the cursors cannot be more than 1.0

LF Jitter

- M1.DataOut1 RJ State
- Value doesn't applicable if state is Off
- `:SOURce:JITTer:LFRequency:PERiodic:STATe`

RJ Amplitude

- RJ Amplitude depends on RJ frequency

RJ Frequency

- RJ frequency depends on RJ amplitude

Unit

- If unit is selected as sec, then amplitude min/max values will be expressed in sec
- `:SOURce:JITTer:LFRequency:UNIT` :SOURce:FREQuency`

HF Jitter

- M1.DataOut1 RJ1 State
- Value doesn't applicable if state is Off
- `:SOURce:JITTer:HFRequency:PERiodic1:STATe`

RJ1 Amplitude

- Depends on RJ2 amplitude, BUJ amplitude and RJ amplitude

RJ2 State

- Value doesn't applicable if state is Off
- `:SOURce:JITTer:HFRequency:PERiodic2:STATe`

RJ2 Amplitude

- Depends on RJ1 amplitude, BUJ amplitude and RJ amplitude
<table>
<thead>
<tr>
<th>Functional block / Parameter</th>
<th>Identifier / Location</th>
<th>Dependent Parameters</th>
<th>Description</th>
<th>Related / Dependent SCP</th>
</tr>
</thead>
<tbody>
<tr>
<td>BUJ State</td>
<td></td>
<td></td>
<td>Value doesn't applicable if state is Off</td>
<td><code>:SOURce:JITTer:HFRequency:BUNCorrelate:STATe</code></td>
</tr>
</tbody>
</table>
| BUJ Amplitude                |                       |                      | Depends on PJ1 amplitude, PJ2 amplitude and RJ amplitude | `*:SOURce:JITTer:HFRequency:PERiodic1:AMPLitude
:SOURce:JITTer:HFRequency:PERiodic2:AMPLitude
:SOURce:JITTer:HFRequency:RANDom:AMPLitude*` |
| RJ State                     |                       |                      | Value doesn't applicable if state is Off | `:SOURce:JITTer:HFRequency:RANDom:STATe` |
| RJ Amplitude                 |                       |                      | Depends on PJ1 amplitude, PJ2 amplitude and BUJ amplitude | `*:SOURce:JITTer:HFRequency:PERiodic1:AMPLitude
:SOURce:JITTer:HFRequency:PERiodic2:AMPLitude
:SOURce:JITTer:HFRequency:BUNCorrelate:AMPLitude*` |
| Error Insertion Ratio        | M1.DataOut1           |                      | Error ratio of 1E-1 or 1E-2 are selectable only if error insertion mode is selected as Variable spacing | `*:OUTPut:INSertion:MODE
:OUTPut:INSertion:RATio*` |
| NB046A Clock                 | M2.DataIn             | Clock Source         | Some parameters only available if clock source is selected as CLK IN | `:CLOCk:SOURce` |
| Clock Source as External Clock Recovery | M2.DataIn             | Clock Source         | Follow Sys Clk option only available if clock source is selected as CLK IN | `*:CLOCk:SOURce
:CLOCk:TRACK:STATe*` |
| Clk In Multiplier            |                       |                      | Clk In multiplier value depends on Data rate and available only if clock source is selected as CLK IN | `*:CLOCk:SOURce
:CLOCk:FREQuency:MULTiplier*` |
| Clock Source as External Clock Recovery | M2.DataIn             | Clock Source         | Available only if FlexDCA is configured for M8070A and N1076A module is connected with the system running M8070A | `:CLOCk:SOURce` |
| Symbol Mapping as Grey, Custom and Uncoded | M2.DataIn/ M1.DataOut1 | Line Coding          | Available only if Line coding is selected as PAM4 | `*:DATA:LINecoding:VALue
:*DATA:LINecoding:PAM4:MAPPing
:*DATA:LINecoding:PAM4:SYMBol:LEVel1
:*DATA:LINecoding:PAM4:SYMBol:LEVel2*` |
| Custom Symbol Mapping        | M2.DataIn/ M1.DataOut1 | Line Coding          | Available only if Line coding is selected as PAM4 and Symbol mapping is selected as Custom | `*:DATA:LINecoding:VALue
:*DATA:LINecoding:PAM4:MAPPing:CUSTOM
:*DATA:LINecoding:PAM4:SYMBol:LEVel1
:*DATA:LINecoding:PAM4:SYMBol:LEVel2*` |
<table>
<thead>
<tr>
<th>Functional block / Parameter</th>
<th>Identifier Location</th>
<th>Dependent Parameters</th>
<th>Description</th>
<th>Related / Dependent SCP</th>
</tr>
</thead>
</table>
| Upper, Middle and Lower Thresholds | M2.DataIn | Depends on Line Coding | Available only if Line coding is selected as PAM4 | `:DATA:LINecoding:VALue`  
`:DATA:LINecoding:PAAM:MAPPIng`  
`:INPut:VOLTage:PAAM:SYMBol:THReshold1|THReshold2`  
| Alignment results for Upper, Middle and Lower Eye Height | M2.DataIn | Depends on Line Coding | Available only if Line coding is selected as PAM4 (Only Query Command) | `:DATA:LINecoding:VALue`  
`:INPut:ALIGNment:EYE:RESult:PAAM4:HEIGht1|HEIGht2`  
`:INPut:ALGNment:EYE:RESult:PAAM4:HEIGht3` |
| PRBS Polynomial as 2^7-1 | Sequence Editor | Depends on Analyzer sequence | Not downloadable for Analyzer sequence for M8046A module | `:DATA:SEQUence:VALue` |
| Symbol Width other than 1 for M8045A and M8046A | Sequence Editor | M8045A and M8046A only support Symbol Width as 1 | Symbol width other than 1 are not supported on LOKI modules | `:DATA:SEQUence:VALue` |
| Branch condition as Break for M8046A | Sequence Editor | Branch condition as Break is not supported for Analyzer sequence | Branch condition as Break is not supported for Analyzer sequence | `:DATA:SEQUence:VALue` |
| RJ Low Pass Filter as 1000 MHz | M1.DataOut1 | Depends on Data Rate (Synthesizer frequency) | Can only be selected is Data Rate is above 7.5 GHz | `:SOURce:JITTer:HFRequency:RANDom:STATe`  
`:SOURce:FREQuency`  
`:SOURce:JITTer:HFRequency:RANDom:FLTer:LPASs` |
Non-Configurable Parameters

The Table 46 on page -152 lists the M8040A parameters which are non-configurable (read-only/gray out/disabled) by default or become non-configurable while configuring other dependent parameters.

<table>
<thead>
<tr>
<th>Functional block name</th>
<th>Parameters</th>
<th>Disabled parameters</th>
<th>Parameters that are non-configurable by default</th>
<th>Parameters that are non-configurable due to settings of other parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clk Gen</td>
<td>Synthesizer (Select Source as Direct)</td>
<td>• Frequency  • Period</td>
<td>• In the Direct source mode, Frequency and Period will be in disabled state.</td>
<td></td>
</tr>
<tr>
<td>Synthesizer (Select Source as Clock Multiplier)</td>
<td>• Frequency  • Period</td>
<td>• In the Clock Multiplier mode, Frequency and Period will be in disabled state.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SSC</td>
<td>• Shape</td>
<td>• The SSC Shape parameters (Open, Import, Export and Reset to Default) are disabled by default. These parameters are enabled when SSC Profile is selected as Arbitrary.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data Out</td>
<td>Line Coding (Select PAM)</td>
<td>• Symbol 0 Level  • Symbol 3 Level</td>
<td>• In the PAM4 Line Coding, Symbol 0 Level and Symbol 3 Level are in disabled state by default.</td>
<td></td>
</tr>
<tr>
<td>Amplifier</td>
<td>• Termination Voltage  • Coupling  • Termination Model</td>
<td>• In the DC Unbalanced mode, all these three parameters become disabled on turning ON the output state.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Amplifier</td>
<td>• Termination Voltage  • Coupling  • Termination Model</td>
<td>• In the DC Balanced mode, on turning ON the output state, Coupling and Termination Model are disabled and Termination Voltage is not available for user.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Amplifier</td>
<td>• High  • Low  • Offset  • Termination Voltage  • Termination Model</td>
<td>• On selecting Coupling as AC, High, Low and offset parameters are disabled. Also, Termination Voltage and Termination Model are unavailable in AC coupling.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Functional block name</td>
<td>Parameters</td>
<td>Disabled parameters</td>
<td>Parameters that are non-configurable by default</td>
<td>Parameters that are non-configurable due to settings of other parameters</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------</td>
<td>---------------------</td>
<td>-----------------------------------------------</td>
<td>---------------------------------------------------------------------</td>
</tr>
<tr>
<td>De-Emphasis</td>
<td>• Coefficient 2 (Main) • Output Swing • Pre-cursor2 • Pre-cursor1 • Post-cursor1</td>
<td>• In the De-Emphasis block, Coefficient 2 (Main), Output Swing, Pre-cursor2, Pre-cursor1, Post-Cursor1 are in disabled state by default. • However, Coefficient 2 (Main) is enabled when the Automatic main cursor is turned off.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Output Timing</td>
<td>• Data Rate</td>
<td>• Data Rate in Output Timing is always in disabled state.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Error Insertion</td>
<td>• Insert Single Bit Error</td>
<td></td>
<td>• In Error Insertion block, when Mode is selected as Error Ratio (Fixed spacing) or Error Ratio (Variable Spacing), on Turning ON error ratio insertion state, &quot;Insert Single Bit Error&quot; will be unavailable.</td>
<td></td>
</tr>
<tr>
<td>Error Insertion</td>
<td>• Error Ratio</td>
<td></td>
<td>• On selecting, Mode as Ctrl In A, Ctrl In B, Break, Sys In A, Sys In B Error Ratio will be disabled.</td>
<td></td>
</tr>
<tr>
<td>Clk Out of Channels</td>
<td>Output Timing • Frequency</td>
<td>• Frequency is always in disabled state by default.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clock Out of M8045A</td>
<td>Amplifier • Termination Voltage</td>
<td></td>
<td>• On selecting, Termination model as Balanced, Termination Voltage will be unavailable.</td>
<td></td>
</tr>
<tr>
<td>Output Timing</td>
<td>Frequency</td>
<td>• Frequency is always in disabled state by default.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trigger Out</td>
<td>Amplifier • Termination Voltage</td>
<td></td>
<td>• On selecting, Termination model as Balanced, Termination Voltage will be unavailable.</td>
<td></td>
</tr>
<tr>
<td>Configuration</td>
<td>• Subrate Frequency</td>
<td>• Whenever the Operating mode is Subrate clock, Subrate Frequency is in disabled state by default</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Configuration</td>
<td>• Divider • Subrate Frequency</td>
<td></td>
<td>• On selecting operating mode as Sequencer Controlled, Divider and Subrate frequency will be unavailable.</td>
<td></td>
</tr>
</tbody>
</table>
### User Interface - M8020A Display Views

<table>
<thead>
<tr>
<th>Functional block name</th>
<th>Parameters</th>
<th>Disabled parameters</th>
<th>Parameters that are non-configurable by default</th>
<th>Parameters that are non-configurable due to settings of other parameters</th>
</tr>
</thead>
</table>
| **Data In**                    | Clock (Select Source as Clk In and Follow Sys clk is Enabled) | • Symbol Rate  
• Clk In Frequency  | • Symbol Rate and Clock In Frequency are disabled. |  |
| **Clock**                      | (Select Source as Clk In and Follow Sys clk is Disabled)  | • Clk In Frequency  |  | • On Turning Off the 'Follow Sys Clock', Clk In Frequency will become re-programmable. |
| **Clock**                      | (Select Source as Sys Clk)                      | • Follow Sys Clock  
• Clk In Multiplier  
• Clk In Frequency  
• Symbol Rate  | • Symbol Rate is in disabled state.  | • On selecting source as "Sys Clk", Follow Sys Clk and Clk In Multiplier, Clk In Frequency will be unavailable. |
| **Line Coding - PAM4**         | (Select PAM4-Uncoded OR Gray Coded)             | • Custom Symbol Mapping  |  | • Custom Symbol Mapping is not available in PAM4 Uncoded and PAM4 Gray coded. |
| **Comparator**                 |                                                 | • Upper Threshold  
• Middle Threshold  
• Lower Threshold  |  |  |
| **Input Timing**               |                                                 | • Data Rate  | • Data rate is always is disabled state.  |  |
| **Alignment Results**          |                                                 | • All Parameters  | • All Alignment results will be in disabled state. irrespective of the line coding (NRZ or PAM4).  |  |
Creating Groups in the Module View

The Module View allows you to create a group of available ports and simultaneously allows you to configure their parameters.

To create a group:

- Switch to Multiple Selection Mode by pressing Single Selection Mode icon.
- From your keyboard, hold the Ctrl key and select the ports from the modules. You need to select at least two ports in order to create a group.
- Right-click on the selected ports and click Create Group option or alternatively you can select the ports and click Create Group of Selection icon. A Create New Group dialog will appear as shown in the following figure:

![Create New Group dialog]

- Provide a group name and press Create.

A new group will be created in the Group View.
System View

The **System View** displays the block diagram representation of the currently selected channel of the M8020A/M8030A. In addition, it also allows you to interactively modify the settings for each channel.

The **System View** user interface is shown in the following figure.

![System View Diagram](image)

The principal parts are represented by blocks which are connected by lines/arrows to show the relationship of the blocks. These blocks are highlighted by the blue lines around block on mouse focus and the corresponding parameters are displayed in the **Parameters** window. The block may contain feature elements (for example, LF Jitter contain PJ and rSSC). You can click on the respective button to enable the feature elements. Once enabled, the feature elements are highlighted in blue color.
Channels

Displays the channels that are connected to the module. You can select the channel on which you want to configure channel settings. You can assign a different color to each channel so that they are easily identified. For details, refer to Settings Window on page 602.

Using the Zoom Tool

The following figure shows the options provided by the zoom tool.

The zoom tools provide the following functionality:

- The Zoom In button allows you to enlarge the block diagram to view more details.
- The Zoom Out button allows you to reduce the block diagram.
- The Zoom Slider allows you to zoom in or zoom out the block diagram. The mouse wheel also provides a quick alternative to the zoom control. To zoom in and out using the mouse, hold down the [Ctrl] key while you turn the mouse wheel. Each click, up or down, increases or decreases the zoom factor by 25%.
- The Fit to View button fits the width of the block diagram so that the user does not have to scroll the block diagram to the right or to the left.
Understanding the System View

To understand the System View, let’s divide it into the following sections:

**Generator**

The following section of the System View represents the generator function:

It allows you to apply settings on the Data Out port or location (data generator).

It includes the following blocks:

- **State** – Click on the **`ON`** button to enable the outputs of Data Out for the selected channel. Once the outputs are enabled, the button changes to “ON” **`ON`**. If you press the button again, it will turn the state “OFF”.
- **Jitter** – Use this block to enable the jitter source of High Frequency Jitter, Low Frequency and Sweep. For more details on jitter, refer to Jitter Setup on page 296.
- **Intersymbol Interference** – Use this option to enable/disable ISI feature.
- **Shortcut for Impairment Setup View** – Use this shortcut to access the Impairment Setup View. For more details, refer to Impairment Setup View on page 175.
- **Interference** – Use this block to enable the interference (CMI or DMI). For details refer to Interference on page 294.
• Amplifier - This block represents the current value of Data Out’s amplitude parameter. You can change the value by clicking on this block and modify the respective parameter in the Parameters window.
• Delay - Set the delay of the active edge of the data output.
• Data Generation - Acts as the output port for the generator which may be connected to the DUT.

Trigger

The following section of the System View represents the trigger function:

It allows you to apply settings on the Trigger Out port or location.

It includes the following blocks:
• State - Click on the button to enable the output of Trigger Output for the channel. Once the output is enabled, the button changes to “ON”. If you press the button again, it will turn the state “OFF”.
• Amplifier - Use this block to set the parameters related to amplifier of the trigger output.
• Output Timing - Use this block to set the delay of the active edge of the trigger output.
Clock

The following section of the System View represents the clock function:

The clock function allows you to apply settings on the Clock Out port or location. It includes the following blocks:

- **State** - Click on the button to enable the output of Clock Source. Once the output is enabled, the button changes to "ON". If you press the button again, it will turn the state "OFF".
- **Jitter** - Use this block to enable the elements of High Frequency Jitter, Low Frequency. For more details on jitter, refer to Jitter Setup on page 296.
- **Amplifier** - Use this block to set the parameters related to amplifier of the clock output.
- **Clock Divider** - Use this block to set a factor on which the output signal will be divided.
- **PLL Synthesizer** - This block represents the currently selected clock source. You can change the clock source by clicking on this block and the modify the respective parameter in Parameters pane. To enable the SSC state jitter source, click on the button. Once the SSC state is enabled, the button changes to "ON". This is how the bit rate is set. For example, 5 GHz sets the bit rate to 5 Gb/s. If you press the button again, it will turn the state "OFF".
Analyzer

The following section of the System View represents the analyzer function:

![Diagram of Analyzer Function]

The Analyzer function allows you to apply settings on the Data In port or location (analyzer). It includes the following blocks:

- **State** - Click on the button to enable the CDR state. Once the CDR state is enabled, the button changes to “ON”. For more details, refer to CDR Setup in M8020A/M8030A on page 320. If you press the button again, it will turn the state “OFF”.
- **Threshold** - Use this block to set the threshold of the input comparator.
- **Input Timing** - Use this block to set input timing delay.
- **Data Analysis** - Use this block to set input threshold and sampling point delay.
System View with M8061A Integration

This section describes the block diagrams provided by the System View when M8061A is integrated with other modules of M8020A.

Channels

Displays the channels that are connected to the M8020A. The following figure shows M1 (2 channels of M8041A), M2 (2 channels of M8051A) and M3 (M8061A) modules connected to the instrument.

When you select the channel, the corresponding block diagram of that channel appears which allows you to interactively configure channel settings. You can also assign a different color to each channel so that they are easily identified. For details, refer to Settings Window on page 602.

Integration Modes

The System View with M8061A integration provides the following modes:

- Standalone Mode
- Mux Only Mode
- Demux Only Mode
- Mux and Demux Mode

Standalone Mode

The Standalone mode is used to set the parameters of the Data Out port of M8041A module and Data In port of M8061A module.

The following figure shows the block diagram of M8041A module in Standalone mode:
The following figure shows the block diagram M8061A module in **Standalone** mode:
Mux Only Mode

The Mux Only mode is used to multiplex the signal in 2:1 ratio. In this mode, M8061A receives the non-inverted signal from the two Data Out ports of M8041A module and multiplex them in one channel in 2:1 ratio. Using this mode, you can set the parameters of Data Out port of M8061A module.

The following figure shows the connection diagram of Mux Only mode:

The following figure shows the block diagram M8041A module in Mux Only mode:
The following figure shows the block diagram of M8061A module in **Mux Only** mode:

**Demux Only Mode**

The **Demux Only** mode is used to de-multiplex the signal in 1:2 ratio. In this mode, the M8061A module provides the output to CDR module (N4877A) which de-multiplex the received signal in 1:2 ratio. Using this mode, you can set the parameters of Data Out and Data In ports of M8061A module.

The following figure shows the connection diagram of **Demux Only** mode:
The following figure shows the block diagram M8041A module in **Demux Only** mode:

![Block diagram M8041A](image)

The following figure shows the block diagram M8061A module in **Demux Only** mode:

![Block diagram M8061A](image)
Mux and Demux Mode

The Mux and Demux mode is use to multiplex the signal in 2:1 ratio and again de-multiplex the signal in 1:2 ratio. Using this mode, you can set the parameters of Data Out and Data In ports of M8061A module.

The M8061A expands the data rate up to 32 Gb/s and provides integrated and calibrated 4-tap de-emphasis (expandable to 8 taps).

The following figure shows the connection diagram of Mux and Demux mode:
The following figure shows the block diagram in Mux and Demux mode:
System View with M8062A Integration

This section describes the block diagrams provided by the **System View** when M8062A is integrated with other modules of M8020A.

**M8062A Configuration**

The following steps describe the procedure for M8062A configuration:

- Launch the M8070A software.
- If the **Modules View** is not already opened, go to **Menu Bar > System** and then click **Module View**.
- Locate the **M8062A** module. The following figure shows an example of Module View when an M8062A (M2) and an M8041A (M1) are installed in the M8020A system:

![Module View Example](image)

**NOTE**

The M8062A module cannot be used standalone. It must be used in combination with an M8041A module.

- Click the **Configuration...** button present on the M8062A module.
The M8062A Configuration dialog will appear as shown in the following figure:

- Make the connections as described in the above figure.
- Click Enable.
- For the block diagram representation and interactively modify the settings of the currently mode, switch to System View. To do so, go to Menu Bar > System and then click System View.

**NOTE**

System view for M8062A is available only when 32G mode is enabled.
The following figure shows the **System View** of the M8062A module:

![System View Diagram](image)

In the M8062A **System View**, the principal parts are represented by blocks which are connected by lines/arrows to show the relationship of the blocks. These blocks are highlighted by blue lines around the block on mouse focus. Parameters corresponding to the selected block are displayed in the **Parameters** window, on the right. The block may contain feature elements (for example, LF Jitter contains PJ and rSSC). You can click on the respective button to enable the feature elements. Once enabled, the feature elements are highlighted in blue color. For more details, refer to **System View** on page 156.

In addition to the blocks that are described in the section **System View** on page 156, the M8062A **System View** has the following new blocks:

**NOTE**

In 32G mode, access to some M8041A user controls are disabled to facilitate software control of this configuration.
- **Clean Clk Out** - Half-rate, or divided, clock output with no applied jitter.
- **Clk In** - Pattern Generator clock input (half-rate). Connect to clock output of M8041A.
- **Clock Source** - Selects the clock source (CDR, System Clock or Clock In) for the M8062A DataIn port (Analyzer).
- **CDR** - Selecting "CDR" as the M8062A DataIn clock source enables the Analyzer CDR, so that incoming data is sampled using the recovered clock.
- **Auto Re-Lock** - When this feature is enabled (the default setting) the CDR will automatically re-lock when there is a loss of lock. When it is disabled, the CDR will only attempt to re-lock when manually initiated by clicking on the arrow next to the Auto Re-Lock On/Off button. It may be necessary to perform a manual re-lock after a pattern change.
- **High Transition Density** - For data patterns with high transition density, such as 1010 pattern, the CDR may have trouble gaining lock. Enabling the High Transition Density setting reduces the CDR's internal gain to allow it to better lock on patterns with high transition densities. It may be necessary to perform a manual CDR re-lock after a change in the High Transition Density setting.
- **Optimize** - After the CDR has gained lock, certain condition changes, such as increasing applied jitter levels, can cause the analyzer to begin to measure errors. Executing the Optimize function causes the CDR to perform a finer alignment adjustment, which may result in a return to an error-free measurement.

**NOTE**

When using the Analyzer CDR, it may take a longer time to lock and achieve BER=0 after a frequency change than with the other clock sources.
M8040A System View

The **System View** displays the block diagram representation of the currently selected channel of the M8040A modules (M8045A and M8046A). In addition, it also allows you to interactively modify the settings for each channel.

The following figure shows the **System View** of channel 1 of the M8045A module (M1):
The following figure shows the **System View** of the M8046A module (M2):
Impairment Setup View

The Impairment Setup View provides a tabular representation of the Impairment Sources and their corresponding parameters for each Data Out channel of the connected modules. This tabular visualization helps you to view, compare and configure the Impairment Source parameters for each channel in the same window.

How to Access the Impairment Setup View

The following are the two ways to access Impairment Setup View:

1. Through Menu Bar - Go to Menu Bar and then click System > Impairment Setup View. The Impairment Setup View will appear as shown in the following figure:

2. Through System View - The Impairment Setup View can also be accessed through the System View by clicking on the Open Impairment View shortcut as shown in the following figure:
Features of the Impairment Setup View

In this tabular matrix of the Impairment Setup View, the rows consist of the Impairment Sources, their corresponding options and their related parameters. The columns represents channels Data Out, Clock and Trigger parameters for each channel.

Columns

Each channel of a module is represented using a particular color code, which form the column header and they correspond to the color-coding used for that channel in the Modules View. See Module View on page 127.

You may rearrange the column headers by clicking and dragging a header to the desired position.

For example, if you want to view the settings of M1Ch2 first, then click and hold the cursor on M1 Ch2, drag it to the right and release the cursor at the desired position.

The Impairment Setup View will now show the channel position as shown in the following figure:
Under each column's header, there are Low Frequency (LF) and High Frequency (HF) usage indicator. The Clock and Trigger has a Low Frequency indicator only. The following figure shows LF and HF indicator for channel 1 of module 1 (M1 Ch1):

These indicators display how much low frequency and/or high frequency is applied on each channel in percentage.

Rows

The Impairment Sources form the rows in the tabular matrix and have a hierarchical structure. To expand and view the options, click ☰ to the left of each Impairment Source.

The following list shows the Impairment Sources and their respective options that are available in the **Impairment Setup View**.

1. Low Frequency (Jitter)
   a. RJ
   b. rSSC
2. High Frequency (Jitter)
   a. RJ1
   b. RJ2
   c. BUJ
   d. RJ
   e. sRJ
   f. Sweep
3 Interference
   a ISI
   b CMI
   c DMI
4 Related Settings
   a SSC
   b Clk/2 Jitter

You can view, compare and even to configure the values of Impairments Source parameters for each channel. For more details on these Impairment Sources and their respective parameters, please refer to the chapter Setting up Generator on page 249.

Viewing Options in the Impairment Setup View

The Impairment Setup View provides the following viewing options:
• Collapse All
   This is the default viewing option of the tabular view.

   Click on the button to collapse the Impairment Sources rows, such that only the top-level hierarchy is displayed. In other words, in this view option, the options under each Impairment Source for the corresponding Data Out, Clock and Trigger of a channel are hidden.

• Expand Level 2 Groups
   This is one-level expansion of the tabular view.

   Click on the button to view options available under Impairment Sources. This view allows you to enable/disable the Impairment Sources options for corresponding channel.
• **Expand All**
  
  This is two-level expansion of the tabular view.

  Click on the **Expand All** button to view the parameters and the corresponding values for each option under the Impairment Sources. This view provides a full view of impairment setup view. Using this view, you can either enable or disable the Impairment Source options and also modify the parameter's value for each channel.
How to set parameters in Impairment Setup View

To enable an option for an Impairment Source corresponding to a Channel or Clock and Trigger, select the check-box for the corresponding setting. To disable the option, unselect the check-box. The following shows an example how to enable the PJ option:

Some options available under the impairment sources are dependent on each other, such that enabling one or more option disables other options. Hover the mouse cursor on the tabular cells to understand the relational impact of such options, as shown in the example below.

The following are the dependencies which should be followed while configuring parameters:

- Sweep cannot be enabled if PJ is enabled.
- sRJ cannot be used if BUJ is enabled.
- RJ and BUJ cannot be used if sRJ is enabled.
- PJ and RJ cannot be used if Sweep is enabled.
• High Frequency Jitter profile of Clock and Trigger Out are controlled by Data Out of channel 1 as shown in the following figure:

![High Frequency Jitter Profile](image)

• The SSC can be enabled/disabled for all Data Out channels by a single option as shown in the following figure:

![SSC Setup](image)

The option to either enable or disable SSC feature is available under Clock and Trigger column.

The Impairment Setup View also allows you to modify the parameter values. Depending upon whether the keypad option is enabled or disabled, the parameter values can be modified in the following ways:

- **When the keypad is enabled**: In this case when you click on the values which you want to modify, an on-screen numeric keypad appears as shown in the following figure:
Either type-in the values using the keyboard or use the on-screen numeric keypad to modify these values.

For more details on how to use the on-screen numeric keypad, refer to On-Screen Numeric Keypad on page 119.

- **When the keypad is disabled:** In this case, you are directly allowed to type-in the values using the keyboard.

How to Use Filters

Filters can be used to select the items to be displayed in the Impairment Setup View. In other word, it helps you to hide the items which are not required in the Impairment Setup View.

To apply filters, click on the icon. This opens Items To Display window as shown in the following figure:
By default, all items (Channels and Parameters) in the **Items To Display** window are selected. However, you can select/unselect the check-box to show/hide the items. The changes are immediately reflected in the **Impairment Setup View**. For example, upon selecting M1 Ch1, M1 Ch2 under the Channels list and PJ under Jitter Types, the **Impairment Setup View** appears as shown below:
It is mandate to select at-least one channel. Failing this will display a message on the Impairment Setup View window that no channels are selected.

Notice that the icon appears on the top right of the Impairment Setup View which indicates that the filter has been applied.

If the channels are selected but their corresponding parameters are not selected, a message that no parameters are selected will be displayed.

The icon also appears in front of each item whose corresponding parameters are not selected. If you move the mouse pointer on this icon, a tool-tip message is displayed as shown in the following figure:
Group View

The **Group View** allows you to:

- Add/remove ports of a group.
- Set the properties of functional block of a group.

How to Launch Group View

The **Group View** is automatically launched when you create a group from the **Module View**. For details, refer to Creating Groups in the Module View on page 155. However, you also launch the **Group View** from the main GUI. To do so:

- Go to the **Menu Bar > System** and then select **Group View**.

The **Group View** will appear as shown in the following figure:

![Group View](image)

The **Group View** includes the following elements:

- Tool bar
- Group View
Tool bar

The tool bar includes the following elements to perform specific functions:

Table 47

<table>
<thead>
<tr>
<th>Elements</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Create New Group</td>
<td>Opens the System Group Editor which allows you to create a new group. For details, refer to Create New Groups in Group View on page 187.</td>
</tr>
<tr>
<td></td>
<td>Show Functional Block in Group</td>
<td>Use this toggle button to show functional blocks or locations in a group.</td>
</tr>
<tr>
<td></td>
<td>Edit Existing Group</td>
<td>Opens the System Group Editor which allows you to edit the group. For details, refer to Edit Existing Group on page 189. This icon is only visible when the group is in the edit mode.</td>
</tr>
<tr>
<td></td>
<td>Delete Group</td>
<td>Deletes the group.</td>
</tr>
</tbody>
</table>

Group View

The Group View allows you to create, edit and delete a group. In addition, it also allows you to set the properties of functional block of the group. These features are further described in the upcoming sections of this chapter.
Create New Groups in Group View

To create a group in Group View:

- Click New Group icon available on the tool bar. This will open the System Group Editor.
- Select the ports or locations from the left side the System Group Editor and the preview of selected ports or locations will appear on right side. See the following figure:

![System Group Editor](image)

- Type a group name in the provided field and click Create. A new group will be created under that name.

Show Function Block/Location in Groups

The Group View allows you to set the group properties either through functional blocks or through locations in the group.

You can click icon to switch to show functional blocks in the group. See the following figure:
The group is represented in the form of functional blocks available in the group. Once you click on the function block, the respective properties of the functional block are visible in the Parameters window. You can now set the properties of each functional block.

You can click the icon to switch to show locations in the group. See the following figure:
The group is represented in the form of ports or locations available in the group. Once you click on the port or location, the respective properties of the port or location block are visible in the Parameters window.

The main advantage of the Group View is that it allows you to set the properties patterns/sequence of similar ports at once.

However, if you set the properties of the similar ports or locations that exists in different channels of a group, the properties of the ports or locations will not be applied. If you try to group the properties by clicking on the header of Group View, the corresponding value in the Parameters window will either be blank or show “?”.

See the following figure:

In this situation, you have to specify the property’s value which will be later applied to both ports or locations.

**Edit Existing Group**

To edit an existing group:

- Click on the **Edit Existing Group** icon. This will open the System Group Editor window.
Select the ports or locations from the left side of the **System Group Editor** and the preview of selected ports or locations will appear on right side. See the figure below:

- Click **OK**. The group will be edited. However, if you provide a new group name in the provided field and click **OK**, a new group will be created under that name.

**Delete a Group**

You can also delete a group. To do so:

- Click on the **Delete Group** icon. It will open a **Delete Group** message box.
- Click **Delete**. The group will be removed from the view.
Setup View

The Setup View shows the block diagram of the pattern generator and error detector to provide a simple overview of the most important instrument settings at a glance.

How to Access the Setup View

The Setup View can be accessed on clicking the Setup View tab, once the M8070A software is launched. It can also be accessed through Menu Bar. Go to Menu Bar and then click System > Setup View. Please note that the Setup View user interface is different for each system, depending upon the connected modules. The following figure shows the Setup View for M8020A system (M8041A and M8051A):

Similarly, you can access the Setup View for M8020A/M8030A/M8040A system which can include M8041A, M8051A, M8061A, M8062A, M8045A, M8046A, M8195A, M8196A, clock recovery and real-time oscilloscope that can be controlled by M8070A.
Understanding Setup View

The **Setup View** interface includes a toolbar, a block diagram and a parameter window. All these GUI elements are described in the following section.

**NOTE**

The information about the GUI elements such as buttons and text fields, where the user inputs are required, are provided in the form of tooltip.

---

**Toolbar**

- **More Ports**
  
  The drop-down option allows you to configure the ports which are not available in the Generator or Analyzer blocks. On selecting a port, the respective parameters are displayed in the **Parameters** window.

- **Preset All**
  
  This option opens the “Preset Instrument State” dialog which resets the instrument state to factory default settings. For details, see section “Preset Instrument State” in the **File Menu** on page 90.
• **Zoom Tool**
  The following figure shows the options provided by the zoom tool.

![Zoom Tool Image]

The zoom tools provide the following functionality:
- The **Zoom In** button allows you to enlarge the block diagram to view more details.
- The **Zoom Out** button allows you to reduce the block diagram.
- The **Zoom Slider** allows you to zoom in or zoom out the block diagram.
- The mouse wheel also provides a quick alternative to the zoom control. To zoom in and out using the mouse, hold down the [Ctrl] key while you turn the mouse wheel. Each click, up or down, increases or decreases the zoom factor by 25%.
- The **Fit to View** button fits the width of the window so that the user does not have to scroll the block diagram to the right or to the left.

**Block Diagram**

This section shows the block diagram of the "Clock and Pattern Generator" pane and the "Analyzer-Detector" pane which is connected via a DUT Control... Each pane displays the functional blocks and their frequently used parameters. You can configure these basic parameters to perform a measurement.

The user interface provided by the block diagram provides the following features:
- **Channel Selection** - The channel selection for the Generator or Analyzer can be made using the drop-down list. Depending upon the selected channel, its corresponding block diagram will be displayed.

![Channel Selection Image]

Please ensure to enable the outputs by clicking on the **Enable Outputs** button. The same can be done by clicking on the **Output** button present on the status bar.
• **Parameters Window** - Once, the channel section is made, you can configure the basic parameters of each functional block. However, you can also view and configure the detailed parameters on clicking the button, available at the top right of the block. All the parameters related to that functional block will be displayed in the Parameter window.

• **Clock and Pattern Generator pane**
  The "Clock and Pattern Generator" pane display the functional blocks which are related to clock generation and pattern generator. It may include Clock Generator, Clock Output, Trigger Output, Impairments, Pattern Data and Data Out 1 for a given channel. However, these functional blocks may vary, depending upon the type of module. In case of M8046A, the Data Out functional will show an additional Coding parameter. Similarly for other modules such as M8062A or AWG modules (M8195A/M8196A), the functional blocks may vary depending upon the channel selection.

• **Analyzer-Detector pane**
  The "Analyzer-Detector" pane display the functional blocks like DATA In which are related to error detection. It may include, Threshold, Equalization, CDR, depending upon the connected modules. For example, the CDR option will not be available for M8046A analyzer. This pane also provides access to various measurements which are supported by the selected analyzer channel. For example, the eye diagram and output level measurements will not be available for M8046A analyzer.
GUI Elements Description

The various GUI elements which are available in the block diagram are described below:

- **Check-Box** - You can use the check-box feature to enable/disable the feature such as Enable SSC, Enable CDR, etc. The following is an example of Enable SSC check-box:

```
Enable SSC (Global)
```

- **Toggle Button** - You can use the toggle button to enable the outputs such as clock output, trigger output, etc. The following is an example of Clock Output button:

```
Clock Output
```

- **Command Button** - You can also use the command buttons such as Break, Restart and Sync to perform some actions. The following is an example of Restart button:

```
Restart
```

- **Buttons that opens another window** - There are some buttons which take you to another window such as Deemphasis..., CDR..., DUT Control... When you click on these buttons, they open with the respective window/parameters. The following is an example of button which take you to Impairment View window:

```
Impairment View...
```

- **Status Information** - Depending upon the analyzer's performance, this option provides the current status of the analyzer such as stopped CDR unlocked, sync loss, etc. The following is an example of analyzer status when there is a sync loss:

```
Analyzer Status
Sync Loss
```
- **Measurement Selection** – Use this drop-down list to select the measurement. The measurement will be provided depending upon the selected analyzer channel.

- **Status Indicator for Calculated BER/SER** – Indicates the status of the calculated BER/SER.

- **Measurement Preview** - Display the measurement preview of the currently run measurement. If you have already run the measurement once, it will show the status of last run measurement. You can double-click on the measurement preview to open the measurement window, provided the instance of that measurement is not closed. The following figure shows an example of measurement preview when the Jitter Tolerance measurement is executed.
How to perform a basic measurement

Follow the given steps to perform a basic measurement using a **Setup View**:

1. Open the **Setup View** window.
2. From the block diagram, select the channel for the “Clock and Pattern Generator” and “Analyzer-Detector” pane.
3. Use the available functional blocks to configure the required parameters for the “Clock and Pattern Generator” and “Analyzer-Detector” pane.
4. Click **Auto Align** button to start the BER threshold auto alignment. Click **Manual Alignment...** button, in case the manually aligning of the sampling point is required.
5. Select the measurement. It will take you to the respective measurement window.
6. Run the measurement. You will see the measurement preview on the “Analyzer-Detector” pane.
Adjustable Intersymbol Interference

The M8070A system software provides integrated and adjustable Intersymbol Interference (ISI) capability to test next-generation high-speed digital designs.

The adjustable and programmable ISI function allows emulating channel loss for characterizing and compliance testing of high-speed digital receivers. This function is integrated in each pattern generator channel of the M8020A/M8030A which streamlines test setup by eliminating the need for external cabling and switching of external ISI traces.

As data rates continuously increase, channel loss between transmitter and receiver becomes more important. Channel loss is caused by printed circuit board traces, connectors, and cables in the signal path; resulting in ISI which depends on the channel material and dimensions, the data rate, and bit pattern. All high-speed digital receivers are specified to tolerate a certain amount of total jitter, which typically includes some ISI caused by channel loss. During receiver characterization and compliance test, this loss needs to be emulated.

The built-in ISI functionality is programmable for each pattern generator channel. It simplifies receiver test automation for data rates up to 16 Gb/s.

The new adjustable ISI option offers the following advantages:

- Streamlines receiver test setup by providing the highest level of integration.
- Provides accurate and repeatable results for receiver characterization and compliance test by supporting a wide range of loss up to 25 dB and 16 GHz with linear loss curves and fine step resolution.
- Fits into the fully scalable and upgradeable receiver test solution with an upgrade option.

Using System View for ISI Configuration

You can use the System View to configure the ISI parameters for a selected 'Data Out' location. When you select ISI in the Jitter block of the System View, the corresponding parameters are loaded on the Parameters window. You can create your own preset or manipulate frequency and insertion loss for the selected preset.
However, the **System View** does not provide flexibility to graphically manipulate the ISI parameters. This can be achieved using the **Adjustable ISI** window.

### How to Launch Adjustable ISI Window:

To launch the **Adjustable ISI** window:

- Go to the **Menu Bar > System** and then select **Adjustable ISI**.

The **Adjustable ISI** window will appear as shown in the following figure:
It includes the following elements:

- Toolbar
- Adjustable ISI Graph
- ISI Parameters

**Toolbar**

The toolbar provides the following convenient adjustable ISI functions:

<table>
<thead>
<tr>
<th>Elements</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open SnP File</td>
<td>Click this button to open an s-parameters file (S2P). Currently, the M8070A GUI supports two port (S2P) and four port (S4P) s-parameters files. The s-parameters (also known as scattered parameters) are displayed when the scattered pattern file is loaded. S-parameters are complex matrix that show insertion loss at certain frequency. The two-port device displays four data points while the four-port device displays sixteen data points.</td>
<td></td>
</tr>
<tr>
<td>Channel Selection</td>
<td>Use this drop-down list for channel section for which the graph is plotted for the corresponding values.</td>
<td></td>
</tr>
</tbody>
</table>
Adjustable ISI Graph

The following figure illustrates an ISI graph for 4-port system:

The ISI graph shows the insertion loss for a 2-port or 4-port system. The values on the graph represent insertion loss with respect to frequency. You can select the data points according to which you want to generate the loss and then manipulate points graphically (mouse drag) or by parameter window to draw the data point graph. Please note that if you manipulate the points of the linear graph to the values which are not in the defined limits of Slope and Offset, the pointer will change to icon. In this case, the linear graph will switch to last set values. However, if you manipulate the points of the linear graph to the values which are not in the defined limits of Slope and Offset, the pointer will change to icon. In this case, a message will appear at the bottom of the graph along with the undo option to revert the graph changes.

ISI Parameters

The ISI parameters are summarized in the following list:

- **State** - Enables/disables the ISI state.
- **Preset** - Allows you to select preset for specific applications representing a typical loss characteristic.
• **Mode** - Controls the ISI as one point or two points. For each point you can specify frequency and insertion loss at that frequency. The calculated values are displayed in the **Parameters** window.
  - **One Point**: In this mode, one point of the linear graph is fixed while the another point can be moved graphically to manipulate insertion loss/frequency values.
  - **Two Points**: In this mode, both points of the linear graph can be moved graphically to manipulate insertion loss/frequency values.

• **Slope** - Shows the calculated slope value (Insertion Loss/frequency, dB/GHz).

• **Insertion Loss Offset** - Shows the Insertion Loss Offset (at frequency=0 Hz).

**Intersymbol Interference (ISI) Setup**

The following steps describe the procedure for ISI setup:

1. Connect the DUT in loopback mode. For connection details, refer to **M8020A and M8030A Getting Started Guide**.
2. From the M8070A software, launch **Adjustable ISI** window.
3. Select **M1.DataOut1** channel from drop-down list.
4. From the **Parameters** window, select the **Preset** from the provided list. It will show the linear graph.
5. Select the mode as ‘**Two Points**’.
6. Manipulate insertion loss/frequency values either graphically or by **Parameters** window.
7. Alternatively, you can also open a S2P or S4P file and graphically manipulate loss and frequency parameters according to data points.
8. Click the toggle button to enable the ISI state.
Controlling AWG(s) from M8070A User Interface

The M8070A system software (Rev 2.5.0.0 or above) allows to control AWGs (M8195A and M8196A) along with the M8020A/M8030A modules. This feature is enabled by license M8070A-1TP or M8070A-1NP. Once the M8195A/M8196A AWG module is installed into an AXIe chassis, it can be accessed via the M8070A software. Ensure that you have latest version of M8070A (Rev 2.5.0.0 or above) and M8195A SFP (Rev 1.3.1.1 or above) software installed in your system. Also to access M8196A, you should have the latest version of M8070A (Rev 3.4.10012.1 or above) and M8196A SFP (Rev 2.0.2.0 or above).

For complete details on M8195A Arbitrary Waveform Generator, visit www.keysight.com/find/m8195a.

For complete details on M8196A Arbitrary Waveform Generator, visit www.keysight.com/find/m8196a.

AWG(s) in Module View

Once the AWG integration is done, you will see a AWG module entry in the Module View. The following figure shows the Module View of M8195A/M8196A AWG:
M819xA Configuration

This section describes the steps to configure M8195A and M8196A AWGs.

**M8195A Configuration**

**NOTE**

M8195A Configuration option is not available for M8195A (Rev 1).

1. Click the **Configuration...** button. Depending upon the available channels in M8195A, the **M8195A Configuration** dialog will appear. The following figure shows the **M8195A Configuration** dialog when four channels in M8195A are available:
2 Click on the radio button to select the memory mode. The following modes are available:

- **One Channel Deep Memory**: The Data Out location of one channel will be sourced from extended memory and the other channels will be sourced from module internal memory. The data range in this mode is 256 Mb/s ... 65 Gb/s.

- **Two Channels Deep Memory**: The Data Out locations of two channels will be sourced from extended memory and the other channels will be sourced from module internal memory. The data range in this mode is 256 Mb/s ... 32.5 Gb/s.

- **Four Channels Deep Memory**: The Data Out locations of all four channels will be sourced from extended memory. The data range in this mode is 256 Mb/s ... 16.250 Gb/s.

- **Random Interface**: The Data Out locations of all channels are used to Generate Random Interface.

- **Sinusoidal Interface**: The Data Out locations of all channels are used to Sinusoidal Interface.

3 Click **Enable**.
M8196A Configuration

1. Click the **Configuration...** button. Depending upon the available channels in M8196A, the **M8196A Configuration** dialog will appear. The following figure shows the **M8196A Configuration** dialog when four channels in M8196A are available:

![M8196A Configuration Dialog]

2. Click on the radio button to select the memory mode. The following modes are available:
   - **Four Channels Deep Memory**: The Data Out locations of all four channels will be sourced from extended memory. The data range in this mode is 256 Mb/s ... 60 Gb/s.
   - **Random Interface**: The Data Out locations of all channels are used to Generate Random Interface.
   - **Sinusoidal Interface**: The Data Out locations of all channels are used to Sinusoidal Interface.

3. Click **Enable**.
Configuring AWG(s) Parameters

The M8195A/M8196A AWG has the **Data Out** and **Clk Gen** ports. You can use the **Parameters** window to configure these ports.

- **Line Coding** - Sets the line coding as NRZ or PAM4.
- **Amplifier** - The **Amplifier** function has the following components:
  - **Amplitude** - Sets the amplitude of the output signal.
  - **Offset** - Sets the offset voltage of output signal.
  - **High** - Sets the high voltage of output signal.
  - **Low** - Sets the low voltage of output signal.
  - **Pulse Shaping Filter** - Sets the filter type used on the waveform. The filter type choices are Gaussian and Raised Cosine. Depending upon the specific waveform used, the waveform gets properties like transition time or roll-off factor. This parameter is only available in M8196A.
  - **Roll-Off Factor** - Sets the roll-off factor for the raised cosine pulse shaping filter. This parameter is only available in M8196A.
  - **Transition Time** - Sets the transition time (20%/80%) of data output signal.
  - **Crossover** - Sets the data’s crossover percentage.
- **Deemphasis** - Sets the deemphasis values in terms of coefficient values. You can set the two post-cursor, main cursor and two pre-cursor by adjusting the coefficient values. For details, see **De-Emphasis Signal Generator** on page 266.
- **Output Timing** - Sets the delay of the output data signal.
- **HF Jitter** - Enables and sets the high frequency jitter.
- **Embedding** - Sets the S-Parameter for embedding.
- **De-Embedding** - The **De-Embedding** function has the following components:
  - **Channel Specific** - Applies channel specific correction of the amplitude and phase using an internal calibration.
  - **Standard Cable** - Defines whether the signal should be pre-distorted considering the properties of the standard cable set.
  - **S-Parameter State** - Enables/Disables S-Parameter compensation.
  - **S-Parameter Profile** - Selects the S-Parameter profile. It also allows you to import and export a S-Parameter profile.
  - **S-Parameter Output Port** - Selects the output port in S-Parameter profile.
- **S-Parameter Input Port** - Selects the input port in S-Parameter profile.

- **Clk Gen** - The Clk Gen port has the following components:
  - Synthesizer - Used to set data rate frequency and period.

- **Random Interface** - The Random Interface function has the following components:
  - Crest Factor Unit - Used to set the random interference crest factor unit type. Following unit types are allowed:
    - LINear - This is the default setting. Select this unit to specify the crest factor as voltage ratio.
    - LOGarithmic - Select this unit to specify the crest factor in dB.
  - Crest Factor - Used to set the random interference crest factor value in dB or as voltage ratio depending on the currently selected crest factor unit type. This is defined as peak value.
  - Highest Frequency - Used to set the random interference high frequency in Hz.
  - Lowest Frequency - Used to set the random interference low frequency in Hz.

- **Sinusoidal Interference** - The Sinusoidal Interference function has the following components:
  - Frequency - Used to set the sinusoidal interference frequency in Hz.

For M8195A, the frequency may be set up to 32 GHz and for M8196A, the frequency can be set up to 46 Gb/s. This is applicable for both NRZ and PAM4 line coding.
Simultaneous Injection of CMSI and DMSI Using M819xA AWGs

The channels of M819xA AWG can be coupled to generate common mode interference (CMI) and differential mode interference (DMI) on an output signal. CMI/DMI is an extension of existing sinusoidal interference.

Follow the given steps to generate multi-tone CMI/DMI on the output signals:

1. In the M819xA Configuration dialog, select **Sinusoidal Interference** and then click **Enable**.

   ![M819xA Configuration Dialog](image)

   For more information on Configuration dialog, see M819xA Configuration on page 204.

2. Set the parameters to generate multi-tone CMI/DMI. For details on parameters, see M819xA AWG CMSI and DMSI Parameters on page 210.
M819xA AWG CMSI and DMSI Parameters

The following functional blocks are available in the Parameter Window to generate CMSI and DMSI.

- **Channel Configuration**
  - **Channel Coupling** – The channel coupling provides the flexibility to couple the two channels. Depending upon the availability of channels in a module, the channels can be coupled in the following ways:
    - **Four channel Module**: Channels 1/2 and Channels 3/4
    - **Two Channel Module**: Channels 1/4
  
  Use the drop-down option to select the channels. For example, selecting “1/2” will couple channels 1 and 2. Once the channels are coupled, the parameters values will be identical across both channels.

  The following block diagram provides an example how to cable the normal/complement outputs of AWG to couple channels 1 and 2:

  ![Diagram](image)

  Select “**None**”, if you don’t want to use the multi-tone functionality.

- **Amplifier** – This functional block has the following parameters:
  - **Output State** – Turns on/off the state of the output.
  - **Termination Voltage** – Sets the external termination voltage.
  - **Amplitude** – Sets the amplitude of the output signal. Once, the channels are coupled, this parameter will be in disabled state. However, the value of this parameter depends on the value of **Amplitude 1**.
- **Offset** – Sets the offset of the output signal.
- **Amplitude Correction Factor** – Sets the amplitude correction factor. The Amplitude Correction Factor parameter is not included in the coupling and so it can be set independently on each coupled channels.

- **Sinusoidal Interference** – This functional block allows you to set Tone Mode, Frequency, Amplitude and Phase for individual signal (1/2). It has the following parameters:
  - **Tone Mode (1/2)**: Sets the tone mode of the output signal. The available options are:
    - **Off** – In this case, the selected tone mode is will not participate.
    - **Common Mode** – In this case, Common Mode Sinusoidal Interference will be generated using non-inverted port of coupled channels.
    - **Differential Mode** – In this case, Differential Mode Sinusoidal Interference will be generated using non-inverted port of coupled channels.
  - **Amplitude (1/2)**: Sets the amplitude of selected tone (1/2). Please note that the value of Amplitude 1 will also reflect in the Amplitude parameter of the Amplifier functional block. The total amplitude across both tones must be between 0 to 995 mV.
  - **Frequency (1/2)**: Sets the frequency of the selected tone (1/2).
  - **Phase (1/2)**: Sets the phase of the selected tone (1/2).

**AWG as External Level Interference (RI/SI) Source**

The Keysight M8195A and M8196A AWG can be used as external level interference source with sinusoidal and random modulation. For this you need to select ‘Random Interference’ or ‘Sinusoidal Interference’ from the M8195A and M8196A configuration dialog. For more details on the M8195A and M8196A configuration dialog, refer to M8195A Configuration on page 204 and M8196A Configuration on page 206. The M8070A system software allows controlling interference parameters such as amplitude, highest frequency, lowest frequency and crest factor. Keysight provides a matched directional coupler pair (orderable option M8045-802) for injecting the RI or SI signal before or after the channel. Specifications for external level interference sources RI/SI with M8195A, M8196A can be found in M8040A data sheet.
The following block diagram shows the recommended RX test setup with RI/SI source (M8195A/M8196A):

Block Diagram for RX Test Setup with RI/SI Source
System View with AWG(s) Integration

This section describes the block diagram provided by the System View when AWG module is integrated in M8070A. The System View for AWG varies on the number of channels available on M8195A or M8196A.

The following figure shows System View of M8195A/M8196A when all four channels are available.

![System View Diagram]

The System View of AWG shows four Data Out channels in the same window. The principal parts of the System View are represented by blocks which are connected by lines/arrows to show the relationship of the blocks. These blocks are highlighted by blue lines around the block on mouse focus. On clicking these blocks, the mostly used parameters are available which can be configured using the on-screen numeric keypad. However, parameters corresponding to the selected block are displayed in the Parameters window, on the right. The block may contain feature
elements (for example, HF Jitter contains PJ1, PJ2 and RJ). You can click on the respective button to enable the feature elements. Once enabled, the feature elements are highlighted in blue color. For more details, refer to System View on page 156.

Signal Generation in AWG

For detailed information about signal generation on arbitrary waveform generators of the M81XX class can be found in the document named "Fundamentals of Arbitrary Waveform Generation" which can be downloaded from here: www.keysight.com/find/awg-apps
Using AWG Frequency Response Calibration for Improved Signal Performance

Keysight recommends performing signal calibration within the AWG system (M8195A/M8196A) for DUT testing.

In other words, the specific channel of the AWG must be calibrated with specific cables and connectors that are used between the AWGs DATA OUT and the DUTs RX port.

To perform the phase/frequency response calibration, you require a DCA-X and DCA-M sampling scope with a receiver module above 30 GHz. Alternatively, you may use a DSA-Z series real-time scope, which is capable of signal analysis above 30 GHz. Generally, a better signal quality is achieved when this calibration is performed using a sampling scope as compared to the calibration performed using a real-time scope.

A S-Parameter file is generated as a result of performing this calibration using IQTools, which can be imported as a De-Embedding filter into the M8070A software. For details on how to perform these steps, refer to IQToolsPhaseFrequencyResponseCalibration.pdf, which is available within the M8070A documentation folder.

Selecting Line Coding

You can define the line coding for a M8195A/M8196A Data Out port through the Parameters window. The M8195A/M8196A Data Out port supports NRZ and PAM4 line coding.

Make sure to use the similar line coding of all Data Out ports assigned to the same sequence of M8195A/M8196A. An *Auto Correction* window will appear if you select different line coding. Clicking on the *Allow* button present on this window, applies the same line coding on all Data Out ports.
The PAM4 line coding provides the symbol mapping options as shown in the following figure:

- **Uncoded** - In this mapping, the bit sequence 00 maps to symbol 0, 01 maps to symbol 1, 10 maps to symbol 2 and 11 maps to symbol 3.
- **Gray Coded** - In this mapping, the bit sequence 00 maps to symbol 0, 00 maps to symbol 0, 01 maps to symbol 1, 11 maps to symbol 2 and 10 maps to symbol 3.
- **Custom** - In this mapping the consecutive data bits are mapped to symbols. The mapping is defined as a comma separated list of bit sequences (e.g. 00, 01, 11, 10). The position within this list corresponds to the symbol level. First value is for Symbol 0 an the last value is for Symbol 3.
- **Symbol Level** - It controls the PAM4 level mappings. It can be used to adjust the actual output level that is being generated by a data output for a specific PAM4 symbol. The levels of PAM4 symbol 0 and 3 cannot be adjusted and are always kept at the value of 0% and 100% of the actual output voltage swing.
Creating Patterns for AWG(s)

The M8070A software provides Pattern Editor for M8195A/M8196A module as well. The functionality of the Pattern Editor is same as for other modules. You can create, edit, load patterns and perform the pattern settings in the same way as done for other modules. For more details, refer to Pattern Editor on page 395.

However for bit coded patterns, the Pattern Editor allows you to view the symbols in the PAM4 No Coding and PAM4 Gray Coding. These options are available in the Settings > Data View Mode.

The following figure shows an example of bit symbol, viewed in the PAM4 Gray Coding.

![Symbol View](image)

In the PAM4 No Coding mode, the bit sequence 00 maps to symbol 0, 10 maps to symbol 2 and 11 maps to symbol 3.

In the PAM4 Gray Coding mode, the bit sequence 00 maps to symbol 0, 00 maps to symbol 0, 01 maps to symbol 1, 11 maps to symbol 2 and 10 maps to symbol 3.

Sequence Settings for AWG(s)

The M8070A software provides Sequence Editor which can be used with most of the devices supported by M8070A. The functionality of the Sequence Editor is the same as for other modules. You can create, edit, load patterns and perform sequence settings in the same way as done in
the M8070A sequence editor. You can change pattern type as static, clock, PRBS, memory pattern, in single block with infinite loop. For more details, refer to Sequence Editor on page 359.

The M819xA modules can be also be configured from the M8070A Sequence Editor. The following figure shows the AWG(s) Sequence Editor:

You can use the Sequence Settings window to reprogram the values of AWG parameters.

Parameters which are not applicable for AWG modules will be either hidden, disabled or checked when performing a sequence download.

The Sequence Editor when used with an AWG module, has the following capabilities:

- A single block can be looped infinitely
- Supports the following block types:
  - PRBS (all polynomials that fit into AWG memory)
  - Memory
  - Static 0 or 1
  - Single pulse per block
  - Clock
Jitter Setting in AWG(s)

The AWG integration into the M8070A software supports sinusoidal jitter, random jitter and spread spectrum clocking (SSC).

Sinusoidal jitter and random jitter can be turned on and off per channel while SSC can only be activated per module.

Periodic Jitter (Valid for PJ1, PJ2 and SSC)

When defining a sequence referencing a specific pattern it will automatically be generated containing the specified jitter. For example in case the given pattern has a duration of 1 µs for the selected baud rate and the jitter period is 2 µs it would not be possible for this jitter to correctly appear inside the pattern. To handle this a second iteration of the pattern is appended giving the memory segment a total duration of 2 µs. With this it is possible for the resulting waveform to contain the selected jitter.

A side effect of this procedure is that the required sample memory for a selected pattern changes depending on the selected jitter components.

In case the jitter cannot be mapped to the available memory while adhering to the jitter accuracy defined in the data sheet a warning message will be displayed to make the user aware of this shortcoming.

Measuring Periodic Jitter

When measuring periodic jitter on an oscilloscope it is important to note that the jitter period will always be rounded in a way that the effective pattern length (which may contain multiple iterations of the user defined pattern) is a multiple of this jitter period.

Another thing to note is that for short pattern, high jitter frequency and the case where the data rate is an integer multiple of the jitter frequency the effective pattern can become maximally short. This will be observable by a relatively fast start of waveform playback but can have an impact on the measured jitter histogram.

For the above mentioned cases the number of distinct edge deviations from their non-jittered positions can be limited which leads to a histogram containing only a low number of lines.

To tweak the quality of the jitter histogram it is possible to use a larger pattern e.g. by repeating the shorter pattern multiple times in the pattern file or using an odd number for the jitter frequency.
Random Jitter (RJ)

The given pattern will be generated with the selected random jitter parameters. Definable are thereby a low pass and high pass frequency which limits the contained jitter components.

Measuring Random Jitter

As the waveform is completely pre-calculated it is not possible to generate truly random jitter with this approach.

Similar to the periodic jitter case it is also true for random jitter that short patterns will not lead to a realistic looking jitter histogram. If a better jitter quality is desired it is therefore necessary to use a longer pattern. In case the actual pattern needs to be short it is possible to have it repeat multiple times in the pattern file and thereby obtain different edge deviations on a single symbol.
Extended Sequencing Capabilities in AWGs

Basic Sequencing

This section describes how patterns are generated in case only a single infinitely looped sequence block is defined. This basic sequencing description is valid for M8195A and M8196A modules.

- PRBS, Static, and Clock sequence block types are repeated with their minimum possible granularity ignoring the number of symbols specified in the sequence block length.
- Memory Patterns and Pulses are created with the chosen pattern length using the sequence block length as the minimum repetition rate.

Extended Sequencing

Pattern Generation

This section describes how the distinct sequence block types are generated when using the enhanced AWG sequencing capabilities in M8070A. Presently, these capabilities are only available with M8195A modules which are configured with the ‘SEQ’ option meant for sequencing.
• PRBS
In a looping sequence block, a PRBS pattern is generated using the specified sequence block length as a minimum number of bits and increased to a full repetition of the base PRBS. As an example, a PRBS7-1 with original length of 127 bits and a sequence block length of 200 bits is given. This will generate a PRBS pattern with a length of 254 bits, meaning two PRBS7-1 iterations. These 254 bits are then used as a base pattern for the generated waveform and multiplied as required to fit into an AWG memory segment.
Non-looping patterns contain the number of sequence bits defined in the sequence block and do not consider the natural PRBS repetition length.

• Memory Pattern
For memory patterns, only the number of bits that are specified as sequence block length, occur in the resulting pattern. In case the memory pattern has a length of 200 bits while the sequence block length is specified as 100 bits, only the first 100 bit of the memory pattern will be used for generating the data stream.

• Static
Static segments use the number of bits in the sequence block, either as a minimum repetition length for roll-out in looped sequence blocks or for defining a minimum pattern length in non-looped sequence blocks.

• Clock
The minimum number of clock symbols are defined by the least common multiple of the clock divider setting and the number of bits specified as sequence block length. In case the line coding is, for example defined as PAM4, the number of bits of a clock sequence block additionally needs to be divisible by the number of bits per symbol which is 2 bit/symbol.

• Pulse
The pulse pattern considers the number of bits specified as sequence block length as the minimum pattern length. The length of the pulse’s high duration is thereby specified by the width property configurable in the sequence block’s data properties. In case of a line coding containing more than one bit per symbol, the pulse pattern width and length must be a multiple of the bits per symbol value (For PAM4, this value is 2 bit/symbol).
Block Settings

Sequence Block

A sequence block can contain an arbitrary user defined pattern, but the effective length of such a sequence block is enlarged internally to fit all the granularity requirements. This leads an effectively sent waveform to be separated into two distinct parts. One part is dubbed as payload (containing the desired pattern) while the other part is called extension (required to meet hardware limitations).

It is ensured that the sequence block length always contains an integral number of symbols. Additionally, the number of sequence block symbols is divisible by two, which allows to stay in sync with a half rate clock signal across multiple sequence blocks.

Traditionally, a sequence block contains only the desired pattern but for M8195A modules, a non-looped sequence block contains a payload and extension pattern part.

- **Payload**
  - It consists of the user-defined pattern. The data sent during the payload duration is provided from a memory pattern location, PRBS selection, etc.
  - The location of the payload inside a sequence block is selectable. Following are the available choices for pattern alignment:
    - Align payload to sequence block start
    - Align payload to sequence block end
- **Extension**
  - The extension part is necessary because of limitations such as sequencer linkage across multiple channels, AWG sample memory granularities, module-wide sample rate and so forth. It extends the waveform sent during playback of a non-looped sequence block to match all preconditions.
The data content of the extension pattern is selectable. Following are the selectable block fill modes:

- **Use Adjacent Symbol Value**
  
  Depending on payload alignment, this setting uses the first or the last symbol value of the payload pattern for filling up the sequence block.

  Using this option will generally produce the shortest sequence block duration with the smallest extension pattern.

- **Repeat Pattern**
  
  This setting repeats the payload inside the extension block. Using this setting, the entire sequence block containing an integral number of payload repeats. This setting produces the same output, independent of the selected payload alignment mode.

  This option generally causes the extension pattern length to increase as it needs to allow for accommodating multiples of the payload pattern length.

- **Fill Extension with Clock Signal**
  
  This option fills the extension pattern with a half rate clock.
Event Configuration

The M8070A software system supports some of the hardware triggering capabilities of M8195A. These features can be configured via the modules view when accessing the 'Trig In', 'Event In', or 'Event Config' functional blocks.

Trig In and Event In

These blocks allow configuration of the input comparator state of the AWG module by defining a decision threshold voltage and an input detection polarity. An event is asserted from the respective input in case the detected voltage transitions above the defined threshold voltage for positive polarity or below the threshold voltage for negative polarity.

Event Config

In this functional block, it is possible to configure whether "Trig In" or "Event In" is connected to trigger a conditional break event in a multi-block sequence. Using M8195A SFP (Soft Front Panel), the advance event corresponds to the conditional break event in M8070A.

By using the break command from the sequence editor it is possible to fire the "Force (Advance) Event" in the SFP. Additionally, it is possible to enable or disable the hardware advance event by using the "Advance Event State" switch.

SCPI Commands

The advance sequencing can also be executed using the remote programming. For details of these commands, refer to M8000 Series Programming Guide.
Controlling N1076A/77A from M8070A

The N1076A electrical clock recovery and N1077A electrical/optical clock recovery provide necessary clock signals to the error detector in M8070A. They take an incoming data (or clock) signal, locks onto it using a phase-locked loop (PLL) circuit, and outputs a recovered clock. The recovered clock can be used as a timing reference for oscilloscopes or M8070A.

N1076A /77A cannot be controlled directly from M8070A, but requires a running instance of FlexDCA N1000-Series System Software.

**NOTE**
The minimum required version of the FlexDCA N1000-Series System Software is A.05.61.23.

One Time Preparation

In order to make N1076A/77A accessible in M8070A please prepare the setup as follows.

1. Install FlexDCA N1000-Series System Software on the computer that the N1076A/77A is connected to via USB. In most cases this will be the same computer that executes M8070A.
2. Start FlexDCA N1000-Series System Software and enable the remote programming interface.
Manually add FlexDCA N1000-Series System Software as an instrument to the I/O Libraries Suite and define the VISA alias that enables M8070A to remote control FlexDCA.

a. Open Keysight Connection Expert.

b. Select Manual Configuration.
   i. Add New Instruments/Interfaces.
   ii. Select "LAN instrument":
      a. Enter the Hostname or IP Address of the computer that runs FlexDCA.
      b. Set Protocol to HiSlip and ensure the Remote Name matches the name that is shown in FlexDCA's SCPI Server Setup.
      c. Test the VISA address to verify that the communication path is setup correctly.
      d. Click "Accept".

c. Select Instruments:
   i. Select the just added instrument at the left side. This may show either "Unknown Instrument" or "N1010A, Keysight Technologies FlexDCA". Verify the VISA address that is shown below the name to ensure this is the correct instrument.
   ii. Click on "Add or Change Aliases" to define one of the alias names that tell M8070A to remote control this instance of FlexDCA.
      a. Click "Add New VISA Alias".
      b. Alias Name: N1076A_PROXY
      c. VISA Address: Select the VISA address that matches the FlexDCA instrument.
      d. Click "Accept".
Using N1076A/77A from within M8070A

In order to use N1076A/77A from within M8070A, the FlexDCA N1000-Series System Software has to be started and fully running before starting M8070A. To ensure this, follow the following startup sequence.

1. Power-up all N1076A/77A that are connected to the PC.
2. Start FlexDCA and wait until the software has completely started up.
3. Verify that the N1076A/77A are correctly assigned to the Extended Modules Slots and that they are connected within FlexDCA. They have to show up at the bottom of the FlexDCA window.
4. Start M8070A System Software.
5. M8070A will show a dedicated module for the FlexDCA instrument.
   a. Press the configure button to enable individual slots of FlexDCA to be controlled from M8070A.
   b. The enabled slots will show up on the module. Click on the respective button to access the clock recovery's parameters.
6. The N1076A/77A can be assigned to an M8046A error detector to be used as an external clock recovery. In this case M8046A will ensure that certain critical parameters are automatically kept in sync between M8046A and N1076A/77A.
   a. Select ‘Ext. Clock Recovery’ as Clock Source of M8046A.
   b. Choose one of the available external clock recoveries under "External Clock Recovery".
As soon as FlexDCA is integrated into M8070A, it will no longer be accessible for interactive use. All remote programming of FlexDCA must be done through M8070A. For more details on the SCPI commands, refer to M8000 Series Programming Guide. Since M8070A is only supporting a subset of the FlexDCA functionality, this will restrict the use of FlexDCA to the control of N1076A/77A. Any other functionality is not accessible through M8070A. These are basically the same SCPI commands that are defined by FlexDCA.

The difference to FlexDCA is that they are located under the root node :N1000, there is no suffix for :SLOT and :CREC, and that there is an extra command argument which holds the M8070A specific identifier (e.g. DCA1.Slot2). But functionality is exactly like when controlling a N1010A FlexDCA directly.

The only M8070A specific command is

```
:N1000:EMODules:SLOT:CONNect[?]<identifier>,{ON | OFF | 1 | 0}
```

This command controls if the specific slot is being enabled to be used by M8070A. It does not establish the connection between N1010A and N1076A/77A. Connecting the N1076A/77A must be done within N1010A prior starting M8070A.

The FlexDCA SCPI Commands are documented in the N1010A FlexDCA online help.

The M8070A documentation shall only have a basic description for the FlexDCA specific commands and point the user to the detailed documentation at the FlexDCA side.
Offline Usage

It is possible to run M8070A in an offline configuration for the external clock recovery. This can be useful to get familiar with the use model or when preparing remote programs without having the actual hardware available.

The easiest way of getting the offline configuration is to start with an online configuration and then simply leaving the clock recovery turned off, the next time M8070A is being started.

If a clock recovery is not available to prepare the offline configuration, then this can still be achieved manually.

1. Start N1010 FlexDCA Software.
2. In FlexDCA open the Interactive SCPI Command Tree.
3 Execute the command
:EMODulesDCAM1:DEVice "N1076A-US12345678"
Select slot number and serial number as required. The example above
is using slot 1 (DCAM1) and the serial number US12345678.

4 Execute the command
:EMODules:SLOT1:SELection DCAM
Make sure to use the same slot number (1 in this example) as for the
previous command.
5 Ensure that N1010A FlexDCA is configured in Keysight Command Expert and the alias is being set.
6 Start M8070A and use the clock recovery in offline mode.

The procedure for offline clock recovery configuration is similar to online one and can also be selected as clock source for a M8046A error detector. If the M8046A error detector is online, then a clock with the correct frequency must be supplied at the CLK IN connector.

In case of offline clock recovery, all commands will executed in the similar way line in online case with the exception of the lock status. The clock recovery will never report unlocked when in offline simulation mode.
Controlling a Real-Time Oscilloscope from M8070A

The M8070A system software (version 4.0 and above) supports certain real-time oscilloscopes to measure BER of NRZ signals and BER as well as SER of PAM4 signals. The real-time oscilloscope is completely controlled from M8070A to capture a signal and convert into a pattern stream that is then uploaded into the M8070A for comparison with an expected pattern and provide BER/SER measurements.

Nevertheless, it is possible to stop measuring BER on the integrated oscilloscope and therefore allow interactive tweaking of oscilloscope settings before continuing the BER measurements. Currently, the following oscilloscopes are supported:

• DSOZ634A
• DSAZ634A
• DSOX96204Q
• DSAX96204Q

Detailed description of the above oscilloscopes can be found at: http://www.keysight.com/find/oscilloscopes

The following licenses are required on the oscilloscope:

• N5384A Serial Data Analysis (SDA)
• N8827A PAM4 Measurement (PM4)
• N5461A Equalization (DEQ)

The minimum supported Infiniium version is 06.10.00616.

All measurements will be done using the Real Edge inputs of the oscilloscope. The achievable target BER is 1e-6.
Required preparation steps

The following preparations must be made to configure the real-time oscilloscope for usage by M8070A. Once this preparation is done, simply power-on the oscilloscope and wait until it has completely started-up before launching M8070A.

- Ensure that the oscilloscope is running the minimum required version of Infinium.
- Ensure the oscilloscope is having the options SDA and PM4 installed. DEQ is optional, and will enable the use of the oscilloscope's feed-forward equalizer in M8070A.
- Connect the oscilloscope to the computer that runs M8070A. Supported remote control interfaces are USB and LAN. In case of a LAN connection, only the HiSLIP protocol is supported.
- M8070A identifies the oscilloscopes to integrate by the existence of an VISA alias for the oscilloscope's the VISA address. This needs to be configured in the Keysight Connection Expert.

The VISA alias names that will mark an oscilloscope for integration into M8070A are
- RTS_PROXY
- RTS_PROXY_1
- RTS_PROXY_2
- RTS_PROXY_3
- RTS_PROXY_4
Setting up a LAN controlled real-time oscilloscope for usage by M8070A

1. Add a new LAN device (this not required for USB connections)
   Enter the oscilloscope's host name or IP address and select the HiSLIP protocol.
   Click **Accept** when done.
2. On the Instruments tab, select the oscilloscope. Click 'Add or Change Aliases' under Instrument Details.
3. Ensure that the correct VISA address is selected, and enter the alias name. Click **Accept** to assign the VISA alias.
When everything is configured correctly, the Instrument Details should look like in the screen below.

Understanding BER measurement with the real-time oscilloscope

Despite the fact that Infinium is capable of measuring BER and SER under certain restrictions, these measurements will not be used when operating the oscilloscope in M8070A.

Instead, the oscilloscope is used as a digitizer and all the pattern comparison and error counting related steps are done by M8070A.

This allows to report a true error count, because M8070A compares against expected pattern and it produces the same detailed error count results as a regular error detector does.
Additionally the standard Error Ratio and Jitter Tolerance measurements of M8070A can be used, which is not possible with Infiniium's built-in BER/SER measurements.

Integrating an oscilloscope into M8070A as an error detector does introduce a few oscilloscope related terms that did not exist in the context of error detectors in the past. One important term to understand is acquisition.

A regular error detector is processing the received data in real-time and is comparing and counting each and every bit that it receives. An oscilloscope as error detector, or better digitizer, is not capable of doing this.

The oscilloscope is capturing the sampled input signal into its acquisition memory and then starts processing of the captured data in order to improve signal shape, apply clock recovery or equalizer algorithms. While the oscilloscope is doing this processing, it does not capture the received input signal. Which means that only a relatively small number of bits is being captured and finally compared with the expected pattern, relative to the time that it takes to process the bits in software.

The steps that it takes from capturing the received signal in the acquisition memory to finally updating the error counters in M8070A are summarized under the term acquisition.

In M8070A the acquisition is normally enabled, thus BER is getting measured. But it can be disabled. This leaves the error detector parameters still under control of M8070A, but additionally enables changing or tweaking oscilloscope settings locally. Therefore settings that are not directly offered by M8070A can still be optimized for the specific measurement task. For example, selecting a type of clock recovery that is not offered by M8070A, or manually fine tuning the threshold values.

While acquisition is enabled, the local user interface of the oscilloscope is locked and no local changes are possible.

The most important parameter in the context of acquisition is the number of bits that shall be processed in one acquisition cycle. This will define the required acquisition memory size on the oscilloscope. Setting the number of bits to a larger value will lower the detectable BER per acquisition. And since a single acquisition directly corresponds to an error counter update in M8070A, this defines the lowest BER value greater than 0.0 that the instantaneous BER will report.
Therefore, the number of bits per acquisition should be at least as large that the targeted minimum detectable BER can be achieved. On the other hand, a large memory size on the oscilloscope side does result in longer execution times for the signal processing. And this causes latencies between adjusting a parameter and getting the first BER result that is based on the new setting and reduces the BER update frequency.

It is best practice to configure the number of bits per acquisition to the smallest possible value that still results in the desired detectable BER. Configuring a small number of bits, will result in an instantaneous BER that becomes more and more insensitive. This is of course causing trouble when relying on the instantaneous BER result, but it is not much of a problem for accumulating error ratio measurements, under the premise that the error distribution is random.

The processing steps within a single acquisition cycle are:
1. The oscilloscope captures the waveform
2. The oscilloscope applies FFE algorithms
3. The oscilloscope applies clock recovery algorithms
4. The oscilloscope applies the decision threshold(s) and extracts digital symbol information
5. M8070A reads the captured symbols from the oscilloscope
6. M8070A aligns the captured data with the expected data
7. M8070A compares the captured data with the expected data
8. M8070A updates the accumulated and instantaneous error counters

These steps are repeated continuously, and only paused when the acquisition is stopped, or a parameter value is getting changed.

After step 8, the error count information is available in M8070A, just like for a hardware based error detector, and is available for measurements.

The currently supported measurements are:
- Error Ratio
- Jitter Tolerance

The currently supported patterns are:
- PRBS $2^n-1$
  - $n = 7, 9, 10, 11, 13, 15, 23, 31, 33, 35, 39, 41, 45, 47, 49, 51$
- Memory patterns
  - Maximum pattern length = 256 kbit
Real-time oscilloscope in Module View

Once the real-time oscilloscope setup is done, you will see its entry in the Module View as shown in the following figure:

The left side of the figure shows the connected modules and the right side shows the Parameters window. The corresponding real-time oscilloscope parameters can be configured through the Parameters window.

NOTE

Using the equalizer auto-set function when measuring a clock pattern will result in incorrect tap-coefficients. The tap optimization requires a certain amount of ISI to produce valid results. This is not the case for a clock signal. Therefore, the equalizer should not be enabled for a clock pattern.
Differences to a hardware based error detector

Due to the post processing style of error counting, there are some differences that need to be taken into account when measuring BER.

1 The measurement duration to achieve a certain target BER with a given confidence level, or simply to compare a given number of bits, is significantly longer than with a hardware based error detector. Therefore a meaningful target BER for a real-time oscilloscope based setup is $10^{-6}$ or higher.

2 Elapsed time cannot be used to estimate or define the number of compared bits.
   This is having impact on how measurements, especially the error ratio measurement, have to be configured when specifying the measurement duration. Always use either a pass/fail criteria or specify the number of bits to measure. Do not specify the measurement duration in terms of time.

3 Single error events may not get recognized.
   The smallest recognizable BER per acquisition is defined by the number of bits per acquisition under DataIn1 -> Acquisition. Error events that occur with a lower probability will not be detected reliably if these are single events. However, when running the error ratio measurement in pass/fail mode, or until a specified number of bits has been compared, the error information will be statistically correct for randomly distributed error events. Increasing the number of bits per acquisition will not only lower the smallest detectable BER of the instantaneous BER result, but also reduce the probability that recurring error events are missed.

4 Inserting single errors, or using an error insertion ratio that is less than the detectable BER, will most likely result in not detecting the error events.

5 Auto-alignments do stop the acquisition. This can have side effects in controlling software if this is monitoring the status bits.

6 The configured pattern sequence is absolutely uncorrelated to any other data channel or sequence in M8070A. This is even true, if multiple error detectors are using the same sequence.

7 The instantaneous BER updates only after a complete acquisition cycle has finished. Depending on the configured number of bits per acquisition, symbol rate, clock recovery and equalizer configuration, this can be in the range of every second to several minutes.
Best practices

The following procedure has proven to be a reliable way of configuring the real-time oscilloscope based error detector.

1. Disable acquisition

2. Configure all parameters. Especially the symbol rate and clock recovery’s loop bandwidth are critical to ensure that the clock recovery will lock.

3. Ensure the signal at the inputs matches the configured parameters. There are cases when the oscilloscope becomes extremely unresponsive if the received signal is not matching the configured parameters. This is mostly caused by misconfiguration of the clock recovery loop bandwidth, or symbol rate.

4. Run a full auto-alignment and observe the oscilloscope display. If no eye diagram is shown or warning messages are displayed, then adjust parameters as suggested by Infinium.

5. Keep the acquisition depth as low as acceptable. If there is no need for a specific minimum detectable BER or confidence level per acquisition, then choose the smallest allowed value, which depends on the expected pattern selection. This will ensure better responsiveness of M8070A and increases the BER update rate.

6. Enable acquisition

Following these steps should ensure that the oscilloscope is successfully acquiring data and M8070A is therefore able to display the resulting BER. If this state is reached, then the parameter settings are good enough to adjust parameters individually. But be aware that choosing the wrong loop bandwidth setting for the clock recovery can not only result in errors due to an unlocked clock recovery, but also have severe impact on processing times of the oscilloscope.

For the best user experience and to avoid common problems that are caused by incorrect settings, please follow the given recommendations:

- Disable acquisition before doing changes to the incoming signal that do not match the parameter settings.
  Keeping the acquisition enabled while the received signal is in conflict with the oscilloscope settings, can cause the oscilloscope to get stuck in processing the signal under wrong parameter configuration.

- Run a full auto-alignment when all parameters are configured, and the signal is applied to the oscilloscope inputs. But do this before enabling acquisition on this signal for the first time.
This will allow an interactive user to observe the oscilloscope's display and adjust settings in case warning messages are shown on the oscilloscope display.

- Take advantage of the possibility to operate the oscilloscope's local user interface while the acquisition is disabled. But be aware that M8070A is not detecting local changes and is not updating its parameters accordingly. Use the Reconfigure function to re-apply the setting as defined in M8070A to synchronize the settings of M8070A and Infiniium.

- When measuring jitter tolerance, configure the number of bits per acquisition to minimum.
  The jitter tolerance measurement is always doing a pass/fail measurement and is collecting acquisitions until the required measurement depth is reached. If the error distribution can be assumed to be random, then it is safe to reduce the bits per acquisition in order to achieve a better responsiveness of the setup.

- If the measurement setup can provide a high precision reference clock (e.g. from the pattern generator being used), then better results can be achieved if this reference is used as the reference for the horizontal time base of the oscilloscope. This is especially true for high symbol rates.

  When using a M8045A as pattern generator, the Ref Clk Out can be configured to 100 MHz and connected to the 100 MHz in connector of the oscilloscope. When this is done, select the External Reference Clock as 100 MHz.

Remote controlling the real-time oscilloscope based error detector

This section provides an overview of the SCPI commands that are relevant for controlling an error detector that is based on a real-time oscilloscope. Many of the commands listed below are also valid for other error detector channels, except for those that configure the acquisition, clock recovery and equalizer parameters.

It is good practice to stop the acquisition manually, when changing multiple parameters and only enable the acquisition, once the parameters are all configured. This avoids that M8070A will automatically stop and restart the acquisition with every parameter that is getting programmed. Additionally, the remote program must to use large enough VISA timeouts that cover the time that it takes to stop acquisition, or auto-set functions that have been initiated. This is important when reprogramming.
parameters while the acquisition is enabled. There is no need for large timeouts if parameters are only set when the acquisition is stopped and the oscilloscope is idle.

Please refer to the M8000 Series Programming Guide for details regarding the commands listed in the following tables.

### Acquisition related commands

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Identifier</th>
<th>Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>INF*.Common</td>
<td>:ACQuisition:STATe &lt;identifier&gt;, {OFF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>:ACQuisition:STATe? &lt;identifier&gt;</td>
</tr>
<tr>
<td>Reconfigure</td>
<td>INF*.Common</td>
<td>:ACQuisition:REConfigure &lt;identifier&gt;</td>
</tr>
<tr>
<td>Bits per Acquisition</td>
<td>INF*.DataIn1</td>
<td>:ACQuisition:BITS&lt;identifier&gt;,&lt;number_of_bits&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>:ACQuisition:BITS? &lt;identifier&gt;</td>
</tr>
<tr>
<td>Symbols per Acquisition</td>
<td>INF*.DataIn1</td>
<td>:ACQuisition:SYMBols&lt;identifier&gt;,&lt;number_of_UI&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>:ACQuisition:SYMBols? &lt;identifier&gt;</td>
</tr>
<tr>
<td>Memory Depth</td>
<td>INF*.Common</td>
<td>:ACQuisition:POINts[:ANALog]? &lt;identifier&gt;</td>
</tr>
</tbody>
</table>

### Clock and clock reference related commands

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Identifier</th>
<th>Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Follow SYS CLK</td>
<td>INF*.DataIn1</td>
<td>:CLOCK:TRACK[:STATe] &lt;identifier&gt;, {OFF</td>
</tr>
<tr>
<td>Symbol Rate</td>
<td>INF*.DataIn1</td>
<td>:SENSe:SRATe[?] &lt;identifier&gt;,&lt;NRf&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>:SENSe:SRATe? &lt;identifier&gt;</td>
</tr>
<tr>
<td>External Reference Clock</td>
<td>INF*.Common</td>
<td>:TRIGger[:SOURce] &lt;identifier&gt;,{INternal</td>
</tr>
<tr>
<td></td>
<td></td>
<td>:TRIGger:REFerence[:FREQuency] &lt;identifier&gt;,{REF1</td>
</tr>
</tbody>
</table>
### Equalization related commands

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Identifier</th>
<th>Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>INF*.DataIn1</td>
<td>:INPut:EQUalization:FFEQualizer:STATe &lt;identifier&gt;, {OFF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>:INPut:EQUalization:FFEQualizer:STATe? &lt;identifier&gt;</td>
</tr>
<tr>
<td>FFE Taps</td>
<td>INF*.DataIn1</td>
<td>:INPut:EQUalization:FFEQualizer:NTAPs &lt;identifier&gt;, &lt;number&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>:INPut:EQUalization:FFEQualizer:NTAPs? &lt;identifier&gt;</td>
</tr>
<tr>
<td>FFE Pre Taps</td>
<td>INF*.DataIn1</td>
<td>:INPut:EQUalization:FFEQualizer:NPRecursor &lt;identifier&gt;, &lt;number&gt;</td>
</tr>
<tr>
<td>Auto-set</td>
<td>INF*.DataIn1</td>
<td>:INPut:EQUalization:FFEQualizer:TAP:AUTO &lt;identifier&gt;</td>
</tr>
</tbody>
</table>

### Clock recovery related commands

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Identifier</th>
<th>Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>INF*.DataIn1</td>
<td>:INPut:CDR:OJTF:STATe{STATe} &lt;identifier&gt;, {OFF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>:INPut:CDR:OJTF:STATe{STATe}? &lt;identifier&gt;</td>
</tr>
<tr>
<td>Loop Bandwidth</td>
<td>INF*.DataIn1</td>
<td>:INPut:CDR:OJTF:SECond:LBANdwidth &lt;identifier&gt;, &lt;NRf&gt;</td>
</tr>
<tr>
<td>Damping Factor</td>
<td>INF*.DataIn1</td>
<td>:INPut:CDR:OJTF:SECond:DFACtor &lt;identifier&gt;, &lt;NRf&gt;</td>
</tr>
</tbody>
</table>

### Line coding related commands

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Identifier</th>
<th>Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coding</td>
<td>INF*.DataIn1</td>
<td>:DATA:LINecoding:VALue? &lt;identifier&gt;, {PAM4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>:DATA:LINecoding:VALue &lt;identifier&gt;</td>
</tr>
<tr>
<td>Symbol Mapping</td>
<td>INF*.DataIn1</td>
<td>:DATA:LINecoding:PAM4:MAPping &lt;identifier&gt;, {NONE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>:DATA:LINecoding:PAM4:MAPping? &lt;identifier&gt;</td>
</tr>
<tr>
<td>Custom Symbol</td>
<td>INF*.DataIn1</td>
<td>:DATA:LINecoding:PAM4:MAPping:CUSTom &lt;identifier&gt;, &lt;string&gt;</td>
</tr>
</tbody>
</table>
### Comparator related commands

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Identifier</th>
<th>Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compare Mode</td>
<td>INF*.DataIn1</td>
<td>:INPut:CMODE &lt;identifier&gt;, &lt;DIFFerential</td>
</tr>
<tr>
<td></td>
<td></td>
<td>:INPut:CMODE? &lt;identifier&gt;</td>
</tr>
<tr>
<td>Polarity</td>
<td>INF*.DataIn1</td>
<td>:INPut:POLarity &lt;identifier&gt;, &lt;NORMAL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>:INPut:POLarity? &lt;identifier&gt;</td>
</tr>
<tr>
<td>Auto-set thresholds</td>
<td>INF*.DataIn1</td>
<td>:INPut:ALIGNment:EYE:ACEN &lt;identifier&gt;</td>
</tr>
</tbody>
</table>

### Sample delay related commands

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Identifier</th>
<th>Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delay</td>
<td>INF*.DataIn1</td>
<td>:INPut:delay &lt;identifier&gt;, &lt;NRF&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>:INPut:delay? &lt;identifier&gt;</td>
</tr>
<tr>
<td>Auto-set delay</td>
<td>INF*.DataIn1</td>
<td>:INPut:ALIGNment:EYE:TCENTER &lt;identifier&gt;</td>
</tr>
</tbody>
</table>

### Error counter related commands

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Identifier</th>
<th>Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instantaneous BER</td>
<td>INF*.DataIn1</td>
<td>:FETCh:IBERate? &lt;identifier&gt;</td>
</tr>
<tr>
<td>Accumulated BER since last acquisition start</td>
<td>INF*.DataIn1</td>
<td>:FETCh:BCOunter? &lt;identifier&gt;</td>
</tr>
<tr>
<td>Sync Loss Threshold</td>
<td>INF*.DataIn1</td>
<td>:DATA:SYNC:THreshol[d]? &lt;identifier&gt;, &lt;NRF&gt;</td>
</tr>
</tbody>
</table>
### Automatic parameter optimizations

<table>
<thead>
<tr>
<th>Function</th>
<th>Identifier</th>
<th>Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-alignment</td>
<td>INF*.DataIn1</td>
<td>::INPut:ALIGNment:EYE[AUTO] &lt;identifier&gt;</td>
</tr>
<tr>
<td>Auto-set thresholds</td>
<td>INF*.DataIn1</td>
<td>::INPut:ALIGNment:EYE:ACEN &lt;identifier&gt;</td>
</tr>
<tr>
<td>Auto-set delay</td>
<td>INF*.DataIn1</td>
<td>::INPut:ALIGNment:EYE:TCEnter &lt;identifier&gt;</td>
</tr>
<tr>
<td>Auto-set equalizer</td>
<td>INF*.DataIn1</td>
<td>::INPut:EQUalization:FFEQualizer:TAP:AUTO &lt;identifier&gt;</td>
</tr>
</tbody>
</table>
5 Setting up Generator

Overview / 250
M8020A/M8030A Generator Ports / 251
M8040A Generator Ports / 253
Bit Rate / 277
Trigger Output / 282
Error Insertion / 288
FEC Error Insertion / 290
Interference / 294
Jitter Setup / 296
Overview

The M8020A/M8030A/M8040A generator generates an output signal based on a data pattern. It has the following possibilities for generating an output signal:

- Providing a wide range of clock frequencies
  You can use the generator's internal clock or an external clock for defining the frequency of the outgoing stream.
- Distorting the signal by adding jitter
  You can connect an external delay control device (for example a function generator) to add jitter to the generated signal.
- Adding errors to the output stream
  The M8020A/M8030A/M8040A can be set up to insert errors into the outgoing stream either internally, according to an external signal, or manually (from the operator).
- Run-time switching between two patterns
  You can set up two patterns and switch between them during runtime either automatically, according to an external signal, or manually.
- Suppressing the output stream
  The output signal can be suppressed according to an external signal.

The M8020A/M8030A/M8040A generator also provides output ports that let you connect an external instrument, such as an oscilloscope.
M8020A/M8030A Generator Ports

The M8020A/M8030A generator ports are used to set the generator’s clock frequency and to define the output signal with respect to jitter, error insertion and signal output. In addition, the generator’s output ports are also used to supply a clock signal and trigger (for example, analyzer), and an arbitrary data signal for testing your device.

The M8020A/M8030A provides a high level of integration with built-in clock synthesizer, de-emphasis, jitter and level interference. It allows you to set the parameters for the built-in generator parameters such as amplifier, de-emphasis, HF and LF jitter, common mode interference and differential mode interference.

The following figure shows the M8020A/M8030A generator’s ports.

The M8020A/M8030A generator’s ports include the following:

- **Ref Clock In**
  The Ref Clik In input can be used as reference frequency or as external system frequency directly for the instrument. An external provided signal can be measured at that input. This input is tightly involved in the system frequency generation.

- **Data Out and Data Out**
  The differential data output serve as device stimuli and can be set up so that they are compatible with a variety of logic families. With respect to Data Out, Data Out has inverted logic.

- **Clock Out and Clock Out**
  The differential clock output serve as frequency (bit rate) reference and can be set up so that they are compatible with a variety of logic families. With respect to Clock Out, Clock Out has inverted logic.
• Trigger Out and Trigger Out
  This port allows you to trigger another device (for example, an oscilloscope) and can be set up so that they are compatible with a variety of logic families. Trigger Out has more modes, e.g. sub rate clock to be used as ref clock for a DUT. With respect to Trigger Out, Trigger Out has inverted logic.

• Sys Out A/B
  The system level control outputs used to trigger events to the DUT or external instruments.

• Ctrl Out A
  The control output port provides the Error Output functionality.

The complementary outputs can be used when:
• additional output capability is needed for an instrument such as an oscilloscope or digital communication analyzer.
• your device requires differential inputs.

**NOTE**
The Generator's Data Out, Clock Out, Trigger Out and ports must be terminated with 50 Ω if they are not connected.
M8040A Generator Ports

The M8040A generator ports are used to set the generator's clock frequency and to define the output signal with respect to jitter, error insertion and signal output. In addition, the generator's output ports are also used to supply a clock signal and trigger (for example, analyzer), and an arbitrary data signal for testing your device.

The M8040A provides a high level of integration with built-in clock synthesizer, de-emphasis, jitter and level interference. It allows you to set the parameters for the built-in generator parameters such as amplifier, de-emphasis, HF and LF jitter, common mode interference and differential mode interference.

The following figure shows the M8040A generator's ports.

The M8040A generator's ports include the following:

- Remote Head - P and N Ports
  The P and N ports of each channel must be connected to the M8057A.

- Clk Out1 and Clk Out 2
  These are the Clk Out ports of channel 1 and 2, respectively. It can generate either a Clean Clk or all timing impairments like Data Out.

- Ref Clock In
  The Ref Clk In input can be used as reference frequency or as external system frequency directly for the instrument. An external provided signal can be measured at that input. This input is tightly involved in the system frequency generation.

- Ref Clock Out
  The Ref Clk Out is used to provide a 10 MHz or 100 MHz reference clock to the DUT or other test equipment.
5 Setting up Generator

- **Clock Out and Clock Out**
  
  The differential clock output serve as frequency (bit rate) reference and can be set up so that they are compatible with a variety of logic families. With respect to Clock Out, Clock Out has inverted logic.

- **Trigger Out and Trigger Out**
  
  This port allows you to trigger another device (for example, an oscilloscope) and can be set up so that they are compatible with a variety of logic families. Trigger Out has more modes, e.g. sub rate clock to be used as ref clock for a DUT. With respect to Trigger Out, Trigger Out has inverted logic.

- **Sys Out A/B**
  
  The system level control outputs used to trigger events to the DUT or external instruments.

- **Ctrl Out A**
  
  The control output port provides the Error Output functionality.

The complementary outputs can be used when:

- additional output capability is needed for an instrument such as an oscilloscope or digital communication analyzer.
- your device requires differential inputs.

### NOTE

The Generator's Data Out, Clock Out, Trigger Out and ports must be terminated with 50 Ω if they are not connected.

---

**Understanding the Output Protection Circuit**

The M8041A and M8051A J-BERT modules offers a huge flexibility for external termination schemes and external termination voltages to address common technologies. For details, please refer to the M8020A Data Sheet.

An internal protection circuit continuously monitors the voltages of clock, data and trigger output. It becomes active and turns off the output(s) if the externally applied termination voltage does not match the respective setting (any longer).
If an output voltage violation occurs, the output(s) is switched off, which means to a "high impedance" condition. When it gets switched on again (manually by the user) it again follows the standard enabling procedure with termination voltage(s) & impedance checks.

A warning icon appears in the Status Window as shown in the following figure:

Understanding the Output Level Parameters

The following figure shows the parameters of a Data, Clock, or Trigger output signal.

As shown in this figure, the signal output levels have the following components:
Setting up Generator

- High voltage is the upper voltage level of the signal.
- Low voltage is the lower voltage level of the signal.
- Offset voltage is the offset of the average voltage level from 0 V.
- Amplitude of the signal.

When adjusting the output levels, it is important to understand the concept of how the M8020A/M8030A handles voltages.

**Changing the Amplitude**

Typically, during tests, when you adjust the amplitude, you want to keep the offset constant. This keeps the ideal sampling point within the eye. The M8020A/M8030A handles this by keeping offset voltage constant when amplitude is changed.

**Changing the Output Levels**

On the other hand, you may want to adjust the output voltage level without changing the amplitude. The M8020A/M8030A handles this by keeping amplitude constant when offset voltage is changed and high/low voltage are accordingly adjusted.

**Voltage Level Restrictions**

The M8020A/M8030A cannot generate a signal that has voltage levels out of range. If you try to enter a value for one parameter that would put another parameter out of limits, the M8020A/M8030A rejects the change. This could happen, for example, if low voltage is already at the minimum, and you try to lower either of high voltage or low voltage, or increase amplitude.
Understanding Delay and Crossover

The M8020A/M8030A provides the possibility of modifying the output data signal by varying the signal’s delay to the clock signal, and the signal’s crossover.

Delay

The exact time delay through a test setup can vary. The delay function allows you to compensate for this by adjusting the active edge of the trigger output relative to the clock/data outputs. This varies the phase relationship of the data and clock outputs (causes the data to have a certain time delay after the clock pulse). The higher the delay, the greater the time difference between the clock signal and the data signal. The delay can be adjusted by the generator’s Data Out 1 and Data Out 2 ports.

![Data Out and Clock Out with Delay](image)

Crossover

Crossover is the voltage level where the overlapped rising and falling edges of the logic levels intersect. This adjustment varies the widths of the logic highs and lows.

The following figure shows examples of crossover at 50 %, 80 %, and 20 %:

![Crossover Examples](image)

Note that the crossover feature is not supported by M8040A.
Why Incorrect Terminations Could Damage Your Device

Choosing wrong terminations may cause your device to output voltage levels that are not as expected. It may also cause excessive current or current flow in the wrong direction, which can damage your device.

Note that an internal protection circuit becomes active if the termination voltage is wrongly adjusted. The protection circuit sets the output voltages to safe levels, typically:

\[ V_{hi} = V_{lo} = V_{term} = \text{externally measured termination voltage}. \]

If you adjust the termination voltage, and try to enter value(s) which are outside of the currently allowed window, the Auto Correction Confirmation message box will pop up with respective apply and discard options as shown in the following figure:

AC Coupling and Bias Tees

The generator's outputs are always internally DC-coupled; even when AC termination is selected. For this reason, caution must be taken when connecting your instrument to a device or test setup.

The diagram below shows a device that is AC coupled. Note that the capacitor is part of the test setup.
You can use an external bias to power your device. You must ensure, however, that the network is oriented correctly. If it is not, your device or instrument may get damaged.

The following diagram shows a bias tee that is positioned correctly. Notice that the generator's outputs are protected by the blocking capacitor.
The following drawing is an example of the external DUT connected to the generator output for the different possible settings.

![Diagram of DUT connection](image)

This figure shows what the generator expects to be externally connected as DUT, with respect to the different selectable termination models.

For AC-coupled mode (see red box above), the instrument actually cannot and does not need to distinguish between these two termination schemes. Therefore the drop-down box **Termination Model** is not shown and active within the GUI when the AC coupled mode is selected.

There are certain impedance/voltage limits you need to keep in order to be able to turn on (enable) the output(s).

Whenever an output amplifier is turned on, the external DC resistance as well as the external termination voltage is measured and calculated.

These are the impedance/voltage limits for various modes / configurations:

- **DC Coupling Unbalanced**: The measured externally connected resistance should be within the allowed range which is between 40 to 65 Ω here. Also, if an external termination voltage is detected that is not within the allowed ±100 mV tolerance window, the output(s) will not turn on.
• **DC Coupling Balanced:** The measured externally connected resistance should be within the allowed range which is between 70 to 130 $\Omega$ here. In this DC Coupling Balanced mode there is an exception implemented, that allows the output(s) to drive high impedance (‘into open’). For this, the set maximum amplitude should be below 300 mv, and the offset setting should be between 0-370 mv.

• **AC Coupling:** When using the AC coupled mode, you must apply an external DC blocking capacitor. Here the external DC resistance must be greater than or equal to 300 $\Omega$, with the HF resistance being ~50 $\Omega$ (single-ended) or ~100 $\Omega$ (differential).

### Setting up Terminations

Before you can start sending signals to your device, you have to choose the proper termination mode. To do so:

1. Go to the **Menu Bar > Generator** and then select **Data Out**.
2. Select **Amplifier** functional block from the **Parameters** window.
3. Provide the DUT’s termination settings.
4. Provide termination voltage.

**CAUTION**

Selecting the wrong termination may damage your device.

5. Connect the DUT’s input ports to the M8020A/M8030A/M8040A’s output ports.

**CAUTION**

Do not apply external voltages to the generator outputs.

Output ports of the generator that are not connected to another device must be terminated with 50 $\Omega$ to prevent the M8020A/M8030A/M8040A from damage. If outputs are disconnected they are usually not turned on because the output enable check detects the misconfiguration. If outputs are disconnected after they have been turned on the protection circuit might get triggered depending on the specific configuration. In this case the output will be switched off. This is an emergency scenario and should never be a normal habit. It can be switched on again (manually by the user) after removing the fault condition, it again follows the standard enabling procedure with termination voltage(s) & impedance checks.
DC Check (Unbalanced/Balanced Termination) for M8040A

DC Check for Unbalanced Termination

**Step 1**  If the Measured Voltage = VT $\rightarrow$ Pass, go to Step 2.

![Diagram of Step 1](image)

**Step 2**  If the Measured Voltage = VT $\rightarrow$ Pass, go to Step 3.

![Diagram of Step 2](image)
Step 3  If the Measured Voltage = VT + 50 mV $\Rightarrow$ Pass, turn on the output driver.

In the above diagrams, only normal output is shown. However, the DC check however is done for normal and complement output. In general, the both outputs (P/N) need to be terminated the same way.

In single ended use case for better convenience the unused output can be terminated with 50 Ohm into GND although termination voltage of used output might not be zero. This is only true as long as the offset voltage is between +1V and -1V. The mismatch is detected during the test and is compensated internally. This is implemented in order to make the termination of unused outputs easier.
5 Setting up Generator

DC Check for Balanced Termination

**Step 1** If the Measured Voltage = OFFSET → Pass, go to Step 2. However, this is false if DUT is unbalanced with VT unequal to OFFSET.

**Step 2** If the Measured Voltage = OFFSET + 100 mV → Pass, go to Step 3. However, this is false if DUT is unbalanced (no matter if VT is equal or unequal to OFFSET).
Step 3  
If the Measured Voltage for P is OFFSET +50 mV and for N is OFFSET -50 mV \( \rightarrow \) Pass. Turn on the output driver. However, this is false if DUT is not connected or AC coupled.

Adjust Output Levels (optional)

Data, Clock and Trigger Out offset and voltage levels can be adjusted. This is typically done when you want to tune your BER measurement or stress the device.

You can adjust the related parameters of the data and clock amplitudes and offsets on the GUI.

To enter specific values for the outputs from the keyboard:
1. Go to the Menu Bar > Generator and then select Data Out and Trigger Out ports. Once more, go to the Menu Bar > Generator and then select Clock Out port.
2. Select Amplifier functional block from the Parameters window.
3. Select coupling as DC.
4. Select termination model as Unbalanced.
5. Enter the desired termination voltage.
De-emphasis Signal Generator

The M8020A/M8030A has a built-in de-emphasis signal generator that can be connected between the Data Out port of the generator and the DUT.

De-emphasis is a method that reduces the voltage of a digital signal if the generated level is high or low for more than one clock period. The principle is illustrated in the following figure.

The de-emphasis amplitude is specified as a fraction of the output amplitude (in percent or dB).

Post-cursor de-emphasis

The figure above refers to a so-called post-cursor de-emphasis. You may wish to know how that is generated.

- One branch has a programmable amplifier to produce the desired output voltage (Peak to Peak Voltage).
• The other one has an adjustable delay (automatically set to one signal clock period) and a programmable inverting attenuator/amplifier to produce the delayed signal with a lower voltage swing.

Finally, the signals of both branches are added. This means, the delayed signal voltage is subtracted from the specified peak-to-peak amplitude.

**Pre-cursor de-emphasis**

It is also possible to convert the input signal to a pre-cursor deemphasized signal.

This can be done by setting the output voltage swing to the desired deemphasis amplitude and specifying a negative amplitude ratio (amplification). This inverts the roles of the two branches. The delayed signal has now a larger amplitude than the direct signal. A waveform example is illustrated in the following figure.

When pre-cursor de-emphasis is generated this way, the complementary Output of the De-Emphasis Signal Converter becomes the normal output and vice versa.

**CAUTION**

Be very careful if you set the de-emphasis ratio to amplification! In this case, there is no indication of the peak-to-peak voltage applied to the DUT. You need to calculate or measure the output signal voltage precisely. Otherwise you might damage your device.
De-emphasis on 2 pre-cursor and 5 post-cursors

The following example illustrates the output of the differential signal with variable de-emphasis on 2 pre-cursor and 5 post-cursors generated by M8020A/M8030A De-Emphasis.

Controlling the De-Emphasis

To control the de-emphasis function:

1. Go to the Menu Bar > Generator and then select Data Out.
2. Select De-Emphasis function block from the Parameters window.

For M8020A/M8030A, you have two (pre-cursor) and five (post-cursor) and the corresponding unit.
You can use the **Preset Enable** button to enable/disable changing the de-emphasis preset register number. Once the **Preset Enable** option is enabled, you can set the preset register number. There are 31 preset registers available addressed by a register index of 0 up to 30. The tap values of the ‘current’ preset register are shown at the output. Preset register 0 is the default register. Supported preset values for M8041A, M8051A and M8062A are 0 - 30 and for M8061A, the only preset value is 0.

You can toggle between dB (decibel) and % (percent). Toggling does not change the value. The **De-Emphasis** function block also allows you to set the “Positive” or “Negative” polarity for de-emphasis.

**M8045A De-Emphasis**

The M8045A provides built-in 5 taps de-emphasis with positive and negative cursors based on a finite impulse response (FIR) filter. You are allowed to enter the de-emphasis values in terms of coefficient values. You can set the two post-cursor, main cursor and two pre-cursor by adjusting the coefficient values.
5 Setting up Generator

Table 49 Specifications for multi-tap de-emphasis

<table>
<thead>
<tr>
<th></th>
<th>NRZ</th>
<th>PAM4</th>
</tr>
</thead>
<tbody>
<tr>
<td>De-emphasis taps</td>
<td>5 taps, can be adjusted for each channel independently</td>
<td></td>
</tr>
<tr>
<td>Coefficient 0</td>
<td>0.0 to ± 0.4</td>
<td>0.0 to ± 0.4</td>
</tr>
<tr>
<td>Coefficient 1</td>
<td>0.0 to ± 0.4</td>
<td>0.0 to ± 0.4</td>
</tr>
<tr>
<td>Coefficient 2 (Main)</td>
<td>0.0 to 1.0</td>
<td>0.0 to 1.0</td>
</tr>
<tr>
<td>Coefficient 3</td>
<td>0.0 to ± 0.45</td>
<td>0.0 to ± 0.45</td>
</tr>
<tr>
<td>Coefficient 4</td>
<td>0.0 to ± 0.45</td>
<td>0.0 to ± 0.45</td>
</tr>
<tr>
<td>Cursor coefficient resolution</td>
<td>0.01</td>
<td>0.01</td>
</tr>
</tbody>
</table>

Controlling the M8045A De-Emphasis

To control the M8045A de-emphasis function:

1. Go to the Menu Bar > Generator and then select Data Out.
2. Select De-Emphasis function block from the Parameters window. The following De-Emphasis parameters will be shown:
For M8045A, you have two pre-cursor (Coefficient 1 and 2), two post-cursor (Coefficient 3 and 4), one main-cursor (Coefficient 2) and the corresponding unit. You can enter the de-emphasis values in terms of coefficient values. Once you enter the coefficient values, the pre-cursor and post-cursor values are automatically reflected in the corresponding fields. Once the **Automatic Main-Cursor** button is enabled, you are not allowed to adjust the main cursor as it is automatically calculated. However, to change the values for main cursor, you need to disable the **Automatic Main-Cursor** button. You are allowed to toggle between dB (decibel) and % (percent). Toggling does not change the value.

Set the values as following:

- **Automatic Main-Cursor button**: Enables automatic calculation of the main cursor.
- **Coefficient 0**: Controls the filter coefficient 0.
- **Coefficient 1**: Controls the filter coefficient 1.
- **Coefficient 2 (Main)**: Controls the filter coefficient 2 (main cursor).
- **Coefficient 3**: Controls the filter coefficient 3.
- **Coefficient 4**: Controls the filter coefficient 4.
- **Output Swing**: Resulting peak to peak output swing as percentage of the configured output amplitude.
- **Unit**: You can toggle between dB (decibel) and % (percent).
Setting Up Data Out Port Parameters

The generator produces clock and data outputs that serve as frequency reference and device stimulus for the device under test.

To set the Data Out parameters:
1. Go to the Menu Bar > Generator and then select Data Out port.
2. Select Amplifier functional block from the Parameters window.
3. Set the parameters as described in this section.

![Settings Table]

**Amplitude**

This text field allows manual entry of the voltage amplitude and displays the current value.

To modify the value, click inside the text field and enter the desired value.

**NOTE**

The M8020A/M8030A will not allow you to adjust a voltage beyond its limits. The limit is determined by the M8020A/M8030A’s internal hardware. If a limit is encountered, the M8020A/M8030A sends a message to the System Error. For more information about voltage limits, see the M8020A Data Sheet.
If you may want to adjust the output voltage level without changing the Amplitude, the J-BERT M8020A handles this by keeping Amplitude constant when Offset voltage is changed and High and Low voltages are accordingly adjusted.

Similarly, if you want to adjust the output voltage level without changing the Offset, the J-BERT M8020A handles this by keeping Offset constant when Amplitude is changed and High and Low voltages are accordingly adjusted.

You can even click **Auto Range** option which will automatically select the amplitude range according to amplitude.

### High Voltage
This text field allows manual entry of the logic high voltage level and displays the current value.

To modify the value, click inside the text field and enter the desired value.

### Offset Voltage
This text field allows manual entry of the voltage level halfway between logic high and logic low (the offset) and displays the current value.

To modify the value, click inside the text field and enter the desired value.

### Low Voltage
This text field allows manual entry of the logic low voltage level and displays the current value.

To modify the value, click inside the text field and enter the desired value.

### Crossover
This text field allows manual entry of the data's crossover percentage, and displays the current value.

Note that the crossover feature is not supported by M8040A.
Clk/2 Jitter
This text field allows manual entry of the Clk/2 Jitter at the Data Out port in units of seconds. It provides half rate clocking; the clock at the clock output runs at half the bit rate.

Data Polarity Inverted
Use this option to invert the logic of the data outputs (Data Out, Trigger Out and Clock Out).

Transition Time
Use this option to control the transition time of the output signal. The choices are smooth, moderate and steep.

Note that the transition time is not supported by M8040A.

Setting up Output Timing

The **Output Timing** functional block provides following parameters:

- **Data Rate** - Sets the channel data rate in b/s. To set up the data rate, go to Clock Generator and set the Frequency.
- **Delay** - Controls the data delay of the output signal. This also affects the channel’s Clock Out signal when the clock source is configured as Data Clock.
- **Jitter Delay** - Controls the delay of jitter profile. Use this option to adjust the jitter phase between multiple outputs (e.g. clock and data) on the receiving side to ensure error free sampling for the jitter frequencies and amplitudes used in the setup.
- **Deskew** – This feature is used to match or adjust the timing delay between the Data Out channels. It is a delay offset that is intended to deskew the output in respect to other outputs. This value is an offset to the data delay as well as jitter delay.

**Line Coding**

You can define the line coding for a Data Out port of the M8045A, M8195A and M8196A modules through the Parameters window.

To set the line coding:
1. Go to the Menu Bar > Generator and then select Data Out.
2. Select Line Coding functional block from the Parameters pane.
3. Select the line coding. The Data Out port supports NRZ and PAM4 line coding which defines how consecutive data bits are mapped to symbols.

The PAM4 line coding provides the following symbol mapping options:
- **Uncoded** – In this mapping, the bit sequence 00 maps to symbol 0, 10 maps to symbol 2 and 11 maps to symbol 3.
- **Gray Coded** – In this mapping, the bit sequence 00 maps to symbol 0, 00 maps to symbol 0, 01 maps to symbol 1, 11 maps to symbol 2 and 10 maps to symbol 3.
- **Custom** – In this mapping the consecutive data bits are mapped to symbols. The mapping is defined as a comma separated list of bit sequences (e.g., 00, 01, 11, 10). The position within this list corresponds to the symbol level. First value is for Symbol 0 and the last value is for Symbol 3.
• **Symbol Level**: It controls the PAM4 level mappings. It can be used to adjust the actual output level that is being generated by a data output for a specific PAM4 symbol. The levels of PAM4 symbol 0 and 3 cannot be adjusted and are always kept at the value of 0% and 100% of the actual output voltage swing.

**NOTE**: Make sure to use the similar line coding for all Data Out ports of M8045A/M8195A/M8196A. An "Auto Correction" window will appear if you select different line coding for Data Out ports. Clicking on the "Allow" button, present on this window applies same line coding on all Data Out ports.
Bit Rate

Bit rate is defined as bits per second. The Generator’s clock rate sets the bit rate and serves as the frequency reference for the Data, Clock and Trigger outputs, your device, and the Analyzer (if it receives its clock from the Generator). It can be generated internally or supplied from an external source.

When to Use an External Clock Source?

The M8020A/M8030A/M8040A’s internal clock can be used for most testing purposes.

There are some circumstances, however, when an external clock source is required:

- **Synchronization with an external clock**
  The M8020A/M8030A/M8040A can be connected to an external clock to allow it to run as part of a larger external system.

- **Use of a modulated clock**
  A frequency- or delay-modulated clock can be used to provide a small amount of jitter to the clock signal.

- **Use of a precision clock**
  A precision clock with very low phase noise can be used to enhance the instrument’s performance. This is especially interesting for longterm measurements.

Bit Rate Range

The M8040A provides symbol rate from 2.0 to 32.4 Gbaud for M8045A Option -G32 and 2.0 to 58.0 Gbaud (all specifications are valid up to 58 Gbaud with over-programming up to 64.8 Gbaud) for M8045A Option -G64.

The M8020A/M8030A provides bit rates from 256 Mbit/s up to 16.2 Gbit/s, depending on the instrument’s options.

However, several specific properties and limitations need to be taken into account when working at low bit rates. The limitations apply to the instrument according to the following hysteresis curve:

- If the bit rate falls below 615 Mbit/s, the limitations apply.
- If the bit rate exceeds 620 Mbit/s, the limitations no longer apply.
The following figure clarifies the behavior in the range between 615 Mbit/s and 620 Mbit/s:

For the generator the following rules apply:
- Below 620 Mbit/s, the Generator can only be operated with an external clock source, because the internal clock source can only produce signals higher than 620 Mbit/s.
- The trigger output cannot be set up to trigger on certain pattern positions or pattern sequences. If this option is enabled (for example in the user interface), the trigger is sent once for each pattern, but the bit position cannot be specified. The option to trigger on the divided clock signal is supported as usual.
- There are restrictions to the available clock to data delay values. The Generator can vary the clock to data delay only within a range of 10 ns (relative to the clock signal). For frequencies above 666 Mbit/s, this range is sufficient to cover the complete clock cycle (= 1 unit interval). For lower frequencies, the valid data delay range is smaller than the clock cycle. The Generator cannot generate signals with a delay outside this range. Therefore, the data delay cannot be set to all values within the clock cycle.
Spread Spectrum Clocking

A **Spread Spectrum Clock** (SSC) is widely used for reducing the peak electromagnetic radiation at the nominal clock frequency. With SSC, the clock pulse is modulated with a relatively low-frequency triangle waveform. This broadens the clock signal spectrum and reduces the peak energy. The M8020A/M8030A allows to emulate such SSC on the data, trigger and clock output signals.

The M8020A/M8030A has a built-in SSC generator.

For the SSC settings, go to **Menu Bar > Clock > Clock Generator** and then select **SSC** function block from the **Parameter** window.
5 Setting up Generator

Setting the Bit Rate

You can use an external clock source or the M8020A/M8030A/M8040A's internal clock to control the bit rate.

To set the bit rate:
1. Go to Menu Bar > Clock and then Clock Generator.
2. Select Synthesizer function block from the Parameter window.
3. Select the appropriate clock source from the following options:
   - Internal - When clock source is selected as Internal, an internal clock oscillator is used. For the internal clock source, different reference clock sources are available for the internal oscillator. When the Reference frequency is selected as Internal 100 MHz, then 100 MHz Reference clock of M8041A/ M8045A module is used and when Reference frequency is selected as AXIe 100 MHz, then 100 MHz reference clock of M950XA AXIe chassis is used.
   - Reference - To use clock source as Reference, we need to connect external reference clock source to Ref Clk In port of M8041A/ M8045A module. Depending upon the connected clock source, you have to choose between either 100 MHz reference frequency or 10 MHz reference frequency.
   - Direct - To use Clock source as Direct, you need to connect external clock source to Ref Clk In port of M8041A/ M8045A port. Enter the frequency of the clock source as the Reference frequency. Also, you can use the Execute button to measure the frequency of the connected clock source. This connects the external clock directly to the clock generator at 8.1 GHz to 16.2 GHz.
   - Clock Multiplier - To use the clock source as Clock Multiplier, you need to connect external clock source to the Ref Clk In port of the M8041A/ M8045A module and then specify the reference frequency. You can generate the specific frequency by choosing multiplier and divider value. Also, you can use the Execute button to measure the frequency of the connected clock source.
4. For Direct clock source, click Execute button to measure the incoming clock's clock rate.
5. Select a clock rate:
   - For Internal Clock Source, you can enter a clock rate in the Value and Units field.
   - For 10/100 MHz Ref Clock Source, the clock connected to the 10/100 MHz Ref In port must be 10/100 MHz.

The selected clock rate applies to the generator. This is also the clock rate generated at the generator's Clock Out port.
The analyzer internally receives its clock from the generator, it runs at the same clock rate.

External Clock Divider

The internal clock (i.e. the bitrate) is the external clock divided by the value specified in the clock divider field. The external clock divider field is available if you have close an external clock source.

External PLL Clock Divider and Multiplier

The internal clock (i.e. the bitrate) is the external PLL divided by the value specified in the divider field and multiplied with the value specified in the multiplier field. The external PLL clock divider and multiplier field are available if you have chosen a clock source.

Clock Rate Indicators

The Bit Rate indicators are shown in the Status Indicators display their current bit rate. The analyzer bit rate is measured from the incoming clock signal or derived from the data signal.
Trigger Output

The generator’s **Trigger Out** port can be used to send a trigger to external devices like an oscilloscope or digital communication analyzer.

In pattern mode, the generator sends a trigger signal that is at least 32 bits long.

In sequence mode, the generator can send a trigger signal whenever a block of the sequence starts or restarts.

Several options are available for the trigger signal. As an example, you can send the trigger as a divided clock signal or as an indicator when the data pattern starts.

### Setting Up Trigger Output

To set up the generator’s **Trigger Output** port:

1. Connect the external instrument to the **Trigger Out** port.
2. Go to **Menu Bar > Generator >** and then select **Trigger Out**.
3. Provide the necessary configuration.

The delay option in the **Trigger Out** functional block sets the delay of the trigger output. When it is set to 0 ps, this means there is no delay or the trigger output and data output are in sync. When it is set as 10 ps, this means the signal which will be received at trigger output port will have a delay of 10 ps.

You can always generate a divided clock signal at the **Trigger Out** port.

The alternate trigger signals refer to patterns and are not generated in sequence mode.

If SSC is enabled, then it also have impact on trigger output signal.

To support the generation of a trigger spike at the beginning of a sequence block, the **Trigger Output** can be put into **Sequence** mode.

**NOTE**

The jitter at **Trigger Out** is always the same as jitter at **Clock Out**. Since, there are no parameters available in the M8070A GUI to set jitter at **Trigger Out**, it can be set using **Clock Out** parameters.
Clock Divided by n

Select this option to send a trigger signal from the Trigger/Ref Clock Out port at every nth clock pulse. Note that the trigger signal itself consists of n/2 bits high followed by n/2 bits low. For example, Clock divided by 8 works as shown below.

![Diagram showing the clock divided by 8](image)

If the Divider Factor n is uneven (For example 3), the clock's duty cycle will not be 50%, but the signal will stay high for (n+1)/2 and low for (n-1)/2. This results in a Duty Cycle Distortion (DCD) of 0.5 UI.

**NOTE**

Sequence Trigger

This function becomes available after a user-defined sequence has been downloaded to the generator.

Click this function to switch the Trigger Out port to Sequence mode.

In Sequence mode, the Trigger Out can generate a spike whenever the execution of a block starts or restarts. Whether that happens for a particular block or not is defined for each block individually in the sequence expression.
FEC Error Insertion

The FEC error insertion feature will be supported by the upcoming M8070A software version 5.1 and above.

The FEC error insertion is independent from the error insertion controlled with the **FEC Error Insertion** functional block available in the **Parameters** window. Both error insertions can be used at the same time.

The FEC error insertion is a license feature and is support by M8070A software version 5.1 and above by installing a module specific FEC license. For details on FEC license, please refer to the **M8040A Licenses** on page 626.

FEC is enabled by selecting one of the FEC factory patterns.
- IEEE_802_3cd_RS_544_514_Scrambled_Idle
- IEEE_802_3cd_RS_544_514_Remote_Fault

To generate FEC for PAM4 on M8045A, follow the given steps using M8070A **Setup View** as illustrated in the following figure:
1. On the **Clock Generator** functional block, set the symbol rate between 16.208 GBd to 26.563 GBd. Please note that the FEC engine only supports 26.5625 GBd PAM4 signals.

2. On the **Data Out** functional block, set output levels. Make sure to turn ON the output levels.

3. On the **Line Coding** functional block select **PAM4**. Enable the PAM4 **Pre-Coder**. Enabling the pre-coder is optional and is only required if the DUT also have the pre-coder enabled.

4. Next step involves selecting the FEC pattern. To do this, click **Select Pattern** dialog. For more information on this dialog, refer to Select Pattern Dialog on page 390. Use this dialog to download FEC pattern on the **Data Out** locations as shown in the following figure:

Both channels of the M8045A generate the FEC encoded signal independently. When setting up the same sequence for both channels, both channels will generate the exactly same bit sequence.

5. The FEC pattern will be now available in the **Sequence Editor**. Infinitely loop the PRBS, FEC encoded scrambled idle and FEC remote fault patterns. Press the Break button to move the sequence to the next block. Refer to **Sequence Editor** on page 359 for details on how to create, loop and break sequences.
FEC patterns require a block length of 5440 and use either an infinite loop or counted loop. The loop count must be a multiple of 8. Due to the differences between FEC frame length and sequencer word width, there will be phases of invalid FEC data when transitioning from a FEC encoded sequence lock into a non-FEC sequence block and vice versa.

6 You can now insert the FEC error into the output data. It can be either pre-FEC error or post FEC error. Select **FEC Error Insertion** function block from the **Parameters** window.
You have the following options for inserting FEC errors into the output data stream:

- **State** - Enables/disables the continuous FEC error insertion. The inserted errors are after the FEC encoding.

- **Errors per Frame** - Specifies the number of symbols to be corrupted within a single FEC frame. The inserted errors are at random symbol positions. Each corrupted symbol will contain exactly one bit error at a random bit position.

- **Insert Single BIP Error** - Insert a single Bit Interleaved Parity (BIP) error. This is a pre-FEC error and can be inserted at any time, even if the FEF error insertion is disabled.

### FEC Remote Programming

The following SCPI commands can be used for FEC error insertion remote programming:

1. **Commands for selecting FEC patterns:**
   
   ```
   :DATA:SEQUence:SET 'M1.DataOut1',Memory,'factory:FEC/IEEE_802_3cd_RS_544_514_Scrambled_Idle'
   ```

2. **Commands for FEC error insertion:**
   
   a. Enable/disable symbol error insertion
      
      ```
      :DATA:FEC:EINsertion:STATe 'M1.DataOut1',<0|1|OFF|ON>
      ```
   
   b. Set the number of symbol errors per FEC frame
      
      ```
      :DATA:FEC:EINsertion:ERRors 'M1.DataOut1',<NR1>
      ```
   
   c. Insert a single BIP error
      
      ```
      ```

For further details on these SCPI commands, please refer to the M8000 Series Programming Guide.
Error Insertion

To test error correction algorithms, alarms and other functions that are embedded in the data pattern, you can insert logic errors (flipped bits) into the pattern.

For the error insertion, go to Menu Bar > Data Out and select Error Insertion function block from the Parameters window.

The instrument provides several options for inserting error bits manually or automatically. You have the following options for inserting errors into the output data stream:

Insert Single Bit Stream

To insert single bit stream:
- Click the slide switch to turn on the Error Insertion state.
- Select the supported mode from the drop-down list.
- Select the error ratio from the drop-down list.

Insert Single Bit Error

- To manually insert a single bit error into the output stream:
  - Click the Data Out port.
• Select **Error Insertion** functional block and enable the **Insert Single Bit Error** state.
• Click **Execute**.

**NOTE**

**TIP** - To find out how your DUT reacts on very small bit error rates, set up the pattern generator to enter errors once every $10^{-12}$ bits and run a longer accumulative test.

You can then find the DUT’s true error rate by calculating the difference between the bit error rate set up in the Generator and the accumulated bit error rate found by the Analyzer.

**NOTE**

If you set up too high an error rate, the Analyzer will not be able to synchronize to the incoming pattern. When setting up an error rate, always make sure that the synchronization threshold is higher than the bit error rate.
FEC Error Insertion

The FEC error insertion is independent from the error insertion controlled with the **FEC Error Insertion** functional block available in the **Parameters** window. Both error insertions can be used at the same time.

The FEC error insertion is a license feature and is support by M8070A software version 5.0 and above by installing a module specific FEC license. For details on FEC license, please refer to the **M8040A Licenses** on page 626.

FEC is enabled by selecting one of the FEC factory patterns.

- IEEE_802_3cd_RS_544_514_Scrambled_Idle
- IEEE_802_3cd_RS_544_514_Remote_Fault

To generate FEC for PAM4 on M8045A, follow the given steps using M8070A **Setup View** as illustrated in the following figure:
1. On the Clock Generator functional block, set the symbol rate between 16.208 GBd to 26.563 GBd. Please note that the FEC engine only supports 26.5625 GBd PAM4 signals.

2. On the Data Out functional block, set output levels. Make sure to turn ON the output levels.

3. On the Line Coding functional block select PAM4. Enable the PAM4 Pre-Coder. Enabling the pre-coder is optional and is only required if the DUT also have the pre-coder enabled.

4. Next step involves selecting the FEC pattern. To do this, click Select Pattern dialog. For more information on this dialog, refer to Select Pattern Dialog on page 390. Use this dialog to download FEC pattern on the Data Out locations as shown in the following figure:

Both channels of the M8045A generate the FEC encoded signal independently. When setting up the same sequence for both channels, both channels will generate the exactly same bit sequence.

5. The FEC pattern will be now available in the Sequence Editor. Infinitely loop the PRBS, FEC encoded scrambled idle and FEC remote fault patterns. Press the Break button to move the sequence to the next block. Refer to Sequence Editor on page 359 for details on how to create, loop and break sequences.
FEC patterns require a block length of 5440 and use either an infinite loop or counted loop. The loop count must be a multiple of 8. Due to the differences between FEC frame length and sequencer word width, there will be phases of invalid FEC data when transitioning from a FEC encoded sequence lock into a non-FEC sequence block and vice versa.

6 You can now insert the FEC error into the output data. It can be either pre-FEC error or post FEC error. Select **FEC Error Insertion** function block from the **Parameters** window.
You have the following options for inserting FEC errors into the output data stream:

- **State** - Enables/disables the continuous FEC error insertion. The inserted errors are after the FEC encoding.

- **Errors per Frame** - Specifies the number of symbols to be corrupted within a single FEC frame. The inserted errors are at random symbol positions. Each corrupted symbol will contain exactly one bit error at a random bit position.

- **Insert Single BIP Error** - Insert a single Bit Interleaved Parity (BIP) error. This is a pre-FEC error and can be inserted at any time, even if the FEF error insertion is disabled.

**FEC Remote Programming**

The following SCPI commands can be used for FEC error insertion remote programming:

1. **Commands for selecting FEC patterns:**
   
   a. DATA:SEQUence:SET 'M1.DataOut1',Memory,'factory:FEC/IEEE_802_3cd_RS_544_514_Scrambled_Idle'

   b. DATA:SEQUence:SET 'M1.DataOut1',Memory,'factory:FEC/IEEE_802_3cd_RS_544_514_Remote_Fault'

2. **Commands for FEC error insertion:**
   
   a. Enable/disable symbol error insertion

   :DATA:FEC:EINSertion:STATe 'M1.DataOut1',<0|1|OFF|ON>

   b. Set the number of symbol errors per FEC frame

   :DATA:FEC:EINSertion:ERRors 'M1.DataOut1',<NR1>

   c. Insert a single BIP error


For further details on these SCPI commands, please refer to the M8000 Series Programming Guide.
Interference

The M8020A/M8030A supports the following two types of interference:
- Common Mode Interference (CMI)
- Differential Mode Interference (DMI)

Common Mode Interference (CMI)

Common Mode Interference (asymmetrical mode) relates to ground (CMI). It has the following characteristics:
- **State**: Enables / disables common mode interference (CMI).
- **Amplitude**: Specifies the amplitude of the common mode interference (CMI).
- **Frequency Source**: Specifies the frequency source for common mode interference (CMI). It can be high frequency source or low frequency source.
Differential Mode Interference (DMI)

Differential Mode Interference (DMI) - Differential Mode Interference (symmetrical mode) is independent of ground (DMI). It has the following characteristics:

- **State**: Enables / disables differential mode interference (DMI).
- **Amplitude**: Specifies the amplitude of the differential mode interference (DMI).
- **Frequency Source**: Specifies the frequency source for differential mode interference (DMI). It can be high frequency source or low frequency source.
- **High Frequency**: Specifies the frequency of the high frequency source.
- **Low Frequency**: Specifies the frequency of the low frequency source.
Jitter Setup

The Jitter Setup function is used for composing the total jitter in a defined and calibrated way. The M8020A/M8030A/M8040A supports the following types of jitters:
- High Frequency Jitter (HF Jitter)
- Low Frequency Jitter (LF Jitter)

High Frequency Jitter (HF Jitter)

The High Frequency Jitter is a composition of the following types of jitters:
- Periodic Jitter 1
- Periodic Jitter 2
- Bounded Uncorrelated Jitter
- Random Jitter
- Spectrally Distributed Random Jitter
- External Jitter Source (Connected to the Delay Ctrl input)

Low Frequency Jitter (LF Jitter)

The Low Frequency Jitter is a composition of the following types of jitters:
- Residual Spread Spectrum Clock
- Periodic Jitter

Global Jitter State On/Off Switch

The Jitter On/Off switch allows you to globally enable or disable the jitter generation.
How to Enable Global Jitter State

You can enable the global jitter state by selecting the **Enable Impairments** check box, present on the status bar of the GUI.

![Enable Impairments](image)

Set Jitter Configuration

In this section, an example of **Periodic Jitter 1** is shown to specify the jitter components.

To specify the jitter components:

- **Set Unit**: Defines the unit of jitter amplitude value in either seconds or UI.
- **Set Delay**: Enter a value to define the jitter delay on clock and data.
- **Enable Jitter**: Enable the jitter source (press the corresponding button).
- **Set Parameters**: Set the most commonly used parameter (typically Amplitude and Frequency) directly.

![Jitter Configuration](image)

Spread Spectrum Clock

The **Spread Spectrum Clocking** setting controls the generator’s spread spectrum (SSC) clocking feature. When the SSC is enabled, it impacts the Data Out, Clock Out, and Trigger Out ports.
The spread spectrum clock is characterized by:
- Deviation
- Frequency
- Type
- Profile
- Shape

- **Deviation**
  If the deviation type **Center Spread** is selected, the deviation can be changed in two different ways:
  - **Change the Center Spread value**: the bit rate remains unchanged, while the upper and lower frequency changes according to the selected deviation. The deviation value specifies ½ p-p value.
  - **Change the Down Spread value**: the upper frequency remains unchanged, while the bit rate is adjusted. The deviation value specifies the p-p value.

For some setups, the I/Q modulator’s range limitations require to use Center Spread instead of Down Spread and adjust the bit rate (and deviation) accordingly.

If the upper or lower frequency is changed, the bit rate will be adjusted according to the selected deviation. The center frequency corresponds to the configured bit rate.
Please note that both the upper and lower frequency and the frequency adjustment of all three frequencies are not reflected in the firmware. The GUI just calculates the resulting bit rate and writes it to the firmware.

The **Deviation** of the clock rate. The ranges of SSC deviation are as follows:

- Down Spread with deviation of 0 ... 1 PPM
- Up Spread with deviation of 0 ... 1 PPM
- Center Spread with deviation of 0 ... 1 PPM
- Asymmetric allows to independently specify up and down deviation. When this is selected, the deviation is no longer specified in terms of peak-peak deviation, but independently for up and down deviation. The value ranges for the up deviation are 0 PPM to 1 PPM and for down deviation are -1 PPM to 0 PPM. The Asymmetric deviation type is only available in M8041A and M8046A modules.

![Image of deviation settings](image)

**NOTE**

The deviation in Upspread and Downspread is the p-p value while in Centerspread it is 1/2 p-p.

- **Frequency**: The deviation Frequency. The SCC provides the frequency range of 100 Hz – 200 kHz.
- **Type**: You can click the drop-down list to choose among Down Spread, Up Spread, Center Spread and Asymmetric deviation type.
- **Profile**: Controls the profile of the spread spectrum clocking. You can use the drop-down list to choose between the Triangular and Arbitrary profile.
- **Shape**: For Arbitrary profile, you need to specify the Arbitrary Waveform file. It is a simple text file that contains the data points which define the arbitrary waveform of the SSC profile.
Periodic Jitter 1

The **Periodic Jitter 1** is characterized by:
- Amplitude
- Frequency

- **Amplitude**: Controls the amplitude of periodic jitter 1.
- **Frequency**: Controls the frequency of the periodic jitter 1.

Periodic Jitter 2

The **Periodic Jitter 2** is characterized by:
- Amplitude
- Frequency

- **Amplitude**: Controls the amplitude of periodic jitter 2.
- **Frequency**: Controls the frequency of the periodic jitter 2.

Specify the Components for Jitter Sweep

The **Periodic Jitter 2** has the following modes:
- Constant Amplitude Sweep
- Variable Amplitude Sweep
To specify the components of jitter sweep select Jitter Sweep functional block from the Parameter window and then select the Mode from the drop-down list to specify components the jitter sweep.

**Periodic Jitter 2 – Constant Amplitude Sweep Parameters**

The Periodic Jitter 2 – Constant Amplitude Sweep is characterized by:

- Amplitude
- Frequency Range
- Sweep Time
- No. of Steps

- **Amplitude**: The maximum peak-to-peak Amplitude is limited by the free capacity of the chosen delay line.
- **Frequency Range**: The stop frequency has to be higher than start frequency and the range should be in accordance with the selected waveform.
• **Sweep Time**: You can specify the duration for sweeping the specified frequency range once.
• **No. of Steps**: You can specify the number of steps to fulfill a complete sweep. The start and stop values are included. The valid range is between 2 to 100.

**Periodic Jitter 2 – Variable Amplitude Sweep Parameters**

The **Periodic Jitter 2 – Variable Amplitude Sweep** is characterized by:
• Standard
• Sweep Time
• No. of Steps
• Step Distance

![Jitter Sweep](image)
• **Standard**: You can use this drop-down list to specify whether you want to select a pre-defined standard or a user-defined standard. All the available predefined standards will be shown in this list. However, if you select the user-defined standard, press **Custom Profile** button to locate the **Jitter Tolerance** standard. The user-defined standard uses the same file format like the **Jitter Tolerance Compliance** measurement.

**NOTE**

Selecting the Standard does allocate the required amount of jitter modulation on the delay line being used. To avoid errors when changing the selection, it is recommended to either select the corresponding bit rate first, or enable the PJ2 source after setting the correct bit rate.

• **Sweep Time**: You can specify the duration for sweeping the selected jitter profile/standard once.
• **No. of Steps**: You can specify the number of steps to fulfill a complete sweep. The start and stop values are included. The valid range is between 2 to 100.
• **Step Distance**: You can use this drop-down list to specify whether the frequency steps are log equidistant (EQUIdistant) along the periodic jitter curve or a frequency step matches a corner frequency on the periodic jitter curve.

**Bounded Uncorrelated Jitter**

**Bounded Uncorrelated Jitter** is characterized by

- Amplitude
- PRBS polynomial
- Data rate
- Filter type
5 Setting up Generator

- **Amplitude**: Controls the amplitude of the BUJ jitter source.
- **PRBS polynomial**: The PRBS polynomial can be chosen from a list. Available are eight polynomials, from $2^7-1$ up to $2^{31}-1$.
- **Data Rate**: Enter an appropriate Data Rate.
- **Filter Type**: The bounded uncorrelated jitter source is equipped with three low-pass filters with cut-off frequencies at 50, 100, and 200 MHz. One of these filters is always active.

**Random Jitter**

**Random Jitter** is characterized by:

- Amplitude
- Filter Settings
- **Amplitude**: The random jitter amplitude must be entered as an rms (root mean square) value.
- **Filter**: The random jitter source is equipped with a 10 MHz high pass and a 100 MHz and 500 MHz low pass filter to limit the spectral range.

**Spectrally Distributed Random Jitter**

*Spectrally Distributed Random Jitter* is composed of two jitter sources: low frequency jitter and high frequency jitter. It is characterized by the amplitudes of the low and the high frequency jitter.

*Spectrally Distributed Random Jitter* is characterized by
- **Amplitude LF**
- **Amplitude HF**

It has the following parameters:
- **sRJ State**: Click this switch to enable the spectrally distributed random jitter.
- **SRJ Amplitude 1 (RMS) LF**: This is the low frequency jitter amplitude as rms value.
- **SRJ Amplitude 2 (RMS) HF**: This is the high frequency jitter amplitude as rms value.
- **sRJ Low Pass Filter**: The spectrally distributed random jitter is equipped with a 100 MHz low pass filter to limit the spectral range, which can be enabled by pressing the corresponding switch.
Residual Spread Spectrum Clock

The Residual Spread Spectrum Clock (rSSC) is generated by modulating the clock that is used for data generation.

The Residual Spread Spectrum Clock is characterized by:
- rSSC Amplitude
- rSSC Frequency

![rSSC Parameters Table]

It has the following parameters:
- **rSSC State**: Click this button to enable/disable the Residual Spread Spectrum Clock.
- **rSSC Amplitude**: This is the amplitude of the rSSC jitter source.
- **rSSC Frequency**: This is the frequency of the rSSC jitter source.

External Jitter Source

To enable the external jitter source:
- From the Data Out port select HF Jitter functional block in the Parameters window.
- Click the External switch to enable external jitter.

![External Jitter Switch]

**NOTE**

Even if the external jitter source is enabled, you can still add or change internal jitter components.
6  Setting up Analyzer

Overview  / 310
M8020A/M8030A/M8040A Analyzer Ports  / 311
Clock Setup  / 318
Sampling Point Setup  / 323
Equalization  / 332
Pattern Synchronization  / 344
Bit Recovery Mode  / 352
Line Coding  / 354
Alignment Results  / 355
Overview

The M8020A/M8030A/M8040A Analyzer examines an incoming bit stream, compares it to the expected pattern, and locates any inconsistencies. The Analyzer requires the following settings to work correctly:

- **The expected pattern**
  The Analyzer needs to "know" which data to expect so that it can detect bit errors. No expected patterns are required in BRM mode.

- **Correct clock frequency**
  Required to recognize the bit rate in the data stream.

- **Appropriate sampling point**
  The sampling point defines where the Analyzer tries to differentiate between 0s and 1s in the data stream. This is necessary so that the Analyzer recognizes the data bits correctly.

- **Synchronization to the incoming pattern**
  The expected pattern must be synchronized to the incoming pattern so that the Analyzer can find any discrepancies.

The Analyzer provides the following functions to enable you to perform tests:

- **Automatic pattern synchronization**
  The Analyzer shifts the incoming data stream bitwise to match it to the expected data pattern. A correct BER can only be measured with matching patterns.

- **Error accumulation**
  You can specify whether a test runs for a specified time or until a specific number of errors has occurred. This lets you carry out longer tests while logging the results to a file.

- **BER location mode**
  You can specify whether all errors are counted or only the errors that occurred on a particular bit position or range of positions.

- **Trigger output for external measurement instruments**
  This allows you to connect other devices for further error analysis.

- **Data format**
  The M8040A (M8046A) analyzer has an enhanced capability over M8020A analyzer to analyze PAM4 data in addition to NRZ.
M8020A/M8030A/M8040A Analyzer Ports

The M8020A/M8030A/M8040A analyzer’s ports are used for running tests and for connecting external equipment.

The following figure shows the J-BERT M8041A analyzer’s ports.

![J-BERT M8041A Analyzer Ports](image)

The M8041A analyzer’s ports include the following:
- Data In and Data In
  This port is connected to the data signal and the inverted data signal.

The following figure shows the M8040A analyzer’s (M8046A) ports.

![M8040A Analyzer Ports](image)

The M8046A analyzer’s ports include the following:
- Data In and Data In
  This port is connected to the data signal and the inverted data signal.
- Clk In
  This is a clock input port to sample the incoming data. Supports full/half and quarter-rate clock. Single ended.
- Ctrl In A
  This port can be used as sequence trigger or pattern capture event.
- Ctrl Out A
  This port outputs a pulse in case of an error. It generates a pulse or static high/low if used from sequencer.
Setting up Analyzer

Data In Port Termination

To ensure a valid setup and to protect the devices from damage, proper termination must be specified for both Data In connections. You can specify the termination by entering the termination voltage in the respective field.

**CAUTION**

Selecting the wrong termination may damage your device.

Why Can Wrong Terminations Damage Your Device?

Choosing wrong terminations may cause your device to output voltage levels that are not as expected. It may also cause excessive current or current flow in the wrong direction, which can damage your device.

If you adjust the termination voltage, and try to enter value(s) which are outside of the currently allowed window, the Auto Correction Confirmation message box will pop up with respective apply and discard options as shown in the following figure:
Setting Up Termination

To select the termination for the Analyzer:

**NOTE**

You must know the termination voltage of the data signal that your DUT sends to the Analyzer.

1. Go to the **Menu Bar > Analyzer** and then select **Data In**.
2. Select **Comparator** functional block from the **Parameters** window.
3. In the **Termination Voltage** field, enter the termination voltage that is appropriate for the incoming data signal.

**CAUTION**

Selecting the wrong termination may damage your device.

4. In the **Polarity** field, select **Inverted** if your device inverts data.

You can now physically connect the DUT to the Analyzer.

**Compare Mode**

The selection in this list defines how the signals arriving at the **Data In** and **Data In** connectors are interpreted. The following options are available:

- **Differential**
  
  If differential mode is selected, both input ports need to receive a signal. The actual data signal is measured as the voltage difference between the two incoming signals.

- **SE-Normal (Single Ended - Normal)**
  
  In normal mode, only the **Data In** port receives the data signal, the **Data In** port is inactive.

- **SE-Complement (Single Ended - Complement)**
  
  In complement mode, only the **Data In** port receives the data signal, the **Data In** port is inactive.

- **Single-Ended**
  
  In the Single-Ended mode, the data stream is provided at either Normal input or Complement input. The other input is either left open or terminated with 50 Ohm.
The availability of the particular compare mode selection depends on the currently used hardware.

The following drawing is an example how the instrument internal circuitry looks like for different settings.

This figure is only true for M8041A and M8051A modules with serial numbers < DE55300500.

This figure shows what the analyzer represents as termination scheme to the DUT. The DUT would be connected to the connectors shown on the left part of the respective schemes above.

For the balanced settings the internal termination voltage of the analyzer is set to equal the Common Mode Voltage, which must be given by the user in the GUI.

VT = Termination Voltage

VC = Common Mode Voltage
The following figure shows a slightly modified figure for the analyzer part:
This figure is true for M8041A and M8051A modules with serial numbers >= DE55300500.

VT = Termination Voltage

This figure shows what the analyzer represents as termination scheme to the DUT. The DUT would be connected to the connectors shown on the left part of the respective schemes above.
Data Inverted

To activate data inverted function, select the Polarity as Inverted in the Comparator functional block of the Analyzer. This function is required if your device inverts data.

Threshold

Enter a Threshold value for applications that do not provide a continuous data stream at the input (for example, any application using bursts), because the averaged threshold voltage will drift from the correct level when there is no input.

PAM4 Decision Threshold

It is only available for PAM4 line coding. It controls the decision threshold of the PAM4 decoder within the data input's input window. The setting of the PAM4 decision thresholds always refers to the actual input voltage range.

The following 3 decision thresholds are applied:

<table>
<thead>
<tr>
<th>Threshold</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lower</td>
<td>Decides between symbol 0 and symbol 1.</td>
</tr>
<tr>
<td>Middle</td>
<td>Decides between symbol 1 and symbol 2.</td>
</tr>
<tr>
<td>Upper</td>
<td>Decides between symbol 2 and symbol 3.</td>
</tr>
</tbody>
</table>
Termination Voltage

In this field, enter the termination voltage that is appropriate for the incoming data signal. This selection should be made before the device is connected to the analyzer.

CAUTION

Selecting the wrong termination may damage your device.

The Data In port is connected to a 50 Ω load impedance (or termination) within the Analyzer. Data termination refers to the voltage level at the end of this load. The logic output from a device requires any connected equipment, including the Analyzer, to have a specific termination voltage.

Input Range

Before you can synchronize the Analyzer to the incoming data stream, you need to define the voltage range within which the eye is located.

Both the high and low level of the data signal must be within this range to find the eye.

NOTE

The input voltage range for M8020A and M8040A is 2V and 500 mV, respectively. When you modify either the high or low voltage, the other voltage is automatically adjusted.
Clock Setup

To measure the **Bit Error Rate** with the **Analyzer**, the bit rate of the data stream must be known. Depending on the options the instrument is delivered with, you could use either an external clock source for the Analyzer (for example, the clock from the generator), or extract the clock signal from the incoming data (CDR mode).

CDR mode does not work for all kinds of data patterns. For example, if the device under test sends only blocks of ones and zeros, there are no transitions in the data stream and the M8020A/M8030A cannot recover the clock.

Also, if you are testing bursts, there are some special considerations for setting up CDR.

**How does Clock Data Recovery Work?**

In CDR mode, the CDR has to recover the clock from the incoming data. To do this, the hardware has to decide whether the voltage at the input connector is a logical '1' or '0' and then recover the clock from the detected transitions.

Clock Data Recovery (CDR) is a special kind of Phase Locked Loop (PLL), which recovers clock signal of a data stream. It is a regulatory loop, which synchronizes the local oscillator with an external reference, in this case the incoming data stream.

**Phase Locked Loop**

A PLL has three parts: a phase detector, a loop filter, and a Voltage Controlled Oscillator (VCO). The phase detector has two inputs, and one output, which is proportional to the phase difference of the inputs. The loop filter is a low pass filter which attenuates the higher frequencies from the output of the phase detector. The VCO is an adjustable oscillator which changes the output frequency depending on its input voltage. The diagram below shows a simple PLL.
One of the most important characteristics of a PLL is its loop transfer function. The loop bandwidth is defined as the integrated magnitude of the PLL's frequency transfer function over the entire frequency spectrum. The loop bandwidth describes how the regulatory loop tracks the VCO to a sine wave FM modulated input signal. Above the bandwidth the loop cannot track such a modulation completely, and thus, the response to the modulation is attenuated.

The other loop parameter is peaking. This describes how much a modulation is exaggerated (mostly close to the loop bandwidth).

Transition Density

The transition density is defined by the number of transitions in the incoming data divided by the total number of bits transmitted. In this field enter the transition density in (%).

This parameter affects the loop bandwidth, and thus must be entered correctly. Some standards specify the loop bandwidth for a given transition density. In such a case enter the value given in the specification, so that the CDR behaves according to the standard. If a standard from the preset list is selected, this field is also preset.

Loop Bandwidth

This is the range of the CDR loop bandwidth. In this field the user should enter the loop bandwidth value; the range is within 313 kHz to 20 MHz.

When the M8020A/M8030A Analyzer is used to characterize a data stream instead of a receiver, the loop parameters should be set according to the used standard.

If the CDR is used to recover the bit stream from a receiver to be characterized due to a lack of a clock output, choose the loop bandwidth significantly higher than the receiver's bandwidth. To characterize a DUT's
CDR it is the best practice to use its recovered clock output instead of the M8020A/M8030A's built in CDR. Choose a low loop bandwidth to measure the jitter on an incoming data stream as the CDR will track the incoming jitter up to the loop bandwidth and thus make it invisible to the Analyzer.

**CDR Spread Spectrum Clocking**

This control is used to adapt the CDR to an input bit stream with SSC.

Enabling SSC state widens the loss of lock detection window, and sets the peaking to optimum SSC performance. Enter the **Expected Deviation** and the type of deviation (**Up-Spread**, **Down-Spread** or **Center-Spread**) to set the locking window to an optimum.

SSC is mostly used **Down-Spread** which means, the clock signal is modulated to a lower frequency and back. Thus the average frequency is lowered by half of the maximum deviation. The CDR is adapted to that value. Enter the maximum deviation as specified in the standard.

**CDR Setup in M8020A/M8030A**

The M8020A/M8030A has an internal CDR. Follow the given steps to perform a **CDR Setup**:

1. Go to the **Menu Bar** > **Analyzer** and then select **Data In**.
2. Select **CDR** functional block from the **Parameters** window. The following parameters will appear:

![CDR Parameter Window](image)

3. Click **CDR State** switch to turn on the CDR state.
4. Specify the CDR parameters setting. For details on CDR parameters, refer to **M8020A/M8030A CDR Parameters** on page 321.
M8020A/M8030A CDR Parameters

The M8020A/M8030A has the following parameters:

- **Control**: You can specify whether the CDR is controlled by the pattern sequence or if it is manually enabled or disabled.
- **CDR State**: It enables or disables the CDR state.
- **Transition Density**: It affects the loop parameters, and it must be either entered, or measured. Some standards define a loop bandwidth for a specific transition density.
- **Loop Order**: The data stream contains multiple frequencies, and the CDR needs to know the expected data rate. You can choose between 2 types of CDR: 1st order and 2nd order.
- **Loop Bandwidth**: It is the input parameter to set the characteristics of the loop.
- **Peaking**: Additionally, you can set the value for peaking in the provided field. It defines the second order CDR characteristics by defining a peaking value which is valid for jitter transfer function. The peaking parameter is only available for the second Loop Order.

CDR Setup for M8040A

The M8040A system does not have an internal CDR so the N1076A/77A can be assigned to an M8046A error detector to be used as an external clock recovery. In this case, M8046A will ensure that certain critical parameters are automatically kept in sync between M8046A and N1076A/77A. To use the N1076A/77A from within M8070A, the FlexDCA N1000-Series System Software has to be started and fully running before starting M8070A. Once all these instruments are connected, start the M8070A software. For details on connections and how to access N1076A/77A from within M8070A, refer to Controlling N1076A/77A from M8070A on page 226.

Follow the given steps to perform a CDR Setup:

1. Go to the **Menu Bar > Analyzer** and then select **Data In**.
2. Select **Clock** functional block from the **Parameters** window. The following parameters will appear:
3 Select ‘Ext. Clock Recovery’ as Clock Source of M8046A.
4 Choose one of the available external clock recoveries under “External Clock Recovery”.

For further details, refer to section *Controlling N1076A/77A from M8070A* on page 226.
Sampling Point Setup

This section provides basic information on the sampling point setup.

How Does the Sampling Point Setup Work?

The sampling point of a data signal is defined by two values: a point in time and a voltage level. Each bit of the data signal is sampled at this point in time and in reference to this voltage level. The point in time (in reference to the clock signal) is referred to as the data input delay, and the voltage level is referred to as the threshold.

The location of the sampling point is the decision factor as to whether the incoming bits are identified as logic 0’s or 1’s. To measure the accurate bit error ratio at the input port, false readings of logic 0’s or 1’s must be avoided. Therefore, the sampling point must be set to the optimum location within the data eye.

The functions within the Sampling Point Setup window allow you to:

- Prepare the Analyzer for the incoming data signal regarding the connector termination.
- Adjust the location of the sampling point.

For details on Sampling Point Setup window, see Sampling Point Setup Window on page 326.

Auto Alignment

Use this option to automatically set the optimum sampling point.

To perform the Auto Alignment:

1. Go to the Menu Bar > Analyzer and then select Data In.
2. Select Analyzer function block from the Parameters window.
3. Specify Alignment BER Threshold form the provided list.
4. Click Execute button for the align sample delay and decision threshold voltage to the received data.
5 Alternatively, you can click on Alignment BER Threshold button present on the Status Indicator to start BER threshold auto alignment.

This routine will not stop if the optimum sampling point cannot be found. If no optimum sampling point is found after a reasonable time, you can click Abort.

The following settings may affect the result of the auto align function:
- Polarity (Data Inverted)
- Threshold (BER Threshold)

**NOTE**

When the line coding “PAM4” is selected for the loopback mode, it is recommended to adjust the pattern generator data output de-emphasis for the post cursor for error free operation (e.g. +0.05 at 25 Gbaud).

Threshold Center Alignment

To perform the Threshold Center Alignment:

1. Go to the Menu Bar > Analyzer and then select Data In.
2. Select Comparator function block from the Parameters window.
3. Specify the Threshold and then click Execute button for the threshold center alignment.

The threshold center alignment starts an auto-search function that sets the threshold to the optimum point of the incoming data eye on the vertical voltage axis without changing the data input delay. This function can be used for determining the optimum threshold for asymmetric data eyes, or for patterns with an unequal mark density.

**NOTE**

This function uses the alignment BER Threshold to determine the top and bottom eye edges.
Delay Center Alignment

To perform the Delay Center Alignment:
1. Go to the Menu Bar > Analyzer and then select Data In.
2. Select Input Timings function block from the Parameters window.
3. Specify the Delay and then click the Execute button to align the sample delay to the received data.

This button starts an auto-search function that aligns the data signal with the clock signal so that the Analyzer samples at the optimum point of the data eye in the time axis. This automatically compensates for delays in the clock/data paths, preventing unnecessary errors. The decision threshold is not changed.

NOTE
Ensure that the received clock frequency is stable before using Data Center.

NOTE
The clock/data alignment process time is pattern dependent, and with some large user patterns the alignment can take several minutes. If you encounter such a long time with a user pattern, it may be possible to first perform clock/data alignment on a pure PRBS pattern. This generally does not affect alignment accuracy, and can minimize measurement time.

This tip does not apply in cases of severe pattern dependent jitter or with devices that do not work with PRBS patterns.

NOTE
This function uses the alignment BER threshold to determine the left and right eye edges.
Canceling Auto Align

Click this button to cancel the **Auto Align**, **Threshold Center**, or **Data Center** functions while they are in progress. The following parameters will be returned to their previous value or status:

- **Auto Align Canceled**
  - Data Delay and Threshold values returned to previous.
- **Threshold Center Canceled**
  - Threshold value returned to previous.
- **Data Center Canceled**
  - Data Delay value returned to previous.

Alignment BER Threshold

In this list, select an alignment BER threshold that is appropriate for your application.

The alignment BER threshold is the pre-defined threshold used by the **Auto Align**, **Threshold Center**, and **Data Center** functions to define the edges of the data input eye in the time and voltage axes. You may wish to change the threshold for the following reasons:

- Choosing smaller alignment BER thresholds will cause the auto-search functions to set more accurate sampling points. However, if the BER threshold is set lower than the residual BER of the measurement, the auto-search functions will fail. 1E-9 is the smallest BER threshold available.

Sampling Point Setup Window

The **Sampling Point Setup** window allows you view and then manually adjust the location of the sampling point.

It can be accessed though the **Menu Bar**. Go to **Menu Bar** and then click **Analyzer > Sampling Point Setup**. However, if you are in the **Setup View** window, you can click on the **Manual Alignment...** button to open the **Sampling Point Setup** window.

The following figure shows the sampling point setup window for M8020A system (M8041A and M8051A):
The vertical axis represents the threshold voltage value and the horizontal axis represents delay which can be used to manually adjusted the location of sampling point.

For M8040A system (M8045A and M8046A), the Sampling Point Setup window display histograms which represents number of times a signal has achieved a particular threshold. For PAM4 line coding, the Sampling Point Setup window shows three vertical voltage axis which represents Upper, Middle and Lower threshold value which can be used to manually adjusted the location of sampling point. For NRZ line coding, the Sampling Point Setup window shows two vertical voltage axis which represents Upper and Lower threshold value which can be used to manually adjusted the location of sampling point.

The following figure shows the Sampling Point Setup window displaying histograms and vertical voltage axis for PAM4 line coding:
The GUI elements provided in the Sampling Point Setup window user interface depends on the type of selected analyzer channel. The following table describes the elements provided by the Sampling Point Setup window:

<table>
<thead>
<tr>
<th>GUI Elements</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Channel</td>
<td></td>
<td>Use this drop-down list to specify the Analyzer's channel on which sampling should be done.</td>
</tr>
<tr>
<td>Auto Align</td>
<td></td>
<td>Click this button to automatically set the optimum sampling point. This routine will not stop if the optimum sampling point is not found.</td>
</tr>
<tr>
<td>Align Threshold</td>
<td></td>
<td>Click this button to start an auto-search function that sets the threshold to the optimum point of the incoming data eye on the vertical voltage axis without changing the data input delay.</td>
</tr>
</tbody>
</table>
Align Data

Click this button to start an auto-search function that aligns the data signal with the clock signal so that the error detector samples at the optimum point of the data eye in the time axis. This automatically compensates for delays in the clock/data paths, preventing unnecessary errors.

Reset Sampling Point

Click this button to return the Threshold and Data Delay to the values measured during the last auto alignment.

Pattern Sync

Click this button to manually initiate the pattern synchronization. This is recommended whenever you did changes to the pattern setup, the voltage levels or the hardware connections (for example, altered cable lengths). Pattern synchronization is not required if it is selected as “Automatic” in the Analyzer functional block.

Automatic Re-Sync / Manual Re-Sync

Use this drop-down list to choose whether you want and automatic or manual synchronization.

- **Automatic Re-Sync** - With this option selected, the error detector constantly tries to synchronize the patterns when the BER threshold is exceeded.
- **Manual Re-Sync** - Manual synchronization can be selected, for example, if the signal delay is very unstable, and you want to avoid that the re-synchronization process affects the measurement results. In Manual synchronization mode use the Pattern Sync button to start the pattern synchronization.

Auto Refresh

Use this toggle button to automatically refresh the histogram.

Accumulate

Use this toggle button to accumulate histogram for the specified time (in seconds). Use the up and down arrows to specify the time.

Parameters Window

While you can manually adjust the voltage, delay values by moving the sampling point, the same can also be done through the Parameters window and vice versa. Similarly, you can also use the Parameters window to execute functions such as Auto Align, Align Threshold, Align Data and Pattern Sync.
How to Set the Sampling Point Automatically

In most cases, you will set up the sampling point automatically. Even if you wish to make some manual adjustments, it is recommended to start with automatically aligning the sampling point. For automatically aligning, press the **Auto Align** button. It will automatically set the optimum sampling point as shown in the following figure:

![Sampling Point Setup](image)

For the PAM4 line coding in M8046A analyzer, it will automatically set the optimum sampling point as shown in the following figure:
How to Adjust the Sampling Point Manually

For manual adjustments, select the vertical voltage axis and move the sampling point vertically towards other location at the selected delay. The same can also be done by changing the Threshold value in the Parameter window. The Sample Point on the sampling diagram moves vertically as you change the value.

In case of PAM4 line coding in M8046A analyzer, there are three vertical voltage axis which represents Upper, Middle and Lower threshold value. You can move the sampling point vertically towards the other location at the selected delay.

The same can also be done by changing the Upper, Middle and Lower threshold value in the Parameter window.

Similarly, select the horizontal axis and move the sampling point horizontally towards the other location at the selected voltage. The same can also be done by changing the Delay value in the Parameter window. The Sample Point in the sampling diagram moves horizontally as you change the value.
Equalization

Equalization is used to correct for the problems caused by the transmission channel. Equalization techniques provide a way to discern the original signal (the signal coming out of the transmitter) given a distorted signal at the receiver.

In other words, equalization corrects for the high-frequency component voltage levels and, in the process, corrects the trajectories of these components in the corresponding eye diagram (that is, opens up the eye).

The M8070A software provides integrated and adjustable equalization capabilities to compensate the loss characteristic in an incoming signal.

Equalization in M8041A/M8051A Data In

The M8041A/M8051A Data In provides pre-defined equalization presets on incoming signals for specific applications e.g. PCIe, USB. The calibration of the equalization is only valid for these specific applications.

Follow the given steps to perform equalization in the M8041A/M8051A Data In:

1. Go to Menu Bar > Analyzer and then select Data In.
2. Select Input Timing functional block from the Parameters window.
3. Select the Equalization presets form the provided drop-down list.

The M8041A-0A3 or M8051A-0A3 license is required to enable the equalization feature in M8041A Data In or M8051A Data In, respectively.
Equalization in M8062A Data In

The M8062A Data In provides pre-defined equalization presets on incoming signals for the data rates above 20 Gb/s.

**NOTE**

The Equalization option in the M8062A user interface will be enabled for the data rates above 20 Gb/s.

Follow the given steps to perform equalization in the M8062A Data In:

1. Go to **Menu Bar > Analyzer** and then select **Data In**.
2. Select **Input Timing** functional block from the **Parameters** window.
3. Select the Equalization preset from the provided drop-down list. The available equalization presets are Low, Medium or High.

**NOTE**

The M8062A-0A3 license is required to enable the equalization feature in M8062A Data In.
Equalization in M8046A Data In

The M8046A provides integrated and adjustable equalization capabilities on the data input to compensate for the loss characteristic of the back channel. Equalization can be adjusted from no equalization (0) to maximum equalization (120) in equidistant steps. This feature is available for NRZ and PAM4 signals and requires M8070A software 4.0 or higher.

The equalization is always automatically compensating the required reference cables (M8046A-802 or N4910A). This applies also when an external clock recovery N1076A or N1077A is used for the recommended pick-off and reference cables. It is mandatory to use the specified cables and pickoffs. Keysight recommends to use the reference cables (refer to M8040A data sheet) because other cables will lead to over/or under-compensation of the input signal.
The M8046A Error Detector provides 120 pre-defined equalization levels for NRZ signals and 55 equalization levels for PAM4 signals. These equalization levels can be adjusted on the data input to compensate for the loss characteristic of the back channel. Specifications on these equalization levels can also be found in M8040A data sheet.

**NOTE**

After changing the equalization level, it is required to re-adjust the threshold voltages again, or use the auto-alignment to re-optimize the sample point setting.
Performing equalization in the M8046A Error Detector

Follow the given steps to perform equalization in the M8046A Error Detector module:

1. Go to Menu Bar > Analyzer and then select Data Input.
2. Select the Equalization parameters from the Parameters window.
3. Specify the Equalization from a range of 0 (off) to 120 (max) pre-defined levels.

Manual optimization of the equalization level

The sampling point setup is showing histogram data of the received signal for an M8046A error detector. This can be used to determine the required equalization level.

1. Go to Menu Bar > Analyzer and then select Sampling Point Setup.
2. Click on the **Parameters** tab on the right side of the graph. Ensure that the parameters remain visible by clicking the pin at the top right corner.

3. Start with the maximum Input range of 500 mV. This ensures that the received signal will not get clipped in the input stage.
4. Click the sample delay marker, and keep the left mouse button held down, while dragging the marker to a position that is supposed to be between the transitions of the signal. Alternatively change the sample delay setting in the parameter editor.

This does not have to be perfect, the goal is just not to sample at the signal transitions.
5 Adjust the input range so that the signal is using around 90 to 95 percent of the input voltage window.
6 Increase the equalization level while observing the histogram. Find the equalization level that opens the eye. This may require re-adjusting the sample delay marker.
7. After manually optimizing the sample delay.

8. It may be required to iterate steps 6 and 7.
9   Finally, click the auto-alignment button.
10 In this example the received signal is a PAM4 signal with a peak amplitude of 150 mV and completely closed eyes. The auto alignment reports eye heights of 10 mV, 9 mV and 13 mV in the logger (Utilities > Logger) for an alignment BER threshold of 1e-9. At the end of the auto alignment, the sampling point setup will draw a schematic eye diagram that gives an indication of the eye opening at the configured alignment BER threshold.

The above figure shows the calculated threshold values and the black area at the sampling point shows the total eye opening achieved after applying equalization.

**NOTE**

The alignment BER threshold defines the BER level that is used by the auto-alignments to determine the inner eye opening as shown in the sampling point setup. The inner eye opening at the alignment BER threshold is used to calculate the optimum sample delay and threshold voltages. Lower values result in a more precise sampling point, especially when the eye opening is small.
Pattern Synchronization

The M8020A/M8030A/M8040A calculates bit error rates by comparing the received data with the expected data patterns. To do this, it needs to know where the start of the pattern is located in the data stream.

Introduction to Pattern Synchronization

Pattern synchronization (sync) refers to aligning the incoming data pattern with the internal reference pattern.

Hardware-Generated Patterns

For 2^n-1 PRBS patterns, bits from the incoming data pattern "seed" the Analyzer's Generator, causing it to generate a precisely aligned internal reference pattern.

Memory-Based Patterns

For software-generated and user patterns, a 48-bit pattern from the pattern is used as a detect word. Optimally, this detect word should be unique within the entire pattern. The Analyzer searches for this detect word within the incoming data stream, and uses the point in the data stream as a reference, and compares all following bits with the pattern. If the measured BER is better than the synchronization BER, the Analyzer will be synchronized.

There are thus three possible outcomes for a synchronization:

- Single instance of the detect word in the data stream
- Multiple instances of the detect word with correct synchronization.

- Multiple instances of the detect word with false synchronization.
If the Analyzer attempts to synchronize on the incorrect detect word, the BER will be unacceptably high, and, if automatic synchronization is selected, the Analyzer attempts another re-sync.

The detect word on which the Analyzer attempts to re-sync is chosen strictly by chance. So if there are two instances of the detect word in the pattern, the Analyzer has a 50% chance of selecting the correct one.

The more instances of the detect word exist in the pattern, the higher are the chances for incorrect synchronization. The software attempts in any case to identify a 48-bit pattern that occurs as seldom as possible in the pattern. For very large patterns, this can unfortunately take a very long time, and the software ends the search if it expects that it would take longer to find an adequate detect word than it would to attempt to synchronize. If the search for a detect word is ended, the most unique detect word identified is used.

Patterns must always be synchronized in order to do accurate BER testing. If patterns are out of alignment by just one bit, errors can be as high as 50% (5E-1) for PRBS patterns, and 100% (1E+0) for custom patterns.
By default, the Analyzer is in automatic sync mode with a sync threshold of 1E-3. This setting is recommended for most applications, and usually allows the synchronization function to be "transparent", requiring no attention. However, for special applications, changes can be made to the sync mode and sync threshold.

What Type of Synchronization Should You Use?

The type of synchronization you use affects how errors are measured and displayed. A Sync Loss is recognized when the BER is greater than the sync threshold. This can be caused by a high error rate, pattern misalignment, or clock loss. Choose the sync mode setting that is appropriate for the type of errors you anticipate.

- Automatic Sync with a sync threshold BER of 1E-3 is recommended for most applications.
  
  With this mode selected, the synchronization algorithm starts whenever the BER exceeds the threshold. However, it is not possible to make accurate BER measurements higher than the sync threshold.

- Manual sync can be used for synchronizing once, confirming proper pattern alignment, and then measuring BERs higher than the sync threshold. This is useful for the following applications:
  
  - To monitor the integrity of clock signals. You may wish to measure BERs that exceed the sync threshold to confirm clock slip.
  
  - To collect data for constructing eye contour information. You may wish to move the sampling point to locations in the data eye that have BERs exceeding the sync threshold.

  This mode doesn’t allow the analyzer to automatically synchronize if the BER becomes greater than the sync threshold. For example, the analyzer will not re-synchronize after momentary clock loss.

  **NOTE**

  Adjusting the data input delay may cause momentary clock loss. If you select Manual Sync mode, this may also result in sync loss.

- Burst sync mode is a special operating mode for measuring data in bursts of bits, rather than one continuous stream of bits.
What is False Synchronization?

For patterns other than PRBS, the Analyzer may gain sync at a point in the pattern that meets the sync threshold, but is not the correct point where the internal reference pattern and the received data pattern match. This is called false synchronization.

NOTE

If the Analyzer is in Manual Sync mode, it is recommended that you keep an eye on the Sync Loss indicator, present on the Status Indicator. There are various actions that can lead to loss of synchronization. Check the sync loss every time you make changes to the instrument.

False synchronization cannot occur with PRBS patterns because a 1 bit misalignment would cause a measurement of 50% or more errors. Thus, the BER during a misalignment would always be greater than the sync threshold BER.

For example, consider a pattern of 1000 ones and 1000 zeros as shown in the following figure. With reference alignment 1 the patterns are totally out of phase and the Analyzer is measuring 100% errors.

But as the reference moves closer to optimum alignment, the percentage of errors gradually approaches zero (reference alignment 2 and 3). For exact alignment, the sync threshold must be set lower than the BER caused by a 1 bit misalignment, in this case 1E-3.
How Can You Tell if Your Synchronization is False?

You may suspect false synchronization under the following conditions:

- You are using a pattern other than PRBS and the Analyzer gains sync, but it measures a constant, fixed error ratio.
- You are using a pattern other than PRBS and the Analyzer gains sync, but auto-search functions (Auto Align, Clock/Data Center, Threshold Center) repeatedly fail.

In a false sync, the sync threshold BER of 1E-3 may be met, but eye edges at BER 1E-3 (required by an auto-search function) may not be found. This is because BERs less than 1E-3 do not exist within the data eye.
If you suspect a false sync, try re-synchronizing at a sync threshold BER lower than the fixed error ratio. If sync is acquired without the problems listed above, then your previous sync was false. Your current sync should be on an exact pattern alignment.
How to Synchronize an Incoming Pattern

To synchronize the incoming pattern to the expected pattern:

1. Go to the **Menu Bar** > **Analyzer** and then select **Data In**.
2. Select the **Analyzer** function block from the **Parameters** window.
3. Select **Re-Sync**. The choices are **Automatic** or **Manual**.
   - Automatic Sync
     When this option is selected, the **Analyzer** constantly tries to synchronize the patterns when the BER threshold is exceeded.
   - Manual
     Manual synchronization can be selected, for example, if the signal delay is very unstable, and you want to avoid that, the resynchronization process affects the measurement results.

**NOTE**
While auto-search functions are in progress, the sync threshold BER is changed to the same value as the alignment BER threshold. If you are using these functions and want to consistently re-synchronize at a lower sync threshold, you must set the alignment BER threshold to the same value as the sync threshold BER.
Bit Recovery Mode

Understanding Bit Recovery Mode (BRM)

Traditionally, bit error rate testing compares the bits from a Device Under Test (DUT) against a reference data set, called the expected data. The user of Bit Error Ratio Tester (BERT) has to provide this expected data and load it into the M8020A/M8030A.

The M8020A/M8030A system then samples the incoming data signal with a sampling point that can be varied over time and voltage, to measure the BER. The M8070A system software is capable of creating graphics, such as the eye opening, from the information gathered during sampling. A compare circuit counts the differences between the bits of the incoming data stream and the expected data.

Now there is a mode that removes the need for the user to provide expected data, while still allowing one and two-dimensional measurements, such as the eye opening.

This is the Bit Recovery Mode (BRM).

This has two benefits:
- the user does not need to worry about the expected bits, which makes a setup easier and faster.
- the M8020A/M8030A system can measure non-deterministic data streams. This means it is no longer necessary to force a device into a specific test mode.

Bit recovery mode uses a second sampling circuit in the M8020A/M8030A analyzer to always sample at the sweet spot of the eye (typically at 50% of eye opening in time and voltage). The sampled data from this second sampling circuit acts as a reference and is passed to the compare circuitry, instead of the expected data.

This means the BER is now a relative figure. Taking the bit from the sweet spot of the eye cannot verify if this bit is correct in itself, it can just use it as a reference for any bit sampled in the border area of the eye. Bit recovery mode makes one and two-dimensional sweeps possible to sample in the border area of the eye and find out how the BER value increases. From this

NOTE

The M8040A analyzer (M8046A) does not support bit recovery mode.
we can derive the random and deterministic ($R_j$ and $D_j$) characteristics.

We can also take the eye opening with a known, deterministic test pattern and compare it with operational data, where a device idles or provides scrambled data, or there are asynchronous events like hand-shake signals.

The Bit Recovery mode also has a limitation that it requires a minimum eye opening: an eye that is too narrow cannot be processed. Care also needs to be taken if there is a good eye opening but there is a finite BER inside the eye.

## Setting up Bit Recovery Mode

To set up the Bit Recovery Mode mode:

1. Go to the Menu Bar > Analyzer and then select Data Input or if you are in Module View, then click on Data In location.
2. Select Analyzer functional block from the Parameters window.
3. Click Bit Recovery Mode switch to turn on the Bit Recovery Mode.

Once the Bit Recovery Mode is enabled, the BRM indicator on the Status Indicator turns green. See Status Indicators Window on page 111.

BRM can be used with all measurements supported by M8070A system software.
Line Coding

You can define the line coding for a Data In port of the M8046A module through the Parameters window.

To set the line coding:
1. Go to the Menu Bar > Generator and then select Data In.
2. Select Line Coding functional block from the Parameters pane.
3. Select the line coding. The Data In port supports NRZ and PAM4 line coding which defines how consecutive data bits are mapped to symbols.

The PAM4 line coding provides the following symbol mapping options:
- **Uncoded** - In this mapping, the bit sequence 00 maps to symbol 0, 01 maps to symbol 1, 10 maps to symbol 2 and 11 maps to symbol 3.
- **Gray Coded** - In this mapping, the bit sequence 00 maps to symbol 0, 00 maps to symbol 0, 01 maps to symbol 1, 11 maps to symbol 2 and 10 maps to symbol 3.
- **Custom** - In this mapping the consecutive data bits are mapped to symbols. The mapping is defined as a comma separated list of bit sequences (e.g. 00, 01, 11, 10). The position within this list corresponds to the symbol level. First value is for Symbol 0 and the last value is for Symbol 3.
Alignment Results

The alignment results are the output of auto alignment. These results are displayed on pressing the auto-alignment button.

The following alignment results are available for NRZ coding:
- **Eye Width** - Width of the eye opening
- **Delay** - Optimum sample delay
- **Input Range** - Input voltage range
- **Threshold** - Optimum threshold voltage
- **Polarity** - Data polarity used for pattern synchronization

The following figure illustrates alignment results for NRZ coding:

![Alignment Results Table](attachment:image.png)

The following alignment results are available for PAM4 coding:
- **Eye Width** - Width of the eye opening
- **Delay** - Optimum sample delay
- **Input Range** - Input voltage range
- **Upper Threshold** - Upper PAM4 decision threshold
- **Middle Threshold** - Middle PAM4 decision threshold
- **Lower Threshold** - Lower PAM4 decision threshold
- **Polarity** - Data polarity used for pattern synchronization
The following figure illustrates alignment results for PAM4 coding:
7 Setting up Patterns

Pattern Overview / 358
Sequence Editor / 359
User-Defined Sequences / 389
Application Specific Patterns / 393
Pattern Editor / 395
Pattern Capture / 428
Interactive Link Training / 435
Using M8062A Data Out Squelch Feature / 455
Pattern Overview

The purpose of data patterns is to simulate the type of data that your device might receive in the real world. Different patterns present different data loads to your instrument, which can cause variations in the bit error ratio. A bit pattern is sent from the generator to your device. At the same time, the expected output pattern of your device is internally generated in the analyzer (to provide a reference).

The M8041A and M8051A modules support 2 Gb pattern memory per channel (requires M8070A software 1.5 or above).

The M8045A and M8046A modules support 2 Gb pattern memory per channel (requires M8070A software 3.7 or above)

Selecting a pattern is the first step in setting up a BER measurement. The M8020A/M8030A provides various patterns to fulfill most standard testing needs. The M8020A/M8030A modules support the following types of patterns:

- PRBS
- Pulse
- Clock
- Static
- Memory Patterns

The M8040A modules support the following types of patterns:

- PRBS (supports all except for 2^7-1 on analyzer)
- Pulse (supports for NRZ, doesn't support for PAM4)
- Clock (supports for NRZ, doesn't support for PAM4)
- Static
- Memory Patterns

Patterns consist of a sequence of symbols. A symbol can have the following type of coding:

- Binary (Bit)
- 8B/10B
- 128B/130B
- 128B/132B
Sequence Editor

Overview

The sequence editor allows you to create and maintain sequences. In addition to this, it also allows you to edit the memory patterns.

A sequence consists of up to 500 blocks that can be looped. Single or multiple blocks can be looped. The sum of the blocks and the counted loops must not exceed 500. An overall loop restarts the sequence after it has come to its end.

You can also upload predefined sequences for PCIe, USB and SATA using the Recall Setting dialog. For details, refer to Recall/Save Instrument State on page 122.

When to Use a Sequence

You may wish to test a device that uses a certain protocol for processing data.

For example, the device might expect synchronization data, a preamble, payload data, and a suffix.

All this can be provided by a user-defined sequence.

How a Sequence is Defined

The sequence is defined by a SequenceExpression which is formulated in its own language, checked by the Sequence Editor.

The SequenceExpression specifies:

- the sequence start (and break) conditions
- the blocks, their contents, and trigger output
- the loops
How to Launch a Sequence Editor

To launch the **Sequence Editor**:

- Go to the **Menu Bar > Patterns** and then select **Sequence Editor**.

The **Sequence Editor** will appear as shown in the following figure:

![Sequence Editor UI](image)

The **Sequence Editor** user interface includes the following elements:

- Toolbar
- Sequence Control Pane
- Sequence Settings Window
- Pattern Edit Pane

These GUI elements are described in the section that follows.
The toolbar provides the following convenient sequence editing functions:

### Table 50

<table>
<thead>
<tr>
<th>Elements</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="New" /></td>
<td>New</td>
<td>Click this icon to create a new sequence. Refer to <a href="#">Creating New Sequence</a> on page 362.</td>
</tr>
<tr>
<td><img src="image" alt="Download" /></td>
<td>Download</td>
<td>Click this icon to save the modifications that are done using the <a href="#">Sequence Settings</a> window on the module. An orange icon indicates that modifications are not yet applied on the module. You can also apply the changes on either generator, or analyzer or both.</td>
</tr>
<tr>
<td><img src="image" alt="Reload Running Sequence" /></td>
<td>Reload Running Sequence</td>
<td>Click this icon to reload the running sequence settings. Reloading a sequence will discard the changes made in the sequence editor and will reload the current sequence with its factory settings.</td>
</tr>
<tr>
<td><img src="image" alt="Add Block Before" /></td>
<td>Add Block Before</td>
<td>Click this icon to add a block before selected sequence block.</td>
</tr>
<tr>
<td><img src="image" alt="Add Block After" /></td>
<td>Add Block After</td>
<td>Click this icon to add a block after selected sequence block.</td>
</tr>
<tr>
<td><img src="image" alt="Loop" /></td>
<td>Loop</td>
<td>Click this icon to create a loop in a sequence block. Refer to <a href="#">Creating a Loop</a> on page 365.</td>
</tr>
<tr>
<td><img src="image" alt="Delete" /></td>
<td>Delete</td>
<td>Click this icon to delete the selected block from the sequence. Deleting a block will also remove all loops that are associated with this block.</td>
</tr>
<tr>
<td><img src="image" alt="&lt;xml&gt;" /></td>
<td>Show Patterns</td>
<td>Click this icon to toggle between the user interface and xml code. The changes made in user interface are also reflected in xml code and vice versa. Shows the patterns in the <a href="#">Pattern Edit Pane</a> if the selected block has memory patterns.</td>
</tr>
</tbody>
</table>
Creating New Sequence

To create a new sequence:

1. Click on the Create New Sequence icon present on the toolbar. A Create New Sequence dialog will appear which allows you to create a new sequence.
2. Perform the following settings:
   - **Name** - Provide a sequence name.
   - **Description** - Provide a description of the sequence.
   - **No. of Blocks** - Enter the number of blocks to be added. You can add up to 500 blocks in a sequence.
   - **Locations** - Click on the button to open the **Select Sequence Locations** dialog box. Use this dialog box to select the sequence location. You can either select a single sequence location or multiple locations.

3. Click **Create** to create a sequence.

### Importing a Sequence

The M8070A **Sequence Editor** allows you to import the sequences, edit them and then use them for testing and analysis.

To import a sequence:

1. Click the **Import Sequence** icon. This opens the standard Windows **Open** dialog, where you can locate the sequences.
Please note that you are only allowed to import patterns with .m8ks file extension.

2 Click Open. A Import Sequence dialog will appear as shown in the following figure:

![Import Sequence dialog](image.png)

This dialog allows you to select the following sequence and pattern options:

a **Select sequence to import**: Select the check box to import the sequences from generator, analyzer or both.

b **Sequence Options**: Select the check box to delete existing sequences, use location of the imported sequences and download sequence after importing.

c **Pattern Option**: Select this option to also import the patterns used in the selected sequences.

3 Click OK to import the sequences.

Please note that the selected sequences with the same name will be overwritten.
Exporting a Sequence

The M8070A Sequence Editor allows you to export patterns and use it for testing and analysis.

To export a pattern:

1. Click the Export Sequence icon. This opens the Export Sequence dialog which allows you to export the sequences from Generator, Analyzer or both. Additionally, it also allows you to export the patterns used in the sequences.

2. Click OK. A standard Windows Save As dialog will open which allows you to save the sequence under the defined file name and location.

Creating a Loop

To create a loop (if desired):

- Click the Add Block Before icon to add the blocks before the selected sequence blocks.
- Click the Add Block After icon to add the blocks after the selected sequence blocks.
• Click the Create Loop icon. A Create Loop dialog will appear as shown in the following figure:

![Create Loop dialog](image)

• Specify the start and end block of the loop for the specified sequence (for e.g. generator, analyzer or user-defined sequence).
• Click Create to create a loop in the specified blocks.
• Click on the loop indicator. You will see a Loop Setting functional block in the Sequence Setting window where you can specify the loop count and enable the looping option.

Loop Within Sequences

A loop defines the transition from the end of a block to the beginning of the same or a previous block. It is not possible to jump into an existing loop. It is also not possible to specify loops within loops (except the default overall loop).

For information on how to create a loop, refer to Creating a Loop on page 365.

Deleting a loop - It is possible to delete a loop. To delete a loop, select the loop indicator and click Delete icon.

Modifying the Existing Sequences

By default, the Generator and Analyzer sequences already exist whenever you launch a Sequence Editor. You can however modify these sequences as per the requirements. Using these options, you can:
• Add and delete the blocks
• Add loops in the blocks
• Specify the settings for each block using the Sequence Settings window. For more details, refer to Sequence Setting Window on page 367.
Once the settings are done, click the Download icon to apply the sequence settings either on generator or on analyzer or on both.

**NOTE**

Please note that there should be at least one block in the sequence. Remember that you are not allowed to perform delete operation in the block if there is only one block in sequence.

Sequence Setting Window

The **Sequence Setting** window allows you to set the properties for the selected block and sequence. Using this window, you can specify the following settings:

- **Instrument Configuration**. For details, refer to Instrument Configuration on page 368.
- **Sequence Configuration**. For details, refer to Sequence Configuration on page 380.
- **Link Training Configuration**. For details, see Link Training Configuration on page 371
- **Block Data**. For details, refer to Block Data on page 381.
- **Block Settings**. For details, refer to Block Settings on page 384.
- **Block Branches**. For details, refer to Block Branches on page 385.
- **Block Controls**. For details, refer to Block Controls on page 386.

**Set to Default Check-Box**

Most of the parameters in the **Sequence Setting** window contains a **Set to Default** check-box which gets highlighted when some modifications are done. You can click on this check-box to change the settings to their default values.

The following figure shows how the check-box gets highlighted when you modify the symbol width to 10.

![Set to Default Check-Box](image)

However, when you click on the **Set to Default** check-box, the value changes to 1 (default value). See the following figure.
7 Setting up Patterns

Instrument Configuration

The instrument configuration section provides the following options:

- **Symbol Width**: Use this option to select the symbol width e.g., 1, 10, 130 or 132 bit. Depending upon the symbol width you have selected, you can specify the coding configuration for that particular symbol width.
- **Replicate**: Select the replicate option (Serialized, Copy or Copy plus Phase Adjust).

If the symbol width is 10, you can specify the 8B/10B coding configuration. Using this, you can define alignment symbol, replacement symbol and filler primitives.

The **Alignment Symbol** contains the K28.1, K28.5 and K28.7 symbols.
The Replacement Symbol contains the K28.0, K28.4, K28.7, K23.7, K27.7, K29.7 and K30.7 symbols.

Filler Primitives are inserted or deleted for clock tolerance compensation. These are not compared and therefore cannot be counted as errors. Filler Primitives contain symbols. A maximum of four alternative filler primitives can be used. Each filler primitive can consist of up to 4 filler symbols. Filler symbols are separated by comma (,). To add filler primitive:

- Click the Add Primitive button.
- Enter the Symbol. The filler primitive can consist of up to 4 filler symbols.

Wild Cards for Filler Primitives

The wild cards allow you to set one or more out of the maximum of four symbols of a filler primitive as don’t care. In this case, all allowed D and K symbols will match and are removed from incoming DUT data.

For example:

K28.5,

Here the dot (.) symbol will be treated as don’t care.

Add Scrambler Configuration

Select the Scrambler Configuration check-box to add scrambler configuration to the sequence.
It allows you to:

- Reset Primitive
- Hold Primitive
- Pause Start Primitive
- Pause End Primitive
- Polynomial
- Reset After Filler Remove
- Reset Value
- Reset Value After Hold

If the symbol width is 130, you can specify the 128B/130B coding configuration. Using this, you can define scrambler reset value and EIEOS (Electrical Idle Exit Ordered Set) for PCIe3 or PCIe4.
### PCIe/USB/SATA Scrambler Polynomials

For the symbol width 8b/10b, the following scrambler polynomials are used:

- **PCIe/USB** - \( G(x) = x^{16} + x^5 + x^4 + x^3 + 1 \)
- **SATA** - \( G(x) = x^{16} + x^{15} + x^{13} + x^4 + 1 \)

For the symbol width 128b/130b and 128b/132b, both standards use the same scrambler polynomial as following:

- **PCIe/USB** - \( G(x) = x^{23} + x^{21} + x^{16} + x^8 + x^5 + x^2 + 1 \)

### Link Training Configuration

This section allows you to configure link training for USB 3.0, USB 3.1, PCIe 3.0 and PCIe 4.0.

#### Link Training for USB 3.0 and USB 3.1

The M8070A system software allows you to test the physical layer compliance of a USB 3.0 and USB 3.1 DUT. It provides the parameters which can be configured for link training USB 3.0 and USB 3.1.

If the symbol width is 10, you can configure the link training parameters for USB 3.0 to control LTSSM (Link Training and Status State Machine). However, if the symbol width is 132, you can configure the link training parameters for USB 3.1 to control LTSSM.

The following figure shows the parameters which can be configured for link training USB 3.0:
The following parameters are available to configure link training USB 3.0:

- **DUT Type** - Specifies which role the BERT should play during link training. It can either be an upstream device for testing a downstream port or vice versa.
- **Target State** - Determines the target state when bringing up the link.
- **Trigger State** - This parameter determines when the trigger output signal of the LTSSM block should be asserted. Additionally, this information can be translated into a trigger pulse on entering or leaving the specified state. This is done by the pulse shaper of the TCRl OUT connector and no direct functionality of the LTSSM.
- **LFPS tPeriod** - Period of the LFPS cycle.
- **LFPS Duty Cycle** - Duty cycle of the LFPS cycle
- **Polling LFPS tBurst** - Link Training handshake before 5Gb/s.
- **Polling LFPS tRepeat** - Link Training handshake before 5Gb/s.
- **Warm Reset LFPS tBurst** - LFPS triggers transition to Rx.Detect.

The following figure shows the parameters which can be configured for link training USB 3.1:
The following parameters are available to configure link training USB 3.1:

- **DUT Type** - Specifies which role the BERT should play during link training. It can either be an upstream device for testing a downstream port or vice versa.
- **Target State** - Determines the target state when bringing up the link.
- **Trigger State** - This parameter determines when the trigger output signal of the LTSSM block should be asserted. Additionally, this information can be translated into a trigger pulse on entering or leaving the specified state. This is done by the pulse shaper of the TCRL OUT connector and no direct functionality of the LTSSM.
- **LFPS tPeriod** - Period of the LFPS cycle.
- **LFPS Duty Cycle** - Duty cycle of the LFPS cycle
- **Warm Reset LFPS tBurst** - LFPS triggers transition to Rx.Detect.
- **SCD1 and SCD2** - SuperSpeedPlus Capability Declaration (SCD) is a step for a SuperSpeedPlus port, while in the Polling LFPS substate, to identify itself as SuperSpeedPlus capable by transmitting Polling LFPS signals with specific patterns unique to SuperSpeedPlus ports.
• **SuperSpeedPlus LFPS Based PWM Message (LBPM)** - LBPM is defined as a low power signaling mechanism for two SuperSpeedPlus ports to communicate with each other based on LFPS signals. The adoption of Pulse Width Modulation (PWM) is to embed the transmitting clock in data and to allow for easy data recovery at the receiver based on LFPS clock.

For further details on link training for USB 3.0 and USB 3.1, refer to Interactive Link Training on page 435.

**Link Training PCIe 3.0 and PCIe 4.0 Parameters**

The M8070A system software allows you to test the physical layer compliance of a PCIe 3.0 and PCIe 4.0 DUT. It provides the parameters which can be configured for link training PCIe 3.0 and PCIe 4.0.

If the symbol width is 130, you can configure the link training parameters for PCIe 3.0 and PCIe 4.0 to control LTSSM (Link Training and Status State Machine).

The following figure shows the parameters which can be configured for link training PCIe 3.0:
The following parameters can be configured as attributes:

- **EIEOS** - The EIEOS (Electrical Idle Exit Ordered Set) allows you to choose the pattern (PCIe3 | PCIe4) to be used for link training.
- **Generation** - Specifies the target link training PCIe Gen3 (8GT/s) or PCIe Gen 4 (16GT/s).
- **DUT Type** - Specifies which role the DUT should play during link training. It can either be an upstream device for testing a downstream port or vice versa.
- **Clock Architecture** - Specifies the clock architecture whether common or separate. In case of common clock, a common RefClk is expected. The M8000 instrument and the DUT run on the same clock. The RefClk is provided by the 'Trig Out' of the clock module of the M8000 instrument. In case of separate clock, the DUT runs on its own RefClk provided by itself or by an external source. The 'Trig Out' of the M8000 instrument is not used as RefClk for the DUT.
• **Loopback through** - Specifies if the real-time equalization is done while going into loopback through L0 / Recovery or through Configuration. When selecting Loopback through L0-Recovery, the LTSSM does a link training as before. Selecting Loopback through Configuration does a link training without real time equalization. When the Loopback through Configuration is selected, all preset parameters are disabled.

• **Trigger State** - Specifies the trigger state. It can be an Add-in-Card (AIC) or a root- complex.

• **Lane** - Specifies the lane number being used.

• **Link** - Specifies the link number being used.

• **Compliance Receive Bit** - Specifies whether the compliance received bit is asserted or deasserted.

• **Link Equalization** - Determines whether link equalization should be performed. It can either be aborted after phase 1 (Bypass) or fully executed. In the second case it can be determined whether only preset or all (i.e. individual cursor) requests should be accepted.

• **Start Preset** - Specifies the preset used by the J-BERT's TX port after switching to Gen 3 operation and when operating as an upstream device.

• **DUT Preset Hint** - Specifies the preset hint being sent by the J-BERT to the DUT during phase 0 of the link equalization procedure. It is only used when the BERT operates as upstream device.

• **DUT Initial Preset** - Specifies the preset the J-BERT transfers to the DUT in phase 0 of the link equalization procedure. It is only used when the BERT operates as an upstream device.

• **DUT Target Preset** - Specifies the preset the J-BERT requests the DUT to switch to during link equalization. Depending on the role the J-BERT is playing, this is done in either phase 2 or 3 of the link equalization training.

• **Speed Change Control** - Specifies whether the speed change to Gen3 (i.e. 8 Gbps) speed will be initiated by DUT or BERT during link training. It is only used when the BERT operates as a downstream device. If not specified DUT will initiate the speed change and will also request BERT for the same. It is only used for the DUT type as System Board.

• **User Calibrated Presets** - Specifies whether BERT's Data Out should use user-calibrated presets or standard presets during link training. Enabling it means that BERT's Data Out will use de-emphasis/pre-shoot values that had been previously calibrated, otherwise it will use standard de-emphasis/pre-shoot values defined by the PCIe3 specification. By default this option is turned off which means that standard presets will be used.
For further details on link training for PCIe 3.0, refer to Interactive Link Training on page 435.

The following figure shows the parameters which can be configured for link training PCIe 4.0:

The following parameters can be configured as an attributes.

- **EIEOS** - The EIEOS (Electrical Idle Exit Ordered Set) allows you to choose the pattern (PCIe3 | PCIe4) to be used for link training. Electrical Idle Exit Ordered Set (EIEOS) for 8.0 GT/s Data Rates
Setting up Patterns

Electrical Idle Exit Ordered Set (EIEOS) for 16.0 GT/s Data Rates

<table>
<thead>
<tr>
<th>Symbol Numbers</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0, 2, 4, 6, 8, 10, 12, 14</td>
<td>00h</td>
<td>Symbol 0: EIEOS Identifier &lt;br&gt;A low frequency pattern that alternates between eight 0s and eight 1s.</td>
</tr>
<tr>
<td>1, 3, 5, 7, 9, 11, 13, 15</td>
<td>FFh</td>
<td>A low frequency pattern that alternates between eight 0s and eight 1s.</td>
</tr>
</tbody>
</table>

- **Generation** - Specifies the target link training PCIe Gen3 (8GT/s) or PCIe Gen 4 (16GT/s).
  If Gen 4 is selected:
  - DUT Target Preset - Cursor is not available in this case for Gen 3
  - DUT Target Preset (Gen4) - Cursor can be used instead only for Gen 4
- **DUT Type** - Specifies which role the DUT should play during link training. It can either be an upstream device for testing a downstream port or vice versa.
- **Clock Architecture** - Specifies the clock architecture whether common or separate. In case of common clock, a common RefClk is expected. The M8000 instrument and the DUT run on the same clock. The RefClk is provided by the ‘Trig Out’ of the clock module of the M8000 instrument. In case of separate clock, the DUT runs on its own RefClk provided by itself or by an external source. The ‘Trig Out’ of the M8000 instrument is not used as RefClk for the DUT.
- **Loopback through** - Specifies if the real-time equalization is done while going into loopback through L0 / Recovery or through Configuration. When selecting Loopback through L0-Recovery, the LTSSM does a link training as before. Selecting Loopback through Configuration does a link training without real time equalization. When the Loopback through Configuration is selected, all preset parameters are disabled.
• **Trigger State** - Specifies the trigger state. It can be an Add-in-Card (AIC) or a root-complex.
• **Lane** - Specifies the lane number being used.
• **Link** - Specifies the link number being used.
• **Compliance Receive Bit** - Specifies whether the compliance received bit is asserted or deasserted.
• **Link Equalization** - Determines whether link equalization should be performed. It can either be aborted after phase 1 (Bypass) or fully executed. In the second case it can be determined whether only preset or all (i.e. individual cursor) requests should be accepted.
• **Start Preset** - Specifies the preset used by the J-BERT’s TX port after switching to Gen 4 operation and when operating as an upstream device.
• **DUT Preset Hint** - Specifies the preset hint being sent by the J-BERT to the DUT during phase 0 of the link equalization procedure. It is only used when the BERT operates as upstream device.
• **DUT Initial Preset** - Specifies the preset the J-BERT transfers to the DUT in phase 0 of the link equalization procedure. It is only used when the BERT operates as an upstream device.
• **DUT Target Preset** - Specifies the preset the J-BERT requests the DUT to switch to during link equalization. Depending on the role the J-BERT is playing, this is done in either phase 2 or 3 of the link equalization training.
• **Select Start Preset Gen 4** - User Defined
  - **User Defined** - Start Preset (Gen 4) entered by user.
• **Start Preset Gen 4** - Start Preset Gen 4 value entered by user (P0 – P9).
• **DUT Initial Preset Gen 4** - DUT Initial Preset Gen 4 value entered by user (P0 – P9).
• **DUT Target Preset Gen 4** - DUT Target Preset Gen 4 value entered by user (P0 – P9, Cursor)
• **User Calibrated Presets** - Specifies whether BERT’s Data Out should use user-calibrated presets or standard presets during link training. Enabling it means that BERT’s Data Out will use de-emphasis/pre-shoot values that had been previously calibrated, otherwise it will use standard de-emphasis/pre-shoot values defined by the PCIe3 specification. By default this option is turned off which means that standard presets will be used.

For further details on link training for PCIe 4.0, refer to Interactive Link Training on page 435.
Sequence Configuration

The sequence configuration section provides the following options:

- **Sequence**: Allows you to apply a sequence configuration on either Generator, Analyzer or user-created sequences.
- **Name**: Provide the sequence name.
- **Locations**: Specify the locations for the sequence. Use the button available to select the locations.
- **Replicate**: Select the replicate option (Serialized, Copy or Copy plus Phase Adjust).
- **Description**: Add a description to the sequence.

**NOTE**

Make sure not to use the unused location which are not being used in the test setup. However, if it is used, ensure that the 'Re-Sync' parameter of these locations is set to manual to reduce overall system load caused by unnecessary pattern re-sync attempts.
Block Data

The Block Data section allows you to:

- Provide a block name.
- Provide a block length.
- Select Block Type. The available options are Clock, Pulse, PRBS, Static, Memory Pattern and Link Training.
  - For block type as Clock, you need to specify the Divider, Replicate and the Compare feature (refer Compare Feature on page 384).
  - The Replicate feature shows how the serial patterns are split to multiple locations. It has the option options:
    Serialize: In this a pattern is split and distributed to the locations. This is for the parallel side of a serial bus.
    Copy: In this each location gets a copy of the pattern.
    Copy Plus Phase Adjust: In this each location gets a copy of the pattern. Scrambler phases of the different locations are set differently. This is for the parallel side of a serial bus.
  - For block type as Pulse, you need to specify the Width, Compare and Offset feature.
  - For block type as PRBS, you need to specify the Polynomial, Replicate, Invert and Seed (Hex) feature. Refer to the Table 51 on page -382 and Table 52 on page -383 for the list of available PRBS polynomials.
The following tables shows the PRBS polynomial for M8020A/M8030A/M8040A that is used to generate the selected PRBS $2^\text{n}-1$.

**Table 51** PRBS polynomials for M8020A/M8030A/M8040A

<table>
<thead>
<tr>
<th>PRBS</th>
<th>Shift Register Length</th>
<th>Polynomial</th>
<th>PRBS Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>$2^7-1$</td>
<td>7</td>
<td>$x^7+x^6+1$</td>
<td>127</td>
</tr>
<tr>
<td>$2^9-1$</td>
<td>9</td>
<td>$x^9+x^5+1$</td>
<td>511</td>
</tr>
<tr>
<td>$2^{11}-1$</td>
<td>11</td>
<td>$x^{11}+x^2+1$</td>
<td>2047</td>
</tr>
<tr>
<td>$2^{13}-1$</td>
<td>13</td>
<td>$x^{13}+x^{12}+x^2+1$</td>
<td>8191</td>
</tr>
<tr>
<td>$2^{15}-1$</td>
<td>15</td>
<td>$x^{15}+x^{14}+1$</td>
<td>32767</td>
</tr>
<tr>
<td>$2^{23}-1$</td>
<td>23</td>
<td>$x^{23}+x^{18}+1$</td>
<td>8388607</td>
</tr>
<tr>
<td>$2^{23p}-1$</td>
<td>23</td>
<td>$x^{23}+x^{21}+x^{18}+x^{15}+x^2+1$</td>
<td>8388607</td>
</tr>
<tr>
<td>$2^{31}-1$</td>
<td>31</td>
<td>$x^{31}+x^{28}+1$</td>
<td>2147483647</td>
</tr>
<tr>
<td>$2^{33}-1$</td>
<td>33</td>
<td>$x^{33}+x^{28}+1$</td>
<td>8589934591</td>
</tr>
<tr>
<td>$2^{35}-1$</td>
<td>35</td>
<td>$x^{35}+x^{32}+1$</td>
<td>34359738367</td>
</tr>
<tr>
<td>$2^{39}-1$</td>
<td>39</td>
<td>$x^{39}+x^{35}+1$</td>
<td>549755813887</td>
</tr>
<tr>
<td>$2^{41}-1$</td>
<td>41</td>
<td>$x^{41}+x^{38}+1$</td>
<td>2199023255551</td>
</tr>
<tr>
<td>$2^{45}-1$</td>
<td>45</td>
<td>$x^{45}+x^{44}+x^{42}+x^{41}+1$</td>
<td>35184372088831</td>
</tr>
<tr>
<td>$2^{47}-1$</td>
<td>47</td>
<td>$x^{47}+x^{46}+1$</td>
<td>140737488355327</td>
</tr>
<tr>
<td>$2^{49}-1$</td>
<td>49</td>
<td>$x^{49}+x^{48}+1$</td>
<td>562949953421311</td>
</tr>
<tr>
<td>$2^{51}-1$</td>
<td>51</td>
<td>$x^{51}+x^{50}+x^{48}+x^{45}+1$</td>
<td>2251799813685247</td>
</tr>
</tbody>
</table>
The following tables shows the PRBS polynomial for M8195A/M8196A that is used to generate the selected PRBS $2^n-1$.

Table 52  PRBS polynomials for AWG (M8195A/M8196A)

<table>
<thead>
<tr>
<th>PRBS</th>
<th>Shift Register Length</th>
<th>Polynomial</th>
<th>PRBS Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>$2^7-1$</td>
<td>7</td>
<td>$x^2 + x^8 + 1$</td>
<td>127</td>
</tr>
<tr>
<td>$2^9-1$</td>
<td>9</td>
<td>$x^9 + x^5 + 1$</td>
<td>511</td>
</tr>
<tr>
<td>$2^{11}-1$</td>
<td>11</td>
<td>$x^{11} + x^9 + 1$</td>
<td>2047</td>
</tr>
<tr>
<td>$2^{13}-1$</td>
<td>13</td>
<td>$x^{13} + x^{12} + x^2 + x + 1$</td>
<td>8191</td>
</tr>
<tr>
<td>$2^{15}-1$</td>
<td>15</td>
<td>$x^{15} + x^{14} + 1$</td>
<td>32767</td>
</tr>
</tbody>
</table>

- For block type as **Static**, you need to specify the **Single Value** and the **Compare** feature.
- If you select **Block Type** as **Memory Pattern**, a **Select Pattern** window will open which allows you to load the memory patterns.
- For block type as **Link Training**, you need to specify the **Direction**.
- Click **Select Location Specific Patterns**. This opens with a drop-down selection where you can specify the ports or locations of specific patterns.
Select the ports or locations and then click Select. The settings option for each port or location will be added to the Block Data functional block.

Click Clear if you want to remove port or location specific patterns and use single pattern for the block.

Compare Feature

The Compare feature allows you to compare the block data for a particular sequence. It provides you the freedom to modify the sequence without deleting the blocks.

When to use/not use this feature

Suppose you created a sequence with multiple blocks. Now, if you want to exclude particular block(s) from that sequence while comparing, instead of deleting the whole sequence, just set the compare functionality "OFF" which in-turn will disable that particular block(s) from the sequence for comparison.

Block Settings

The Block Settings section allows you to:

- Click on the corresponding ON/OFF toggle button to turn on the following features:
  - CDR
  - Error Insertion
• Click on the ON/OFF toggle button to enable the block settings on the sequence.
• Click on the ON/OFF toggle button to turn on the Symbol Align feature.
• Select disparity whether positive, negative or unchanged.
• Click on the ON/OFF toggle button to turn on the Sync and Loop feature.

**NOTE**
The Sync feature will be automatically turned on once you turn on the Sync and Loop feature.

• Use the drop down option to specify whether you want to apply trigger on either Pulse or Pulse or PRBS Match.

**NOTE**
The changes made in the Block Settings section are reflected on the selected block.

**Block Branches**

The Block Branches are used to add the branches within the sequence. You can add up to two branches in a sequence.

To add a Block Branches, click on the Add Branch button. The Block Branches section will appear as shown in the following figure:
The **Block Branches** section provides the following settings:

- **Source**: Use the drop-down list to specify the source for the branch.
- **Event**: Specify the event for the branch.
- **Go to Block**: Specify the block name to jump.
- **Enabled**: Use the ON/OFF toggle button to enable the branching option.
- Click **Add Branch** if you want to add another branch. Up to two branches can be added within the same block.
- Click **Delete** icon to delete the branch.

Once the branching is enabled in a block, the **Block Branches** icon will appear on the sequence block as shown in the following figure:

![Block Branches Icon](image)

**Block Controls**

The **Block Controls** section allows you to provide sink value at Ctrl Out A and Sys Out A/B. These values help you to trigger the given sink at different values that are defined i.e. Low, High or Pulse. Press **Add Control** to add more block controls. You can add up to four block controls.

![Block Controls](image)
Setting up Patterns

Editing a Pattern in a Sequence Editor

The **Sequence Editor** user interface contains **Pattern Edit Pane** that allows you to edit the memory patterns.

Make sure to enable the **Show Patterns** option by clicking on the **Show Pattern** icon, present on the toolbar. This will display the **Pattern Edit Pane**, in case it is not visible in the **Sequence Editor**.

To edit a pattern, you have to first load it in the sequence block. To do so:

1. Select the block on which the patterns are loaded.
2. Go to **Sequence Setting** window and then select **Block Data** functional block.
3. Select the **Block Type** as **Memory Patterns**. A **Select Pattern** window will open which allows you to load the memory patterns. You can download large memory patterns (up to 2 Gb) on each channel.
4. Select the desired pattern and click **Select**.
5. The pattern will be loaded into the selected block as well as on the **Pattern Edit Pane**. See the following figure:

![Pattern Edit Pane](image)

6. Edit the patterns as explained in the section **Pattern Edit Pane** on page 414.
-sharing Sequences

The M8070A software currently does not allow the functionality to share the sequences. However, there is a workaround to share sequences.

Follow the given steps:

1. Go to File > and click Save Instrument State... Once you save the instrument state, the sequence settings are also saved in the Settings folder which is created at the following path: “Documents\Agilent\M8070A\Workspaces\Default\User\Settings”

2. Share Settings folder.

3. Copy the Settings folder at the same path on another system.

4. Go to File > and click Recall Instrument State.... The sequences will now appear in the Sequence Editor.
User-Defined Sequences

This section describes the basics of user-defined sequences.

A sequence is created and maintained by means of the Sequence Editor. A sequence consists of up to 500 blocks that can be looped. Each block can generate a pause signal (constant 0 or 1), a divided clock signal, a $2^n - 1$ PRBS, or a user pattern.

Single or multiple blocks can be looped. The sum of the blocks and the counted loops must not exceed 500. An overall loop restarts the sequence after it has come to its end.

Sequence Block Display

A new sequence consists of one block that is infinitely repeated (looped). By default, this block has a length of 512 bits and generates a Pause 0 signal (a continuous stream of zeros). All this is shown on the display.

Sequence Block Parameters

The Sequence Setting window allows you to change the contents and the trigger generation of a sequence block.

Choices are:

- **Block No.** - Can be up to 500 blocks.
- **Length** - This is the length of the pattern in bits for a standard pattern of 128 bits.
- **Block Type** - Clock, PRBS, Pulse, Static or Memory Patterns.
- **PRBS** - You can choose a PRBS of polynomial $2^n - 1$. The range of $n$ is 7, 10, 11, 15, 23, or 31. You can change the block length, if desired.
- **Divided Clock** - You can use this option to generate the signal at every nth clock pulse.
- **Memory Pattern** - When you select pattern type as memory pattern, a Select Pattern dialog will appear. You have to locate the pattern file and then click OK. The patterns will be loaded in the sequence.
Select Pattern Dialog

The **Select Pattern** dialog allows you to either select a single pattern for all the analyzer and Generator locations or setup individual patterns for selected locations.

**NOTE**

This operation will download the new sequences. If the **Sequence Editor** is already opened, then changes made in the **Sequence Editor** will not be saved.

This dialog provides the following tabs:

**All Locations**

This tab allows you to select a single pattern and download it to all locations.
You to select the pattern from the following options:
- Clock
- Pulse
- PRBS
  Refer to the Table 51 on page -382 and Table 52 on page -383 for the list of available PRBS polynomials.
- Static
- Memory
  In case the Memory option is selected, a Select Memory Pattern... button will appear.

When you click this button, the Select Pattern dialog will appear.

Once you select the pattern in Select Pattern dialog, click Apply button to download the pattern.
Selected Locations

This tab allows you to setup individual patterns for selected locations. You to select the pattern from the following options:

- Clock
- Pulse
- PRBS

Refer to the Table 51 on page -382 and Table 52 on page -383 for the list of available PRBS polynomials.

- Static
- Memory

In case the Memory option is selected, a Select Pattern dialog will appear to load the memory pattern.

If you wish to open the Sequence Editor with the selected patterns, either select the "Open sequence editor after applying changes" check-box or click the Sequence Editor... button.

Click Apply to apply the changes.
Application Specific Patterns

This section describes how to select the patterns for a specific standards. These patterns are applicable for M8045A and AWG (M8195A/M8196A) modules.

OIF CEI

**OIF CEI QPRBS13-CEI**

This pattern is defined in CEI 56G-VSR-PAM4 appendix 16.C.3.1.

1. Select PRBS13-1 from hardware PRBS generator or use the factory pattern available at the following location:
   Factory\CEI\PRBS13Q-CEI_bit
2. Choose Line Coding as PAM4.
3. Set Symbol Mapping to Gray Coded (Default).

**OIF CEI QPRBS31-CEI**

This pattern is defined in CEI 56G-VSR-PAM4 appendix 16.C.3.2.

1. Select PRBS31-1 from hardware PRBS generator.
2. Choose Line Coding as PAM4.
3. Set Symbol Mapping to Gray Coded (Default).

IEEE 802.3

**IEEE 802.3 QPRBS13**

This pattern is defined in IEEE 802.3 clause 94.2.9.3. It is stored in a way that will output the correct PAM4 symbols when Symbol Mapping is set to Gray Coded.

1. Select the factory pattern available at the following location:
   Factory\IEEE\QPRBS13_Lane0_bit_SelectGrayCoded
2. Choose Line Coding as PAM4.
3. Set Symbol Mapping to Gray Coded (Default).
IEEE 802.3 PRBS13Q

This pattern is defined in IEEE 802.3 clause 120.5.11.2.3.
1. Select PRBS13-1 from hardware PRBS generator or use the factory pattern available at the following location:
   Factory\IEEE\PRBS13Q_Lane0_bit
2. Choose Line Coding as PAM4.
3. Set Symbol Mapping to Gray Coded (Default).

For convenience additional lane 1 to lane 3 versions are stored at:
   Factory\IEEE\PRBS13Q_Lane1_bit
   Factory\IEEE\PRBS13Q_Lane2_bit
   Factory\IEEE\PRBS13Q_Lane3_bit

These additional versions are intended for multi-lane applications and using alternative seeds as defined in table IEEE 802.3 94-11.

IEEE 802.3 PRBS31Q

This pattern is defined in IEEE 802.3 clause 120.5.11.2.4.
1. Select PRBS31-1 from hardware PRBS generator.
2. In the block settings activate the Invert feature of the hardware PRBS generator.
3. Choose Line Coding as PAM4.
4. Set Symbol Mapping to Gray Coded (Default).

IEEE 802.3 SSPRQ

The IEEE/SSPRQ_bit_SelectGrayCoded (120.5.11.2.3) pattern corresponds to the pattern as defined in release 1.0 of the spec while IEEE/SSPRQ_bit_SelectGrayCoded_D1p5 (120.5.11.2.5) pattern is the version from Draft 1.5 of the spec. It is stored in a way that will output the correct PAM4 symbols when Symbol Mapping is set to Gray Coded.
1. Select the factory patterns available at the following location:
   Factory\IEEE\SSPRQ_bit_SelectGrayCoded
   Factory\IEEE\SSPRQ_bit_SelectGrayCoded_D1p5
2. Choose Line Coding as PAM4.
3. Set Symbol Mapping to Gray Coded (Default).
Pattern Editor

The pattern editor provides an interactive user-interface for creating, editing and importing the patterns.

How to Launch Pattern Editor

To launch the Pattern Editor:
- Go to the Menu Bar > Patterns and then select Pattern Editor.

The Pattern Editor will appear as shown in the following figure:

![Pattern Editor Screen](image)

The Pattern Editor user interface includes the following elements:
- Toolbar
- Settings Window
- Pattern Edit Pane
The toolbar provides the following convenient pattern editing functions:

**Table S3**

<table>
<thead>
<tr>
<th>Elements</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>New</td>
<td>Click this icon to create a new pattern. For details, refer to Creating New Patterns on page 398</td>
</tr>
<tr>
<td></td>
<td>Open</td>
<td>Click this icon to open a pattern from a file. For details, refer to Opening Existing Patterns on page 401</td>
</tr>
<tr>
<td></td>
<td>Save</td>
<td>Click this icon to save the current pattern. For details, refer to Saving Patterns on page 403.</td>
</tr>
<tr>
<td></td>
<td>Save As</td>
<td>Click this icon to change the properties of current pattern and then save it under different name. For details, refer to Saving Patterns on page 403.</td>
</tr>
<tr>
<td></td>
<td>Import</td>
<td>Click this icon to import patterns, edit them and use them for testing and analysis. For details, refer to Importing Patterns on page 406.</td>
</tr>
<tr>
<td></td>
<td>Export</td>
<td>Click this icon to export patterns in the desired location. These patterns can be used by other instruments for testing and analysis. For details, refer to Exporting Patterns on page 408.</td>
</tr>
<tr>
<td></td>
<td>Download</td>
<td>Click this icon to download the pattern to either all locations or on the selected locations. An orange icon indicates that the pattern is modified and is not yet downloaded to any location(s).</td>
</tr>
</tbody>
</table>
Copy These functions follow Microsoft Windows copy/paste functionality. You can perform the copy/paste operations in the following ways:

- Click on Copy/Paste icons
- Use keyboard shortcuts (Ctrl+C, Ctrl+V)
- Right click and use the context menu options

The Copy/Paste function allows you to:

- Select either the partial data or the complete symbols in a pattern and copy/paste it anywhere in the pattern.
- Use the copy/paste operations for the partial data across multiple instances of Pattern Editor, irrespective of the pattern coding.
- Use the paste operation to and from clipboard to Pattern Editor.

Please note that the paste operations for the complete pattern symbol is only allowed in the same pattern symbol coding.

This icon is only available when the partial data is copied from the pattern. Whenever a paste operation is done using this function, the underline data will be pasted.

Paste as String
- Paste as Data

Undo Reverses the last editing action, such as typing, modifying or deleting text. When you do such actions, you can use the Undo command to restore them.

Redo Restores the last editing action, such as typing, modifying or deleting text if no other actions have occurred since the last Undo.

Find Click this icon to open the Find Symbol dialog box and perform the search operation for a specified segment in the pattern. For details, see Find Symbol Dialog Box on page 409.

Select All Click this icon to select all the symbols in the pattern.

Block Edit Click this icon to perform block edit operations on currently selected pattern. For details, refer to Block Edit Operations on page 410.

Go To Click this icon if you want to jump to an arbitrary bit position. See Go To Bit Dialog Box on page 411.

<table>
<thead>
<tr>
<th>Elements</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Copy</td>
<td>These functions follow Microsoft Windows copy/paste functionality. You can perform the copy/paste operations in the following ways: Click on Copy/Paste icons, use keyboard shortcuts (Ctrl+C, Ctrl+V), right click and use the context menu options. The Copy/Paste function allows you to: Select either the partial data or the complete symbols in a pattern and copy/paste it anywhere in the pattern. Use the copy/paste operations for the partial data across multiple instances of Pattern Editor, irrespective of the pattern coding. Use the paste operation to and from clipboard to Pattern Editor. Please note that the paste operations for the complete pattern symbol is only allowed in the same pattern symbol coding. This icon is only available when the partial data is copied from the pattern. Whenever a paste operation is done using this function, the underline data will be pasted.</td>
</tr>
<tr>
<td></td>
<td>Paste as String</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Paste as Data</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Undo</td>
<td>Reverses the last editing action, such as typing, modifying or deleting text. When you do such actions, you can use the Undo command to restore them. Keyboard shortcut - Ctrl + Z</td>
</tr>
<tr>
<td></td>
<td>Redo</td>
<td>Restores the last editing action, such as typing, modifying or deleting text if no other actions have occurred since the last Undo. Keyboard shortcut - Ctrl + R</td>
</tr>
<tr>
<td></td>
<td>Find</td>
<td>Click this icon to open the Find Symbol dialog box and perform the search operation for a specified segment in the pattern. For details, see Find Symbol Dialog Box on page 409.</td>
</tr>
<tr>
<td></td>
<td>Select All</td>
<td>Click this icon to select all the symbols in the pattern. Keyboard shortcut - Ctrl + A</td>
</tr>
<tr>
<td></td>
<td>Block Edit</td>
<td>Click this icon to perform block edit operations on currently selected pattern. For details, refer to Block Edit Operations on page 410.</td>
</tr>
<tr>
<td></td>
<td>Go To</td>
<td>Click this icon if you want to jump to an arbitrary bit position. See Go To Bit Dialog Box on page 411.</td>
</tr>
</tbody>
</table>
The Pattern Editor allows you to perform following tasks on patterns:

- Create a new patterns. For details, refer to Creating New Patterns on page 398.
- Open and already existing patterns. For details, refer to Opening Existing Patterns on page 401.
- Save a patterns. For details, refer to Saving Patterns on page 403.
- Import supported patterns. For details, refer to Importing Patterns on page 406.
- Perform block edit operations. For details, refer to Interactive Link Training on page 435.
- Edit a patterns on Pattern Edit Pane. For details, refer to Pattern Edit Pane on page 414.

Creating New Patterns

To create a new pattern:

1. Click the New icon present on the tool bar. This opens with the Create New Pattern sliding window as shown in the following figure:

2. Select the coding type. The Pattern Editor currently supports the following types of coding:
   - Bit (Binary)
   - 8B/10B
   - 128B/130B
   - 128B/132B
3 Specify the number of symbols. Use the UP and DOWN button to increase or decrease the number of symbols.

4 Specify the fill patterns.

5 Specify by using the ON/OFF toggle switch whether you want to use Mask and Squelch (Electric Idle). In Squelch, the amplifier output is zero.

6 After you have entered these parameters, click Create. The newly created pattern will appear in the Pattern Editor pane.

7 Click the Save icon to save the pattern. For more details, refer to Saving Patterns on page 403.

Downloading Patterns

You can also download the pattern to either selected locations or on all locations using the Download Pattern dialog. To do so, follow the given steps:

1 Create a new pattern or open an existing pattern.

2 Click on the Download button. If the pattern is not saved, a message will appear to save the pattern before downloading.

3 Once saved, a Download Pattern dialog will appear. This dialog allows you to download the selected pattern to either on all locations or on the selected locations.
This dialog provides the following tabs:

- **All locations** – Use this tab to download the memory pattern on all locations. Since, it is a memory pattern, this dialog disable all other pattern options. Only, the memory pattern option is available.

- **Selected Locations** – Use this tab to download the current pattern to the selected locations. On selecting the check-box, the name of the current pattern will appear.
4 Click **OK** to download the pattern.

5 If you wish to open the **Sequence Editor** with the selected patterns, either select the "Open sequence editor after applying changes" check-box or click the **Sequence Editor...** button and then click **OK**.

**Opening Existing Patterns**

To open an existing user pattern:

1 Click the **Open** icon present on the tool bar.
   
   This opens the **Open Pattern** dialog, where you can locate and open the desired pattern. You can even perform the operations such as renaming and deleting the pattern file and creating new folders.
You can select the pattern from the following default folders:

1. **Shared**: Patterns that are shared between settings.
2. **Current**: Patterns that are local to current setting.
3. **Factory**: Factory supplied standard patterns. These patterns are read only and cannot be modified.

- Click **Open** to load the patterns.
- To rename a file, select the file and click **Rename**. The filename will become editable.
- To delete a file, select the file and click **Delete**.
- To add a new folder, select location you want to create your folder and then click **New Folder**.
- To rename a folder, select the folder and click **Rename**. The folder name will become editable.
- To delete a folder, select the folder and click **Delete**.
Saving Patterns

To save the current user pattern:

1. Click the **Save** icon present on the tool bar. A **Save Pattern** dialog will appear which allows you to save the patterns under the defined file name and location.

You can use the **Save Pattern** dialog to perform the operations such as renaming and deleting the patterns. You can even create a new folder or save the patterns in the **Current** or **Shared** folders. The current folder is for current users while the shared folder is accessible by all users. If the pattern has already been saved earlier, the saved file will be updated.
2 Click on the **Save As** icon if you wish to change the properties of current pattern and then save it under different name. The current pattern can be either a non-captured pattern or a captured pattern.

a For saving a non-captured pattern, a **Select Pattern Properties** dialog will appear. This dialog provides the following options:

- Make a copy of current pattern with no change in pattern properties.
- Change the properties of current pattern. Using this option, you can change the pattern coding and enable/disable Squelch and Mask.
- You can save the entire pattern or can also provide the pattern range to be saved.

b For saving a captured pattern, a **Select Captured Pattern Properties** dialog will appear. This dialog provides the following options:
• Change the properties of current pattern. Using this option, you can change the pattern coding and enable/disable Mask, Squelch and Error as Mask.

The **Use Error As Mask** option is only visible when the **Use Mask** option is enabled and coding is same as captured pattern.

• Change the properties of current captured pattern. Using this option, you can change the pattern coding and enable/disable Mask, Squelch and Error as Mask.

• You can save the entire captured pattern or can also provide the pattern range to be saved.

• Click **Override** to remove all errors from the pattern.

3 Press **Save As...** button. A standard **Save As Pattern** dialog box will appear.
Setting up Patterns

4 Specify the name and location and click **Save**.

**Importing Patterns**

The M8070A **Pattern Editor** allows you to import patterns, edit them and use it for testing and analysis.

To import a pattern:

1. Click the **Import** icon. This opens the **Select File** dialog which allows you to locate the pattern. You are allowed to import patterns with any file extension (.ptrn and .txt).
2. Select the pattern and click **Open** in the **Select File** dialog.
3. If you import a .ptrn file, skip the step 4 and go to step 5.
4. However, if you import a .txt file, a **Select Import Pattern Properties** dialog will appear.
This dialog allows you to change the pattern coding and enable Squelch and Mask in the pattern.

5 Click OK. An Import Pattern dialog will appear as shown in the following figure:

6 Choose a location (shared or current) to save the pattern. You can also create a new folder.

7 Provide a file name and click Import. The imported patterns will appear in the Pattern Edit Pane.
Exporting Patterns

The M8070A Pattern Editor allows you to export patterns and use it for testing and analysis.

To export a pattern:

1. Click the Export icon. This opens the Select Pattern to Export dialog as shown in the following figure:

2. Select the pattern and click Export. This opens the Export Pattern dialog.
3 Locate the path and file name for the .prtn file.
4 Click Save to export the data to the specified destination.

Sharing Patterns

You can share patterns to other users by exporting the pattern to a shared location and later importing that pattern to Pattern Editor. For details on how to export and import patterns, refer to Exporting Patterns on page 408 and Importing Patterns on page 406.

Find Symbol Dialog Box

The Find Symbol dialog box allows you to search for a specified bit sequence or symbols in the pattern. If you click Find Next, the next occurrence of this bit sequence or symbol is highlighted.
The search pattern can be entered in binary/hex/symbol format, depending on currently selected mode in pattern editor. You can continue editing the pattern while this dialog box is still open.

**Block Edit Operations**

The **Block Edit** window provides an easy way to modify parts of the pattern or the entire pattern at once. This can be used when setting up a new pattern. It can also be used as an optional technique for editing existing patterns.

Click on the **Block Edit** icon present on the toolbar. The **Block Edit** sliding window will appear as shown in the following figure:

![Block Edit Window](image)

With the **Block Edit** window, you can use the drop-down list to specify whether the block edit operation has to be performed on data or listed attributes. You can also define the range that is to be modified. The available options for the range are:

- **All**
  Choose this option to edit the entire pattern.

- **Range**
  Choose this option to select the range of bits, symbols or blocks entered in the **From** and **To** fields.

The **Block Edit** window contains the following tabs:

- **Fill**
  This tab allows filling the given range in the pattern with the specified value. The available options for the **Fill** tab are:
    - **Fill Pattern**
Fills the specified value to the given range in the pattern. You can only enter the patterns depending upon the pattern mode (Bit coded or Symbol coded) selected from Data View Mode.

- **Invert**
  Invert the bits. 0 becomes 1 and 1 becomes 0.

- **Rotate**
  This tab provides the following options:
  - **Rotate Symbol Left by:**
    Treats the pattern data in the specified range as a circular buffer and rotates the bits to the left by the specified amount. No data will be lost and what is at the start of the buffer will be at the end of the buffer after the rotation.
  - **Rotate Symbol Right by:**
    Treats the pattern data in the specified range as a circular buffer and rotates the bits to the right by the specified amount. No data will be lost and what is at the end of the buffer will be at the start of the buffer after the rotation.
  - **Align to Sequence:**
    Aligns the pattern data in the specified range to a specified pattern sequence.

**Go To Bit Dialog Box**

The **Go To** dialog box allows you to set the cursor to an arbitrary position in the pattern.

Enter the bit position (=address) or alternatively you can use the UP and DOWN arrow buttons to enter the bit position and then click **OK**. The cursor will be placed in front of the character with the selected bit.
Settings Window

The Settings Window allows you to set the visualizations of the currently selected patterns. This helps you to easily identify the data and attributes in the pattern.

The Settings Window provides the following options:

Data View

The Data View option allows you to set the following:

- **Data View Mode** - Select the data view mode as Bin, Hex, PAM4 No Coding, PAM4 Gray Coding and PAM4 Custom coding.

- **Custom Symbol Mapping** - It appears only when you view the bit pattern as PAM4 Custom. It allows you to map the consecutive data bits to PAM4 symbols. The mapping is defined as a comma separated list of bit sequences (e.g. 00, 01, 11, 10).

- **Show High Low** - Toggle the ON/OFF switch to display either high or low transition in the patterns. This option is only available in Bit coding.

- **Show Continuous Stream** - Toggle the ON/OFF toggle switch to show continuous stream in the patterns. This option is only available in Bit coding.

Colors

The Colors option allows you to set the following:

- **Background Color** - Changes the background color of the pattern editor pane.

- **Caret Color** - Changes the color of the carat in the pattern.

- **Zero Color** - Changes the color of all occurrences of zeros (0) in the pattern.

- **One Color** - Changes the color of all occurrences of ones (1) in the pattern.
• **Transition Color** - Changes the transition color in the pattern.
• **Mask Color** - Changes the color of the bits that are masked.
• **Squelch Color** - Changes the color of the bits that are squelch.
• **Attribute 1 Color** - Changes the color of attribute 1.
• **Attribute 0 Color** - Changes the color of attribute 0.

You can at anytime reset the color settings to default colors by pressing the **Reset to Default Colors** button.

**Visuals**

The **Visual** option allows you to set the following:
• **Data** - Changes the data appearance as selected from the data visual options.
• **Attributes** - Changes the attribute appearance as selected from the attributes visual options.
The pattern edit pane displays the pattern and also allows you to edit it. The pattern edit pane shows the symbol and data. You can edit selected data using the keyboard keys. Remember, the pattern edit pane does not allow you to enter any wrong data.

The pattern edit pane allows you to import and export patterns. For details on how to import and export the patterns, refer to Importing Patterns on page 406 and Exporting Patterns on page 408.

The pattern edit pane also allows you to save the current pattern with other pattern coding. You can right click on the pattern edit pane and use the context menu option (Save As) to save the current pattern or save the selected range of pattern. For details, refer Saving Patterns on page 403.

The pattern edit pane also allows the copy/paste functionality. Once you select the symbols in a pattern, you can copy them and paste it anywhere in the pattern. You can perform the copy/paste operations in the following ways:

- Click on Copy/Paste icons
- Use keyboard shortcuts (Ctrl+C, Ctrl+V)
- Right click and use the context menu options
Please note that the copy operation only allows a complete symbol to be copied.

It is possible to use the copy/paste operations across multiple instances of Pattern Editor window with same pattern coding.

The pattern edit pane also allows the undo and redo operations. Using this operation you can reverse or restore the last performed action. You can use the keyboard shortcuts (Ctrl+Z) for Undo and (Ctrl+R) for Redo operations.

The pattern edit pane also provides the scrolling feature which can be utilized using the keyboard and mouse. With a keyboard, you can use the up or down arrow keys to move the scrollbar. With a mouse, you can move scroll bar by clicking the scroll arrow at either end of the scroll bars, click empty portions of the scroll bar, or click and drag the scroll box. When you press the scroll bar using the mouse, a tool-tip appears which displays the current position of the symbol number.

Patterns consist of a sequence of symbols. A symbol can have the following type of coding:

1  Bit (Binary)
2  8B/10B
3  128B/130B
4  128B/132B

The following figure shows the Pattern Edit Pane with a bit coded pattern (Binary) pattern:
The bottom of the **Pattern Editor Pane** indicates the position of the selected symbols and buttons to edit them. These buttons are only available when you create a pattern in bit coding and the data view mode is binary (BIN). You can use these buttons to:

0 - Set data 0
1 - Set data 1.

X - Click this toggle button to add/remove mask on a data.
S - Click this toggle button to add/remove squelch on a data.

You can use the **< >** buttons as well as the keyboard keys to move the pointer position to the left, right, up and down in the pattern.

In binary mode, when you click on any symbol, its position is displayed as following:

- The top of the **Pattern Editor Pane** displays the index of cursor (symbol) in current row.
- The bottom of the **Pattern Editor Pane** displays the symbol number.

The following figure shows the **Pattern Editor Pane** with a symbol coded (8B/10B) coded pattern:
You can use the **Settings Window** to enhance the visualizations of the current pattern. For details, refer to "Settings Window" on page -412.

**Symbol Attributes**

A symbol can have additional attributes to modify behavior. They are supported by all symbols. These are:

1. **Mask**: This attribute only affects the **Data In** ports. It specifies if the symbol is actually compared or masked (excluded from compare).
2. **Squelch**: This attribute only affect the **Data Out** ports. If this attribute is 1, a squelch (out of band) level is used.

In addition there are coding specific attributes, to control aspects of the coding like bypassing or using a scrambler.

**Editing a Pattern**

To edit a pattern:

1. Open an already existing pattern. Refer to **Opening Existing Patterns** on page 401.
2. If no pattern is available, a new pattern can be created. Refer to **Creating New Patterns** on page 398.
3. Select the bits to be edited in the patterns.
4. Use the keyboard to enter the required bits. It can be in form of 0 or 1.
5 If the current pattern is in use in some other location(s), then the orange Download button will get highlighted when the pattern is modified.

6 Click on the Download button to download the pattern. Once it is download, the green Download button will appear.

**Editing a Captured Pattern**

To edit a captured pattern, it needs to be converted to an editable pattern. Follow the given steps to make the captured pattern editable:

1. Open an already saved captured pattern. Refer to Opening Existing Patterns on page 401.
2. Select the bits to be edited in the pattern.
3. Use the keyboard to enter the required bits. It can be in form of 0 or 1. A Select Captured Properties dialog will appear:

   ![Select Captured Properties Dialog]

4. Change the properties of current pattern. Using this option, you can change the pattern coding and enable/disable Mask, Squelch and Error as Mask.

   The Use Error As Mask option is only visible when the Use Mask option is enabled and coding is same as captured pattern.

5. Click Override to remove all errors from the pattern.
6. Click Save As. A Save Pattern As dialog will appear.
7. Specify the name and location and click Save.
Bit Coding

The following figure shows the pattern edit pane with a bit coded pattern in binary (BIN) mode:

The bottom of the pattern edit pane indicates the position of the selected symbols and buttons to edit them. These buttons are only available when you create a pattern in bit coding and the data view mode is binary (BIN). You can use these buttons to:

0 - Set data 0
1 - Set data 1.
X - Click this toggle button to add/remove mask on a data.
S - Click this toggle button to add/remove squelch on a data.

You can use the buttons as well as the keyboard keys to move the pointer position to the left, right, up and down in the pattern.

The bottom of the pattern edit pane also displays the symbol number which indicates the number.

You can use the Settings Window to enhance the visualizations of the current pattern. For details, refer to “Settings Window” on page -412.

To encode a bit coded symbol 1, 2 or 3 bits are needed. This depends on the use of mask and squelch:
### Table 54  Plain bit coding without using mask or squelch

<table>
<thead>
<tr>
<th>Bit offset range</th>
<th>Bit (range) name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Data</td>
<td>Data bit</td>
</tr>
</tbody>
</table>

### Table 55  Mask is used

<table>
<thead>
<tr>
<th>Bit offset range</th>
<th>Bit (range) name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Data</td>
<td>Data bit</td>
</tr>
<tr>
<td>1</td>
<td>Mask</td>
<td>Mask (ignored on DataOut)</td>
</tr>
</tbody>
</table>

### Table 56  Squelch is used

<table>
<thead>
<tr>
<th>Bit offset range</th>
<th>Bit (range) name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Data</td>
<td>Data bit</td>
</tr>
<tr>
<td>1</td>
<td>Squelch</td>
<td>Squelch (ignored on DataIn)</td>
</tr>
</tbody>
</table>

### Table 57  Mask and Squelch are used

<table>
<thead>
<tr>
<th>Bit offset range</th>
<th>Bit (range) name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Data</td>
<td>Data bit</td>
</tr>
<tr>
<td>1</td>
<td>Mask</td>
<td>Mask (ignored on DataOut)</td>
</tr>
<tr>
<td>2</td>
<td>Squelch</td>
<td>Squelch (ignored on DataIn)</td>
</tr>
</tbody>
</table>
8B/10B Coding

The following figure shows the pattern edit pane with a 8B/10B coded pattern:

You can use the Settings Window to enhance the visualizations of the current pattern. For details, refer to Settings Window on page 412.

This type of pattern contain:

- **Symbol**: 8B/10B coding have 8 bits in one symbol.
- **Attributes**: It has the following attributes:
  - **Mask**: This attribute only affects the Data In ports.
  - **Squelch**: This attribute only affects the Data Out ports.
  - **Scrambler Enable**: This attribute enables/disables the scrambler.
  - **Scrambler Pause**: This attribute is used to pause scrambler for some special symbol.
  - **Scrambler Reset**: This attribute is used to reset scrambler LFSR (Linear feedback shift register).
  - **Start of frame**: This attribute enables/disables the start of frame marker.
  - **K/D**: This attribute specifies whether the symbol bits are control characters or data.
  - **Data**: Specifies data bits.
To encode an 8B/10B symbol, 16 bits (2 bytes) are used:

Table 58

<table>
<thead>
<tr>
<th>Bit offset range</th>
<th>Bit (range) name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>7:0</td>
<td>Data</td>
<td>Symbol data</td>
</tr>
<tr>
<td>8</td>
<td>K/D</td>
<td>0 = D-character, 1 = K-character</td>
</tr>
<tr>
<td>9</td>
<td>Reserved for future use. Must be set to 0</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Mask</td>
<td>Mask (if present, ignored on DataOut)</td>
</tr>
<tr>
<td>11</td>
<td>Squelch</td>
<td>Squelch (if present, ignored on DataIn)</td>
</tr>
<tr>
<td>12</td>
<td>Enable Scrambler</td>
<td>Enable Scrambler (ignored on DataIn)</td>
</tr>
<tr>
<td>13</td>
<td>Pause Scrambler</td>
<td>Pause Scrambler (ignored on DataIn)</td>
</tr>
<tr>
<td>14</td>
<td>Reset Scrambler</td>
<td>Reset Scrambler (ignored on DataIn)</td>
</tr>
<tr>
<td>15</td>
<td>Start of Frame</td>
<td>Start of Frame (ignored on DataOut)</td>
</tr>
</tbody>
</table>
128B/130B Coding

The following figure shows the pattern edit pane with a 128B/130B coded pattern:

You can use the Settings Window to enhance the visualizations of the current pattern. For details, refer to Settings Window on page 412.

This type of pattern contain:

- **Symbol**: 128B/130B coding having 128 bit in one symbol.
- **Attributes**: It has the following attributes:
  - **Mask** - This attribute only affects the Data In ports.
  - **Squelch** - This attribute only affects the Data Out ports.
  - **Scrambler Enable** - This attribute enables/disables scrambler.
  - **Scrambler Pause** - This attribute is used to pause the scrambler for some special symbol.
  - **Scrambler Reset** - This attribute is used to reset the scrambler LFSR (Linear feedback shift register).
  - **Scrambler Bypass** - This attribute is used to bypass the scrambling over the symbol.
  - **Scrambler Bypass Byte 0** - If this bit is enabled, it does not allow scrambling over the symbol.
- **Do DC Balancing** - This attribute is used to set DC balancing over symbol.
- **Reset DC Balancing** - This attribute resets the DC balancing state.
- **Send Scrambled State** - This attribute specifies whether to send the scrambled state.
- **Reset Parity** - This attribute is used to reset the parity bit.
- **Pause Parity** - This attribute is used to pause the parity bit.
- **Start of frame** - This attribute enables/disables the start of frame marker.
- **Framing** - This attribute enables/disables the start of frame marker.
- **Data** - Specifies the data bits.

To encode a 128B/130B symbol, 144 bits (18 bytes) are used:

<table>
<thead>
<tr>
<th>Bit offset range</th>
<th>Bit (range) name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:0</td>
<td>Framing</td>
<td>Framing bits</td>
</tr>
<tr>
<td>129:2</td>
<td>Data</td>
<td>Data</td>
</tr>
<tr>
<td>130</td>
<td>Mask</td>
<td>Mask (if present, ignored on DataOut)</td>
</tr>
<tr>
<td>131</td>
<td>Squelch</td>
<td>Squelch (if present, ignored on DataIn)</td>
</tr>
<tr>
<td>132</td>
<td>Reset Scrambler</td>
<td>Scrambler reset (ignored on DataIn)</td>
</tr>
<tr>
<td>133</td>
<td>Pause Scrambler</td>
<td>Scrambler pause (ignored on DataIn)</td>
</tr>
<tr>
<td>134</td>
<td>Bypass Scrambler</td>
<td>Scrambler bypass</td>
</tr>
<tr>
<td>135</td>
<td>Bypass Byte 0</td>
<td>Scrambler bypass byte 0</td>
</tr>
<tr>
<td>136</td>
<td>Do DC Balancing</td>
<td>Do DC balancing (ignored on DataIn)</td>
</tr>
<tr>
<td>137</td>
<td>Reset DC Balancing</td>
<td>Reset DC balancing (ignored on DataIn)</td>
</tr>
<tr>
<td>138</td>
<td>Send Scrambler State</td>
<td>Send scrambler state (ignored on DataIn)</td>
</tr>
<tr>
<td>139</td>
<td>Reset Parity</td>
<td>Reset Parity (ignored on DataIn)</td>
</tr>
</tbody>
</table>
128B/132B Coding

The following figure shows the pattern editor pane with a 128B/132B coded pattern:

![Pattern Editor Pane](image)

<table>
<thead>
<tr>
<th>Bit offset range</th>
<th>Bit (range) name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>140</td>
<td>Pause Parity</td>
<td>Pause Parity (ignored on DataIn)</td>
</tr>
<tr>
<td>141</td>
<td>Start of Frame</td>
<td>Start of Frame (ignored on DataOut)</td>
</tr>
<tr>
<td>143:142</td>
<td></td>
<td>Reserved for future use. Must be set to 0</td>
</tr>
</tbody>
</table>

**NOTE**

When using 128/130 coding pattern contains Sync Symbols to achieve Symbol Alignment. These Sync Symbols need to be at least 16 symbols apart.

You can use the Settings Window to enhance the visualizations of the current pattern. For details, refer to Settings Window on page 412.
This type of pattern contain:

- **Symbol**: 128B/132B coding having 128 bit in one symbol.
- **Attributes**: It has the following attributes:
  - **Mask** - This attribute only affects the Data In ports.
  - **Squelch** - This attribute only affects the Data Out ports.
  - **Scrambler Reset** - This attribute is used to reset the scrambler LFSR (Linear feedback shift register).
  - **Scrambler Pause** - This attribute is used to pause the scrambler for some special symbol.
  - **Scrambler Bypass** - This attribute is used to bypass the scrambling over the symbol. If this bit is enabled, it will not allow scrambling over the symbol.
  - **Scrambler Bypass Byte 0** - If this bit is enabled, it does not allow scrambling over the symbol.
  - **Do DC Balancing** - This attribute is used to set DC balancing over the symbol.
  - **Reset DC Balancing** - This attribute resets the DC balancing state.
  - **Send Scrambled State** - This attribute specifies whether to send the scrambled state.
  - **Reset Parity** - This attribute is used to reset the parity bit.
  - **Pause Parity** - This attribute is used to pause the parity bit.
  - **Start of frame** - This attribute enables/disables the start of frame marker.
  - **Framing 0 1 2 3** - This attribute enables/disables the start of frame marker.

- **Data** - Specifies the data bit.

You can edit selected data using the keyboard.

To encode a 128B/132B symbol, 144 bits (18 bytes) are used:

Table 60

<table>
<thead>
<tr>
<th>Bit offset range</th>
<th>Bit (range) name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3:0</td>
<td>Framing</td>
<td>Framing bits</td>
</tr>
<tr>
<td>131:4</td>
<td>Data</td>
<td>Data</td>
</tr>
<tr>
<td>132</td>
<td>Mask</td>
<td>Mask (if present, ignored on DataOut)</td>
</tr>
<tr>
<td>133</td>
<td>Squelch</td>
<td>Squelch (if present, ignored on DataIn)</td>
</tr>
<tr>
<td>Bit offset range</td>
<td>Bit (range) name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>134</td>
<td>Reset Scrambler</td>
<td>Scrambler reset (ignored on DataIn)</td>
</tr>
<tr>
<td>135</td>
<td>Pause Scrambler</td>
<td>Scrambler pause (ignored on DataIn)</td>
</tr>
<tr>
<td>136</td>
<td>Bypass Scrambler</td>
<td>Scrambler bypass</td>
</tr>
<tr>
<td>137</td>
<td>Bypass Byte 0 Scrambler</td>
<td>Scrambler bypass byte 0</td>
</tr>
<tr>
<td>138</td>
<td>Do DC Balancing</td>
<td>Do DC balancing (ignored on DataIn)</td>
</tr>
<tr>
<td>139</td>
<td>Reset DC Balancing</td>
<td>Reset DC balancing (ignored on DataIn)</td>
</tr>
<tr>
<td>140</td>
<td>Send Scrambler State</td>
<td>Send scrambler state (ignored on DataIn)</td>
</tr>
<tr>
<td>141</td>
<td>Reset Parity</td>
<td>Reset Parity (ignored on DataIn)</td>
</tr>
<tr>
<td>142</td>
<td>Pause Parity</td>
<td>Pause Parity (ignored on DataIn)</td>
</tr>
<tr>
<td>143</td>
<td>Start of Frame</td>
<td>Start of Frame (ignored on DataOut)</td>
</tr>
</tbody>
</table>

**NOTE**

When using 128/132 coding pattern contains Sync Symbols to achieve Symbol Alignment. These Sync Symbols need to be at least 16 symbols apart.
Pattern Capture

The M8020A/M8030A/M8040A Analyzer captures the data received from the device under test. The captured data bits are displayed in the pattern capture pane in binary or 8b/10b symbol coding. The received data is compared with the expected data and the errored bits/symbols are highlighted. The captured data can be saved for post processing. The maximum capture memory for M8041A, M8051A, M8061A and M8045A is 2 Gb and for M8062A is 1 Gb. However, it also depends on the holdoff length which represents the amount of symbols in which the trigger events will be ignored.

How to Launch Pattern Capture Window

To launch the Pattern Capture window:

- Go to the Menu Bar > Patterns and then select Pattern Capture.

The Pattern Capture window will appear as shown in the following figure:

The Pattern Capture window includes the following elements:
- Toolbar
- Pattern Captured Pane
- Captured Results
- Parameters Window
Toolbar

The toolbar provides the following convenient pattern capture functions:

Table 61

<table>
<thead>
<tr>
<th>Elements</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Start</td>
<td>Starts capturing the current pattern</td>
</tr>
<tr>
<td></td>
<td>Stop</td>
<td>Stops capturing the current pattern</td>
</tr>
<tr>
<td></td>
<td>Reset</td>
<td>Resets the values of acquisition parameters</td>
</tr>
<tr>
<td></td>
<td>Manual Trigger</td>
<td>Manually starts the event that is triggering the capture logic.</td>
</tr>
<tr>
<td></td>
<td>Save Captured Data</td>
<td>Opens the “Save As” dialog which allows to save the captured data patterns as a separate pattern in the workspace (shared/current).</td>
</tr>
<tr>
<td></td>
<td>Save As</td>
<td>Click this icon to change the properties of current pattern and then save it under different name. For details, refer to Saving Patterns on page 403.</td>
</tr>
<tr>
<td></td>
<td>Export</td>
<td>Click this icon to export patterns in the desired location. These patterns can be used by other instruments for testing and analysis. For details, refer to Exporting Patterns on page 408.</td>
</tr>
<tr>
<td></td>
<td>Copy</td>
<td>Copies the selected data. (Ctrl +A)</td>
</tr>
<tr>
<td></td>
<td>Select All</td>
<td>Click this icon to select all the symbols in the pattern.</td>
</tr>
</tbody>
</table>
Parameters Window

The **Parameters** window have the following acquisition and show parameters for pattern capture.

**Acquisition Parameters**

- **Analyzer** – Use this drop-down menu to select the channel against which the data capture has to be performed.
- **Trigger** – Selects the event that is triggering the captured logic. It can be captured on the following four stop events:
  - **Immediately** – Starts capturing the data immediately and displays the captured data.
  - **Error** – Starts capturing the data when it receives an errored bit and displays the captured data.
  - **CTRL IN A** – Waits for a trigger signal from CTRL IN A port and displays the captured data.
  - **CTRL IN B** – Waits for a trigger signal from CTRL IN B port and displays the captured data.
- **Slope** – Selects the edge (rising edge or falling edge) of CTRL IN A or CRL IN B that is triggering the captured logic.
• **Holdoff** - Defines the minimum of data bits to capture before the trigger event occurs. This value is adjusted to a multiple of the current symbol granularity.

• **Capture Depth** - Defines the minimum of data bits to capture including holdoff. This value is adjusted to a multiple of the current symbol granularity.

**Show Parameters**

• **View Coded Pattern As** - Display the coded pattern (8B/10B) in Binary, Hex or Symbol view.

• **View Bit Pattern As** - Displays the captured bit coed pattern in Binary, Hex, PAM4 No Coding, PAM4 Gray Coding and PAM4 Custom coding.

• **Custom Symbol Mapping** - It appears only when you view the bit pattern as PAM4 Custom. It allows you to map the consecutive data bits to PAM4 symbols. The mapping is defined as a comma separated list of bit sequences (e.g. 00, 01, 11, 10).

**How to Capture a Pattern**

The following example explains the steps to capture a pattern to display errored bits.

1. Switch to **Parameters** window.

2. Set the acquasation parameters are shown below:
   - Location: M1.DataIn1
   - Trigger: Error
   - Holdoff: 500
   - Capture Depth: 10000

3. Click **Start** button. A message "Waiting for Trigger" will appear. You can click **Manual Trigger** to manually trigger the captured logic.

4. The captured data will be displayed in the **Pattern Captured** pane. The errored bits are marked red as shown in the following figure:
Pattern Capture Pane

The Pattern Capture Pane displays the captured pattern in the binary or 8b/10b symbol coding.

The errored bits in the captured patterns are marked red. You can use the Error Navigation buttons to jump to next, previous, first or last error.

Please note that the Pattern Capture pane does now allow to editing feature. This means you cannot edit the captured pattern. However, if you want to edit a captured pattern, you have to first save it and then open in the Pattern Editor. For details on how to edit pattern, refer to Editing a Pattern on page 417. Using a Pattern Editor, you can also save the results in different encoding schemes.
Saving a Captured Pattern

You can save the captured pattern for post processing. To do so;
• Click Save icon. This will open a Save Captured Pattern dialog.

• Specify the folder where it will be saved.
• Enter a file name and click Save. The current pattern will be saved under the filename.

You can open the saved file in the Sequence Editor and then download it to module to create a sequences. For details, refer to Sequence Editor on page 359.

Capture Results Pane

The Capture Results pane displays the results of the patterns captured.
The results are summarized as following:

- **Location** - Displays the location on which pattern capture is performed.
- **Capture Status** - Displays the current status of the capturing event as ‘Finished’, ‘Stopped’ or ‘Waiting for Trigger’.
- **First Error** - Displays the position of first error bit.
- **Last Error** - Displays the position of last error bit.
- **Errors Count** - Displays the total number of errored bits.
- **Holdoff** - Displays the minimum number of data bits to capture before the trigger event occurs.
- **Capture Depth** - Displays the minimum number of data bits to capture including holdoff.
Interactive Link Training

PCI Express 3.0/4.0 Testing

Interactive link training is required for link equalization testing as outlined in the PCI Express (R) Architecture PHY Test Specification.

LTSSM (Link Training and Status State Machine)

Link Training and Status State Machine (LTSSM) is the sub-block that drives and controls the link initialization, and training process for a PCIe device to enable the normal data exchange between the two devices over the link. LTSSM operates at the physical layer level and exchanges physical layer packets (Ordered sets such as TS1 and TS2) to initialize, train, and manage the link.

Two PCIe 3.0/4.0 instruments exchange Training Sequences as shown in the following diagram:

Training Sequences are also used to switch the link to low power states.

LTSSM States

LTSSM transits through various states and sub states during link initialization, training, and management. The entry and exit of each of these states and the exchange of packets (Ordered sets) between the two devices during each state is as per the PCIe specifications.

As per the PCIe specifications, LTSSM has 11 states and further sub-states. These states are referred to frequently in this chapter to describe LTSSM testing using the Keysight LTSSM Tester tool. Following is a list of these states followed by a diagram to illustrate the sequence of these states as per the PCIe specifications.

- Detect
- Quiet
- Polling
- Configuration
- L0
- Recovery
• L0s
• L1
• L2
• Hot Reset
• Disabled
• Loopback

The following figure displays the top-level states of LTSSM.

The Link Training starts in state "Detect". The purpose of this state is to detect when a far end termination is present. In the "Polling" state, bit lock and Symbol lock are established and Lane polarity is configured. In "Configuration", both the Transmitter and Receiver are sending and receiving data at the negotiated data rate. In "Recovery", both the Transmitter and Receiver are sending and receiving data using the
configured Link and Lane number as well as the previously supported data rate(s). An active link that can transport transaction layer packets is in state “L0”. All power management states are entered from this state.

The intent of the “Disabled” state is to allow a configured Link to be disabled until directed or Electrical Idle is exited (i.e., due to a hot removal and insertion) after entering “Disabled”. The “Loopback” is intended for test and fault isolation use.

LTSSM Tests for PCIe 3.0/4.0

You can execute the following types of LTSSM tests for PCIe 3.0/4.0:

Table 62

<table>
<thead>
<tr>
<th>Test Number</th>
<th>Test Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.3</td>
<td>Add-in Card Transmitter Initial Tx EQ Test for 8.0GT/s</td>
</tr>
<tr>
<td>2.4</td>
<td>Add-in Card Transmitter Link Equalization Response Test for 8GT/s</td>
</tr>
<tr>
<td>2.7</td>
<td>System Board Transmitter Link Equalization Response Test for 8GT/s</td>
</tr>
<tr>
<td>2.10</td>
<td>Add-in Card Receiver Link Equalization Test for 8GT/s</td>
</tr>
<tr>
<td>2.11</td>
<td>System Board Receiver Link Equalization Test for 8GT/s</td>
</tr>
</tbody>
</table>
**Test Setup**

The following block diagram shows the setup for test 2.3:

![Diagram for Test 2.3](image)

The following block diagram shows the setup for test 2.4:

![Diagram for Test 2.4](image)
The following block diagram shows the setup for test 2.7:

![Block Diagram for Test 2.7]

The following block diagram shows the setup for test 2.10:

![Block Diagram for Test 2.10]
The following block diagram shows the setup for test 2.11:

![Block Diagram]

Link Training PCIe 3.0 and PCIe 4.0 Parameters

Refer the section Link Training Configuration on page 371 for the PCIe 3.0 and PCIe 4.0 parameters which are added to pattern sequence language for specifying certain values to configure the LTSSM.

Link Training Configuration

You can configure the link training parameters to control LTSSM using the Sequence Settings window. For details on link training parameters, refer to Link Training Configuration on page 371.

Test Procedure

Follow the given steps to perform link training for test 2.3:

1. In the M8070A software load the instrument state PCIe_PHY2.3_Test.
2. Power on the DUT.
3. Enable the Outputs of the M8041A.
4. Reset the DUT by pressing the reset button on the CBB.
5. With this setup everything is prepared for capturing the data for the P0 preset. Hit the Break button in the Sequence Editor to start the link training. If link training was successful the Status Indicator should show that the sequencer of the generator is executing block 4 or 5 and that there are no bit errors.
6 Set up the oscilloscope.

7 For shutting down the PCIe link hit the Break button again. The sequencer of the generator should return to block 2.

8 Before taking the measurement for P1 the test pattern has to be changed. For this select block 4 of the generator sequence. Under Sequence Settings > Block Data change the memory pattern to compliancePatternHeaderP1Lane0. This pattern can be found in the Current directory. Not changing the pattern will cause the SIG test software to show the wrong preset number, but won’t affect the test results otherwise.

9 Do the same for block 4 of the error detector sequence.

10 Under Sequence Settings > Instrument Configuration > Link Training PCIe (3.0 or 4.0) and change the DUT Initial Preset to P1.

11 Download the changed sequence.

12 Repeat the test as for P0 and then repeat the test procedure for P2 through P9.

13 Start the SIG software and load all captured files into the Preset Test.

Link Training Log

The Link Training Log window displays the log generated while initiating the link training test. All information regarding the executed tests and their status are displayed with the date and time stamp. This helps to identify the root cause of a problem. For instance, the Link Training Log shows test failure due to an unexpected LTSSM state change.

The following figure shows the log generated by the link training test for PCIe 3.0.
Setting up Patterns

The following figure shows the log generated while initiating the link training test for PCIe 4.0:

![Link Training Log](image)

You can open/close the Link Training Log window by clicking on the Show/Hide Link Training Log icon present in the status bar. The Show/Hide Link Training Log icon with orange background indicates an update or new entry in the link training log.

User Calibrated Presets

It specifies whether BERT’s Data Out should use user-calibrated presets or standard presets during link training. Turning it on means that BERT’s Data Out will use de-emphasis/pre-shoot values that had been previously calibrated, otherwise it will use standard de-emphasis/pre-shoot values defined by the PCIe specification (defined below). By default this option is turned off which means that standard presets will be used.

The following table shows standard preset from PCIe specification:

<table>
<thead>
<tr>
<th>Preset Number</th>
<th>De-emphasis (dB)</th>
<th>Preshoot (dB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>P0</td>
<td>-6.0</td>
<td>0.0</td>
</tr>
<tr>
<td>P1</td>
<td>-3.5</td>
<td>0.0</td>
</tr>
<tr>
<td>P2</td>
<td>-4.5</td>
<td>0.0</td>
</tr>
<tr>
<td>P3</td>
<td>-2.5</td>
<td>0.0</td>
</tr>
<tr>
<td>P4</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>P5</td>
<td>0.0</td>
<td>1.8</td>
</tr>
</tbody>
</table>
Link Training for USB 3.0 and USB 3.1

The M8020A system allows you to test the physical layer compliance of a USB 3.0 (SuperSpeed) and USB 3.1 (SuperSpeedPlus) DUT.

It provides the following types of testing:
- Transmitter Testing for USB 3.0/3.1
- Receiver Jitter Tolerance Testing for USB 3.0/3.1

The M8070A software provides the parameters which can be configured for link training USB 3.0 and USB 3.1.

LTSSM (Link Training and Status State Machine)

Link Training and Status State Machine (LTSSM) is the sub-block that drives and controls the link initialization, and training process for a USB device to enable the normal data exchange between the two devices over the link. LTSSM operates at the physical layer level and exchanges physical layer packets (Ordered sets such as TS1 and TS2) to initialize, train, and manage the link.

Two USB 3.0/3.1 instruments exchange Training Sequences as shown in the following diagram:

Training Sequences are also used to switch the link to low power states.
LTSSM States

LTSSM transits through various states and sub-states during link initialization, training, power management and error testing. The entry and exit of each of these states and the exchange of packets (Ordered sets) between the two devices during each state is as per the USB specifications.

LTSSM consist of 12 main link states and their sub-states. These states and sub-states are responsible for link initialization, training, power management and error testing.

The following figure displays the top-level states of LTSSM.
The USB 3.0 and 3.1 LTSSM consists following states and their sub-states:

1. **Rx.Detect** - Rx.Detect is the power on state of the LTSSM for both a downstream port and an upstream port. It is also the state for a downstream port upon issuing a Warm Reset, and the state for an upstream port upon detecting a Warm Reset from any other link state except eSS.Disabled. The purpose of Rx.Detect is to detect the impedance of far-end receiver termination to ground.

   It contains three sub-states:
   - **Rx.Detect.Reset** - Rx.Detect.Reset is a default reset state used by the two ports to synchronize the operation after a Warm Reset; this substate exits immediately if Warm Reset is not present.
   - **Rx.Detect.Active** - Rx.Detect.Active is a sub-state for far-end receiver termination detection.
   - **Rx.Detect.Quiet** - Rx.Detect.Quiet is a power saving sub-state in which the function of a far-end receiver termination detection is disabled. A port will perform the far-end receiver termination detection periodically during Rx.Detect.

2. **Polling** - Polling is a state for port capability negotiation and link training. During Polling, a Polling.LFPS handshake shall take place between the two ports in SuperSpeed operation before the link training is started. Similarly for SuperSpeedPlus operation, Polling.LFPS based SCD1/SCD2 handshakes, LBPM based port capability negotiation and match, and subsequent port configuration shall take place before SuperSpeedPlus link training is started. Bit lock, block alignment for SuperSpeedPlus operation, symbol lock, lane polarity inversion, and Rx equalization trainings are achieved using TSEQ, SYNC, TS1, and TS2 training ordered sets.

   It contains the following sub-states:
   - **Polling.LFPS** - Polling.LFPS is a substate designed to establish the PHY’s DC operating point, and to synchronize the operations between the two link partners after exiting from Rx.Detect. This is also a substate for a port to identify itself based on various Polling.LFPS signatures.
   - **Polling.LFPSPlus** - Polling.LFPSPlus is a substate where the port SuperSpeedPlus operation performs SCD2 handshake, for additional confirmation of the SuperSpeedPlus capability of its link partner.
   - **Polling.PortMatch** - Polling.PortMatch is a substate where the two ports in SuperSpeedPlus operation perform the LBPM handshake, for announcing, matching, and deciding the operation on the highest common capability between the two link partners.
• **Polling.PortConfig** - Polling.PortConfig is a substate where a port configures its PHY according to PHY Capability LBPM matched in Polling.PortMatch, and synchronizes with its link partner in exiting from this substate to Polling.RxEQ. Depending on matched PHY Capability LBPM, a port may configure its PHY for SuperSpeed operation or SuperSpeedPlus operation.

• **Polling.RxEQ** - Polling.RxEQ is a substate for receiver equalization training. A port is required to complete its receiver equalization training.

• **Polling.Active** - Polling.Active is a substate that continues the link’s Enhanced SuperSpeed training.

• **Polling.Configuration** - Polling.Configuration is a substate where the two link partners complete the Enhanced SuperSpeed training.

• **Polling.Idle** - Polling.Idle is a substate where the port decodes the TS2 ordered set received in Polling.Configuration and determines the next state.

3 **U0** - U0 is the normal operational state where packets can be transmitted and received. U0 does not contain any substate machines.

4 **Recovery** - The Recovery link state is entered to retrain the link, or to perform Hot Reset, or to switch to Loopback mode. In order to retrain the link and also minimize the recovery latency, the two link partners do not train the receiver equalizers. Instead, the last trained equalizer configurations are maintained.

   It contains three sub-states:

   • **Recovery.Active** - Recovery.Active is a substate to train the Enhanced SuperSpeed link by transmitting the TS1 ordered sets.

   • **Recovery.Configuration** - Recovery.Configuration is a substate designed to allow the two link partners to achieve the Enhanced SuperSpeed handshake by exchanging the TS2 ordered sets.

   • **Recovery.Idle** - Recovery.Idle is a substate where a port decodes the link configuration field defined in the TS2 ordered set received during Recovery.Configuration and determines the next state.

5 **Loopback** - Loopback is intended for test and fault isolation. Loopback includes a bit error rate test (BERT) state machine. A loopback master is the port requesting loopback. A loopback slave is the port that retransmits the symbols received from the loopback master.
It contains two sub-states:

- **Loopback.Active** - Loopback.Active is a substate where the loopback test is active. The loopback master is sending data/commands to its loopback slave. The loopback slave is either looping back the data or detecting/executing the commands it received from the loopback master.

- **Loopback.Exit** - Loopback.Exit is a substate where a loopback master has completed the loopback test and starts the exit from Loopback.

SuperSpeedPlus uses some additional LTSSM states to configure the 10G operation mode. LFPS handshake is divided in more states SCD1.LFPS, SCD2.LFPS (SuperSpeedPlus Capability Declaration) and LBPM (low power signaling mechanism for two SuperSpeedPlus ports to communicate with each other).

**Link Training Methods**

Following are the link training methods for USB 3.0 and USM 3.1:

- **WarmReset (only for Devices – upstream ports)**

  A WarmReset generated by downstream port to upstream port; done when ‘Device’ is selected. A WarmReset consists of a continuous LFPS (Low Frequency Periodic Signal).

**Loopback Training**

Loopback testing provides a standard way to quantify the bit error rate (BER) for established links between host and device. There is one loopback master and one loopback slave in the loopback configuration. The loopback master is the port that has the Loopback bit asserted in TS2 ordered sets. A loopback slave is the port that retransmits the symbols received from the loopback master. Master checks returned data for errors.

Loopback.Active is a sub-state where the loopback test is active. The loopback master is sending data/commands to its loopback slave. The loopback slave is either looping back the data or detecting/executing the commands it received from the loopback master.

**Sequence**

For performing compliance tests the DUT has to be ‘trained’ into loopback mode. The pattern sequencer available in the M8070A software is able to set up a USB 3.x DUT into the specific loopback mode. The sequencer is also able to send compliance pattern to the DUT and can compare the received pattern with expected pattern for measuring e.g. bit error rates.
The pattern sequence language is based on XML. The pattern sequence language can be created and edited using the Sequence Editor in the M8070A software interface.

If symbol width 10 or 132 are selected following additional parameters will be visible on the right hand side in the Sequence Editor in the Parameter Window. On selecting the Symbol Width 10, the parameters for Link Training USB 3.0 are available in the Parameter Window. Similarly, on selecting the Symbol Width 132, the parameters for Link Training USB 3.1 are available in the Parameter Window.

Refer the section Link Training Configuration on page 371 for the parameters which are added to pattern sequence language for specifying certain values to configure the LTSSM.

The following figure shows an example of the link training sequence for USB 3.0 on Generator:

The following figure shows an example of the link training sequence for USB 3.0 on Analyzer:
### Link Training USB 3.0 and USB 3.1 Parameters

The following table shows the parameters which can be configured for link training USB 3.0 and USB 3.1:

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Values</th>
<th>Default</th>
<th>Description</th>
<th>Applicable for USB LTSSM 3.0 / 3.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>DUT Type</td>
<td>Host, Device</td>
<td>Device</td>
<td>Specifies which role the BERT should play during link training. It can be either an downstream port (Host) or an upstream port (Device)</td>
<td>Both</td>
</tr>
<tr>
<td>Target State</td>
<td>LoopbackViaPolling, LoopbackViaPolling</td>
<td></td>
<td>Determines the target state when bringing up the link</td>
<td>Both</td>
</tr>
</tbody>
</table>
### Trigger State

**XML:** triggerState
- RxDetectReset
- RxDetectActive
- PollingLFPS
- PollingRxEq
- PollingActive
- PollingConfiguration
- U0
- RecoveryActive
- RecoveryConfiguration
- LoopbackActive
- PollingLFPSPlus
- PollingPortMatch
- PollingPortConfig

This parameter determines when the trigger output signal of the LTSSM block should be asserted. Additionally, this information can be translated into a trigger pulse on entering or leaving the specified state. This is done by the pulse shaper of the Ctrl Out A connector and no direct functionality of the LTSSM.

<table>
<thead>
<tr>
<th>LFPS</th>
<th>tPeriod XML: lfps_tPeriod</th>
<th>10 ns – 110 ns</th>
<th>50 ns</th>
<th>Period and Duty cycle of LFPS cycle</th>
<th>Both</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Duty Cycle XML:lfps_dutyCycle</td>
<td>40 % – 60 %</td>
<td>50 %</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Polling LFPS</td>
<td>tBurst XML: pollingLFPS_tBurst</td>
<td>0.5 µs – 2 µs</td>
<td>1 µs</td>
<td>Link Training handshake before 5Gb/s</td>
<td>USB 3.0</td>
</tr>
<tr>
<td></td>
<td>tRepeat XML: pollingLFPS_tRepeat</td>
<td>5 µs – 20 µs</td>
<td>10 µs</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Warm Reset LFPS</td>
<td>tBurst XML: warmResetLFPS_tBurst</td>
<td>80 ms – 120 ms</td>
<td>100 ms</td>
<td>LFPS trigger transition to Rx.Detect</td>
<td>Both</td>
</tr>
<tr>
<td>SCD1 and SCD2</td>
<td>tBurst XML: scd1scd2_tBurst</td>
<td>0.5 µs – 1.5 µs</td>
<td>1 µs</td>
<td>SuperSpeedPlus Capability Declaration (SCD) is a step for a SuperSpeedPlus port, while in the Polling.LFPS substate, to identify itself as SuperSpeedPlus capable by transmitting Polling.LFPS signals with specific patterns unique to SuperSpeedPlus ports.</td>
<td>USB 3.1</td>
</tr>
<tr>
<td></td>
<td>tRepeat0 XML: scd1scd2_tRepeat0</td>
<td>4 µs – 11 µs</td>
<td>7.5 µs</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>tRepeat1 XML: scd1scd2_tRepeat1</td>
<td>9 µs – 16 µs</td>
<td>12.5 µs</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SuperSpeedPlus LFPS Based PWM Message (LBPM)</td>
<td>tPWM XML: superSpeedPlus_tPWM</td>
<td>1.9 µs – 2.5 us</td>
<td>2.2 µs</td>
<td>LBPM is defined as a low power signaling mechanism for two SuperSpeedPlus ports to communicate with each other based on LFPS signals. The adoption of Pulse Width Modulation (PWM) is to embed the transmitting clock in data and to allow for easy data recovery at the receiver based on LFPS clock.</td>
<td>USB 3.1</td>
</tr>
<tr>
<td></td>
<td>tLFPS-0 XML: superSpeedPlus_tLFPS-0</td>
<td>0.4 µs – 0.9 us</td>
<td>0.750 µs</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>tLFPS-1 XML: superSpeedPlus_tLFPS-1</td>
<td>1.23 µs – 1.9 us</td>
<td>1.450 µs</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Test Setup

**Test Setup Requirements**

The following are the test setup requirements to perform a USB link training:

- Keysight M8020A High Performance Serial BERT with a M8041A module
- One Keysight U7242A Fixture
- One 6 inch USB 3.0 cable
- Four SMA cables
- Four 11742A blocking capacitor

**M8020A Setup**

The following figure illustrates M8020A device setup to perform a USB link training:
Setting up Patterns

The following figure illustrates M8020A host setup to perform a USB link training:

![Link Training Configuration Diagram]

**Link Training Configuration**

You can configure the link training parameters to control LTSSM using the Sequence Settings window. For details on link training parameters, see Link Training Configuration on page 371.

USB 3.0 and 3.1 link training is possible with every channel of a M8041A and M8051A module.

**Test Procedure**

Follow the given steps to perform link training:

1. Load the instrument state in the M8070A software.
2. Power on the DUT.
3. Enable the Outputs of the M8041A.
4. Reset the DUT (disconnect/connect power at the fixture).
5. With this instrument setup everything is prepared for capturing the data. Hit the Break button in the Sequence Editor to start the link training. If link training is successful, the Status Indicator should show that the sequencer of the generator is executing the last block and that there are no bit errors.
6. For shutting down the link hit the Break button again. The sequencer of the generator should return to block 2.
7. Press Break button again for starting the link training again.
Link Training Log

The Link Training Log window displays the log generated while initiating the link training test for USB 3.0 and USB 3.1. All information regarding the executed tests and their status are displayed with the date and time stamp. This helps to identify the root cause of a problem. For instance, the Link Training Log shows test failure due to an unexpected LTSSM state change.

The following figure shows the log generated while initiating the link training test for USB 3.0:

![Log for USB 3.0](image1)

The following figure shows the log generated while initiating the link training test for USB 3.1:

![Log for USB 3.1](image2)
You can open/close the Link Training Log window by clicking on the Show/Hide Link Training Log icon present in the status bar. The Show/Hide Link Training Log icon with orange background indicates an update or new entry in the link training log.
Using M8062A Data Out Squelch Feature

This M8062A Data Out squelch feature is used to squelch the M8062A’s Data Out signals as specified in the selected pattern file.

Limitations

Following are the limitations of this feature:
- Minimum duration of signal squelch is 40 ns
- The squelch effects turn on/off only occurs on a raster of 10 ns.
- The squelch duration can only be modified in the granularity of a Symbol Width dependent bit raster
- Squelch/Data accuracy is ± 2 hardware word widths as defined in Table 63 on page -458.
- Inversion switch of Ctrl Out A signal is not supported when using squelch

Hardware Requirements

To use this feature, the M8041A module must be coupled with a M8062A module.

Hardware Setup

To use this feature it is required to connect the predefined cable (M8046A-801) from Ctrl Out A of the M8040A module to the Electrical Idle In of the M8062A module.

Software Usage

Following the given steps to use the M8062A Data Out squelch feature though M8070A software:

1. From the Modules View, activate the Ctrl Out A output of the M8041A module (M1).
2 Change the electrical idle input (squelch input) setting of the M8062A module (M2) to External. This is for external signal to have any effect on the M8062A's Data Out.

3 More settings for the **Electrical Idle In** can be changed by selecting the respective module location configured with Elect Idle In.

4 Open the **Sequence Editor**. The squelch can be activated by adding a **Sequence Control** to the M8062A Data Out sequence. Select the **Target** as **Ctrl Out A**, the **Module** as **M2** (the only valid selection with M8062A usage) and the **Source** as **Squelch**.

5 Alternatively for activating this feature in the GUI it is also possible to specify this setting directly in the XML definition of the sequence. With this it also is possible to activate this feature via SCPI:
6 Open the Pattern Editor window. When creating a new pattern it is necessary to activate squelch information bits in the pattern. This allows definition of squelched bits by pressing the S key or using the respective GUI button. The squelched bits are then underlined by a yellow line.
When defining a pattern containing signal squelching for usage with M8062A it is required to always squelch two bits in a row. This is necessary because the pattern will be downloaded independently into Channel 1 and Channel 2 of the M8041A module driving the M8062A. By squelching a single bit the whole word will be squelched. Effective word widths used by the hardware depend on the Symbol Width setting in the Sequence Editor.

![Sequence Settings](image)

The selection thereby results in the following hardware word width for M8041A/M8062A.

**Table 63 Hardware word width corresponding to selected symbol width**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>64</td>
<td>128</td>
</tr>
<tr>
<td>10</td>
<td>80</td>
<td>160</td>
</tr>
<tr>
<td>130</td>
<td>130</td>
<td>260</td>
</tr>
<tr>
<td>132</td>
<td>132</td>
<td>264</td>
</tr>
</tbody>
</table>

For signal squelching to work reliably, it is required that the resulting duration of the squelched blocks is at least 20 ns in length. Otherwise, the Electrical Idle In of the M8062A might miss a signal from the M8041A’s Ctrl Out A port.

The minimum granularity of a squelch signal is limited by the currently used word width of the M8041A/M8062A combination.
8 Working with Measurements

Overview / 460
Exploring Measurement User Interface / 461
Error Ratio Measurement / 467
Output Timing Measurement / 479
Output Level Measurement / 495
Jitter Tolerance Measurement / 508
Eye Diagram Measurement / 525
Parameter Sweep Plugin / 534
Overview

The M8070A software provides the following measurements:

- Error Ratio
- Output Timing
- Output Level
- Jitter Tolerance
- Eye Diagram

**NOTE**

Please note that the M8046A module only supports the following measurements:

- Error Ratio
- Output Timing
- Jitter Tolerance
Exploring Measurement User Interface

This section describes the functionality provided by the measurement user interface.

Launching the Measurement User Interface

To launch the measurement user interface:
- Go to the Menu Bar > Measurements and then select the respective measurements (Error Ratio, Output Timing, Output Level or Jitter Tolerance) to launch the measurement user interface.

The following figure shows the measurement user interface:

The measurement user interface has the following GUI elements which are common to all measurements:
- Toolbar
- Status Indicator
- Measurement History Pane
- Measurement Graph
- Parameter Window
- Calculated Results Pane
Let's discuss these GUI elements in the following sections.

**Toolbar**

The toolbar contains the following icons:

<table>
<thead>
<tr>
<th>Elements</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Start /Continue Measurement</td>
<td>Starts a measurement.</td>
</tr>
<tr>
<td>Break</td>
<td>Measurement</td>
<td>Halts the measurement at that point. Once paused, you can continue the measurement again by pressing Continue Measurement icon. Note: This option is not available in Error Ratio Measurement.</td>
</tr>
<tr>
<td>Stop</td>
<td>Measurement</td>
<td>Stops the measurement.</td>
</tr>
<tr>
<td>Step Into</td>
<td>Measurement</td>
<td>Steps further into the measurement. Note: This option is not available in Error Ratio Measurement.</td>
</tr>
<tr>
<td>Enable/Disable Measurement Run History</td>
<td>Enables or disables the measurement run history. For details, refer to Measurement History Window on page 463.</td>
<td></td>
</tr>
<tr>
<td>Clear</td>
<td>Measurement History</td>
<td>Clears the measurement run history.</td>
</tr>
<tr>
<td>Copy</td>
<td>Measurement History Properties</td>
<td>Copies the measurement history properties to the currently running measurement.</td>
</tr>
<tr>
<td>Reset</td>
<td>Measurement</td>
<td>Resets the measurement to its default values.</td>
</tr>
</tbody>
</table>
Status Indicator

The status indicator shows the current state of a measurement. There can be various states of a measurement, depending on the type of measurement. These may be as follows:

- **Not Started**: Indicates that the measurement has not yet started.
- **Running**: Indicates that the measurement is currently running.
- **Stop**: Indicates that the measurement is stopped.
- **Error**: Indicates an error while executing the measurement which is caused due to invalid parameter settings.
- **Suspended**: Indicates that the measurement is suspended.
- **Finished**: Indicates that the measurement is completed.

The following figure shows the status indicator while the measurement is running:

![Running Status Indicator](image)

Measurement History Window

The **Measurement History** window maintains the history of executed measurement along with their time stamp. This allows you to refer to the previously run measurements and compare their results.

The **Measurement History** window is shown in the figure below:

![Measurement History Window](image)

Click the icon to toggle between the enable/disable measurement run history in the Measurement History window.
Copy Measurement History Properties

This feature allows you to copy the properties of run measurement to currently running measurement.

To do so,
- Select a measurement history from the list shown in the Measurement History window.
- Click the Copy Measurement History Properties icon. The properties of the selected measurement will be copied to the current measurement.

Measurement Graph

The Measurement Graph displays the calculated graph and results.

The following figure displays the Measurement Graph of the Output Timing Measurement.
The **Measurement Graph** contains the following tabs:

- **Graph**: Displays the graphical representation of the measurement. The graph varies from measurement to measurement. The details of each measurement graph are further described in their respective sections.

- **Location**: Displays the raw measurement data for that location. However, if you are running measurement for a group, multiple tabs will appear that display the raw measurement for each location.

When you right-click on the **Measurement Graph**, a context menu appears which provides the following options:

- **Turn ON/OFF Fit to view (Ctrl+Home)**: Turns ON/OFF Fit to view option.
- **Fit to view (Home)**: Makes the visible area fit to display entire contents.
- **Copy screenshot (F11)**: Copies the screenshot of charts to clipboard.
- **Save screenshot (Ctrl+S)**: Saves the screenshot as an image (PNG) under a name.
- **Quick Help (Alt+F1)**: Opens a window that provides brief information about the dynamic display.

**Parameters Window**

The **Parameter** window allows you to set the parameters for a location or a group. For each measurement, it contains two types of parameters:

- **Acquisition Parameters**: Pre-Parameters influence how the data for a measurement is collected; changes require a re-run in order to be effective. It also allows you to select a location or location group against which the data acquisition is performed.

- **Evaluation Parameters**: Post-Parameters influence how the collected measurement data is evaluated. Changes do not require a re-run in order to be effective.

The acquisition and evaluation parameters differ from measurement to measurement. The detailed description of these parameters are explained in the sections that follow.

**Calculated Results Pane**

The **Calculated Results** pane displays the calculated results in the form of measurement parameters for each location. The calculated measurement parameters varies from measurement to measurement.
The **Calculated Results** pane is shown in the following figure:

![Calculated Results](image)

For each location, you can click on the slide button to show/hide the measurement graph.
Error Ratio Measurement

Overview

The Error Ratio Measurement allows you to collect measurement data over a specific period. This can be used to create test scenarios that are reproducible and comparable. Also, you can let tests run over long times and then evaluate the results afterwards.

While the error ratio measurement is running, you should not modify the measurement setup, as the measured bit errors do not represent the performance of your DUT under real circumstances.

The period of time can be set through the Parameters window, an absolute time setting, or the time it takes to measure a specified number of bits or bit errors. The accumulation period should be long enough to make a statistically valid BER measurement.

Launching Error Ratio Measurement

To launch the Error Ratio Measurement:

- Go to the Menu Bar > Measurements and then select Error Ratio.

The user interface of Error Ratio Measurement will appear as shown in the following figure:
The **Error Ratio** user interface includes the following elements:

- **Toolbar**: For details, refer to **Toolbar** on page 462.
- **History Pane**: For details, refer to **Measurement History Window** on page 463.
- **Measurement Graph**: For details, refer to **Measurement Graph** on page 472.
- **Parameter Pane**: For details, refer to **Acquisition and Evaluation Parameters for Error Ratio** on page 469.
- **Calculated Results**: For details, refer to **Calculated Results** on page 474.
Acquisition and Evaluation Parameters for Error Ratio

The **Parameters** window allows you to set the acquisition and evaluation parameters for **Error Ratio** measurement:

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acquisition Parameters</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Analyzer Location</td>
<td>Location or location group against which the data acquisition is performed.</td>
<td>Use the drop-down list to specify the location or location group.</td>
</tr>
<tr>
<td>Accumulation End</td>
<td>Specify the criteria to end accumulation.</td>
<td>Pass/Fail</td>
</tr>
<tr>
<td>Accumulation Duration</td>
<td>Specify the acquisition duration.</td>
<td>Fixed Time</td>
</tr>
<tr>
<td>Accumulation Fix Time</td>
<td>Specifies the duration of the accumulation.</td>
<td>Min - 1 s</td>
</tr>
<tr>
<td>Accumulation Interval</td>
<td>Specify the accumulation interval on which the error ratio sample is taken.</td>
<td>Min - 100 ms</td>
</tr>
<tr>
<td>Accumulation Stop Criteria</td>
<td>Specify the accumulation end criteria when measurement is run on a group of analyzers.</td>
<td>Per Analyzer</td>
</tr>
<tr>
<td>Number of Compared Bits</td>
<td>Specify the number of compared bits for which the error ratio sample is taken.</td>
<td>Min - 1E+6</td>
</tr>
<tr>
<td>Target Error Ratio</td>
<td>Specifies the target error ratio of the accumulation results.</td>
<td>Min - 1E-18</td>
</tr>
<tr>
<td>Target Confidence Level</td>
<td>Specifies the target confidence level of the accumulation results.</td>
<td>Min - 0.1 %</td>
</tr>
</tbody>
</table>
How to Run a Measurement

The Error Ratio measurement immediately starts calculating the error ratio as soon as it receives a valid signal and the respective error ratio settings are done.

To run an Error Ratio measurement, perform the following steps:

• Use the Parameters window to select the location or location group for which the data acquisition has to be performed.
• Set the acquisition parameters in the Parameters window. For details, refer to Acquisition and Evaluation Parameters for Error Ratio on page 469.
• Click the Start Measurement icon to run the measurement. The measurement status indicator will indicate Running.

Please note that once you run the measurement you cannot modify the acquisition parameters. However, if you try to modify acquisition parameters by stopping the measurement and then run the measurement, a new instance of measurement will be executed.
Error Ratio Measurement with PAM4 Symbols

The M8040A modular system allows you to run the Error Ratio measurement using the PAM4 symbols. To do so,

- Switch to the Module View.
- From the Generator (M8145A), select Data Out location. Choose the Line Coding as PAM4 in the Parameter window.
- From the Analyzer (M8146A), select Data In location. Choose the Line Coding as PAM4 in the Parameter window.
- Once done, switch to Error Ratio measurement.
- Set the acquisition parameters in the Parameters window. For details, refer to Acquisition and Evaluation Parameters for Error Ratio on page 469.
- Click the Start Measurement icon to run the measurement. The measurement status indicator will indicate Running.
- The Display Error Ratio in the Parameter window will now show the error ratio for various symbol levels (0-3) as shown in the following figure:

![Display Error Ratio](image)

- See Calculated Results on page 474 for the results which are displayed when an Error Ratio measurement is performed with PAM4 line coding.
How to Stop a Measurement

To stop an Error Ratio measurement:

- Click the Stop Measurement icon to stop the measurement.

Measurement Graph

Once you run an Error Ratio measurement for a specified duration, the calculated graph and the raw data is shown on the measurement graph as follows:

This graph displays the delta errored 1's ratio, delta errored 0's ratio, and total delta error ratio at data points over the entire accumulation period. The error ratios on the y-axis are set to a range of 1E+0 (100% errors) to 1E−12. The accumulation period is on the x-axis.
Display Change

During accumulation, data will appear to move from left to right on the ratios graph. When the graph is completely filling the display, the x-axis time scale will double. The data graph is then occupying only half of the display and will continue to move to the right again. This will repeat until the accumulation period has ended.

Measurement Data

The following figure shows the raw measurement data for the selected location.

<table>
<thead>
<tr>
<th>TimeStamp</th>
<th>Error Ratio</th>
<th>Compared Bits</th>
<th>Errord Bits</th>
<th>Error Zero Rate</th>
<th>Compared Zeroes</th>
<th>Error One Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:00:00:211</td>
<td>1.13e-08</td>
<td>1.06e+09</td>
<td>1.40e+01</td>
<td>7.64e-09</td>
<td>5.24e+08</td>
<td>4.00e+00</td>
</tr>
<tr>
<td>00:00:00:415</td>
<td>5.89e-09</td>
<td>1.02e+09</td>
<td>6.00e+00</td>
<td>9.89e-09</td>
<td>5.06e+08</td>
<td>5.00e+00</td>
</tr>
<tr>
<td>00:00:00:637</td>
<td>9.01e-09</td>
<td>1.11e+09</td>
<td>1.00e+01</td>
<td>1.27e-08</td>
<td>5.51e+08</td>
<td>7.00e+00</td>
</tr>
<tr>
<td>00:00:00:845</td>
<td>9.61e-09</td>
<td>1.04e+09</td>
<td>1.00e+01</td>
<td>7.75e-09</td>
<td>5.16e+08</td>
<td>4.00e+00</td>
</tr>
<tr>
<td>00:00:01:075</td>
<td>1.31e-08</td>
<td>1.15e+09</td>
<td>1.50e+01</td>
<td>8.78e-09</td>
<td>5.70e+08</td>
<td>5.00e+00</td>
</tr>
<tr>
<td>00:00:01:241</td>
<td>1.56e-08</td>
<td>8.33e+08</td>
<td>1.30e+01</td>
<td>1.94e-08</td>
<td>4.13e+08</td>
<td>8.00e+00</td>
</tr>
<tr>
<td>00:00:01:424</td>
<td>1.09e-08</td>
<td>9.16e+08</td>
<td>1.00e+01</td>
<td>1.32e-08</td>
<td>4.54e+08</td>
<td>6.00e+00</td>
</tr>
</tbody>
</table>

Test Times and Confidence Levels

A true Error Ratio measurement must be statistically valid. Because it is not possible to predict with certainty when errors will occur, your device must be tested long enough to have confidence in its Error Ratio performance.
Calculated Results

The following results are displayed when the bit coded patterns are loaded in Sequence Editor:

<table>
<thead>
<tr>
<th>Location</th>
<th>Show Graphics</th>
<th>Error Ratio</th>
<th>Compared Zeros</th>
<th>Error Zero Ratio</th>
<th>Error Ones</th>
<th>Error One Ratio</th>
<th>Compared Ones</th>
<th>Compared Bits</th>
<th>Error Ratio</th>
<th>Error Zero Ratio</th>
<th>Error One Ratio</th>
<th>Confdence Level@TargetErrorRatio</th>
</tr>
</thead>
<tbody>
<tr>
<td>M1.Data1</td>
<td>On</td>
<td>5.76e-12</td>
<td>1.74e+11</td>
<td>1.00e+00</td>
<td>0.00e+00</td>
<td>8.61e+10</td>
<td>0.00e+00</td>
<td>1.14e-11</td>
<td>8.75e+10</td>
<td>1.00e+00</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Errored Zeros**: Displays the number of errored zeros during the accumulation period.
- **Errored Ones**: Displays the number of errored ones during the accumulation period.
- **Error Bits**: Displays the number of errored bits during the accumulation period.
- **Compared Zeros**: Displays the number of compared zeros during the accumulation period.
- **Compared Ones**: Displays the number of compared ones during the accumulation period.
- **Compared Bits**: Displays the number of compared bits during the accumulation period.
- **Error Ratio**: Displays the ratio of the number of errors to the number of bits.
- **Error Zero Ratio**: Displays the ratio of the number of errors zero to the number of bits.
- **Error One Ratio**: Displays the ratio of the number of errors one to the number of bits.
- **Total Words**: Displays the total number of received sequencer words.
- **Frames**: Displays the number of frames received in a time interval.
- **Errored Frames**: Displays the number of errored frames received in a time interval.
- **Frame Error Ratio**: Displays the ratio of the number of frame errors to the number of frames received in the current (or last completed) accumulation period.
- **ConfidenceLevel@TargetErrorRatio**: Displays the percentage of confidence level achieved at specified target error ratio at certain point of time.


• **ErrorRatio@TargetConfidenceLevel**: Displays the number of error ratio achieved at specified confidence level at certain point of time.

• **Results**: Display the measurement result either **Pass** or **Fail**. It is only available when the “Accumulation End” is selected as “Pass/Fail”.

However, when the symbol coded patterns are loaded in **Sequence Editor**, the following results are displayed:

![Calculated Results Table]

- **Symbol Error Ratio**: Displays the symbol ratio of the number of errored symbols to the total number of symbols received.
- **Received Symbols**: Displays the total number of Received Symbol Count (all incoming symbols excluding incoming filler symbols) received in a time interval.
- **Compared Symbols**: Displays the number of compared symbols considered for the accumulation period.
- **Errored Symbols**: Displays the number of errored symbols measured during the accumulation period.
- **Illegal Symbol Ratio**: Displays the ratio of the number of Illegal Symbol count to the number of symbols received in the accumulation period.
- **Illegal Symbols**: Displays the total number of Illegal Symbols received in the accumulation period.
- **Filler Symbols Ratio**: Displays the ratio of total no of filler symbols to the number of symbols received during the accumulation period.
- **Filler Symbols**: Displays the total no of filler symbols received during the accumulation period.
- **Disparity Error Ratio**: Displays the ratio of the number of illegal disparity change count to the number of symbols received in the accumulation period.
- **Wrong Disparity**: Displays the total number of wrong disparity received in the accumulation period.
- **Error Ratio**: Displays the ratio of the number of errors to the number of bits.
- **Compared Bits**: Displays the number of compared bits during the accumulation period.
8 Working with Measurements

- **Errored Bits**: Displays the number of errored bits during the accumulation period.
- **ConfidenceLevel@TargetErrorRatio**: Displays the percentage of confidence level achieved at specified target error ratio at certain point of time.
- **Results**: Display the measurement result either Pass or Fail. It is only available when the “Accumulation End” is selected as “Pass/Fail”.
- **Total Words**: Displays the total number of received sequencer words.
- **Frame Error Ratio**: Displays the ratio of the number of frame errors to the number of frames received in the accumulation period.
- **Frames**: Displays the number of frames received in a time interval.
- **Errored Frames**: Displays the number of errored frames received in a time interval.
- **ErrorRatio@TargetConfidenceLevel**: Displays the number of error ratio achieved at specified confidence level at certain point of time.

The following results are displayed when an Error Ratio measurement is performed with PAM4 line coding:

- **Symbol Error Ratio**: Displays the symbol ratio of the number of errored symbols to the total number of symbols received.
- **Errored Symbols**: Displays the number of errored symbols considered for the accumulation period.
- **Compared Symbols**: Displays the number of compared symbols considered for the accumulation period.
- **Error Ratio**: Displays the ratio of the number of errors to the number of bits.
- **Compared Bits**: Displays the number of compared bits during the accumulation period.
- **Errored Bits**: Displays the number of errored bits during the accumulation period.
Error Ratio Measurement for a Group of Analyzers

The error ratio measurement can also be executed on a group of analyzers and combined result will appear in form of Graph, Data Tab and Calculated Results.

To run this, an Accumulation Stop Criteria parameter is available under Acquisition Parameters. It can be set as "Per Analyzer" or "Combined Analyzer".

- Per Analyzer - Graph, Data Tab and combined Calculated Results will not be visible.
- Combined Analyzer - Graph, Data Tab and combined Calculated Results will be visible.

This parameter will be only be available when a group is selected as an analyzer (if the group is having only one location, this will not be available to the user). Also, the availability of this parameter depends on "Accumulation End" parameter. If the "Accumulation End" is set as "Full Duration", it will not be available. However, the results for group of analyzers will be visible in the Calculated Results.

Follow the given steps to calculate combined results for an analyzer group:

1. Select the analyzer group.
2. Specify Accumulation End as "Pass/Fail" or "Number of Bits".
3. Specify Accumulation Stop Criteria as "Combined Analyzer".
4. Specify Accumulation Duration, Fixed Time and Interval.
5. In case the Accumulation End is selected as Pass/Fail, set Target Error Ratio and Target Confidence Level.
6. In case the Accumulation End is selected as Number of Bits, specify No. of Compared Bits.
7 Run the measurement.
8 The calculated results for the analyzer group will appear as shown in the following figure:
Output Timing Measurement

Overview

The Output Timing measurement is used to measure the timing and jitter behavior for a device under test (DUT). It uses a bit error rate (BER) measurement to evaluate the shape of the eye for the output signal of the DUT. It also analyzes the jitter, separates the random jitter and deterministic jitter components, and estimates the total jitter.

A direct result is the determination of the optimum sampling point delay for receiving data from the DUT with maximum confidence.

DUT Output Timing/Jitter includes the Fast Total Jitter measurement that can be used to measure the total jitter for devices which generate a very low error density in a reasonable time span.

Output Timing Characteristics

The sampling point is swept automatically within a 1.5 clock period to generate a “bathtub” curve. The resulting graph is centered around the optimum sampling point of the port.

In addition, the results are available in a tabular view. If a clock signal is defined, the software measures the data to clock alignment and displays the absolute delay.

Jitter Characteristics

The DUT Output Timing/Jitter measurement calculates the different components making up the jitter:

- Random Jitter (RJ)
- Deterministic Jitter (DJ)

Example Results

The following illustration shows the resulting graph of a typical DUT Output Timing measurement:
Understanding the Jitter Calculation

After the output timing behavior of the DUT is measured, the M8020A/M8030A calculates the different jitter components:
Random and Deterministic Jitter

To understand the RJ and DJ results, it is helpful to first understand how the software generates the results:

1. The bathtub curve is measured.

2. All measurement points that have BER between the BER Threshold and Minimum BER for RJ/DJ Separation are transformed into Q-space. The Q-factor describes the signal-to-noise ratio at the decision circuit.

3. Linear regression is performed for both the left and right edges.

4. The mean and sigma are calculated for both lines:
   - RJ is calculated as the mean of the two sigmas.
   - DJ is calculated as the period minus the difference of the two means.

5. The estimated TJ is calculated:
   - Linear regression is used to extrapolate the bathtub curve to lower BER values.
   - The intersections of the resulting lines with the Residual BER for RJ/DJ Separation are located.
   - The eye opening is calculated.
   - The estimated TJ is the period minus the width of the eye opening.
The following illustration shows a jitter curve where both RJ and DJ are present. It also shows how the TJ peak-to-peak and RMS are calculated.

Estimated Total Jitter

The Estimated Total Jitter (TJ) allows you to predict the jitter expected for very low bit error rates that would take a long time to measure. It is obtained by extrapolating the measured BER curves.

The TJ is estimated by extending the BER curves (based on the points detected between the BER Threshold and the Minimum BER for RJ/DJ Separation) to the Residual BER for RJ/DJ Separation level. The estimated TJ is the period minus the width of the measured eye.
Explanation of the Fast Total Jitter Measurement

The **Fast Total Jitter** measurement is an optimized method to determine the total jitter for devices that generate a very low error density (BER well below $10^{-10}$).

To measure (not estimate) the total jitter for a device with a BER of $10^{-12}$ with conventional methods, one usually needs to compare more than $10^{12}$ bits for each sample point. To measure a full eye opening this way with appropriate timely resolution takes time (maybe days or weeks, depending on the data rate), and the probability of seeing one or no error in $10^{12}$ bits is not higher than 37%.

If one would compare $10^{13}$ bits for the same device, the probability of seeing ten errors is even lower (12%), but the probability of observing no error is almost zero.

The **Fast Total Jitter** measurement implements a method that reduces the measurement time considerably and provides a higher accuracy. It is based on statistical and probability calculations.
Measurement Duration

The duration of a Fast Total Jitter measurement depends on:
- the BER threshold
- the bit rate
- the sample delay step size
- the contribution of random jitter
- the contribution of deterministic jitter

Compared to a conservative bathtub measurement, the Fast Total Jitter measurement can reduce the measurement time by more than a factor of 40.

Typical test times are approximately 20 minutes at 10 Gbit/s and slightly more than one hour at 2.5 Gbit/s for a measurement at the 10^{-12} BER threshold with an overall confidence level better than 90%.

Acquisition Parameters

You can use the Properties window to specify the following acquisition parameters:

Set the criteria for moving to the next sample point:
- Number of Compared Bits
  After this number of compared bits, the measurement stops for the current sample point and moves to the next one.
- Number of Errors
  After this number of errors, the measurement stops for the current sample point and moves to the next one. This allows you to speed up the measurement. You can switch off this option if only the number of compared bits is important.

Set the criteria for the sample delay:
- Sample Delay Resolution
  Specifies the time distance between sampling points. A smaller value yields more sampling points in a unit interval. You can enter the resolution in UI.
  If the resolution used for the measurement is not high enough, the bathtub curve does not clearly show the edges. For example, you may wish to change the Resolution from 0.01 to 0.005 and run the measurement again.
- Sample Delay Optimization
  You can choose between Fast Total Jitter at BER or None.
• Fast Total Jitter at BER
  This enables the Fast Total Jitter measurement. Before enabling this measurement, you need to know the BER floor of the device and to specify a BER threshold that is above that floor.

Evaluation Parameters

You can use the Properties window to specify the following evaluation parameters:

• Analyze Errors
  You can analyze for:
  - All Errors
    To calculate the BER values from all bits/errors.
  - Errored Zeros
    To calculate the BER values if "0" is expected, but "1" received.
  - Errored Ones
    To calculate the BER values if "1" is expected, but "0" received.

• BER Threshold
  To calculate the parameters for the given BER threshold. This is the BER level for which output timing numerical values (phase margin, skew, etc.) are calculated. It is also the upper limit of the BER range for RJ/DJ separation.
  The BER threshold influences some of the parameters of the DUT Output Timing measurement. You can also drag and drop the horizontal BER threshold in the graphical display to change this value.

• Min BER for RJ/DJ Separation
  Lower limit of the BER range for RJ/DJ separation.

• Residual BER for Estimated Total Jitter
  BER level for which the estimated total jitter is calculated.

• Display Unit
  Choose between Unit Interval and Seconds to select the timebase for the display's x-axis.

• Vertical Axis Scale
  Choose between Logarithmic and Linear to select the scale for the display's y-axis.
  For example, a DUT Output Timing measurement displayed on a linear scale may look like this:
- Show Measured Points

If you want to see the points that have actually been measured, click the Show Measured Points slide button.
Launching the Output Timing Measurement

To launch the Output Timing user interface:

- Go to the Menu Bar > Measurements and then select Output Timing.

The Output Timing user interface will appear as shown in the following figure:

The Output Timing user interface includes the following elements:

- **Toolbar**: For details, refer to Toolbar on page 462
- **History Pane**: For details, refer to Measurement History Window on page 463.
- **Measurement Graph**: For details, refer to Measurement Graph on page 490
- **Parameters Window**: For details, refer to Parameters Pane on page 488.
- **Calculated Results**: For details, refer to Calculated Results on page 491.
Parameters Pane

The **Parameters** window shows the acquisition parameters and evaluation parameters for output timing measurement.

**Table 66**

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Acquisition Parameters</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Acquisition Location</td>
<td>Location or Location Group against which the data acquisition is performed.</td>
<td></td>
</tr>
<tr>
<td>Sample Delay</td>
<td>Specify the sample delay resolution.</td>
<td>Min - 5 mUI</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Max - 200 mUI</td>
</tr>
<tr>
<td>Sample Delay Optimization</td>
<td>Specify the sample delay optimization.</td>
<td>None</td>
</tr>
<tr>
<td>Fast Total Jitter at BER</td>
<td>Specifies the Fast Total Jitter BER. This is a conditional parameter and appear when <strong>Sample Delay Optimization</strong> is selected as “Fast Total Jitter”</td>
<td>Min - 1E-15</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Max - 1E-9</td>
</tr>
<tr>
<td>No. of Compared Bits</td>
<td>Specify the criteria for moving to the next measurement and is only enabled when the <strong>Sample Delay Optimization</strong> is “None”.</td>
<td>Min - 1 E+0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Max - 1E+18</td>
</tr>
<tr>
<td>Enable Number of Errors</td>
<td>Use the slide switch to enable this property.</td>
<td>ENABLE</td>
</tr>
<tr>
<td>Number of Errors</td>
<td>Specify the criteria for moving to the next measurement and is only enabled when the <strong>Sample Delay Optimization</strong> is “None”. This parameter gets enabled when you enable the “Enable Number of Errors”.</td>
<td>Min - 1 E+0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Max - 1E+18</td>
</tr>
<tr>
<td><strong>Evaluation Parameters</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BER Threshold</td>
<td>Specify the BER threshold</td>
<td>Min - 1E-15</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Max - 1E-1</td>
</tr>
<tr>
<td>Min BER for RJ/DJ Separation</td>
<td>Specifies the minimum BER for random and deterministic jitter components separation.</td>
<td>Min - 1E-18</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Max - 1E-0</td>
</tr>
<tr>
<td>Residual BER for Estimated Total Jitter</td>
<td>Specify the residual BER for estimated total jitter.</td>
<td>Min - 1E-12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Max - 1E-6</td>
</tr>
</tbody>
</table>
How to Run Output Timing Measurement

To run an Output Timing measurement, perform the following steps:

- Use the Parameters window to select the location or location group for which the data acquisition has to be performed.

- Set the acquisition and evaluation parameters for Output Timing in the Parameters Window. For details, refer to Acquisition Parameters on page 484 and Evaluation Parameters on page 485.

- Click the Start Measurement icon to run the measurement. The measurement status indicator will indicate Running.

How to Stop Output Timing Measurement

To stop a measurement:

- Click the Stop Measurement icon to stop the measurement.
Measurement Graph

Once you run an **Output Timing** measurement for a specified duration, the following graph is shown on the measurement graph:

The bathtub curve in the graph shows the overall jitter distribution over a unit interval and serves as the basis for bit error rate estimation.

How an Output Timing Measurement Works

The sampling point is swept automatically within a 1.5 clock period to generate a “bathtub” curve. The resulting graph is centered around the optimum sampling point.

The BER Bathtub graph plots TJ (Total Jitter) data and BER values across an entire bit period, which is labeled as the unit interval (UI) on the horizontal axis. BER values are calculated using DJ and RJ and are used to extrapolate to low BER levels. In general, the BER values will differ from the measured TJ values at high probabilities, but the two should converge at low probabilities. Jitter can be measured by moving the sampling point across the eye pattern into the crossing region step by step.
The sampling point—the amplitude decision threshold and the time at which the bits are measured—is scanned across the eye pattern over the time period while monitoring the BER. The bathtub curve can also be used to separate random from the deterministic jitter.

The slope of the bathtub curve is the measure of the random jitter, whereas the slope offset positions on the time axis are set by deterministic jitter. Total jitter is quantified by noting points where BER reduces to at both the eye edges and subtracting this interval from the bit period.

**Calculated Results**

The calculated results for the **Output Timing** measurement are displayed in the tabular format. It includes the following elements:

- **Location**: Location or Location/Group against which the data acquisition is performed.
- **Show Graphics**: Displays the measurement graph in the measurement output window.
- **Optimal Sample Delay**: Sample delay coordinate of the center of a bounding box around the BER threshold contour line.
- **Phase Margin**: Period of time where the bit error rate is lower than the BER threshold.
- **Total Jitter Peak-to-Peak**: Peak-to-peak value for total jitter. Calculated as the pulse period (unit interval) minus the Phase Margin.
- **Total Jitter RMS**: The average of the left and right jitter histogram root mean squared values.

- **Jitter Mean**: Mean value for total jitter. Calculated as the weighted average of the left edge jitter histogram.

- **Random Jitter RMS**: The total jitter component with Gaussian distribution. After transforming a contiguous range of measured points into Q space and performing a linear regression, it is calculated as the mean of the sigmas of the two straight lines. The contiguous range is limited by the BER Threshold and the Min. BER for RJ/DJ Separation threshold.

- **Deterministic Jitter**: The total jitter component with non-Gaussian distribution. After transforming a contiguous range of measured points into Q space and performing a linear regression, it is calculated as the period minus the difference between the means of the two straight lines.

- **Estimated Total Jitter**: A forecast of the expected jitter for very low bit error rates. After extrapolating the measured BER curves, it is calculated as the period minus the expected width of the eye opening.

- **Left Edge No. Points**: The number of points that has been measured between the BER Threshold and the Min. BER for RJ/DJ Separation threshold. It is displayed for both slopes. This number has to be greater than 2 for the RJ, DJ, and estimated TJ values to be applicable.

- **Left Edge R^2**: The R^2 values are calculated for both slopes of the bathtub curve. They are a measure of how well the transformed points between BER Threshold and Min. BER for RJ/DJ Separation fit to the linear regression. They have to be greater than 0.75 for the RJ, DJ, and estimated TJ values to be applicable.

- **Right Edge No. Points**: The number of points that has been measured between the BER Threshold and the Min. BER for RJ/DJ Separation threshold. It is displayed for both slopes. This number has to be greater than 2 for the RJ, DJ, and estimated TJ values to be applicable.

- **Right Edge R^2**: The R^2 values are calculated for both slopes of the bathtub curve. They are a measure of how well the transformed points between BER Threshold and Min. BER for RJ/DJ Separation fit to the linear regression. They have to be greater than 0.75 for the RJ, DJ, and estimated TJ values to be applicable.
Fast Total Jitter Measurement Results

The Fast Total Jitter measurement provides both graphical and numerical results:

The example below shows a copied result, and the display of measured points was enabled.

The results of the recent measurement are disabled, because they refer to a standard "bathtub" measurement that provides many more results. By actuating the Show indicator, you can inspect both alternatively.

The resulting graph shows you the points in time that have been investigated and whether the actual BER at these points was higher or lower than the BER threshold specified for the measurement.

For coded patterns, the Fast Total Jitter measurement will only work when the bit recovery mode is enabled.

Calculated Results for Fast Total Measurement

The calculated results for the Fast Total Jitter measurement are displayed in the Calculated Results pane. It includes the following elements:

- **Location**: Location or Location/Group against which the data acquisition is performed.
- **Show Graphics**: Displays the measurement graph in the measurement output window.

- **Optimal Sample Delay**: The mean value of the left and right bathtub/Total Jitter BER Threshold intersections.

- **Phase Margin**: The period of time where the bit error rate is lower than the Total Jitter BER Threshold.

- **Total Jitter Peak-Peak**: Peak-to-peak value of the total jitter. Calculated as the pulse period (unit interval) minus the Phase Margin at the Total Jitter BER Threshold.

- **Total Jitter Uncertainty**: Displays the total jitter uncertainty.
Output Level Measurement

Overview

The **Output Levels** measurement allows you to characterize the behavior of the output levels of a device under test (DUT). The sampling delay is fixed. The analyzer's decision threshold is automatically swept within a user-defined range.

A direct result is the determination of the optimum decision threshold level for receiving data from the DUT with maximum confidence.

Launching the Output Level Measurement

To launch the **Output Level** user interface:

- Go to the **Menu Bar > Measurements** and then select **Output Level**.

The **Output Level** user interface will appear as shown in the following figure:
The **Output Level** user interface includes the following elements:

- **Toolbar**: For details, refer to Toolbar on page 462.
- **History Pane**: For details, refer to Measurement History Window on page 463.
- **Measurement Graph**: For details, refer to Measurement Graph on page 490.
- **Parameters Window**: For details, refer to Parameters Window on page 496.
- **Calculated Results**: For details, refer to Calculated Results on page 503.

**Parameters Window**

The **Parameters** window have the following acquisition, evaluation and show parameters for output level measurement.

**Acquisition Parameters**

- **Analyzer**: Specifies location/location group against which data acquisition is performed.
• **Resolution**: Specifies the distance between the sampling points. The lower this value is, the more sampling points you have in the selected voltage range. The minimum step width is hardware-dependent. At the time being, the minimum is 1 mV.

• **Low Level**: This is the lower end of the measured voltage range.

• **High Level**: This is the upper end of the measured voltage range.

• **Number of Compared Bits**: After this number of compared bits, the measurement stops for the current sample point and moves to the next one.

• **Number of Errors**: After this number of errors, the measurement stops for the current sample point and moves to the next one. This allows you to speed up the measurement. You can switch off this option if only the number of compared bits is important.

**Evaluation Parameters**

• **BER Threshold**: This is the bit error rate threshold at which the Threshold Margin is determined. It is also the upper threshold for the Q-factor calculations. The BER Threshold is displayed in the BER vs. Threshold graph.

• **Min BER for Q**: This is the lower threshold for the Q-factor calculations.

**Show Graphics View**

**BER vs. Threshold Graph**: This graph shows the relationship between the analyzer decision threshold and the measured BER.
The BER considers all errors. It is calculated as:

\[
\text{BER}_{\text{All Errors}} = \frac{\sum \text{Error } 1s + \sum \text{Error } 0s}{\text{(total # of Bits)}}
\]

- **QBER vs. Threshold Graph**: This graph shows the extrapolation of the optimum Q-factor and the optimum threshold level from a limited number of measured points.
  The measured data points to be used for the calculation have to be within a contiguous BER range. This range is defined by specifying the Min BER for Q (lower threshold) and the BER Threshold (upper threshold). Both thresholds can be set in the lower section of the View tab.
  The Q-factor can only be calculated if for both high and low level rails two or more points fall within the defined BER range. For reliable results use at least five measured points.
  To ensure proper settings, enable the **Show Measured Points** function and switch to the **BER vs. Threshold** graph. Move the upper BER threshold marker (vertical line) so that a sufficient number of measured points is included for the calculation:
This graph illustrates the calculation of the Q-factor as the best fit line through the calculated points.

![Graph illustrating Q-factor calculation](image)

**Changing the Measurement Setting**

- If you change the acquisition settings through **Parameter** window after the measurement has been run, please note that the changes on the parameters tab will take only effect if you run the measurement again.
- However, if you change the parameters that change the display of the measured data (graphics, show measurement points and axis scale), there is no need to repeat the measurement.

**Available Views**

The **Output Levels** measurement provides three different graphical views to visualize the calculated results:

- **BER versus Threshold:**
  This graph shows the relationship between the analyzer decision threshold and the resulting BER. It presents the raw data.

- **Q from BER versus Threshold:**
  This graph shows the extrapolation of the Q-factor and the optimum threshold level from a limited number of measured points.
How to Execute Output Level Measurement

To run an Output Level measurement, perform the following steps:

- Use the Parameters window to select the location or location group for which the data acquisition has to be performed.

- Set the acquisition and evaluation parameters for Output Level in the Parameters Window. For details, refer to Parameters Window on page 496.

- Click Start Measurement icon to execute the measurement. The measurement status indicator will indicate Running.

How to Stop Output Level Measurement

To stop a measurement:

- Click Stop Measurement icon to stop the measurement.

Measurement Graph

The Measurement Graph displays the absolute values of the derivative of the bit error rates over the thresholds (dBER/dTh). It visualizes the data that forms the basis for the calculations of the level and noise values.

The Output Level measurement provides Q from BER versus Threshold graph. This graph refers to the Q-factor calculations.

The following illustration shows the BER versus Threshold graph of a simple Output Level measurement:
The **Measurement Graph** contains the following tabs:

- **Graph**: Displays the graphical representation of the measurement. The graph varies from measurement to measurement. The details of each measurement graph are further described in their respective sections.

- **Location**: Displays the raw measurement data for that location. However, if you are running measurement for a group, multiple tabs will appear that display the raw measurement for each location.

When you right-click on the **Measurement Graph**, a context menu appears which provides the following options:

- **Turn ON/OFF Fit to view (Ctrl+Home)** - Turns ON/OFF Fit to view option.

- **Fit to view (Home)** - Makes the visible area fit to display entire contents.

- **Copy screenshot (F11)** - Copies the screenshot of charts to clipboard.

- **Save screenshot (Ctrl+S)** - Saves the screenshot as an image (PNG) under a name.
How to Improve the Output Levels Display

You can consider the following points to change the display of an existing measurement:

- **Measurement Points**: If you wish to see more details to investigate the graph, select `Show Measured Points` on the `Graph` option of the `Properties` window. With this option selected, all measured points are indicated in the graph with small squares.

- **Zoom**: Several zoom factors are available. When you show the zoom graph, you can also allow the zoom graph to track the mouse.

- **Scale**: Choose between `Logarithmic` and `Linear` to select the scale for the displays x-axis. The scale of the **QBER vs. Threshold** graph is always linear.

- **Graph Context Menu**: When you right-click on the Measurement Graph, a context menu appears which provides the options such as fit to view, copy and save screen shot and quick help of dynamic display.

How to Change the Output Levels Properties

In the example measurement, we have set the focus on speed: 100 threshold levels and 1,000,000 compared bits per measuring point. You may wish to obtain more precise results.

1. Switch to the **Parameters** window.
2. Increase the **Number of Compared Bits** to 100,000,000.
   Remember: One failure per 1 million bits yields a BER resolution of 10^-6. One failure per 100 million bits yields a BER resolution of 10^-8.
3. Decrease the **Sample Threshold Resolution** to 2mV.
   This gives us 500 steps per Volt.
4. Press the **Start Measurement** icon to repeat the measurement with the new parameters.

The measurement now takes more time than the previous, but it is also much more precise.
Calculated Results

The following figure illustrates the calculated results:

The calculated results are divided into three groups:
- Level Results
- Noise Results
- Q-factor Results

Level Results

The level results are defined as follows:
- **High Level**: The High Level is the mean of the upper dBER/dTh distribution. It is calculated as:

\[
\text{Mean} = \frac{\sum (\text{dBER} \cdot \text{threshold})}{\sum \text{dBER}}
\]
Working with Measurements

- **Low Level**: The Low Level is the mean of the lower dBER/dTh distribution. It is calculated as:

$$\text{Mean} = \frac{\sum (d\text{BER} \cdot \text{threshold})}{\sum d\text{BER}}$$

- **Mean Level**: The Mean Level is the middle between the High and Low Levels, calculated as:

$$\text{Mean Level} = \frac{\text{Low Level} + \text{High Level}}{2}$$

- **Amplitude**: The Amplitude is the difference between its High and Low Levels.

- **Threshold Margin**: The Threshold Margin is the distance between the upper and the lower BER curves at the position given by the BER Threshold setting.

**Noise Results**

The noise parameters are defined as follows:

- **High Level Std. Dev.**: The standard deviations are derived from the dBER/dTh histogram.

The High Level Standard Deviation is calculated as:

$$\text{StdDev} = \sqrt{\frac{\sum (\text{threshold} - \text{Mean})^2 \cdot d\text{BER}}{\sum d\text{BER}}}$$

where Mean is the High Level of the terminal.

- **Low Level Std. Dev.**: The Low Level Standard Deviation is calculated as:

$$\text{StdDev} = \sqrt{\frac{\sum (\text{threshold} - \text{Mean})^2 \cdot d\text{BER}}{\sum d\text{BER}}}$$

where Mean is the Low Level of the terminal.
• **Peak Peak Noise**: The peak-to-peak Noise is calculated as:

\[
\text{Peak Peak Noise} = \text{HighLevel} - \text{LowLevel} - \text{Threshold Margin}
\]

Note that the **Threshold Margin** depends on the position of the BER Threshold.

• **Signal/Noise Ratio (RMS)**: The RMS Signal-to-Noise Ratio is calculated as:

\[
\text{SNR (RMS)} = \frac{\text{HighLevel} - \text{LowLevel}}{\text{StdDev 1} + \text{StdDev 0}}
\]

• **Signal/Noise Ratio (Peak Peak)**: The peak-to-peak Signal-to-Noise Ratio is calculated as

\[
\text{SNR (PeakPeak)} = \frac{\text{HighLevel} - \text{LowLevel}}{\text{PeakPeakNoise}}
\]

Note that the **Peak-to-Peak Noise** depends on the position of the BER Threshold.

**Q Factor Results**

The numerical Q-factor parameters are defined as follows:

• **Q Factor**: The Q-factor is calculated as:

\[
Q = \frac{\mu_1 - \mu_0}{\sigma_1 + \sigma_0}
\]

where \(\mu_{1,0}\) is the mean level of the 1 and 0 rails, respectively, and \(\sigma_{1,0}\) is the standard deviation of the noise distribution on the 1 and 0 rails.
• **Q Optimum Threshold**: The Q Optimum Decision Threshold is calculated as:

$$\text{Optimum Decision Threshold} = \frac{\sigma_0 \mu_1 + \sigma_1 \mu_0}{\sigma_1 + \sigma_0}$$

• **Q Residual BER**: The Q Residual BER is the expected BER at the Optimum Decision Threshold. It is calculated as:

$$\text{BER} = \frac{e^{-(Q^{1/2})}}{Q_{opt}/\sqrt{2\pi}}$$

Numbers below 1e-255 are expressed as zero.

• **Q High Level**: The Q High Level is the mean, calculated from the linear regression curve for the high level data:

$$\mu = \frac{-A}{B}$$

• **Q High Level Std.Dev**: The Q High Level Standard Deviation is the $\sigma$ (Sigma), calculated from the linear regression curve for the high level data:

$$\sigma = \left| \frac{1}{B} \right|$$

• **Q High Level Nr. Points**: This is the number of data points used for the calculation of the Q High Level value. It depends on the setting of the BER Threshold and also on the setting of the Min BER for Q parameter. The minimum for calculating Q-factor values is two points. It is recommended to use more than 5 points.

• **Q High Level R^2**: The $R^2$ parameter is an indicator that shows how well the converted data points fit to the straight line. It is calculated as:
The $R^2$ parameter should be examined before trusting the Q-values. Its maximum value is 1.0. It must be seen in conjunction with the number of data points.

For example: Two data points always fit perfectly well, but the resulting Q-factor calculations are not reliable. On the other hand, 50 data points may reveal a poor $R^2$ value. This tells you that the linearization is prone to errors.

If the $R^2$ value falls below 0.75, the Q-factor calculations are not applicable.

- **Q Low Level**: The Q Low Level is the mean, calculated from the linear regression curve for the low level data:

$$\mu = \frac{-A}{B}$$

- **Q Low Level Std.Dev**: The Q Low Level Standard Deviation is the $\sigma$ (Sigma), calculated from the linear regression curve for the low level data:

$$\sigma = \left| -\frac{1}{B} \right|$$

- **Q Low Level Nr. Points**: This is the number of data points used for the calculation of the Q Low Level value. It depends on the setting of the BER Threshold and also on the setting of the Min BER for Q parameter.

  The minimum for calculating Q-factor values is two points. It is recommended to include more than 5 points.

- **Q Low Level R^2**: The $R^2$ value can also be seen as an indicator of how well the noise distribution fits to Gaussian shape. It will not fit, for example, if the received signal is dominated by cross-talk or modal noise.
Jitter Tolerance Measurement

Overview

A **Jitter Tolerance** measurement is used to determine the ability of a device or system to maintain communication quality in the presence of jitter. It comes in two varieties:

- **Jitter Tolerance Characterization** determines the jitter levels where the device under test can no longer maintain a desired bit error ratio (BER).
- **Jitter Tolerance Compliance** verifies that the device under test is able to maintain a BER level at pre-defined jitter levels and jitter frequencies, as defined by a standard.

The basic setup of a jitter tolerance test is illustrated below:

![Jitter Tolerance Setup Diagram](image)

Understanding Jitter Tolerance

The behavior and the passed/failed classification of data receiving devices or circuits are determined by their ability to withstand:

- Jitter
- Intersymbol interference
- Level noise

This refers particularly to the performance of phase-locked loops (PLLs) or clock data recovery circuits (CDR).
Jitter tolerance can be measured by applying a distorted data signal to the DUT and measuring the resulting bit error ratio. To make jitter tolerance tests reproducible, the signal distortion must also be reproducible. This requires some definitions.

**Jitter**

Receivers react differently on
- different types of jitter
- the jitter composition
- the jitter frequency spectrum
- the combination of jitter frequencies and data rate

Various test standards specify the jitter composition to be used for jitter tolerance tests.

The M8020A/M8030A provides the following means for generating artificial (reproducible) jitter:
- Two types of voltage-controlled signal delay lines
- A phase shifter for modulating the generated clock

**Intersymbol Interference**

Conductors on PC boards have a limited bandwidth. This causes intersymbol interference which changes the shape of the received eye opening. The eye becomes asymmetrical.

**Level Noise**

Level noise affects the voltage amplitude of the eye opening.

PLL Performance Test Testing a PLL (or CDR) is not complete until the entire frequency range of the PLL has been checked under worst-case conditions.

For this purpose, the M8020A/M8030A provides the Jitter Tolerance Characterization measurement.

**PLL Standards and Compliance Tests**

The Optical Internetworking Forum (OIF) as well as other institutions have proposed standards for testing the performance of data receivers and receiver circuits in the presence of jitter.

For this purpose, the M8020A/M8030A provides the Jitter Tolerance Compliance measurement.
Types of Jitter

The standards for jitter tolerance tests prescribe combinations of certain jitter types. This section gives an overview of these types.

Random Jitter

Random jitter (RJ) is always present. Resistors, transistors, and other components generate noise that impacts transmitters and receivers.

This kind of jitter has a Gaussian distribution over time.

Bounded Uncorrelated Jitter

Similar to random jitter, bounded uncorrelated jitter (BUJ) has also a Gaussian distribution, but this distribution is cut (bounded) at both sides.

This kind of jitter can be caused, for example, by crosstalk on a parallel bus or by intersymbol interference of random or long pseudo random binary bit sequences.

To simulate bounded uncorrelated jitter for jitter tolerance tests, it can be generated from a filtered (frequency-limited) PRBS.

Periodic Jitter

Periodic jitter (PJ) is generally picked up from other periodic sources.

- **Rectangular Jitter**: Rectangular jitter may be caused, for example, by a switching power supply. The jitter amplitude is usually specified in UI. One UI (Unit Interval) is always the reciprocal of the present data rate.

- **Sinusoidal Jitter**: This kind of jitter can be picked up from any adjacent signal or clock. The jitter histogram has a U-shape.

- **Triangular Jitter**: Triangular jitter is always generated by a spread spectrum clock but can also be caused by other periodic sources. Triangular jitter has a uniform jitter distribution.

Intersymbol Interference

Intersymbol interference (ISI) is caused by bandwidth limitations of cables and backplanes. It cuts off higher frequencies and hence changes the shape of the eye opening.

Intersymbol interference can be simulated by inserting a defined transmission path between the Generator and the DUT.
Crosstalk

Crosstalk between adjacent signal paths modulates the vertical eye amplitude. This narrows the voltage range of the receiver needed for capturing data correctly.

For jitter tolerance tests, amplitude modulation is most often simulated by modulating the data output with a sinewave signal. This is called Sinusoidal Interference (SI).

Total Jitter

Total jitter is the sum of all kinds of jitter.

BER Setup

Table 67  BER setup description

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Rate</td>
<td>Displays the Data Rate for the measurement.</td>
</tr>
<tr>
<td>Target BER</td>
<td>Sets the required target BER. The default is 1.0E-09.</td>
</tr>
<tr>
<td>Confidence Level</td>
<td>Confidence Level = 1 – exp(-data rate * gate time * measurement depth)</td>
</tr>
<tr>
<td>Frequency Relax Time</td>
<td>Sets the amount of time to pause the measurement after a change in jitter modulation frequency.</td>
</tr>
<tr>
<td>Amplitude Relax Time</td>
<td>Sets the amount of time to pause the measurement after a change in jitter modulation amplitude.</td>
</tr>
</tbody>
</table>

Graph Setup

Table 68  Graph setup description

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template Limits</td>
<td>Show/hides the maximum and minimum jitter amplitude limits in the graph.</td>
</tr>
<tr>
<td>Template Points</td>
<td>Show/hides the template points in the graph.</td>
</tr>
<tr>
<td>Compliance Limits</td>
<td>Show/hides the compliance curve in the graph.</td>
</tr>
</tbody>
</table>
### Instrument Setup

**Table 69** Instrument setup description

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generator</td>
<td>The Generator drop down list box shows all available Data Out locations that are used as a data source. A generator must be specified to perform the measurement.</td>
</tr>
<tr>
<td>Analyzer</td>
<td>The Analyzer drop down list box shows all available Data In locations that are used for data acquisition. A detector must be specified to perform the measurement.</td>
</tr>
</tbody>
</table>

### Measurement Setup

**Table 70** Measurement setup description

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measurement Template</td>
<td>Click the <code>Open</code> icon to open the Jitter Tolerance Measurement template.</td>
</tr>
<tr>
<td>Start Frequency</td>
<td>Sets the start frequency of the Jitter Tolerance Measurement.</td>
</tr>
<tr>
<td>Stop Frequency</td>
<td>Sets the stop frequency of the Jitter Tolerance Measurement.</td>
</tr>
<tr>
<td>Num Points</td>
<td>Sets the number of measurement points.</td>
</tr>
<tr>
<td>Mode</td>
<td>Sets the Jitter Tolerance Measurement mode. The options are Compliance or Characterization. In Characterization mode you have to set the search algorithms. For details, refer to Characterization on page 513. To set Compliance margins, see Compliance Margin on page 518.</td>
</tr>
<tr>
<td>Step Size</td>
<td>Sets the step size for characterization algorithms. The option are Binary Step Size, Linear Step Size and Log Step Size. For details, see Step Size on page 517.</td>
</tr>
<tr>
<td>CDR LBW Auto</td>
<td>Automatically sets the external CDR Loop Bandwidth.</td>
</tr>
</tbody>
</table>
Characterization

Table 71  Characterization

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Algorithm</td>
<td>Search algorithms apply to characterization measurements only.</td>
</tr>
</tbody>
</table>

Binary

The Binary algorithm uses a variable step size to find the highest passing SJ amplitude at each SJ frequency in the template. Starting at the maximum SJ amplitude determined by the upper limit in the template file or the instrument limit, whichever is lower, followed by the minimum SJ amplitude determined by the lower limit in the template file, the Binary algorithm then sets subsequent SJ amplitudes at the logarithmic midpoint between the highest passing and lowest failing SJ amplitudes. A test point is determined to be a passing point if the BER measured is below the BER threshold set by the user.

The equation for the midpoint \( c \) between points \( a \) and \( b \) on a log scale is:

\[ c = 10^{\frac{\log(a) + \log(b)}{2}}. \]

The algorithm exits if the channel is tolerant of the maximum jitter amplitude or is intolerant of the minimum jitter amplitude. Otherwise, the algorithm continues until the last step size is less than the minimum step size set by the user for Binary algorithms.

The jitter tolerance result at each jitter modulation frequency is the highest jitter amplitude at which the measurement was made below the threshold BER. However, if the device is intolerant of even the minimum jitter value, the result is not valid and is not plotted.

In many cases, the Binary algorithm is the quickest. However, devices with hysteresis may not have consistent results when using the Binary algorithm since the approach direction (up vs. down) will cause the result to vary. This occurs because the PLL in the clock data recovery unit will typically hold lock longer as the jitter is increased, then it would establish lock as the jitter is reduced. For example, a receiver may have a higher passing SJ amplitude when the previous step was a lower (passing) SJ amplitude, compared to a lower passing SJ amplitude when the previous step was a higher (failing) SJ amplitude. If this is a problem, see the Binary + Down Linear and Binary + Up Linear algorithms.
The following is an example of the Binary algorithm. At a single SJ frequency, if the true pass/fail SJ amplitude is 0.7 UI, the minimum step size is 0.1 UI, the template minimum is 0.1 UI, and the template maximum is 1.0 UI, then the binary algorithm would follow these test points:

1. Template maximum 1.0 UI - FAIL
2. Template minimum 0.1 UI - PASS
3. Log midpoint between 1.0 UI (FAIL) and 0.1 UI (PASS) = 0.32 UI - PASS
4. Log midpoint between 1.0 UI (FAIL) and 0.32 UI (PASS) = 0.57 UI - PASS
5. Log midpoint between 1.0 UI (FAIL) and 0.57 UI (PASS) = 0.75 UI - FAIL
6. Log midpoint between 0.75 UI (FAIL) and 0.57 UI (PASS) = 0.65 UI - PASS
7. Log midpoint between 0.75 UI (FAIL) and 0.65 UI (PASS) = 0.70 UI - PASS
8. Last step size < 0.1 UI, highest passing SJ amplitude is 0.70 UI

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary + down linear</td>
<td>The Binary + Down Linear algorithm is the same as the Binary algorithm followed by the Down Linear algorithm. Refer to the descriptions for Binary and Down Linear in this table.</td>
</tr>
<tr>
<td>Binary + up linear</td>
<td>The Binary + Up Linear algorithm is the same as the Binary algorithm followed by the Up Linear algorithm. Refer to the descriptions for Binary and Up Linear in this table.</td>
</tr>
<tr>
<td>Down linear</td>
<td>The Down Linear search algorithm starts at the maximum jitter value determined by the template. If a BER measurement has errors above the measurement threshold, the jitter amplitude is adjusted lower by the linear step size. This algorithm exits when the BER is measured below the measurement threshold BER, or if the last amplitude measurement point was at the minimum jitter value in the template. The jitter tolerance result at each jitter modulation frequency is the highest jitter amplitude at which the measurement was made below the threshold BER. However, if the device is intolerant of even the minimum jitter value, the result is not valid and is not plotted.</td>
</tr>
</tbody>
</table>
### Working with Measurements

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Down logarithmic</strong></td>
<td>The Down Logarithmic search algorithm starts at the maximum jitter value determined by the template. If a BER measurement has errors above the measurement threshold, the jitter amplitude is adjusted lower by the coefficient calculated from the logarithmic step size. For example, if the coefficient is 10%, then the next amplitude equals the previous amplitude minus 10% of the previous amplitude. This algorithm exits when the BER is measured below the measurement threshold BER, or if the last amplitude measurement point was at the minimum jitter value in the template. The jitter tolerance result at each jitter modulation frequency is the highest jitter amplitude at which the measurement was made below the threshold BER. However, if the device is intolerant of even the minimum jitter value, the result is not valid and is not plotted.</td>
</tr>
<tr>
<td><strong>Up linear</strong></td>
<td>The Up Linear search algorithm starts at the minimum jitter value determined by the template. If a BER measurement has errors below the measurement threshold, the jitter amplitude is adjusted higher by the linear step size. This algorithm exits when BER is measured above the measurement threshold BER, or if the last amplitude measurement point was at the max jitter value in the template. The jitter tolerance result at each jitter modulation frequency is the highest jitter amplitude at which the measurement was made below the threshold BER. However, if the device is intolerant of even the minimum jitter value, the result is not valid and is not plotted.</td>
</tr>
<tr>
<td><strong>Up logarithmic</strong></td>
<td>The Up Logarithmic search algorithm starts at the minimum jitter value determined by the template. If a BER measurement has errors below the measurement threshold, the jitter amplitude is adjusted higher by the coefficient calculated from the logarithmic step size. For example, if the coefficient is 10%, then the next amplitude equals the previous amplitude plus 10% of the previous amplitude. This algorithm exits when the BER is measured above the measurement threshold BER, or if the last amplitude measurement point was at the maximum jitter value determined by the template. The jitter tolerance result at each jitter modulation frequency is the highest jitter amplitude at which the measurement was made below the threshold BER. However, if the device is intolerant of even the minimum jitter value, the result is not valid and is not plotted.</td>
</tr>
</tbody>
</table>
Up Log + Linear | The Up Log + Linear search algorithm performs the same algorithm as Up Logarithmic, but in addition, it returns to the last passing amplitude and steps linearly up until it reaches a fail point. The algorithm continues to increase the SJ amplitude until failure, even if it surpassed the original failed point.

Adaptive Binary | The adaptive binary algorithm is a combination of an up logarithmic search and a binary search. The initial search at the start frequency uses the logarithmic step size for the upwards search and switches to a binary search when the first failed measurement point is found. The binary search is reducing the step size until it becomes smaller as the defined binary step size. For all following jitter frequencies, the search starts at the last known pass amplitude. This algorithm is most efficient when the search is configured to start with the high jitter frequency, and therefore usually less points to measure until it finds the first fail. The advantage over the binary algorithm is, that it avoids measuring unnecessary pass points at low jitter amplitude, as well as avoiding the maximum jitter amplitude. Avoiding the excessive jitter condition helps saving measurement time because the number of times the device under test needs to recover will be less than with a simple binary search.

Custom | Custom algorithms can be implemented using the DUT Control Interface. This allows to implement search algorithms that select the jitter amplitude in a way that it optimizes measurement time, or excessive jitter conditions in a way that is not covered by the standard search algorithms. The search algorithm is defined by the implementation of three dedicated DUT Control Interface hooks.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up Log + Linear</td>
<td>The Up Log + Linear search algorithm performs the same algorithm as Up Logarithmic, but in addition, it returns to the last passing amplitude and steps linearly up until it reaches a fail point. The algorithm continues to increase the SJ amplitude until failure, even if it surpassed the original failed point.</td>
</tr>
<tr>
<td>Adaptive Binary</td>
<td>The adaptive binary algorithm is a combination of an up logarithmic search and a binary search. The initial search at the start frequency uses the logarithmic step size for the upwards search and switches to a binary search when the first failed measurement point is found. The binary search is reducing the step size until it becomes smaller as the defined binary step size. For all following jitter frequencies, the search starts at the last known pass amplitude. This algorithm is most efficient when the search is configured to start with the high jitter frequency, and therefore usually less points to measure until it finds the first fail. The advantage over the binary algorithm is, that it avoids measuring unnecessary pass points at low jitter amplitude, as well as avoiding the maximum jitter amplitude. Avoiding the excessive jitter condition helps saving measurement time because the number of times the device under test needs to recover will be less than with a simple binary search.</td>
</tr>
</tbody>
</table>
| Custom | Custom algorithms can be implemented using the DUT Control Interface. This allows to implement search algorithms that select the jitter amplitude in a way that it optimizes measurement time, or excessive jitter conditions in a way that is not covered by the standard search algorithms. The search algorithm is defined by the implementation of three dedicated DUT Control Interface hooks.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up Log + Linear</td>
<td>The Up Log + Linear search algorithm performs the same algorithm as Up Logarithmic, but in addition, it returns to the last passing amplitude and steps linearly up until it reaches a fail point. The algorithm continues to increase the SJ amplitude until failure, even if it surpassed the original failed point.</td>
</tr>
<tr>
<td>Adaptive Binary</td>
<td>The adaptive binary algorithm is a combination of an up logarithmic search and a binary search. The initial search at the start frequency uses the logarithmic step size for the upwards search and switches to a binary search when the first failed measurement point is found. The binary search is reducing the step size until it becomes smaller as the defined binary step size. For all following jitter frequencies, the search starts at the last known pass amplitude. This algorithm is most efficient when the search is configured to start with the high jitter frequency, and therefore usually less points to measure until it finds the first fail. The advantage over the binary algorithm is, that it avoids measuring unnecessary pass points at low jitter amplitude, as well as avoiding the maximum jitter amplitude. Avoiding the excessive jitter condition helps saving measurement time because the number of times the device under test needs to recover will be less than with a simple binary search.</td>
</tr>
<tr>
<td>Custom</td>
<td>Custom algorithms can be implemented using the DUT Control Interface. This allows to implement search algorithms that select the jitter amplitude in a way that it optimizes measurement time, or excessive jitter conditions in a way that is not covered by the standard search algorithms. The search algorithm is defined by the implementation of three dedicated DUT Control Interface hooks.</td>
</tr>
</tbody>
</table>

A tutorial script 'JTOL-Custom-Algorithm-with-Virtual-DUT.py' is part of the M8070A installation and is demonstrates how to implement the algorithm correctly. This algorithm requires the DUT Control Interface license (M8070A-1TP, M8070A-1NP or M8070A-1TT).
### Step Size

#### Table 72  Step size descriptions for characterization algorithms

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary Step Size</td>
<td>The Step Size for the Binary algorithm defines the exit criteria for the algorithm. The Binary search algorithm stops once its step size falls below this user defined Step Size. The Binary Step Size applies to the Binary algorithm and the binary portions of the Binary + Down Linear and Binary + Up Linear algorithms.</td>
</tr>
<tr>
<td>Linear Step Size</td>
<td>This defines the step size for each step of the Up Linear and Down Linear algorithms. When Down Linear is enabled as the search algorithm, the measurement starts from the maximum (which depends on the jitter frequency). A step size of 100 mUI, for example, may result in a sequence of 1000 UI, 999.9 UI, 999.8 UI, and so on. The test for one frequency stops when the BER limit is met or minimum specified amplitude is reached. When Up Linear is enabled as the search algorithm, the measurement starts from the minimum. A step size of 100 mUI, for example, will result in a sequence of 0.1 UI, 0.2 UI, 0.3 UI, and so on. The test for one frequency stops when the BER limit is exceeded or the maximum amplitude is reached.</td>
</tr>
<tr>
<td>Log Step Size</td>
<td>This defines the step size for each step of the Up Logarithmic and Down Logarithmic algorithms. When Down Logarithmic is enabled as the search algorithm, the measurement starts from the maximum (which depends on the jitter frequency). A percentage of 50%, for example, may result in a sequence of 1000 UI, 500 UI, 250 UI, and so on. The test for one frequency stops when the BER limit is met or the specified minimum amplitude is reached. When Up Logarithmic is enabled as the search algorithm, the measurement starts from the specified minimum amplitude. A percentage of 50%, for example, may result in a sequence of 0.1 UI, 0.15 UI, 0.23 UI, and so on. The test for one frequency stops when the BER limit is crossed or the maximum amplitude (which depends on the jitter frequency) is reached.</td>
</tr>
</tbody>
</table>
Launching Jitter Tolerance Measurement

To launch the Jitter Tolerance Measurement:

- Go to Menu Bar > Measurements and then select Jitter Tolerance.

The Jitter Tolerance user interface will appear as shown in the following figure:

---

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compliance Margin</td>
<td>In Compliance mode, the test starts at points defined on the jitter tolerance curve and is increased or decreased by the specified margin percent. The compliance template is adjusted according to the equation SJ Amplitude (with margin) = original SJ Amplitude * (1.0 + margin(%) / 100). This can be used to test if a receiver can withstand a certain percentage more jitter than dictated by the compliance template. Conversely, if a receiver is failing, the margin can be lowered to test if a receiver can pass a compliance test with a less stringent template.</td>
</tr>
</tbody>
</table>
The Jitter Tolerance user interface includes the following GUI elements:

- **Toolbar**: For details, refer to Toolbar on page 462.
- **Status Indicator**: For details, refer to Status Indicator on page 463.
- **Measurement History Window**: For details, refer to Measurement History Window on page 463.
- **Measurement Graph**: For details, refer to Measurement Graph on page 520
- **Results Pane**: For details, refer to Viewing the Jitter Tolerance Results on page 521.

**How to Run Jitter Tolerance Measurement**

Once you have specified the Frequency, BER, and Search criteria, press the **Start Measurement** icon to run the measurement. The measurement status indicator will show the progress.

**How to Stop/Abort Jitter Tolerance Measurement**

To stop a measurement, click the **Stop Measurement** icon.
Measurement Graph

After a jitter tolerance measurement has been run, results can be viewed by clicking on the **Graph** tab. The graph displays the sinusoidal jitter frequency on the x-axis, and the sinusoidal jitter amplitude on the y-axis.

The following figure shows the measurement results in the graph view.

![Jitter Tolerance Measurement Graph](image)

**Result Points**

The graph displays the BER measurement results of each tested sinusoidal jitter point. Passing results are displayed as a green dot. If the **Show All Points** option is enabled, all measured pass points will be shown by green dots, else the only last passed result for a given frequency will be shown by a green dot. If this green dot is selected, its respective measurement result can be seen as highlighted in the **Results** tab and vice-versa. Also, a green line connects the last passed result (green dot) of each frequency. In the graph, the green "+" means that you've reached the instruments max jitter capability without a fail. The red cross "x" means that you have failed to reached the instruments max jitter capability.
Maximum and Minimum Template Limit Lines

The solid white lines on the graph show the search range during characterization. This feature reduces test time by eliminating points where the DUT is likely to pass when its performance range is known.

Template Points

The green dots on the graph are the measurement points defined in the Template File.

Compliance Limit Line

The dashed white line on the graph shows the compliance test defined in the Template File.

Viewing the Jitter Tolerance Results

Measurement results can also be viewed in tabular form by clicking on the Results tab.

The following figure shows the results at each measurement point in tabular form.

If a passed result point (green dot) on the measurement graph is selected, its respective measurement results can be seen as highlighted in the Results tab and vice-versa.
Saving Jitter Tolerance Measurement Results

You can also save the Jitter Tolerance Measurement results in a CSV file. To do so:

- Click on the Save icon. A standard Save As dialog will appear.
- Provide a filename and location.
- Click Save. The Jitter Tolerance Measurement results will be saved in CSV format.

Using the Jitter Tolerance Template Editor

The Jitter Tolerance Template Editor is used to modify the currently loaded template file. It can be accessed by clicking on the Open Jitter Tolerance Template Editor icon, present on the toolbar.

The following is an example of jitter tolerance template editor showing the measurement point values (frequency and amplitude) for the currently loaded template file.
Template Editor Toolbar

<table>
<thead>
<tr>
<th>Elements</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Previous /Next Measurement</td>
<td>The left and right arrow buttons cause the vertical marker to jump to the next/previous measurement point.</td>
</tr>
<tr>
<td></td>
<td>Point</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Auto Scale Graph</td>
<td>Scales the graph to the optimum setting.</td>
</tr>
</tbody>
</table>
Template Editor Functions

Table 75

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edit</strong></td>
<td></td>
</tr>
<tr>
<td>Frequency</td>
<td>The frequency at the current vertical marker position is displayed in this window. Changing this frequency using the keypad, allows new measurement points to be defined.</td>
</tr>
<tr>
<td>Add Test Point/Remove Test Point</td>
<td>Use the drop-down menu to add or remove test points and then click on the Execute button.</td>
</tr>
<tr>
<td><strong>Test Points</strong></td>
<td></td>
</tr>
<tr>
<td>Measurement Template</td>
<td>Selects the Jitter Tolerance Measurement template file. It provides the following functions:</td>
</tr>
<tr>
<td>New</td>
<td>Opens a new template file.</td>
</tr>
<tr>
<td>Open...</td>
<td>Opens an existing template file which includes limits, compliance, and jitter tolerance measurement state.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the currently open template file to the current filename.</td>
</tr>
<tr>
<td>Save As...</td>
<td>Saves the currently open template file to a different filename and/or location.</td>
</tr>
<tr>
<td>Maximum</td>
<td>Changes the maximum amplitude of the measurement point at the current vertical marker position. These are the points along the solid white line on the graph.</td>
</tr>
<tr>
<td>Compliance</td>
<td>Changes the compliance amplitude of the measurement point at the current vertical marker position. These are the points along the upper solid white line on the graph.</td>
</tr>
<tr>
<td>Minimum</td>
<td>Changes the minimum amplitude of the measurement point at the current vertical marker position. These are the points along the lower solid white line on the graph.</td>
</tr>
</tbody>
</table>
Eye Diagram Measurement

What is an Eye Diagram?

The M8070A System Software provides quick design analysis with the Eye Diagram capability.

The Eye Diagram allows a quick check for the DUT’s signal output, and determines the signal quality. The eye contour lines display the measured eye at a deeper BER level, for accurate results.

The Eye Diagram feature provides the following measurement capabilities:

- Eye Diagram Waveform
- BER Contour Lines
- Automatic Measurement for the most relevant eye parameters:–
  - Eye Height
  - Eye Width
  - Jitter P-P
  - Jitter RMS
  - Cross Voltage

The Eye Diagram generates a three dimensional graph of the bit error rate (BER).

This measurement helps in determining and analyzing the quality of the DUT’s signal output. The Eye Diagram results comprise of voltage(y), time(x), and BER(z).

The Eye Diagram, and the table of Calculated Eye Measurement Results form simultaneously. They become more precise with the increasing number of measured bits.

The following graph shows the Eye Diagram integrated in the M8070A system software:
Methods of Representation of Eye Diagram

There are two methods of representing the eye diagram:

- Waveform
- Contour

Waveform

Waveform is the shape, and form of a signal. The waveform graph shows the periodical variation of voltage against time.

The waveform in the M8020A/M8030A is similar to the one in the oscilloscope. In this case, the waveform initially gives a coarse, but quick picture of the signal quality; while the 'smooth waveform' quickly generates a high resolution graph. The waveform is displayed in an incremental way, showing the coarse picture quickly, and then refining it further.

The BER Threshold is configurable. The BER Threshold is the level up to which the signal is represented as waveform, and BER values below this threshold are represented as contours.
BER Contour

Contour is a curve connecting points where the BER has a same particular value.

The contour graph is plotted within the Eye Diagram, and it helps to determine the Eye Opening at deep bit error rates, such as $1 \times 10^{-10}$, $1 \times 10^{-12}$, and so forth. Depending upon the user’s requirement the deep BERs can be calculated. The extrapolated eye contour lines display the eye opening for lower BER levels, such as $1 \times 10^{-15}$. The BER is displayed as a function of sampling delay, and sampling threshold.

The eye opening is one of the main characteristics of a high speed device.

The legend on the right side of the screen represents the contour BER values in different colors. When you select a BER value from the legend, it displays the contour for the selected BER in the same color. Initially all the BER values on the legend are struck across. When the contour is measured, the BER value changes into normal font; and when the contour is extrapolated the BER value changes into italics. A BER value for which a Contour does not exist is struck across. You can select multiple BER values. The screen shot below displays the contour and the legend.

![Contour Graph](image)

The outer contour represents the measured BER contour, while the inner lines are extrapolated.
The Minimum Number of Errors indicates the minimum number of hits required to plot the contour.

Eye Diagram Measurement Parameters

**Acquisition Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyzer</td>
<td>Location or location group against which the data acquisition is performed.</td>
</tr>
<tr>
<td>Persistence</td>
<td>Set the criteria for Persistence.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Infinite</td>
<td>With ‘Infinite’, the eye appears with the Automated Eye Parameter Measurement, and the results keep on improving in accuracy, as more number of points get measured and represented on the diagram along with the deeper BER values. The BER threshold in the Graph Tab decides how long the measurements will be done at the boundaries of the eye. Once the measured points exceed the BER Threshold defined by the user, the measurement is done deep inside the eye. This is a default setup for persistence.</td>
</tr>
<tr>
<td>Fixed Time (Secs)</td>
<td>With ‘Secs’, the measurement runs for the specified time, and the measurement automatically restarts showing only the refined eye diagram. To stop the measurement, click the abort button.</td>
</tr>
<tr>
<td>Number of eyes</td>
<td>Set the criteria for the number of eyes.</td>
</tr>
<tr>
<td>1.5ui</td>
<td>This option displays ‘1.5’ eyes on the graph. The transitions of the complete eye are placed such, that, they show ‘0.25’ eyes on both sides. So, the total number of displayed eyes is 1.5.</td>
</tr>
<tr>
<td>2ui</td>
<td>This option displays ‘2.0’ eyes on the graph. The transitions of the complete eye are placed such, that, they show ‘0.5’ eyes on both sides. So, the total number of displayed eyes is 2.0.</td>
</tr>
</tbody>
</table>
Evaluation Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculate Results For</td>
<td>Set the criteria for calculating the eye width, eye height, JPP, JRMS, cross voltage according to the BER threshold selected.</td>
</tr>
<tr>
<td>0 Errors</td>
<td>To see '0 errors' select the option. This gives the results according to the last measured contour for the current measurement. This is more significant in the case of deep BERs.</td>
</tr>
<tr>
<td>BER Threshold</td>
<td>Enter the BER threshold at which the five results, eye width, eye height, JPP, JRMS, and cross voltage, will be calculated. The show checkbox displays the contour at which the results are calculated.</td>
</tr>
<tr>
<td>Transition Time</td>
<td>Set criteria for transition time 10/90 Measures horizontal scan from 10% to 90% of the signal amplitude. 20/80 Measures horizontal scan from 20% to 80% of the signal amplitude.</td>
</tr>
</tbody>
</table>

Graph Settings

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Unit</td>
<td>Set the criteria for the Timing Units: Unit Interval Unit used to measure delay relative to the eye width. Seconds Unit used to measure eye width in absolute terms of time.</td>
</tr>
<tr>
<td>Show Waveform</td>
<td>This option shows the waveform graphic.</td>
</tr>
<tr>
<td>Smooth Waveform Graphics</td>
<td>The smooth waveform gives a finer waveform output. It logarithmically interpolates between the measured points to give a finer waveform.</td>
</tr>
<tr>
<td>Waveform BER Threshold</td>
<td>The BER Threshold value allows the user to measure around the eye boundaries first, and then, deeper inside the Eye for BERs beyond the specified threshold.</td>
</tr>
<tr>
<td>Contours</td>
<td>This option plots the contour.</td>
</tr>
<tr>
<td>Contour Legend</td>
<td>This shows the list of BER values.</td>
</tr>
</tbody>
</table>
Launching the Eye Diagram Measurement

To launch the **Eye Diagram Measurement**:  
- Go to **Menu Bar > Measurements** and then select **Eye Diagram**.

The **Eye Diagram** user interface will appear as shown in the following figure:

![Eye Diagram User Interface](image)

The **Eye Diagram** user interface includes the following GUI elements:
- **Toolbar**: For details, refer to [Toolbar](#) on page 462.
- **Status Indicator**: For details, refer to [Status Indicator](#) on page 463.
- **Measurement History Window**: For details, refer to [Measurement History Window](#) on page 463.
- **Results Pane**: For details, refer to [Calculated Eye Diagram Results](#) on page 532.

How to Start/Abort an Eye Diagram Measurement

To initiate the eye diagram measurement:
1. Click the Eye Diagram menu item from the Analysis submenu.
2. Click the Start button to execute the measurement.

The measurement runs, and the eye diagram along with the Calculated Eye Diagram Results get updated constantly.
The following graph shows the eye diagram.

3 To stop the measurement click on Abort.

How to Change the Default Settings

To achieve desired results, you can change the measurement parameters through the Parameters window:

1. Click the Properties button to open the Properties dialog box.
2. Use the different tabs in this dialog box to make the required settings:

   For details, see Acquisition, Evaluation and Graph Settings.
   Please note that you can only change the Evaluation and Graph Settings while the measurement is running.
Calculated Eye Diagram Results

The following results are displayed when an eye diagram measurement is completed:

<table>
<thead>
<tr>
<th>Location</th>
<th>Sample Count</th>
<th>1-Level</th>
<th>0-Level</th>
<th>Rise Time</th>
<th>Fall Time</th>
<th>Eye Amplitude</th>
<th>Eye Height</th>
<th>Eye Width</th>
<th>Jitter Rise-Fall</th>
<th>Jitter RMS</th>
<th>Crest Voltage</th>
<th>Signal to Noise Ratio</th>
<th>Duty Cycle</th>
<th>Detention</th>
</tr>
</thead>
<tbody>
<tr>
<td>M1.DatAll</td>
<td>2.17e+11</td>
<td>277 mV</td>
<td>-392 mV</td>
<td>133 mV</td>
<td>109 mV</td>
<td>568 mV</td>
<td>536 mV</td>
<td>166 mV</td>
<td>34 mV</td>
<td>6 mV</td>
<td>49.54 %</td>
<td>32.57</td>
<td>10 mV</td>
<td>10 mV</td>
</tr>
</tbody>
</table>

- **Location**: Location or Location/Group against which the data acquisition is performed.
- **Sample Count**: The number of points measured for the eye diagram. If persistence, 'infinite', is enabled, the value will gradually increase.
- **Error Bits**: Displays the number of errored bits during the accumulation period.
- **1-Level**: One Level is a measure of the mean value of the logical 1 of an eye diagram.
- **0-Level**: Zero level is the measurement of the mean value of the logical 0 of an eye diagram.
- **Rise time**: Measures the mean transition-time taken by the data on the rising edge of the eye diagram. The data crosses three thresholds: lower, crossover point, upper and the eye transition.
  
  Note: Rise time is dependent on the Transition Time of the View Tab. The two options are 10/90 and 20/80.
- **Fall time**: Measures the mean transition-time taken by the data on the falling edge of the eye diagram. The data crosses three thresholds: lower, crossover point, upper and the eye transition.
  
  Note: Fall time is dependent on the Transition Time of the View Tab. The two options are 10/90 and 20/80.
- **Eye Amplitude**: The difference between the logic 1 level and the logic 0 level.
- **Eye Height**: Measures the vertical opening of an eye diagram with respect to BER threshold. This determines “eye closure” due to noise.
  
  Note: The Eye Height is calculated according to the BER Threshold set in the View Tab. Eye Height is calculated with ‘Height at’ in the View tab.
- **Eye Width**: The horizontal measurement of the eye opening at a specified BER Threshold.
  
  Note: The Eye Width is calculated according to the BER Threshold set in the View Tab. Eye Width is calculated as per the selection of either Width at Crossing Point or Custom defined Width.

- **Jitter Peak-Peak**: Full width of the histogram at the eye crossing point with respect to BER threshold.
  
  Note: The Jitter P-P is calculated according to the BER Threshold set in the Parameter window.

- **Jitter RMS**: A standard deviation of the crossing point histogram with respect to BER threshold.
  
  Note: The Jitter RMS is calculated according to the BER Threshold set in the Parameter window.

- **Cross Voltage**: Crossing percentage is a measure of the amplitude of the crossing points relative to the 1 level and 0 level.
  
  Note: The Cross Voltage is calculated according to the BER Threshold set in the Parameter window.

- **Signal to Noise Ratio**: In signal-to-noise, the "signal" is the information power of the signal indicated by the difference between the ‘1’, and ‘0’ level. The "noise" is the combined standard deviations of the ‘1’ level spread, and the ‘0’ level spread.

- **Duty Cycle Distortion**: This value is the difference between the period of a 1 bit and a 0 bit.
Parameter Sweep Plugin

The Parameter Sweep plugin allows a user to sweep the parameters of the selected location/location group to the desired analyzer in order to calculate BER. This is helpful in scenarios when a user wants to pick a property to sweep within a specified range with specified steps and measure BER with respect to that sweep. Using this plugin, a user can sweep the parameters using the acquisition parameters provided in the Parameter window and then run the measurement to calculate BER.

Launching Parameter Sweep Plugin

To launch the Parameter Sweep plugin, go to the Menu Bar > Measurements and then select Parameter Sweep. The user interface of Parameter Sweep plugin will appear as shown in the following figure:

The Parameter Sweep Plugin user interface includes the following GUI elements:

- **Toolbar**: For details, refer to Toolbar on page 462.
- **Status Indicator**: For details, refer to Status Indicator on page 463.
- **Measurement History Window**: For details, refer to Measurement History Window on page 463.
- **Parameters Window**: For details, refer to Parameter Sweep Plugin Parameters on page 535.
- **Measurement Graph**: For details, refer to Measurement Graph for Parameter Sweep on page 537.
- **Measurement Data**: For details, refer to Measurement Data for Parameter Sweep on page 539.

Parameter Sweep Plugin Parameters

### Measurement Setup

The measurement setup includes the following acquisition parameters:

- **Analyzer** - This parameter lists all available Data In locations that are used for data acquisition.
- **Sweep Location** - This parameter sets the location/location group string against which the sweep property needs to be performed.
- **Sweep Parameter** - This parameter sets the sweep parameter to be swept amongst the list of other parameters present in current location or group.
- **Sweep Mode** - This parameter sets the sweep mode. The choices are ‘ABSolute’ and ‘RELative’.
  - In the ‘ABSolute’ mode, the property will sweep from the value specified in the ‘Sweep From’ parameter to a value specified in the ‘Sweep To’ parameter.
  - In the ‘RELative’ mode, the property will be sweep from a value relative to the current value specified in the ‘Sweep From’ parameter to a value relative to the current value specified in the ‘Sweep To’ parameter.
- **Sweep Relax Time** - This parameter sets the relaxing time between the sweep before reading the BER. The relaxing time can be between 0 sec to 60 sec.
- **Sweep From** - This parameter sets the value from where the sweep needs to be performed for that particular parameter.
- **Sweep To** - This parameter sets the value till the sweep needs to be performed for that particular parameter.
- **Steps** - This parameter sets the value as for how many steps user wants to sweep the parameter between the current “Sweep From” and “Sweep To” range.
- **Steps Accumulation End** - This parameter sets the steps accumulation end criteria to sweep. The choices are “No. of Bits” or “Pass/Fail”.

---

**Keysight M8000 Series of BER Test Solutions User Guide**

---

**Working with Measurements**

---

535
• In case the **Step Accumulation End** is selected as **Pass/Fail**, set **Target Error Ratio** and **Target Confidence Level**.
  - **Target Error Ratio** - This parameter sets the target error ratio of the accumulated results.
  - **Target Confidence Level** - This parameter sets the target confidence level of the accumulated results.
• In case the **Step Accumulation End** is selected as **No. of Bits**, specify **Number of Compared Bits** and **Number of Errors**.
  - **Number of Compared Bits** - This parameter allows the user to specify the number of compared bits; that would be used as criteria for moving to the next measurement point in case when the sample delay optimization is "NONE".
  - **Number of Errors** - This parameter enables the user to set the additional no. of errored bits to consider while moving to the next measurement points. To enable this feature, you have to click on the toggle button.
• **Pre BER Alignment** - This parameter sets the pre BER alignment criteria before it sweeps to next measurement point. The choices are:
  - **None** - This parameter does not initiate any pre BER alignment.
  - **Data Alignment** - This parameter initiates pattern resynchronization.
  - **Sample Delay Optimization** - This parameter initiates search for the value of data/clock delay that puts the active clock edge in the center of the data eye, midway between the two relative delay points with a measured BER
  - **Threshold Optimization** - This parameter initiates search for the 0/1 threshold voltage midway between the two 0/1 threshold voltages with a measured BER
  - **Full Sample Point Optimization** - This parameter initiates auto alignment.

**Graph Setup**

The graph setup includes the following parameters:

• **Vertical Axis Scale** – This parameter specify the Y axis scale. The choices are Linear and Logarithmic. If Linear is specified then the BER values are in terms of a linear scale. If Logarithmic is specified then the BER values are in terms of a logarithmic scale.
• **Measured Points** – This parameter show/hides the measured points on the graph. When this option selected, all measured points are indicated on the graph.

• **Graph Legends** – This parameter show/hide graph legends. When this option selected, the legends are shown on the right side of the graph. The color scheme of the graph corresponds to color of the respective legend.

How to Run Parameter Sweep Measurement

To run an **Parameter Sweep** measurement, perform the following steps:

• Use the **Parameters** window to select the location or location group for which the data acquisition has to be performed.

• Set the acquisition and graph setting parameters for **Parameter Sweep** in the **Parameters** window. For details, refer to **Parameter Sweep Plugin Parameters** on page 535.

• Click the **Start Measurement** icon to run the measurement. The measurement status indicator will indicate **Running**.

• Wait till the status indicator shows **Finish** status.

**NOTE**

Please note that once you run the measurement you cannot modify the acquisition parameters. However, if you try to modify acquisition parameters by stopping the measurement and then run the measurement, a new instance of measurement will be executed.

How to Stop Parameter Sweep Measurement

To stop a measurement, click the **Stop Measurement** icon to stop the measurement.

Measurement Graph for Parameter Sweep

Once you run a **Parameter Sweep** measurement for a specified duration, the calculated graph and the measurement data is shown on the measurement graph as follows:
The Measurement Graph contains the following tabs:

- **Graph**: Displays the graphical representation of the measurement. You can apply various graph settings to the selected graph to view it as per the requirement. For graph settings, refer to Graph Setup on page 536.

- **Location**: Displays the raw measurement data for the location/location group. If you are running measurement for a group, multiple tabs will appear that display the raw measurement for each location.

When you right-click on the Measurement Graph, a context menu appears which provides the following options:

- **Turn ON/OFF Fit to view (Ctrl+Home)** - Turns ON/OFF Fit to view option.
- **Fit to view (Home)** - Makes the visible area fit to display entire contents.
- **Copy screenshot (F11)** - Copies the screenshot of charts to clipboard.
- **Save screenshot (Ctrl+S)** - Saves the screenshot as an image (PNG) under a name.
- **Quick Help (Alt+F1)** - Opens a window that provides brief information about the dynamic display.
Measurement Data for Parameter Sweep

The measurement data can be viewed by clicking on the location/location group tab which appears at the bottom of the measurement graph. This tab is only available once the parameter sweep measurement is successfully executed.

The following figure shows the measurement data for the selected location.

![Measurement Data Table](image_url)

The measurement data displays measurement points such as Sweep Value, Error Ratio, Compared Bits, Errored Bits, Errored Zero Ratio, Compared Zeros, Errored Zeros, Error One Ratio, Compared Ones and Errored Ones which are repeated in the same order for subsequent measured points.
9 Utilities

Overview / 542
Script Editor / 543
DUT Control Interface / 556
SCPI Editor / 588
SCPI Recorder / 593
Self Test Utility / 596
Licenses Window / 601
Settings Window / 602
Logger Window / 605
SCPI Server Information / 606
Plug-in Manager / 607
Overview

The M8070A software provides the following utilities:

- Script Editor
- DUT Control Interface
- SCPI Editor
- Self Test Utility
- Licenses Window
- Settings Window
- Logger Window
- SCPI Server Information
- Plug-in Manager Window
Script Editor

The **Script Editor** provides flexibility to the programmers to automate their plug-ins thus allowing them to do everything they want in the measurements.

The **Script Editor** uses the IronPython programming language which is a flexible and powerful language suitable to a range of tasks. The IronPython is an open-source implementation of the Python programming language which is tightly integrated with the .NET Framework. IronPython can use the .NET Framework and Python libraries, and other .NET languages can use Python code just as easily. Whether you’re interested in writing full applications, tackling scripting tasks, or embedding a scripting language into another application, IronPython has something to offer you.

For more details on the IronPython, please refer to the following web-page: [http://ironpython.net](http://ironpython.net)
Launching the Script Editor

To launch the Script Editor:

- Go to the Menu Bar > Utilities and then select Script Editor.

The Script Editor interface will appear as shown in the following figure:

The Script Editor interface consists of the following GUI elements:

- Toolbar
- Editor Pane
- Output Pane
- Console
- Settings Window
- Find and Replace Dialog

The listed GUI elements are described in the section that follows.
### Toolbar

The **Script Editor** toolbar provides the following convenient script editing functions:

#### Table 76

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Keyboard Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="New" /></td>
<td>New</td>
<td>CTRL + N</td>
<td>Click this icon to create a new project/module. For details, refer to <a href="#">Creating a Script</a> on page 552.</td>
</tr>
<tr>
<td><img src="image" alt="Save" /></td>
<td>Save</td>
<td>CTRL + S</td>
<td>Click this icon to save the current project/module. For details, refer to <a href="#">Saving a Script</a> on page 552.</td>
</tr>
<tr>
<td><img src="image" alt="Import" /></td>
<td>Import</td>
<td>CTRL + O</td>
<td>Click this icon to import external project/module (.PY) into the current project/module. For details, refer to <a href="#">Importing a Script</a> on page 552.</td>
</tr>
<tr>
<td><img src="image" alt="Export" /></td>
<td>Export</td>
<td>CTRL + E</td>
<td>Click this icon to export the project/module (.PY) to the local drive. For details, refer to <a href="#">Exporting a Script</a> on page 553.</td>
</tr>
<tr>
<td><img src="image" alt="Cut" /></td>
<td>Cut</td>
<td>CTRL + X</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Copy" /></td>
<td>Copy</td>
<td>CTRL + C</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Paste" /></td>
<td>Paste</td>
<td>CTRL + V</td>
<td>These functions follow Microsoft Windows conventions.</td>
</tr>
<tr>
<td><img src="image" alt="Delete" /></td>
<td>Delete</td>
<td>DEL</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Undo" /></td>
<td>Undo</td>
<td>CTRL + Z</td>
<td>Click this icon to undo your last action.</td>
</tr>
<tr>
<td><img src="image" alt="Redo" /></td>
<td>Redo</td>
<td>CTRL + SHIFT + Z</td>
<td>Click this icon to redo your last action.</td>
</tr>
</tbody>
</table>
### Status Indicator

The **Status Indicator** indicates the current state of the script. It is located on the right side of the toolbar.

![Running Icon](image)

It shows the following status:

- **Running** - When the script is being executed.
- **Not Running** - When the script is either not executed or the execution is completed.
- **Failed** - When the script execution fails.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Keyboard Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Start Script Icon" /></td>
<td>Start Script</td>
<td>F5</td>
<td>Click this icon to execute the script. For details, refer to Running a Script on page 553.</td>
</tr>
<tr>
<td><img src="image" alt="Start Selected Icon" /></td>
<td>Start Selected</td>
<td>F8</td>
<td>Click this icon to execute the select portion of the script.</td>
</tr>
<tr>
<td><img src="image" alt="Stop Script Icon" /></td>
<td>Stop Script</td>
<td>F6</td>
<td>Click this icon to stop the currently running script.</td>
</tr>
<tr>
<td><img src="image" alt="Reset local variables and loops Icon" /></td>
<td>Reset local variables and loops</td>
<td></td>
<td>Click this icon to reset the local variable and loops in the script.</td>
</tr>
<tr>
<td><img src="image" alt="Duplicate Row/Selection Icon" /></td>
<td>Duplicate Row/Selection</td>
<td>CTRL + D</td>
<td>Click this icon to duplicate the code of the current cursor position or selected code to a new row. For details, refer to Adding Duplicate Row/Selection in the Code on page 554.</td>
</tr>
<tr>
<td><img src="image" alt="Restore default window layout Icon" /></td>
<td>Restore default window layout</td>
<td></td>
<td>Click this icon to restore the default window layout.</td>
</tr>
</tbody>
</table>
Editor Pane

The Editor pane allows you to:
- Write, edit, debug and run the scripts
- Open, save, import and export the scripts
- Debug the script code
- Run the entire script or selected lines from the script
- Apply settings to the editor using the Settings window

The Editor pane is an area where you enter code and execute it immediately. It also allows the execution of a single line of script code, with the resulting messages printed to the Output pane. For details, refer to Output Pane on page 548. In addition, the Editor pane has many features to help you enter, edit, check syntax, and debug script code. Beside this, it also allows you to use the Microsoft Window’s standard functionally such as cut, copy, paste, undo and redo operations in the script code.

The following figure shows a simple program written in the Editor pane.

```
1 prices = {'apple': 0.49, 'banana': 0.50}
2 my_purchase = {
3     'apple': 1,
4     'banana': 6
5 }
6 grocery_bill = sum(prices[fruit] * my_purchase[fruit]
7 for fruit in my_purchase)
8 print 'I owe the grocer $%.2f' % grocery_bill
```

Context Menu

The Context menu appears when you right-click on the editor pane. It provides the Window’s standard functionally such as undo, redo, cut, copy, paste, delete and select all operations in the script code.

The following figure shows the options provided by the Context menu:
Output Pane

The **Output** pane displays the result of the executed script code. However, if the interpreter finds any error in the code, it is displayed in this pane.

The following figure shows an output of a program shown in an **Output** pane:

It provides the following options:

**Clear Window** - Click the **Clear Window** icon to clear the output pane.

**Export** - Click the **Export** icon to open a Window’s standard **Save As** dialog to save the content of the **Output** pane in a log file.
Console

The **Console** allows you to enter, interact with and visualize data, inside a command interpreter. All the commands entered in the **Console** are executed in a separate process, thus allowing you to interrupt any process at any time.

Settings Window

The **Settings** window provides settings for **Editor pane**, **Output pane** and **Console**.

The following table lists the settings for **Editor pane**:

**Table 77**

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Whitespace</td>
<td>Click this switch to show whitespace in the code.</td>
</tr>
<tr>
<td>Convert Tabs to Spaces</td>
<td>Click this switch to convert tabs to spaces in the code.</td>
</tr>
<tr>
<td>Tab Size</td>
<td>Use this setting to increase/decrease the tab size in the code.</td>
</tr>
</tbody>
</table>
The following table lists the settings for **Output** pane:

**Table 78**

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word Wrapping</td>
<td>Click this switch to enable word wrapping in the code.</td>
</tr>
<tr>
<td>Zoom</td>
<td>Use this setting to zoom in or zoom out the code.</td>
</tr>
<tr>
<td>Code Completion</td>
<td>Click this switch to enable code completion feature. It saves the key strokes for caret movement when coding which can greatly reduce typing required for coding. The following figure shows how the code completion feature can reduce the typing while coding:</td>
</tr>
</tbody>
</table>

![Image of code completion feature](image)

The following table lists the settings for **Output** pane:

**Table 78**

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word Wrapping</td>
<td>Click this switch to enable word wrapping.</td>
</tr>
<tr>
<td>Zoom</td>
<td>Use this setting to zoom in or zoom out the output of the program executed.</td>
</tr>
<tr>
<td>Autoscroll Output</td>
<td>Click this switch to enable autoscroll feature.</td>
</tr>
</tbody>
</table>
The following table lists the settings for **Console**:

**Table 79**

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom</td>
<td>Use this setting to zoom in or zoom out.</td>
</tr>
<tr>
<td>Code Completion</td>
<td>Click this switch to enable code completion feature. It saves the key strokes for caret movement when coding which can greatly reduce typing required for coding.</td>
</tr>
</tbody>
</table>

**Find and Replace**

The **Find and Replace** dialog provides the search and replace capability in the script. The **Quick Find** option allows you to locate a specified text string while the **Quick Replace** option allows you to locate and replace a specified text string.

The **Find and Replace** dialog provides the following options:

- **Find What** - Displays the search string you want to locate.
- **Replace With** - Displays the string that will replace the string you searched for.
Utilities

• **Look In** - Provides the search operation either in the entire document (script) or in the selection (selected part of the script).

• **Find Options** - Provides several other options (Match case, Match whole word, Search up and Search type) in the find dialog that you can use to customize your search.

• **Find Next** - Locates the next instance of the search string.

• **Replace** - Displays the string that will replace the string you searched for.

• **Replace All** - Replaces all instances where the search string is found.

Creating a Script

To create a script, click the **New** icon present on the toolbar. You can use **Editor** pane to write a script code.

Saving a Script

To save a current script, click the **Save** icon present on the toolbar.

Importing a Script

To import a script, click the **New** icon present on the toolbar. A Windows’s standard **Open** dialog will appear.

- Locate the python script file (.PY) you want to import.
- Click **OK**.
Exporting a Script

To export a script, click the New icon present on the toolbar. The Window’s standard Save As dialog will appear.

- Select the location where you want to export the script.
- Enter a file name in the File Name text field.
- Click Save.

Running a Script

You can run either the complete script code or the selected part. To do so:

- Click the Start Script icon present on the toolbar to execute the entire script.
- Click the Start Selected icon present on the toolbar to execute the selected part of the script.

Verify the status of the executed scripts though Status Indicator. Refer to Status Indicator on page 546.

The output of the scripts will be displayed in the Output pane. However, if the scripts fails, the error will also be shown in the Output pane.
Stopping a Script

To stop the currently running script, click the Stop icon present on the toolbar.

Please note that for few scripts, the Stop button sometimes do not respond while trying to abort script execution. This means that once the user presses the Stop button, the script execution stops, but the script editor gives an impression that the script is running because the progress indicator continues to run and Stop button is still clickable and Start button is disabled.

To handle such scripts, the following exception should be used:

```csharp
private void ExecuteScript()
{
    try
    {
        m_Script.ExecuteCode(m_Code);
    }
    // Exceptions from in here will be ignored, otherwise the program will close down involuntarily
    catch (Exception) {}
    finally
    {
        lock (m_AccessLocker)
        {
            m_Code = null;
        }
    }
}
```

Adding Duplicate Row/Selection in the Code
To create a copy of the current row of the code or the selected part, click the **Duplicate Row/Selection** icon.

The following figure shows the row being duplicated using the **Duplicate Row/Selection** option.
DUT Control Interface

The **DUT Control Interface** feature allows you to control a device under test at well defined positions within the measurements of the M8070A software. It allows you to:

- Read out error count information from devices with built-in error counters.
- Read out and write devices status registers
- Import and edit of Python scripts to access DUT from M8070A system software
- Integrate devices built-in error count information in error monitoring and jitter tolerance test routines of M8070A.

The **DUT Control Interface** editor provides inserting code snippets of the supported DUT. This allows you to tailor the supported measurements in a way that the DUT is controlled at critical points during the measurement and also provide error information for the measurement. Currently, the **DUT Control Interface** supports using a DUT’s built-in error counters in the following measurements:

- Error Ratio Measurement
- Jitter Tolerance Measurement

All other measurements provide callback functions as well. These are useful to tailor the measurement to the DUT (e.g. settling times in dependency of measurement parameters), or to control the device under test during the measurement.

The **DUT Control Interface** feature is enabled by the license M8070A-1TP or M8070A-1NP.

Launching the DUT Control Interface

To launch the **DUT Control Interface**:

- Go to the **Menu Bar > Utilities** and then select **DUT Control Interface**.

The **DUT Control Interface** interface will appear as shown in the following figure.
The **DUT Control Interface** interface consists of the following GUI elements:
- Toolbar
- Editor Pane
- Output Pane
- Console
- Insert Code
- Settings Window
- Find and Replace Dialog

The listed GUI elements are described in the section that follows.
Utilities

Toolbar

The toolbar provides the following convenient script editing functions:

Table 80

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![New]</td>
<td>New</td>
<td>Click this icon to open a new DUT script. For details, refer to Creating a Script on page 552.</td>
</tr>
<tr>
<td>![Open]</td>
<td>Open</td>
<td>Click this icon to open an existing DUT script.</td>
</tr>
<tr>
<td>![Save]</td>
<td>Save</td>
<td>Click this icon to save the current DUT script. For details, refer to Saving a Script on page 552.</td>
</tr>
<tr>
<td>![Save As]</td>
<td>Save As</td>
<td>Click this icon to save the current DUT script under different file name at either shared or current locations. For details, refer to Saving a Script on page 552.</td>
</tr>
<tr>
<td>![Import]</td>
<td>Import</td>
<td>Click this icon to import external DUT script (.PY) into the editor. For details, refer to Importing a Script on page 552.</td>
</tr>
<tr>
<td>![Export]</td>
<td>Export</td>
<td>Click this icon to export the DUT script (.PY) to the local drive. For details, refer to Exporting a Script on page 553.</td>
</tr>
<tr>
<td>![Cut]</td>
<td>Cut</td>
<td>These functions follow Microsoft Windows conventions.</td>
</tr>
<tr>
<td>![Copy]</td>
<td>Copy</td>
<td>These functions follow Microsoft Windows conventions.</td>
</tr>
<tr>
<td>![Paste]</td>
<td>Paste</td>
<td></td>
</tr>
<tr>
<td>![Delete]</td>
<td>Delete</td>
<td></td>
</tr>
<tr>
<td>![Undo]</td>
<td>Undo</td>
<td>Click this icon to undo your last action.</td>
</tr>
<tr>
<td>Icon</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image1" alt="Redo Icon" /></td>
<td>Redo</td>
<td>Click this icon to redo your last action.</td>
</tr>
<tr>
<td><img src="image2" alt="Duplicate Row/Selection Icon" /></td>
<td>Duplicate Row/Selection</td>
<td>Click this icon to duplicate the code of the current cursor position or selected code to a new row. For details, refer to Adding Duplicate Row/Selection in the Code on page 554.</td>
</tr>
<tr>
<td><img src="image3" alt="Install Icon" /></td>
<td>Install</td>
<td>Click this button to install or uninstall the DUT control interface. Installing the DUT Control Interface script integrates the implemented functions into the M8070A software and makes the built-in error counters available for measurements and the remote interface. Editing, or interactive execution of the script is no longer possible when the script is installed.</td>
</tr>
<tr>
<td><img src="image4" alt="Start Script Icon" /></td>
<td>Start Script</td>
<td>Click this icon to execute the script. For details, refer to Running a Script on page 553. Running the script in the editor is useful to debug the script functionality. The individual functions can be executed from the Console after the script has been executed.</td>
</tr>
<tr>
<td><img src="image5" alt="Start Selected Icon" /></td>
<td>Start Selected</td>
<td>Click this icon to execute the select portion of the script. This is useful to update the functionality available on the console after making changes to parts of the script, without executing all of the script. This avoids other side effects like resetting global variables that can be unwanted during testing the script.</td>
</tr>
<tr>
<td><img src="image6" alt="Stop Script Icon" /></td>
<td>Stop Script</td>
<td>Click this icon to stop the currently running script.</td>
</tr>
<tr>
<td><img src="image7" alt="Reset local variables and loops Icon" /></td>
<td>Reset local variables and loops</td>
<td>Click this icon to reset the local variable and loops in the script.</td>
</tr>
<tr>
<td><img src="image8" alt="Restore default window layout Icon" /></td>
<td>Restore default window layout</td>
<td>Click this icon to restore the default window layout.</td>
</tr>
</tbody>
</table>
Status Indicator

The **Status Indicator** indicates the current state of the script. It is located on the right side of the toolbar.

It shows the following status:

- **Running** - When the script is being executed.
- **Not Running** - When the script is either not executed or the execution is completed.
- **Failed** - When the script execution fails.

Editor Pane

The **Editor** pane allows you to:

- Write, edit and run the scripts
- Open, save, import and export the scripts
- Run the entire script or selected lines from the script
- Apply settings to the editor using the **Settings** window

The **Editor** pane is an area where you enter code and execute it immediately. It also allows the execution of a single line of script code, with the resulting messages printed to the **Output** pane. For details, refer to **Output Pane** on page 548. In addition, the **Editor** pane has many features to help you enter, edit and check syntax of the code. Besides this, it also allows you to use the Microsoft Windows’s standard functionally such as cut, copy, paste, undo and redo operations in the script code.

The following figure shows a simple program written in the **Editor** pane.
Context Menu

The Context menu appears when you right-click on the editor pane. It provides the Window’s standard functionality such as undo, redo, cut, copy, paste, delete and select all operations in the script code.

The following figure shows the options provided by the Context menu:
Output Pane

The Output pane displays the result of the executed script code. However, if the interpreter finds any error in the code, it is displayed in this pane.

The following figure shows an output of a program shown in an Output pane:

It provides the following options:

- **Clear Window** - Click the Clear Window icon to clear the output pane.

- **Export** - Click the Export icon to open a Window’s standard Save As dialog to save the content of the Output pane in a log file.

Console

The Console allows you to enter, interact with and visualize data, inside a command interpreter. All the commands entered in the Console are executed in a separate process, thus allowing you to interrupt any process at any time.
Insert Code Window

The **Insert Code** window lists code snippets that are supported by the DUT Control Interface. You can double-click on the code snippet to insert them in the **Editor** pane. The code snippets ensure correct signature of the supported functions and contain documentation of the expected functionality and the function’s arguments.

Please note that you are not allowed to modify the script when the DUT control script is installed.

Also, the **Output** pane and **Console** will not be available when DUT control script is installed.

Settings Window

The **Settings** window provides settings for the **Editor** pane, **Output** pane and **Console**.

The following table lists the settings for the **Editor** pane:

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Whitespace</td>
<td>Click this switch to show whitespace in the code.</td>
</tr>
<tr>
<td>Convert Tabs to Spaces</td>
<td>Click this switch to convert tabs to spaces in the code.</td>
</tr>
<tr>
<td>Tab Size</td>
<td>Use this setting to increase/decrease the tab size in the code.</td>
</tr>
</tbody>
</table>
The following table lists the settings for the Output pane:

**Table 82**

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word Wrapping</td>
<td>Click this switch to enable word wrapping.</td>
</tr>
<tr>
<td>Zoom</td>
<td>Use this setting to zoom in or zoom out the output of the program executed.</td>
</tr>
<tr>
<td>Autoscroll Output</td>
<td>Click this switch to enable autoscroll feature.</td>
</tr>
</tbody>
</table>
The following table lists the settings for **Console**:

**Table 83**

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom</td>
<td>Use this setting to zoom in or zoom out.</td>
</tr>
<tr>
<td>Code Completion</td>
<td>Click this switch to enable code completion feature. It saves the key strokes for the caret movement when coding which can greatly reduce typing required for coding.</td>
</tr>
</tbody>
</table>

Find and Replace

The **Find and Replace** dialog provides the search and replace capability in the script. The **Quick Find** option allows you to locate a specified text string while the **Quick Replace** option allows you to locate and replace a specified text string.

The **Find and Replace** dialog provides the following options:

- **Find What** - Displays the search string you want to locate.
- **Replace With** - Displays the string that will replace the string you searched for.
- **Look In** - Provides the search operation either in the entire document (script) or in the selection (selected part of the script).
- **Find Options** - Provides several other options (Match case, Match whole word, Search up and Search type) in the find dialog that you can use to customize your search.
- **Find Next** - Locates the next instance of the search string.
- **Replace** - Displays the string that will replace the string you searched for.
- **Replace All** - Replaces all instances where the search string is found.

**Creating a New Script**

To create a new script, click the **New** icon present on the toolbar. A default script will be loaded in the **Editor** pane which you can edit to create a new script.

**Open a Script**

To open a saved script, click the **Open** icon present on the toolbar. A **Open Hooks Script** dialog will appear which allows you to open the DUT scripts.

**Saving a Script**

To save the current script, click the **Save** icon present on the toolbar. A **Save Hooks Script** dialog will appear which allows you to save the scripts on either shared or current folder.

**Importing a Script**

To import a script, click the **Import** icon present on the toolbar. A Window’s standard **Open** dialog will appear.
Exporting a Script

To export a script, click the Export icon present on the toolbar. The Window’s standard Save As dialog will appear.

- Select the location where you want to export the script.
- Enter a file name in the File Name text field.
- Click Save.
Running a Script

You can run either the complete script code or the selected part. To do so;

- Click the **Start Script** icon present on the toolbar to execute the entire script.

- Click the **Start Selected** icon present on the toolbar to execute the selected part of the script.

Verify the status of the executed scripts through **Status Indicator**. Refer to **Status Indicator** on page 546.

The output of the scripts will be displayed in the **Output** pane. However, if the scripts fail, the error will also be shown in the **Output** pane.

Stopping a Script

To stop the currently running script, click the **Stop** icon present on the toolbar.

Stopping the script does not always work. If the script is using non-Python code (e.g. calling functions in .Net libraries), then the execution of these functions cannot be stopped in all cases.

Adding Duplicate Row/Selection in the Code

To create a copy of the current row of the code or the selected part, click the **Duplicate Row/Selection** icon.

The following figure shows the row being duplicated using the **Duplicate Row/Selection** option.
Effects on M8070A GUI on Installing a DUT Control Script

On successful installation of DUT control scripts, the following changes are reflected in M8070A GUI.

**Module View**

A new DUT control along with the supported parameters is now added in the Module View.

**Group View**

New locations will be now available to create a group in the Group View.
Error Ratio Measurement

A new location will be now available in the Analyzer parameter of the Error Ratio Measurement.

Jitter Tolerance Measurement

A new location will be now available in the Analyzer parameter of the Jitter Tolerance Measurement.
Writing a Script Code for DUT Control Interface

Scripting Runtime

- The underlying scripting technology uses IronPython 2.7.5
- The M8070A does not include the full IronPython 2.7.5 installation, only the scripting engine itself. When referencing the modules of an IronPython installation that is available on the computer, it must be ensured that the versions match.
- IronPython makes it very easy to use functionality provided by the Microsoft .NET framework, but it cannot directly access dynamic link libraries that are not based on .NET. Functions that are implemented in unmanaged DLLs (usually implemented in C or C++) do require a .NET wrapper library. For details see: https://msdn.microsoft.com/en-us/library/ms235282.aspx
- Python functions do not have out parameters. If a function is using out parameters, then these will be returned as additional return values. Example:
  - C# function
    ```csharp
    bool DoSomething(int arg1, out double resultArg1, double arg2, out int resultArg2, out string resultArg3)
    
    double arg2, out int resultArg2,
    out string resultArg3)
    
    - IronPython usage
      ```python
      (returnValue, resultArg1, resultArg2, resultArg3) = DoSomething(arg1, arg2)
      ```
- Remote commands to control M8070A cannot be used within the DUT Control Interface scripts. While this is possible in principle, it will cause problems when the functions implemented in the DUT Control Interface are being executed in the context of remote commands (e.g. query error counters via :fetc:bco?). In this case the remote interface is busy until the DUT counters have been returned by the script function DUT_getBER, but while the remote interface is busy it cannot process any further remote commands, neither internally issued nor external ones. This can very easily end up in deadlock/timeout scenarios.
- Code outside of function definitions is being executed at load time of the script. This can be used to initialize required variables, or establish the communication link with the DUT.
Minimum Requirements to Integrate a DUT’s Error Counters

- Implement DUT_getLocations() to return a unique name for each location within the DUT that does provide an error counter (e.g. Lane1, Lane2, Lane3, Lane4)
  
  **Example:**
  
  The following example defines DUT_getLocations to define 4 locations named Lane to Lane 4:
  
  ```python
  def DUT_getLocations():
      return ["Lane1", "Lane2", "Lane3", "Lane4"]
  ```

- Implement DUT_getBER(location) to return the error counter for each of the defined locations.
  
  **Example:**
  
  The following example reads BER counter from one of 4 Lanes. Each Lane is assumed to be controlled by an instance of a driver class that implements the IBerReader interface (see code snippet below). The instances of the 4 lanes are held in a dictionary that allows easy lookup by the given location name.
  
  ```python
  # create empty dictionary
  myDUTs = {}
  # instantiate the driver for each location
  myDUTs["Lane1"] = MyDutBerReader(1)
  myDUTs["Lane2"] = MyDutBerReader(2)
  myDUTs["Lane3"] = MyDutBerReader(3)
  myDUTs["Lane4"] = MyDutBerReader(4)
  
  def DUT_getBER(location):
      global myDUTs
      (bits, errors) = myDUTs[location].GetCounter()
      return BitErrorCounter(bits, errors)
  ```

- Implement DUT_synchPattern(location) to synchronize the error counter to the received data stream.
  
  Optionally reset the DUT, but be aware that this should not have side effects on other locations.
  
  The M8070A framework expects the DUT’s error counters to be running all the time. If the synchronization occurs on a stopped to running transition, then the sop as well as the start need to be part of DUT_syncPattern(location).
def DUT_syncPattern(location):
    global myDUTs
    lane = myDUTs[location]
    lane.Stop()
    lane.ResetDut()
    lane.Start()

- Optionally implement DUT_Init(location, initArg) if it is required to configure the DUT to different modes.

  DUT_Init can be called from the remote programming interface, so the test automation is able to execute initialization code on the DUT programmatically.

  The M8070A software will not call DUT_Init unless the script is using it internally, or it is either requested from the remote programming interface, or interactively from within the DUT Control Interface script editor.

**NOTE**

- Making script code executable from within the remote programming interface can cause a security issue in your computer.

- The M8070A software is not able to limit the user script's functionality. It is the user's responsibility to ensure that no unsafe or otherwise critical code is being executed from within DUT_Init.

- Special care should be taken when using the python statements eval or exec, as these allow dynamic execution of python code.

- Keysight recommends not using eval or exec at all, except the DUT or application requires this.

- Keysight is not liable for any kind of damage caused by the use of remote executable script code (see Limitation of Liability in End User License Agreement).
Useful Sources of Information

- http://ironpython.net/
  Home of the IronPython project.
  Especially the IronPython .Net Integration documentation is a valuable
  source of information regarding access to the .Net framework
  (http://ironpython.net/documentation/dotnet/)
- https://www.python.org/
  Home of the python programming language. This is the preferred
  source of information regarding to the language syntax itself.
  When referring the language documentation make sure to use the
  Python 2.7 documentation.
  Keep in mind that Python is not the same as IronPython, so Python
  libraries or modules are not necessarily working with IronPython.
  Title: NET Framework Class Library
  Programming reference of the .NET framework that is accessible to
  IronPython scripts.

Useful Code Snippets

Importing core .NET functionality

The base .NET functionality is implemented in mscorlib.dll

Making a .NET data type available to the script requires loading the
assembly and importing the data type.

Example: Importing and using System.UInt64

```csharp
clr.AddReference("mscorlib")
from System import UInt64
comparedBits = UInt64(0)
comparedBits = comparedBits + UInt64(1e6)
```

Using .NET Generic Types

It is often required to use generic types when calling .NET code.

The C# code to instantiate a List of Strings looks like this:

```csharp
using System;
using System.Collections.Generic;
var stringList = new List<string>();
```
Using User Defined .NET Assemblies (e.g. Implementations of IBerReader)

In order to reference user defined assemblies, the search path of the scripting engine needs to be extended. After this is done the assembly reference can added and the data type imported.

```python
clr.AddReferenceToFile("MyDutCustomBerReader")
from MyNamespace.MyDutCustomBerReader import MyDutBerReader
myDUT = MyDutBerReader()
myDUT.DoSomething()
```

Using the COM Port to Access the DUT

.NET does provide a dedicated class to work with the computer’s COM ports. This class is implemented in the System assembly.

**Importing the SerialPort class**

```python
clr.AddReference("System")
import System.IO.Ports.SerialPort
```
# additional reference assembly mscorlib to have all data types
# available that are used by SerialPort
clr.AddReference("mscorlib")

**Open the COM Port**

# create an instance of SerialPort for COM4
serialPort = System.IO.Ports.SerialPort("COM4")

# configure COM4 to 9600 bit/s 8N1
serialPort.BaudRate = int(9600)
serialPort.DataBits = int(8)
# available choices for Parity are
# None    : System.IO.Ports.Parity.None
# Odd     : System.IO.Ports.Parity.Odd
# Even    : System.IO.Ports.Parity.Even
# Mark    : System.IO.Ports.Parity.Mark
# Space   : System.IO.Ports.Parity.Space
serialPort.Parity = System.IO.Ports.Parity.None
# available choices for StopBits are
# None    : System.IO.Ports.StopBits.None
# One     : System.IO.Ports.StopBits.One
# Two     : System.IO.Ports.StopBits.Two
# OnePointFive : System.IO.Ports.StopBits.OnePointFive
serialPort.StopBits = System.IO.Ports.StopBits.One
# set read and write timeouts to 500ms
serialPort.ReadTimeout = int(500)
serialPort.WriteTimeout = int(500)

# finally open the COM port
serialPort.Open()

**Reading and Writing Data**

# write a string
serialPort.Write("Sending string data")

# sending binary data

# prepare the data to be sent. SerialPort expects an Array of Byte. This requires importing mscorlib!
buf = System.Array[System.Byte] ([0x5A, 0x02, 0x00, 0xaf])

# send 4 bytes beginning at offset 0
serialPort.Write(buf, 0, 4)

# reading 100 bytes
numBytes = 100
buf = System.Array.CreateInstance(System.Byte, numBytes)
serialPort.Read(buf, 0, numBytes)

Closing the COM Port

The following code snippet shows the required code to close the COM port and discard the SerialPort instance. This code should be called in the OnUninstall function of the DUT Control Interface in order to ensure that the COM port becomes unavailable after the currently active script becomes removed from the computer’s memory.

if (serialPort != None):
    # check if COM port is open
    if (serialPort.IsOpen):
        serialPort.Close()
    # dispose the serialPort instance
    serialPort.Dispose()
    # ensure that the disposed object is not used in future
    serialPort = None

Common Pitfalls when Working with COM Ports

A COM port cannot be opened more than once. Therefore it is very important to close the port before the script is unloaded.

This does have several implications:

- If the COM port is not available when the script is being loaded (e.g. when recalling a setting), then the script will fail opening the COM port and the DUT will not be accessible.
• When working with additional tools to communicate with the DUT, e.g. a debug-tool to configure the device, only one process can have control over the COM port at a time. If the M8070A software has opened the COM port in the DUT Control Interface script, then the external tool cannot control the device and vice versa.

• Exceptions in the program flow may not prevent releasing the COM port.

Best Scripting Practices

• Always implement OnUninstall and close the COM port properly.
• Create and open the COM port as late as possible in the script.
  • Import all data types
  • Implement all driver functionality to communicate with the device.
  • Implement the required hook functions and call the device specific functions.
  • Configure and open the COM port.
    The preferred place to do this is in the DUT_connect and DUT_disconnect hooks.
  • Initialize the DUT using the successfully opened COM port.
    If there can be errors during the initialization phase, ensure that the variable that provides access to the COM port is only getting invalid after the COM port has been closed.

Communication with the M8070A Instrument Layer

Overview

The DUT Control Interface provides a functional API to allow interaction with the instrument layer of the M8070A software.

The functional API is provided via the global symbol M8000 within the DUT Control Interface script.

This is similar to the M8000.Scpi API in the Script Editor, but does not allow sending remote commands to the M8070A software. Instead it provides direct access to measurement relevant status and control of the sequencing directly.
This can be used to implement measurement hooks that take the status information of the instrument into consideration and initiate sequence branching in dependency of the reported status.

The API to control the instrument may not be used from within the DUT specific hooks. Doing so will cause error messages when executing the respective hooks at runtime.

If an API call is resulting in an error (e.g. when reading status bits that don't exist for a DUT) then an exception is thrown, which finally results in an error message on the level of the DUT Control Interface script.

Examples

An example of how this can be used to re-train a DUT back into loopback during a Jitter Tolerance measurement can be found in the Tutorials folder of the Factory provided DUT Control Interface scripts.

The script is named Retrain_DUT_in_JTOL.py and demonstrates how the Instrument API can be used to control the sequence in dependency of the reported status information and bit counter values.

API Summary

The following is giving a quick overview over Instrument control API:

**Sequencing Control**

M8000.Instrument.Sequence.Restart(groupOrLocationName)

Restart the sequence on the given group or location.

M8000.Instrument.Sequence.BreakAll()

Execute a sequence break, which will influence all sequencers in the system that are capable of being controlled by the break command.

M8000.Instrument.Sequence.GetBlockNumber(groupOrLocationName)

Reads the current sequence block number from the addressed locations.

**Analyzer Control**

M8000.Instrument.Analyzer.AutoAlign(groupOrLocationName)

Execute an auto-alignment on the addressed locations.
M8000.Instrument.Analyzer.DataCenter(groupOrLocationName)
Executes a data-center alignment on the addressed locations.

M8000.Instrument.Analyzer.ThresholdCenter(groupOrLocationName)
Executes a threshold-center alignment on the addressed locations.

M8000.Instrument.Analyzer.SyncNow(groupOrLocationName)
Executes a pattern synchronization on the addressed locations.

M8000.Instrument.Analyzer.GetBitCounters(groupOrLocationName, combineIntoOneResult)
Read the bit counters from the addressed locations and return either the sum of all addressed counters, or each addressed counter individually.

M8000.Instrument.Analyzer.GetDataLoss(groupOrLocationName, combineIntoOneResult)
Read the data loss status bit from the addressed locations and return either the logical OR of all addressed locations, or each location's status individually.

M8000.Instrument.Analyzer.GetSyncLoss(groupOrLocationName, combineIntoOneResult)
Read the sync loss status bit from the addressed locations and return either the logical OR of all addressed locations, or each location's status individually.

M8000.Instrument.Analyzer.GetSymbolLoss(groupOrLocationName, combineIntoOneResult)
Read the symbol loss status bit from the addressed locations and return either the logical OR of all addressed locations, or each location's status individually.
M8000.Instrument.Analyzer.GetCdrUnlock(groupOrLocationName, combineIntoOneResult)

Read the CDR unlock status bit from the addressed locations and return either the logical OR of all addressed locations, or each location's status individually.

API Details

Sequencing Control

M8000.Instrument.Sequence.Restart(groupOrLocationName)

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Restart the sequence on the given group or location.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameters</td>
<td></td>
</tr>
<tr>
<td>groupOrLocationName</td>
<td>Addresses the locations that shall be restarted.</td>
</tr>
<tr>
<td></td>
<td>The use of .Net regular expression patterns is allowed.</td>
</tr>
<tr>
<td>Returns</td>
<td>Nothing</td>
</tr>
<tr>
<td>Notes</td>
<td>• Initiates the restart, but does not wait until all sequencers have actually executed the request.</td>
</tr>
<tr>
<td></td>
<td>• Not allowed for &quot;DUT_&quot; hooks.</td>
</tr>
<tr>
<td></td>
<td>• Not supported for locations defined by the DUT Control Interface script.</td>
</tr>
</tbody>
</table>

M8000.Instrument.Sequence.BreakAll()

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Execute a sequence break, which will influence all sequencers in the system that are capable of being controlled by the break command.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameters</td>
<td>None</td>
</tr>
<tr>
<td>Returns</td>
<td>Nothing</td>
</tr>
<tr>
<td>Notes</td>
<td>• Initiates the break, but does not wait until the sequencers have executed the break.</td>
</tr>
<tr>
<td></td>
<td>• Not allowed for &quot;DUT_&quot; hooks.</td>
</tr>
</tbody>
</table>
M8000.Instrument.Sequence.GetBlockNumber(groupOrLocationName)

**Functionality**
Reads the current sequence block number from the addressed locations. The use of .Net regular expression patterns is allowed.

**Parameters**
- **groupOrLocationName**: Addresses the locations that shall be read. The use of .Net regular expression patterns is allowed.

**Returns**
`IReadOnlyDictionary<string, int>`
The dictionary contains one entry for each addressed location.

**Notes**
- Not allowed for "DUT_" hooks.
- Not supported for locations defined by the DUT Control Interface script.

Analyzer Control

M8000.Instrument.Analyzer.AutoAlign(groupOrLocationName)

**Functionality**
Execute an auto-alignment on the addressed locations.

**Parameters**
- **groupOrLocationName**: Addresses the locations that shall be aligned. The use of .Net regular expression patterns is allowed.

**Returns**
Nothing

**Notes**
- Is blocking until the alignment has finished.
- Not allowed for "DUT_" hooks.
- Not supported for locations defined by the DUT Control Interface script.
**M8000.Instrument.Analyzer.DataCenter(groupOrLocationName)**

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Executes a data-center alignment on the addressed locations.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameters</td>
<td></td>
</tr>
<tr>
<td>groupOrLocationName</td>
<td>Addresses the locations that shall be aligned.</td>
</tr>
<tr>
<td></td>
<td>The use of .Net regular expression patterns is allowed.</td>
</tr>
<tr>
<td>Returns</td>
<td>Nothing</td>
</tr>
<tr>
<td>Notes</td>
<td>• Is blocking until the alignment has finished.</td>
</tr>
<tr>
<td></td>
<td>• Not allowed for &quot;DUT_&quot; hooks.</td>
</tr>
<tr>
<td></td>
<td>• Not supported for locations defined by the DUT Control Interface script.</td>
</tr>
</tbody>
</table>

**M8000.Instrument.Analyzer.ThresholdCenter(groupOrLocationName)**

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Executes a threshold-center alignment on the addressed locations.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameters</td>
<td></td>
</tr>
<tr>
<td>groupOrLocationName</td>
<td>Addresses the locations that shall be aligned.</td>
</tr>
<tr>
<td></td>
<td>The use of .Net regular expression patterns is allowed.</td>
</tr>
<tr>
<td>Returns</td>
<td>Nothing</td>
</tr>
<tr>
<td>Notes</td>
<td>• Is blocking until the alignment has finished.</td>
</tr>
<tr>
<td></td>
<td>• Not allowed for &quot;DUT_&quot; hooks.</td>
</tr>
<tr>
<td></td>
<td>• Not supported for locations defined by the DUT Control Interface script.</td>
</tr>
</tbody>
</table>
### M8000.Instrument.Analyzer.SyncNow(groupOrLocationName)

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Executes a pattern synchronization on the addressed locations.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Parameters</strong></td>
<td></td>
</tr>
<tr>
<td>groupOrLocationName</td>
<td>Addresses the locations that shall be aligned.</td>
</tr>
<tr>
<td></td>
<td>The use of .Net regular expression patterns is allowed.</td>
</tr>
<tr>
<td><strong>Returns</strong></td>
<td>Nothing</td>
</tr>
<tr>
<td><strong>Notes</strong></td>
<td>• Is blocking until the synchronization has finished.</td>
</tr>
<tr>
<td></td>
<td>• Not allowed for &quot;DUT_&quot; hooks.</td>
</tr>
<tr>
<td></td>
<td>• Supported for locations defined by the DUT Control</td>
</tr>
<tr>
<td></td>
<td>Interface script. But requires implementation of</td>
</tr>
<tr>
<td></td>
<td>DUT_syncPattern.</td>
</tr>
</tbody>
</table>

### M8000.Instrument.Analyzer.GetBitCounters(groupOrLocationName, combineIntoOneResult)

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Read the bit counters from the addressed locations and return either the sum of all addressed counters, or each addressed counter individually.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Parameters</strong></td>
<td></td>
</tr>
<tr>
<td>groupOrLocationName</td>
<td>Addresses the locations that shall be read.</td>
</tr>
<tr>
<td></td>
<td>The use of .Net regular expression patterns is allowed.</td>
</tr>
<tr>
<td>combineIntoOneResult</td>
<td>• True</td>
</tr>
<tr>
<td></td>
<td>Return the sum of all addressed bit counters as a single instance of type BitErrorCounter.</td>
</tr>
<tr>
<td></td>
<td>• False</td>
</tr>
<tr>
<td></td>
<td>Return a dictionary of type IReadOnlyDictionary&lt;string, BitErrorCounter&gt; that holds an entry for each addressed location.</td>
</tr>
<tr>
<td><strong>Returns</strong></td>
<td>BitErrorCounter</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>IReadOnlyDictionary&lt;string, BitErrorCounter&gt;</td>
</tr>
<tr>
<td><strong>Notes</strong></td>
<td>• Not allowed for &quot;DUT_&quot; hooks.</td>
</tr>
</tbody>
</table>
### M8000.Instrument.Analyzer.GetDataLoss(groupOrLocationName, combineIntoOneResult)

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Read the data loss status bit from the addressed locations and return either the logical OR of all addressed locations, or each location's status individually.</th>
</tr>
</thead>
</table>

**Parameters**

<table>
<thead>
<tr>
<th>groupOrLocationName</th>
<th>Addresses the locations that shall be read. The use of .Net regular expression patterns is allowed.</th>
</tr>
</thead>
</table>
| combineIntoOneResult | • True  
  Return the logical OR of all addressed status bits.  
  • False  
  Return a dictionary of type IReadOnlyDictionary<string, bool> that holds an entry for each addressed location. |

**Returns**  
bool  
IReadOnlyDictionary<string, bool>

**Notes**  
• Not allowed for "DUT_" hooks.  
• Not supported for locations defined by the DUT Control Interface script.

### M8000.Instrument.Analyzer.GetSyncLoss(groupOrLocationName, combineIntoOneResult)

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Read the sync loss status bit from the addressed locations and return either the logical OR of all addressed locations, or each location's status individually.</th>
</tr>
</thead>
</table>

**Parameters**

<table>
<thead>
<tr>
<th>groupOrLocationName</th>
<th>Addresses the locations that shall be read. The use of .Net regular expression patterns is allowed.</th>
</tr>
</thead>
</table>
### M8000.Instrument.Analyzer.GetSymbolLoss(groupOrLocationName, combineIntoOneResult)

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Read the symbol loss status bit from the addressed locations and return either the logical OR of all addressed locations, or each location's status individually.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameters</td>
<td><strong>groupOrLocationName</strong> Addresses the locations that shall be read. The use of .Net regular expression patterns is allowed. <strong>combineIntoOneResult</strong> • True Return the logical OR of all addressed status bits. • False Return a dictionary of type IReadOnlyDictionary&lt;string, bool&gt; that holds an entry for each addressed location.</td>
</tr>
<tr>
<td>Returns</td>
<td>bool or IReadOnlyDictionary&lt;string, bool&gt;</td>
</tr>
<tr>
<td>Notes</td>
<td>• Not allowed for &quot;DUT_&quot; hooks. • Not supported for locations defined by the DUT Control Interface script.</td>
</tr>
</tbody>
</table>
M8000.Instrument.Analyzer.GetCdrUnlock(groupOrLocationName, combineIntoOneResult)

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Read the CDR unlock status bit from the addressed locations and return either the logical OR of all addressed locations, or each location's status individually.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameters</td>
<td></td>
</tr>
<tr>
<td>groupOrLocationName</td>
<td>Addresses the locations that shall be read. The use of .Net regular expression patterns is allowed.</td>
</tr>
<tr>
<td>combineIntoOneResult</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• True</td>
</tr>
<tr>
<td></td>
<td>Return the logical OR of all addressed status bits.</td>
</tr>
<tr>
<td></td>
<td>• False</td>
</tr>
<tr>
<td></td>
<td>Return a dictionary of type IReadOnlyDictionary&lt;string, bool&gt; that holds an entry for each addressed location.</td>
</tr>
<tr>
<td>Returns</td>
<td>bool</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>IReadOnlyDictionary&lt;string, bool&gt;</td>
</tr>
<tr>
<td>Notes</td>
<td>• Not allowed for &quot;DUT_&quot; hooks.</td>
</tr>
<tr>
<td></td>
<td>• Not supported for locations defined by the DUT Control Interface script.</td>
</tr>
</tbody>
</table>
SCPI Editor

The **SCPI Editor** lists all SCPI that can be used to program M8020A/M8030A and also provides a platform to execute them.

The following figure depicts the elements of the **SCPI Editor**:

![SCPI Editor Diagram](image)

The listed elements are described below:
- **SCPI Text Box** - Allows you to type the SCPI.
- **SCPI List Pane** - Lists all SCPI related to M8020A/M8030A.
- **Execute Button** - Click this button to run the SCPI.
- **SCPI History Pane** - Maintains the history of the executed SCPI commands and also displays the invalid command errors.
- **Clear History Icon** - Clears the contents of the SCPI History Pane.

SCPI Basics

There are a number of key areas to consider when using SCPI for the first time. These are as follows:
- Instrument Model
- Command Syntax
- Optional Command Keywords
- Query Responses
- Command Separators
- SCPI Command Structure
- Invalid Commands
Instrument Model

SCPI guidelines require that the M8020A/M8030A is compatible with an instrument model. This ensures that when using SCPI, functional compatibility is achieved between instruments that perform the same tasks. For example, if two different instruments have a programmable clock frequency setting, then both instruments would use the same SCPI commands to set their frequency. The instrument model is made up of a number of subsystems.

The sub-system defines a group of functions within a module and has a unique identifier under SCPI, which is called the Root Keyword.

Command Syntax

Commands may be up to twelve characters long. A short-form version is also available which has a preferred length of four characters or less. In this document the long-form and short-form versions are shown as a single word with the short-form being shown in upper-case letters.

For example, the long-form node command SOURce has the short-form SOUR. Using the short form saves time when entering a program; however, using the long form makes a program more descriptive and easier to understand.

SCPI commands may be commands only, commands and queries, or queries only. A question mark at the end of a command indicates that it is a query. If the question mark appears in brackets (?!), the command has a command and query form.

Optional Command Keywords

Some layers in the SCPI command structure are optional. These optional keywords are indicated by square brackets ([ ]). A typical use for these types of keywords is with a command that is unique to one module. In this case, the top layer (Root Keyword) of the command structure may be omitted.

For example, the following command code segments are functionally identical:

```
[:SOURce]:JITTer[:GLOBal][:STATe] <ON|OFF|1|0>
:JITTer <ON|OFF|1|0>
:JITT <ON|OFF|1|0>
:jitt <ON|OFF|1|0>
```

Note that it is not necessary to include the syntax inside the square brackets ([ ]).
Query Responses

It is possible to interrogate the individual settings and status of a device using query commands. Retrieving data is a two-stage operation.

The query command is sent from the controller using the OUTPUT statement and the data is read from the device using the ENTER statement. A typical example is the SCPI IEEE 488.2 Common Command *IDN? which queries the identity of a device.

NOTE
When sending strings to the instrument, either the double quote ("), or the single quote may be used (‘), the latter being more suited to PASCAL programs, which make use of a single quote; the former being more suited to use in BASIC programs, which use a double quote as a delimiter.

Command Separators

The SCPI command structure is hierarchical and is governed by commas, semicolons and colons:

• Commas are used to separate parameters in one command.
• Colons are used to separate levels.
• Semicolons are used to send more than one command to the instrument at a time.

It is possible to send several commands in one pass, as long as the commands all belong to the same node in the SCPI tree. The commands have to be separated by semicolons.

The following SCPI commands provide examples of this.

SOURce:VOLTage:OFFSet ‘M2.DataOut2’,-0.99
SOURce:VOLTage:AMPLitude ‘M2.DataOut2’,1.11

These commands can also be sent as follows:

VOLT:OFFS ‘M2.DataOut2’,-0.99; ‘M2.DataOut2’,AMPL 1.11

SCPI Command Structure

The SCPI command structure can be best examined by means of an example. For example, the command to set the generator’s output amplitude is:

[:SOURce]:VOLTage[:AMPLitude] ‘M1.DataOut1’,1.11
The structure of this command can be illustrated as follows:

- [:SOURce] - This is the top layer of the command structure and identifies the source subsystem.
- :VOLTage - This is the next layer and defines the subnode for setting a voltage level.
- [:AMPLitude] - This is the command itself for setting the output amplitude level.
- ‘M1.DataOut1’, 1.11 - This specifies module 1, DataOut port of channel 1, and specifies an amplitude of 1.11.

To translate this syntax into a command line, follow the convention described above. Remember, however, that the command line can be created in several different ways. It can be created with or without optional keywords, and in a long or short form. The following example gives three possible forms of the command line; all are acceptable.

In long form:
:SOURce:VOLTage:AMPLitude 'M1.DataOut1',1.11

In short form:
:SOUR:VOLT:AMPL 'M1.DataOut1',1.11

With the optional commands removed:
:VOLT 'M1.DataOut1',1.11

The long form is the most descriptive form of programming commands in SCPI.

Invalid Commands

A command is invalid and will be rejected if:
- It contains a syntax error.
- It cannot be identified.
- It has too few or too many parameters.
Executing SCPI Commands

To execute a SCPI command, follow the given steps:
1. Select the SCPI from the given list. You can also type the SCPI in the provided text box to expedite the command search.
2. Use the proper SCPI command syntax along with the command separators. For complete details, refer to SCPI Basics on page 588. The following example shows a SCPI command to enable Global Jitter State:
   ```scpi
   :SOURce:JITTER:GLOBal:STATe 'M1.SYSTEM', ON
   ```
3. Click **Execute**. The output of the SCPI command will be displayed in the **History** pane as shown in the following figure:

   ![SCPI Editor](image)

4. Click the **Clear History** icon to clear the contents of **History** pane.

For complete details on M8020A/M8030A/M8040A SCPI commands, refer to the **M8000 Series Programming Guide**.
SCPI Recorder

The SCPI recorder is a tool that enables you to quickly discover, record, and learn about the commands needed to perform almost any task remotely. When you've recorded your commands, you can play them back and save them as a macro. Click the REC button and the recorder performs the following tasks:

1. Captures most M8070A setting changes (mouse clicks or keyboard presses).
2. Translates the setting into an equivalent SCPI remote-programming command.
3. Records the SCPI command within the dialog box.
4. Play back the recorded commands.

Click **Menu Bar > Utilities > SCPI Recorder** to open this dialog box.

- **Start/Stop Recording** - Click the REC button to begin recording. The button turns red to alert you that any mouse clicks or keyboard presses will be recorded. When you have captured all your commands, click the STOP REC button again to end the recording. A REC indicator will appear on the right side of the menu bar until the recording is going on.
9 Utilities

- **Play/Pause Commands** - Click **Play** to play back your recording and observe the commands as they are executed. Playback will only start when you stop the recording the commands. Use **Playback Speed** to control the rate that the commands are played: Slow, Normal, Fast or Custom. In case of Custom, you can set the playback speed from 0 to 120 seconds. During playback, click **PAUSE** to temporarily stop the playback. You can also right-click and then click **Execute** to run a single command from the list of recorded commands.

- **Copy/Paste Recorded Commands** - You can use Windows clipboard to copy your recorded commands. Click on a command to select it. Shift click to select a range of commands. Ctrl click to select non-adjacent commands. Ctrl-A selects all commands. Ctrl-C copies all selected commands. In another application, use Ctrl-V to paste the commands. You can also right-click and then click **Copy**. By copying commands you can create your own sequence of commands and execute them later.

- **Save/Load Recorded Commands** - Click **Save Script File** to save the recorder commands into a script file (.TXT). This file can be reloaded into the dialog box at any time by clicking **Load Script File**. The SCPI script files are ASCII files, so you can edit them as well as create new script files using a text editor.

- **Delete Recorded Commands** - Click **Delete All** to delete all recorded commands from the dialog box. To delete a single command, select the command and press "Delete" on your keyboard. Alternatively, you can right-click and then click **Delete**.
- **Run SCPI Recorder in Background** - You can continue the SCPI recording in the background while you perform the other GUI functions. To do so, click on the **SCPI Recorder options** > **Close**. You will see the following message:

![Continue Recording dialog](image)

Click “Yes” to continue recording in the background. The **SCPI Recorder** dialog will minimize. You can recall this dialog either on pressing the **REC** button or clicking on **Utilities** > **SCPI Recorder**.

On closing the **SCPI Recorder** dialog, all the captured commands will appear in the dialog unless the M8070A software instance is closed.
Self Test Utility

The **Self Test** utility checks the specific system information of the hardware components for basic functionality. On execution, the following results are displayed:

- System related information such as connected modules, serial no. and hardware revision.
- Module related information such as calibration, power supplies and memory controller.

Launching the Self Test Utility

To launch the **Self Test**:

- Go to the **Menu Bar > Utilities** and then select **Self Test**.

The **Self Test** utility will appear as shown in the following figure:

![Self Test Utility](image)

The **Self Test** utility consists of the following GUI elements:

- Toolbar
- Self Test History
- Self Test Results Window
Utilities
9

Toolbar

The toolbar provides the following convenient self test functions:

Table 84

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Execute Self Test</td>
<td>Click this icon to run the self test.</td>
</tr>
<tr>
<td></td>
<td>Abort Self Test</td>
<td>Click this icon abort a self test.</td>
</tr>
<tr>
<td></td>
<td>Save Self Test</td>
<td>Click this icon to save the selected self test from the history. For details, refer to Saving Self Test Results on page 599.</td>
</tr>
<tr>
<td></td>
<td>Delete Self Test</td>
<td>Click this icon to delete the selected self test from the history.</td>
</tr>
<tr>
<td></td>
<td>Close Report</td>
<td>Click this icon to close the self test result.</td>
</tr>
</tbody>
</table>

Self Test History

The Self Test History maintains the history of self tests (Passed or Failed) executed by the user. The passed self test results are indicated by green LED while the failed ones are indicated by red LED.
At any point of time, you can double-click on the shown self test entries to view their respective results. Once viewed, you can click on Close Report icon to close the self test results.

The Self Test History also allows you to save and delete the self test reports. For details, refer to Saving Self Test Results on page 599 and Deleting Self Test Results on page 600.

Self Test Results Window

The Self Test Results window displays the results of the executed self test. It display the following results:

- System related information such as connected modules, serial no. and hardware revision.
- Module related information such as calibration, power supplies and memory controller.

Executing Self Test

To execute a self test:

- Terminate each Data Out port with 50 Ω.
- Remove any devices from the tested M8000 system as any connected device under test might be damaged.
- Click the Execute Self Test icon. The following message will appear:
Before performing a system self-test, terminate each Data Out port with 50 Ω. Take care to remove any devices from the tested M8000 system as any connected device under test might be damaged.

Aborting Self Test

To abort a self test:

- Click the Abort Self Test icon to abort the self test. The self test will stop and the self test failure entry will be displayed in the Self Test History.

Saving Self Test Results

To save the self test results from the Self Test History:

- Click the Save Report icon. A standard Save Result dialog will appear.
• Use the navigation pane to provide a location to save the file.
• Provide a file name and specify the file format. You can save the file in RTF, HTML, XML and TXT formats.
• Click Save.

Deleting Self Test Results

To delete a self test entry from the Self Test History:

• Click_Delete Report_ icon. The entry will be removed from the Self Test History.
Licenses Window

The **Licenses** window displays the license information currently installed in the modules or host.

Launching the Licenses Window

To launch the **Licenses** window:
- Go to the **Menu Bar > Utilities** and then select **Licenses**.

The **Licenses** window is shown in the following figure:

![Licenses Window](image)

The **Licenses** window is divided into two panels. The left panel shows the modules/host information. Once you select modules/host, the corresponding license information is shown in the right panel.

To exit the **Licenses** window, click the **Close** button.

For detailed information on the M8020A/M8030A licenses, refer to **Licenses** on page 613.
Settings Window

The **Settings** window allows you to set the display and channel settings in the GUI. In addition, you can use this dialog to enable/disable **Parameter** hint dialog on the GUI startup.

To open the **Settings** window, go to **Menu Bar > Utilities** and then select **Settings...** The **Setting** window will appear as shown in the following figure:

![Settings Window](image)

The **Settings** window has the following tabs:
- Display tab
- Channel tab
- Hints tab

These tabs are described in the section, that follows.
Display Tab

The Display tab provides the following options:

- **Display** - The Display option provides the following choices:
  - **Color Scheme** - Use this option to change the color scheme of the GUI. You can choose between the dark or light scheme. The dark scheme is selected by default.
  - **Font Setting** - Use this option to change the font settings in the GUI.
  - **Use System Fonts** - Select this option to use the system fonts in the GUI.

Keypad Visibility

- **Disable Keypad** - Use this option to disable the on-screen numeric keypad in the GUI. The on-screen numeric keypad is enabled by default.

Channel Tab

- **Channel** - The Channel tab displays the color schemes applied to the various channels of the connected modules. In addition, this tab also allows you to assign your own color schemes to each individual channel of the connected modules.

  The following figure depicts how the different color schemes are applied to the various channels of the connected modules.
You can also select **Use Instrument Front Panel Colors** option to assign the color which is available on the front panel of the instrument to each individual channel.

**NOTE**

The color schemes assigned to the channels will change if you switch to light color scheme from the **Display Setting** tab.

**Hints Tab**

The **Hints** tab allows you to show/hide the **Parameter** hint dialog which appears in the **Setup View** on the GUI startup. For details, see **Setup View** on page 191. Select/unselected the corresponding check-box to show/hide the **Parameter** hint dialog.
Logger Window

The **Logger** window displays errors, warnings and information messages along with their respective descriptions, applications from where they are generated and their time stamps.

The **Logger** window always appears whenever you launch the M8070A user interface. However, you can open/close this window by clicking on the **Logger** button, present on the status bar.

The **Logger** window allows you to:

- **Message Selection** - Use this option to choose whether you want to view errors, warnings or information message.
- **Copy** - Use this option to copy a message. You need to select a message in order to enable copy feature.
- **Select All** - Use this option to select all messages. It also enables copying all messages.
- **Clear Messages** - Use this option to delete all messages.
- **Auto Scroll** - Use this option to enable/disable auto scroll option. When the **Auto Scroll** option is enabled, it will automatically scroll you to the new message without using the scroll bar.
- **Open On Message** - Turn this button OFF if you don't want the Logger window to automatically pop-up whenever a message is received.
- **Column Option** - Use this button to filter the messages either from **Log From** column or **Date and Time** column.
- **Search Messages** - Use this option to search messages by providing an input in the **Search Messages** search box.
SCPI Server Information

This dialog lists the VISA resource and remote access strings to connect instruments.

For Remote Access: Use "CND-181030.mssl.keysight.com" instead of "localhost".
Note: To use TCP/IP connections it may be necessary to add the instrument in the Keysight ConnectionExpert.
Utilities 9

Plug-in Manager

A plug-in is a piece of software application that acts as an add-on to the main software and enhances its capability. Plug-in allows the software to host additional functionality without undergoing a major modification or enhancement. A plug-in is not a permanent part of the software, hence can be installed, uninstalled and updated as and when required.

The M8070A system software for the M8000 Series of BER Test Solutions supports plug-ins. Thus, the present capabilities of M8070A can be further enhanced by simply adding the required plug-ins.

The Plug-in Manager simplifies all the tasks related to plug-in management. It displays list of plug-ins that are installed in the software. For each plug-in, it displays the information such as Name, Version, Vendor, Description, State and Build Date. In addition, the Plug-in Manager also allows you to install, uninstall and update the plug-ins.

How to Launch Plug-in Manager

To launch Plug-in Manager, open the M8070A user interface and then go to Menu > Utilities and then Plug-in Manager. The Plug-in Manager window will appear as shown in the following figure:

The Plug-in Manager window displays two types of plug-ins:

- **Compatible Plug-ins** – plug-ins which are compatible with the current version of software.
- **In-Compatible Plug-ins** – plug-ins which are not compatible with the current version of software.
The Plug-in Manager window displays the following information of each plug-in:

- **Name** - Name of the plug-in
- **Version** - Version no. of the plug-in
- **Vendor** - Vendor/publisher of the plug-in
- **Description** - Brief description of the plug-in
- **State** - State of the plug-in. For details on different plug-in states, see Plug-in States on page 608.
- **Build Date** - Build date of the plug-in

### Plug-in States

There can be the following plug-in states:

- **Installed** - When the plug-in is installed but the M8070A software is not re-started. In this case, the installed plug-in is not loaded or it cannot be used. You have re-start the M8070A software in order to load the plug-in.
- **Loaded** - When the plug-in is installed and the M8070A software has been re-started. In this case, the installed plug-in is ready to be used. Remember, you have to restart the M8070A software in order to load the plug-in.
- **Not Loaded** - When the plug-in is installed and but failed to load. In this case, the installed plug-in cannot be used.
- **Version In-Compatible** - When the version of the installed plug-in is not compatible with the current version of M8070A software.

### How to Install a Plug-in

The Plug-in Manager window allows you to install a plug-in.

To do so:

1. Download plug-in file from Keysight webpage:  
   www.keysight.com/find/m8000
2. Click on Install Plug-in from File button. A Window’s standard Open dialog will appear.
3. Locate the plug-in file (*.M8KP) you want to install and click OK.
4. On the successful installation of plug-in, the following message will appear:
5 Restart the software. Once you restart the software, the plug-in state will change to **Loaded**. See **Plug-in States** on page 608.

**NOTE**

Ensure to restart the M8070A software for the changes to take effect.

How to Uninstall a Plug-in

The **Plug-in Manager** window allows you to uninstall a plug-in.

To do so:

1. Select the plug-in from the list.
2. Click on **Uninstall Selected Plug-in** button or right-click on the selected plug-in. The **Uninstall Plug-in** dialog will open.
3. Click **Yes**. If the state of plug-in is **Installed**, then it will be immediately uninstalled from the software.
4. However, if the plug-in is currently in use (**Loaded** or **Not Loaded**), then you will receive the following message.
How to Update a Plug-in

The Plug-in Manager window also allows you to update an already installed plug-in.

Following the given steps to update the plug-in with its higher version:

1. Download plug-in file from Keysight webpage:
   www.keysight.com/find/m8000

2. Click on **Install Plug-in from File** button. A Window’s standard **Open** dialog will appear.

3. Locate the plug-in file (*.M8KP) you want to update and click **OK**. You will see the following message:

4. Click **Yes**. If the state of plug-in is **Installed**, then it will be immediately updated and the following message will appear:

   **Uninstallation Information**

   MIPI_CPHY_Editor_Plugin is marked for uninstallation. It is currently in use and will be
   uninstalled on next startup.

5. Restart the software. The plug-in will be uninstalled on software startup.

How to Update a Plug-in

The Plug-in Manager window also allows you to update an already installed plug-in.

Following the given steps to update the plug-in with its higher version:

1. Download plug-in file from Keysight webpage:
   www.keysight.com/find/m8000

2. Click on **Install Plug-in from File** button. A Window’s standard **Open** dialog will appear.

3. Locate the plug-in file (*.M8KP) you want to update and click **OK**. You will see the following message:

   **Install Plugin**

   Current version 2.4.88.1 of MIPI_CPHY_Editor_Plugin is already installed. Do you want to update it
   with version 3.4.88.1?

4. Click **Yes**. If the state of plug-in is **Installed**, then it will be immediately updated and the following message will appear:
5 However, if the plug-in is currently in use (Loaded or Not Loaded), then you will receive the following message.

6 Click Yes. The following message will appear:

7 Click OK. The selected plug-in will be uninstalled from the software. You can now install the new version of that plug-in. For installation procedure, see How to Install a Plug-in on page 608.
The Plug-in Manager window does not directly allow you to update an installed plug-in with previous (lower) version. If you try to do so it will give the following error message:

![Installation Failed!](image)

In this case, you have to uninstall the plug-in and then install the previous (lower) version of that plug-in again.

How to Access an Installed Plug-in Through M8070A User Interface

Follow the steps to access an installed plug-in through M8070A user interface:

1. Launch M8070A software user interface.
2. In the M8070A user interface, go to Menu Bar and then click Application menu. It will list all installed plug-ins.
3. Select the plug-in.
4. The plug-in user interface will appear in the M8070A software.

For complete details on how to operate plug-in user interface, refer to the respective plug-in’s User Guide
10 Licenses

Overview / 614
Supported Licenses / 615
M8020A/M8030A Licenses / 618
M8040A Licenses / 626
Keysight License Manager / 628
Keysight License Service / 629
Installing the Licenses / 630
Overview

The M8070A software requires a license to communicate with the M8020A/M8030A/M8040A hardware. You either purchased an M8070A license to install on a dedicated host computer (M8070A-OTP) or one that can be installed on a network server that will be used as a license server for operation over a company network (M8070A-ONP, floating/networked).

In addition to the M8070A license, the M8020A, M8030A and M8040A, being a modular product, includes different sets of modules hosted in an M9505A or M9514A AXI chassis, respectively. Each module has its own licenses corresponding to specific features. Therefore, you need to install these licenses in your instrument in order to use the modules/features.
Supported Licenses

The M8020A/M8030A/M8040A supports the following types of licenses:

- Node-Locked (Uncounted) Licenses
- Floating Licenses
- Module-Specific Licenses

In addition to the binding characteristic (node-locked, floating, or module-specific), licenses have the following characteristics:

- Duration (permanent or time-perishable)
- Version (conventional or date-based)
- Features (an instrument may have one or more features licensed)
- Transportability (the ability to be moved from one instrument to another)

Finally, the following license types are available for legacy systems. Please contact Keysight Technologies support first (http://www.keysight.com) if you are considering using these in new designs:

- Counted Node-Locked License
- Upgrade License

Node-Locked (Uncounted) Licenses

Node-locked licenses are tied to a particular instrument or PC Host ID. The Host ID consists of the model number and serial number, and is stored in SecureStorage on the instrument or PC.

The node-locked licenses can be of the following type:

- Permanent licenses that do not have expiration date.
- Time-perishable licenses that have expiration date.
- Transportable licenses that can be moved from one instrument to another, and may be either time-perishable or permanent.
- Non-removable licenses that typically provide right-to-use for a hardware component.

Permanent License

A permanent license is the most common type of license. It does not have an expiration date.
Temporary License (Trial License)

A temporary (trial) license differs from the perpetual license in a way that it has an expiration date. These licenses are typically provided at no charge for evaluation of new functionality that is licensed. Also, rental companies may use the trial licenses to enable a certain functionality for a limited time-frame.

A temporary (trial) license can be of the following two types:

- **30 days free trial license** - The 30 days free trial license for the M8000 Series of BER Test Solutions can be downloaded using the following weblink:

- **9 months DST license** - The DST license can only be ordered by rental companies and distributors.

Transportable Node-Locked License

A transportable license can be moved (transported) from one instrument to another. It can be either permanent or time-perishable, but it must be node-locked. Once a license has been transported off of a system, that feature is no longer valid on that system. If a user wishes to transport the license back to the original device, he or she is free to do so.

When removed from the device, this license is marked as not reinstallable on the system. The user is notified and a transport confirmation key will be generated so that a new license can be redeemed with a new Host ID.

If the license file is transported back to the original system, a unique serial number ensures that the new license has a different signature from any previously installed and transported licenses (which cannot be reinstalled).

You can acquire a transportable license by moving the license from a system where it was previously installed, or by acquiring the license from the Keysight Software Manager web site. You cannot manually create a transportable license. Even if you know the correct syntax, construct the license correctly, and sign it with a license generator, you will not be able to transport the license. The Keysight Software Manager which provides the real-time re-hosting does not recognize a transportable license that it did not originate.
Floating Licenses

A floating license entitles anyone on the same network to use the licensed software, up to the numeric limit specified in the license file. You must configure a license server in order to use floating licenses. These licenses require the license server manager daemon (FLEXnet Publisher Imadmin) and the Keysight daemon (agilent.exe) to be running in order to count the concurrent usage of the licenses.

Floating licenses are further subdivided into local and remote licenses. Local licenses are stored in the licensing folder and in secure storage; remote licenses are kept in a “Remote Licenses” sub folder, and are not stored in SecureStorage. Floating licenses are installed on two different host machines, the application host and the server host. A license is considered to be local if there is a SERVER line in the license with a host name that refers to the host where the license is installed. Conversely, a license is considered to be remote if there is a SERVER line in the license that has a host name that is different from the host where the license is installed.

Module-Specific Licenses

Module-specific licenses are a specialized type of license that enables a specific module of a modular instrument (such as a PXI or AXIe module). The module-specific license resides on the controller and is bound to both the controller (typically a PC) and the module; the controller by means of the HostID, and the module itself by means of the module serial number which is embedded in the feature name for the license. Module-specific licenses may be time-perishable.
M8020A/M8030A Licenses

The licenses used by the various modules of M8020A/M8030A are listed in the following tables:

M8070A System Software for M8000 Series of BER Test Solutions

**M8070 - M8000 Series BER Test Solution License**

<table>
<thead>
<tr>
<th>Product</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>M8070A-0TP</td>
<td>0TP</td>
<td>System Software for M8000 Series of BER Test Solutions, Transportable, Perpetual License</td>
</tr>
<tr>
<td>M8070A-0NP</td>
<td>0NP</td>
<td>System Software for M8000 Series of BER Test Solutions, Network/Floating, Perpetual License</td>
</tr>
</tbody>
</table>

M8041A - High-Performance BERT Module

**M8041A - Basic Selection**

<table>
<thead>
<tr>
<th>Product</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>M8041A-G08</td>
<td>G08</td>
<td>Generator one Channel, Data Rate up to 8.5 Gb/s</td>
</tr>
<tr>
<td>M8041A-G16</td>
<td>G16</td>
<td>Generator one Channel, Data Rate up to 16 Gb/s (Upgrade: U16)</td>
</tr>
<tr>
<td>M8041A-C08</td>
<td>C08</td>
<td>BERT one Channel, Data Rate up to 8.5 Gb/s</td>
</tr>
<tr>
<td>M8041A-C16</td>
<td>C16</td>
<td>BERT one Channel, Data Rate up to 16 Gb/s (Upgrade: UED)</td>
</tr>
</tbody>
</table>
### M8041A- Module Functionality

<table>
<thead>
<tr>
<th>Product</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>M8041A-0G2</td>
<td>0G2</td>
<td>Second Channel for Generator, License</td>
</tr>
<tr>
<td>M8041A-0A2</td>
<td>0A2</td>
<td>Second Channel for Analyzer, License</td>
</tr>
<tr>
<td>M8041A-0G3</td>
<td>0G3</td>
<td>Advanced Jitter Sources for Receiver Characterization, Module-wide License</td>
</tr>
<tr>
<td>M8041A-0G4</td>
<td>0G4</td>
<td>Multi-tap De-emphasis, Module-wide License</td>
</tr>
<tr>
<td>M8041A-0G5</td>
<td>0G5</td>
<td>Adjustable ISI, Module-wide License</td>
</tr>
<tr>
<td>M8041A-0G6</td>
<td>0G6</td>
<td>Reference Clock Input with Multiplying PLL, Clockgroup-wide License</td>
</tr>
<tr>
<td>M8041A-0G7</td>
<td>0G7</td>
<td>Advanced Interference Sources for Receiver Characterization, Module-wide License</td>
</tr>
<tr>
<td>M8041A-0S1</td>
<td>0S1</td>
<td>Interactive Link Training for PCI Express, Clockgroup-wide License</td>
</tr>
<tr>
<td>M8041A-0S2</td>
<td>0S2</td>
<td>SER/FER Analysis for Coded and Retimed Loopback, Clockgroup-wide License</td>
</tr>
<tr>
<td>M8041A-0A3</td>
<td>0A3</td>
<td>Analyzer Equalization, Module-wide License</td>
</tr>
<tr>
<td>M8041A-0S3</td>
<td>0S3</td>
<td>Interactive Link Training for USB 3.0 and USB 3.1, Module wide License</td>
</tr>
<tr>
<td>M8041A-0S4</td>
<td>0S4</td>
<td>Interactive Link Training for PCI Express 8Gt/s and 16Gt/s, Clock Group wide License</td>
</tr>
<tr>
<td>M8041A-0S1</td>
<td>0S1</td>
<td>Interactive Link Training for PCI Express, 8Gt/s, Clock Group wide License</td>
</tr>
<tr>
<td>M8041A-0SX</td>
<td>0SX</td>
<td>10GBASE-KR Transmitter Equalization Training, Module-wide License</td>
</tr>
</tbody>
</table>
### Table 88  M8041A - License Upgrades for M8041A High-Performance BERT Module

<table>
<thead>
<tr>
<th>Product</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>M8041A-U16</td>
<td>U16</td>
<td>Upgrade to 16 Gb/s data rate from M8041A-G08 and M8041A-G08, Module-wide License</td>
</tr>
<tr>
<td>M8041A-UED</td>
<td>UED</td>
<td>Upgrade to BERT from M8041A-G08 and M8041A-G16, Module-wide License</td>
</tr>
<tr>
<td>M8041A-UG2</td>
<td>UG2</td>
<td>Upgrade to Second Channel for Generator, License</td>
</tr>
<tr>
<td>M8041A-UA2</td>
<td>UA2</td>
<td>Upgrade to Second Channel for Analyzer, License</td>
</tr>
<tr>
<td>M8041A-UG3</td>
<td>UG3</td>
<td>Upgrade to Advanced Jitter Sources for Receiver Characterization, Module-wide License</td>
</tr>
<tr>
<td>M8041A-UG4</td>
<td>UG4</td>
<td>Upgrade to Multi-tap De-emphasis, Module-wide License</td>
</tr>
<tr>
<td>M8041A-UG5</td>
<td>UG5</td>
<td>Upgrade to Adjustable ISI, Module-wide License</td>
</tr>
<tr>
<td>M8041A-UG6</td>
<td>UG6</td>
<td>Upgrade to Reference Clock Input with Multiplying PLL, Clockgroup-wide License</td>
</tr>
<tr>
<td>M8041A-UG7</td>
<td>UG7</td>
<td>Upgrade to Advanced Interference Sources for Receiver Characterization, Module-wide License</td>
</tr>
<tr>
<td>M8041A-US1</td>
<td>US1</td>
<td>Upgrade to Interactive Link Training for PCI Express, Clockgroup-wide License</td>
</tr>
<tr>
<td>M8041A-US2</td>
<td>US2</td>
<td>Upgrade to SER/FER Analysis for Coded and Retimed Loopback, Clockgroup-wide License</td>
</tr>
<tr>
<td>M8041A-UA3</td>
<td>UA3</td>
<td>Upgrade to Analyzer Equalization, Module-wide License</td>
</tr>
<tr>
<td>M8041A-US3</td>
<td>US3</td>
<td>Upgrade to Interactive Link Training for USB 3.0 and USB 3.1, Module-wide License</td>
</tr>
<tr>
<td>M8041A-US4</td>
<td>US4</td>
<td>Upgrade to Interactive Link Training for PCI Express for PCI Express 8GT/s and 16GT/s, Clock Group wide License</td>
</tr>
<tr>
<td>M8041A–U14</td>
<td>U14</td>
<td>Upgrade of M8041A-US1 to US4, Interactive Link Training for PCI Express for 8GT/s and 16GT/s, Clock Group wide License</td>
</tr>
<tr>
<td>M8041A-US1</td>
<td>US1</td>
<td>Upgrade to Interactive Link Training for PCI Express, 8GT/s, Clock Group wide License</td>
</tr>
<tr>
<td>Product</td>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>--------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>M8041A-USX</td>
<td>USX</td>
<td>Upgrade to 10GBASE-KR Transmitter Equalization Training, Module-wide License</td>
</tr>
<tr>
<td>M8041A-UR3</td>
<td>UR3</td>
<td>Upgrade of M8041A-0A3 with latest CTLE Presets, Return-to-Factory</td>
</tr>
</tbody>
</table>
M8051A - High-Performance BERT Module

M8051A - Basic Selection

Table 89  M8051A- Basic Selection

<table>
<thead>
<tr>
<th>Product</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>M8051A-G08</td>
<td>G08</td>
<td>Generator one Channel, Data Rate up to 8.5 Gb/s</td>
</tr>
<tr>
<td>M8051A-G16</td>
<td>G16</td>
<td>Generator one Channel, Data Rate up to 16 Gb/s</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Upgrade: U16)</td>
</tr>
<tr>
<td>M8051A-C08</td>
<td>C08</td>
<td>BERT one Channel, Data Rate up to 8.5 Gb/s</td>
</tr>
<tr>
<td>M8051A-C16</td>
<td>C16</td>
<td>BERT one Channel, Data Rate up to 16 Gb/s (Upgrade: UED)</td>
</tr>
</tbody>
</table>

M8051A - Module Functionality

Table 90  M8051A- Module Functionality

<table>
<thead>
<tr>
<th>Product</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>M8051A-0G2</td>
<td>0G2</td>
<td>Second Channel for Generator, License</td>
</tr>
<tr>
<td>M8051A-0A2</td>
<td>0A2</td>
<td>Second Channel for Analyzer, License</td>
</tr>
<tr>
<td>M8051A-0G3</td>
<td>0G3</td>
<td>Advanced Jitter Sources for Receiver Characterization, Module-wide License</td>
</tr>
<tr>
<td>M8051A-0G4</td>
<td>0G4</td>
<td>Multi-tap De-emphasis, Module-wide License</td>
</tr>
<tr>
<td>M8051A-0G5</td>
<td>0G5</td>
<td>Adjustable ISI, Module-wide License</td>
</tr>
<tr>
<td>M8051A-0G7</td>
<td>0G7</td>
<td>Advanced Interference Sources for Receiver Characterization, Module-wide License</td>
</tr>
<tr>
<td>M8051A-0A3</td>
<td>0A3</td>
<td>Analyzer Equalization, Module-wide License</td>
</tr>
<tr>
<td>M8051A-0SX</td>
<td>OSX</td>
<td>10GBASE-KR Transmitter Equalization Training, module-wide license</td>
</tr>
</tbody>
</table>
Table 91  M8051A - License Upgrades for M8051A High-Performance BERT Module

<table>
<thead>
<tr>
<th>Product</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>M8051A-U16</td>
<td>U16</td>
<td>Upgrade to 16 Gb/s data rate from M8051A-G08 and M8051A-C08, Module-wide License</td>
</tr>
<tr>
<td>M8051A-UED</td>
<td>UED</td>
<td>Upgrade to BERT from M8051A-G08 and M8051A-G16, Module-wide License</td>
</tr>
<tr>
<td>M8051A-UG2</td>
<td>UG2</td>
<td>Upgrade to Second Channel for Generator, Module-wide License</td>
</tr>
<tr>
<td>M8051A-UA2</td>
<td>UA2</td>
<td>Upgrade to Second Channel for Analyzer, Module-wide License</td>
</tr>
<tr>
<td>M8051A-UG3</td>
<td>UG3</td>
<td>Upgrade to Advanced Jitter Sources for Receiver Characterization, Module-wide License</td>
</tr>
<tr>
<td>M8051A-UG4</td>
<td>UG4</td>
<td>Upgrade to Multi-tap De-emphasis, Module-wide License</td>
</tr>
<tr>
<td>M8051A-UG5</td>
<td>UG5</td>
<td>Upgrade to Adjustable ISI, Module-wide License</td>
</tr>
<tr>
<td>M8041A-UG7</td>
<td>UG7</td>
<td>Upgrade to Advanced Interference Sources for Receiver Characterization, Module-wide License</td>
</tr>
<tr>
<td>M8051A-UA3</td>
<td>UA3</td>
<td>Upgrade to Analyzer Equalization, Module-wide License</td>
</tr>
<tr>
<td>M8051A-U16</td>
<td>U16</td>
<td>Upgrade to 16 Gb/s data rate from M8051A-G08 and M8051A-C08, Module-wide License</td>
</tr>
<tr>
<td>M8051A-USX</td>
<td>USX</td>
<td>Upgrade to 10GBASE-KR Transmitter Equalization Training, Module-wide License</td>
</tr>
<tr>
<td>M8051A-UR3</td>
<td>UR3</td>
<td>Upgrade of M8051A-0A3 with latest CTLE Presets, Return-to-Factory</td>
</tr>
<tr>
<td>M8051A-US6</td>
<td>US6</td>
<td>Upgrade to SAS-3 transmitter equalization training, module-wide license</td>
</tr>
</tbody>
</table>
### M8061A Multiplexer 2:1 with De-emphasis

**Table 92  M8061A Licenses**

<table>
<thead>
<tr>
<th>Product</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>M8061A-001</td>
<td>001</td>
<td>32 Gb/s multiplexer</td>
</tr>
<tr>
<td>M8061A-004</td>
<td>004</td>
<td>4-tap de-emphasis</td>
</tr>
<tr>
<td>M8061A-008</td>
<td>008</td>
<td>Extension to 8-tap de-emphasis</td>
</tr>
<tr>
<td>M8061A-U04</td>
<td>U04</td>
<td>Upgrade to 4-tap de-emphasis</td>
</tr>
<tr>
<td>M8061A-U08</td>
<td>U08</td>
<td>Upgrade to 8-tap de-emphasis</td>
</tr>
</tbody>
</table>

### M8062A 32Gb/s Front-end for J-BERT M8020A High-Performance BERT

#### M8062A - Basic Selection

**Table 93  M8062A - Basic Selection**

<table>
<thead>
<tr>
<th>Product</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>M8062A-C32</td>
<td>C32</td>
<td>32 Gb/s BERT front-end</td>
</tr>
<tr>
<td>M8062A-G32</td>
<td>G32</td>
<td>32 Gb/s Pattern generator front-end</td>
</tr>
</tbody>
</table>

#### M8062A - Module Functionality

**Table 94  M8062A - Module Functionality**

<table>
<thead>
<tr>
<th>Product</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>M8062A-0G4</td>
<td>0G4</td>
<td>Multi-tap De-emphasis License</td>
</tr>
<tr>
<td>M8062A-0G5</td>
<td>0G5</td>
<td>Adjustable Intersymbol Interference (ISI) License</td>
</tr>
<tr>
<td>M8062A-0A3</td>
<td>0A3</td>
<td>Analyzer Equalization License</td>
</tr>
<tr>
<td>M8062A-0A4</td>
<td>0A4</td>
<td>Clock Recovery up to 32 Gb/s</td>
</tr>
</tbody>
</table>
## M8062A - License Upgrades for M8062A 32Gb/s Front-end for J-BERT M8020A High-Performance BERT

**Table 95**

<table>
<thead>
<tr>
<th>Product</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>M8062A-UED</td>
<td>UED</td>
<td>Upgrade of M8062A-G32 Pattern Generator to M8062A-C32 BERT License</td>
</tr>
<tr>
<td>M8062A-UA3</td>
<td>UA3</td>
<td>Upgrade of M8062A to Analyzer Equalization License</td>
</tr>
<tr>
<td>M8062A-UG4</td>
<td>UG4</td>
<td>Upgrade of M8062A to Multi-tap De-emphasis License</td>
</tr>
<tr>
<td>M8062A-UG5</td>
<td>UG5</td>
<td>Upgrade of M8062A to Adjustable Intersymbol Interference License</td>
</tr>
<tr>
<td>M8062A-UA4</td>
<td>UA4</td>
<td>Upgrade of M8062A to Clock Recovery up to 32 Gb/s</td>
</tr>
<tr>
<td>M8062A-USC</td>
<td>USC</td>
<td>Upgrade of 100GBASE-KR4 and 25GBASE-KR Transmitter Equalization Training, module-wide license</td>
</tr>
<tr>
<td>M8062A-US6</td>
<td>US6</td>
<td>Upgrade to SAS-3 transmitter equalization training, module-wide license</td>
</tr>
</tbody>
</table>

**NOTE**

In addition to the M8062A-UA4 license, M8062A modules with serial numbers < MY55400300 may also require a hardware upgrade in order to enable the CDR feature.
M8040A Licenses

M8045A Pattern generator and clock module, 32/64 Gbaud

M8045A - Basic Selection

Table 96  M8045A - Basic Selection

<table>
<thead>
<tr>
<th>Product</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>M8045A-G32</td>
<td>G32</td>
<td>Pattern generator one channel NRZ, data rate up to 32 Gbaud</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(requires remote head, M8057A)</td>
</tr>
<tr>
<td>M8045A-G64</td>
<td>G64</td>
<td>Pattern generator one channel NRZ, data rate up to 64 Gbaud</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(requires remote head, M8057A)</td>
</tr>
<tr>
<td>M8045A-0G2</td>
<td>0G2</td>
<td>Second channel, hardware and license (requires remote head,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>M8057A)</td>
</tr>
<tr>
<td>M8045A-0G3</td>
<td>0G3</td>
<td>Advanced jitter sources for receiver characterization, module-wide license</td>
</tr>
<tr>
<td>M8045A-0G4</td>
<td>0G4</td>
<td>De-emphasis, module-wide license</td>
</tr>
<tr>
<td>M8045A-0P3</td>
<td>0P3</td>
<td>PAM4 encoding up to 32Gbaud, module-wide license</td>
</tr>
<tr>
<td>M8045A-0P6</td>
<td>0P6</td>
<td>Extension to PAM4 encoding up to 64Gbaud, module-wide license</td>
</tr>
<tr>
<td>M8045A-0G9</td>
<td>0G9</td>
<td>FEC encoding, module-wide license</td>
</tr>
</tbody>
</table>

M8045A - License Upgrades for M8045A

Table 97  M8045A - License Upgrades for M8045A

<table>
<thead>
<tr>
<th>Product</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>M8045A-U64</td>
<td>U64</td>
<td>Upgrade to 64 Gbaud (requires remote head, M8057A)</td>
</tr>
<tr>
<td>M8045A-UG2</td>
<td>UG2</td>
<td>Upgrade to second channel, hardware and license (requires remote head, M8057A)</td>
</tr>
<tr>
<td>M8045A-UG3</td>
<td>UG3</td>
<td>Upgrade to advanced jitter sources for receiver characterization, module-wide license</td>
</tr>
</tbody>
</table>
M8045A-UG4 UG4 Upgrade to de-emphasis, module-wide license
M8045A-UP3 UP3 Upgrade to PAM4 encoding up to 32 Gbaud, module-wide license
M8045A-UP6 UP6 Upgrade to extension to PAM4 encoding up to 64 Gbaud, module-wide license
M8045A-UG9 UG9 Upgrade to FEC encoding

NOTE
Please note that M8045A-UG2 (upgrade to second channel) is a return-to-factory upgrade.

M8046A Analyzer Module, 32/64 Gbaud

M8046A - Basic Selection

<table>
<thead>
<tr>
<th>Product</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>M8046A-A32</td>
<td>A32</td>
<td>Analyzer, one channel, data rate up to 32 Gbaud, NRZ</td>
</tr>
<tr>
<td>M8046A-OP3</td>
<td>OP3</td>
<td>PAM4 decoding up to 32 Gbaud, license</td>
</tr>
<tr>
<td>M8046A-A03</td>
<td>A03</td>
<td>Equalizer license</td>
</tr>
<tr>
<td>M8046A-0A3</td>
<td>0A3</td>
<td>Equalization, license (only needed for &gt; 32 Gbaud)</td>
</tr>
<tr>
<td>M8046A-A64</td>
<td>A64</td>
<td>Analyzer, one channel, data rate up to 64 Gbaud, NRZ</td>
</tr>
</tbody>
</table>

M8046A - License Upgrades for M8046A

<table>
<thead>
<tr>
<th>Product</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>M8046A-UP3</td>
<td>UP3</td>
<td>Upgrade to PAM4 decoding up to 32 Gbaud, license</td>
</tr>
</tbody>
</table>
Keysight License Manager

**Keysight License Manager** is a software utility used with Full Licensing that enables end users to easily manage right-to-use licenses for software and hardware capabilities on Keysight instruments or systems. The graphical user interface (GUI) gives you a visual representation of the licenses installed on your Keysight Technologies systems and provides access to the following features:

- Install licenses for new capabilities
- Transport licenses from one controller to another
- Remove licenses for capabilities no longer needed

For detailed information on **Keysight License Manager**, refer to the Keysight License Manager Help. You can access the Keysight License Manager Help from the **Keysight License Manager** web page:

http://www.keysight.com/find/LicenseManager
Keysight License Service

The Keysight License Service is used in Full Licensing to accomplish installation, listing, validation, removal, and transportation of instrument licenses.

**NOTE**

The Keysight License Service is a Windows service that runs automatically and appears in the Windows Task Manager and Event Viewer the same as other processes. ACCL code communicates with this service to perform licensing functions, and the service monitors system and user events and take appropriate actions.

**NOTE**

The Keysight License Service supports certain specific firewalls. These firewalls must be appropriately configured. For details, refer to Firewall Configuration for Licensing on page 631.
Installing the Licenses

Software Requirements

The M8070A uses the following operating system for installation:

- Microsoft Windows 7 (64 bit) SP1
- Windows 8 (64 bit)
- Windows 8.1 (64 bit)
- Windows 10 (Version 1607, Anniversary Update or newer)

NOTE

In case you ordered M8020A-BU1 all module and M8070A licenses have been pre-installed (except for a floating/networked license). All other system configurations require license installation as described in this step.

Installing M8070A-OTP License (not required for M8020A-BU1 and M8030A-BU1)

The following procedure shows how to redeem and install a M8070A license on a dedicated host computer.

1 Locate the Software License Entitlement Certificate.
2 Follow the instructions on the Software License Entitlement Certificate to redeem your license.
3 You will receive a license file (in an email). The file has the suffix .lic.
4 Follow the instructions in the email to complete the installation of the license file.
5 In the M8070A software interface, verify that the license has been installed by selecting Help > Licenses and then viewing the license status in the Installed column.

Installing Temporary License (Trial License) for the M8000 Series

A temporary (trial) license can be of the following two types:

- **30 days free trial license** - The 30 days free trial license for the M8000 Series of BER Test Solutions can be downloaded using the following weblink: http://www.keysight.com/main/editorial.jspx?cc=IN&lc=eng&ckey=2624767&nid=-32914.1100508&id=2624767
- **9 months DST license** - The DST license can only be ordered by rental companies and distributors.
The following procedure shows how to redeem and install a trial license on a dedicated host computer.

1. Locate the **Software License Entitlement Certificate**.
2. Follow the instructions on the **Software License Entitlement Certificate** to redeem your license.
3. You will receive a license file (in an email). The file has the suffix .lic.
4. Follow the instructions in the email to complete the installation of the license file.
5. In the M8070A software interface, verify that the license has been installed by selecting **Utilities > Licenses...** then viewing the license status in the **Installed** column.

### Installing M8070A-ONP Floating/Networked License

An M8070A-ONP floating/networked license resides on a network server and is accessible by multiple users. The user checks out a license each time the software is accessed. The server tracks the number of licenses checked out and the number of licenses available for use.

The server must be running license services. This server can be a dedicated computer running the license server or it can run license services and the M8070A software concurrently.

### Firewall Configuration for Licensing

If your instrument or PC has a firewall installed and enabled, your system administrator may need to allow certain executables and/or a limited range of port numbers to go through the firewall. This topic discusses those ports and configuration for three common firewalls.

**NOTE**

Typically, the Licensing installer will do the necessary configuration of the Windows firewall. These instructions are provided in case you need to verify or modify the firewall configuration manually.
1. In Windows, click **Start** > **Control Panel** > **System and Security** > **Windows Firewall**.
2. In the left pane, click **Allow a program or feature through Windows Firewall**. If this is not accessible, perform the following alternate procedure:
   1. In Windows, click **Start** and enter **Allow a program through Windows Firewall** in the search field.
   2. In the **Control Panel**, select **Allow a program through Windows Firewall** as shown in the following figure.

![Control Panel](image)

3. Click **Change Settings**. You may need to provide an administrator password or provide confirmation for this action.
4. Click on the **Allow another program** button.
5. Select **M8000** then click **Add**.
6. Add program path:
   
   C:\Program Files (x86)\FlexNet Publisher License Server Manager\lmadmin.exe.
Repeat step 4 to step 6 to add other programs.

8 In the **Allowed Programs** dialog, click **OK** to save the settings.

**Installing the FlexNet License Manager**

The **FlexNet License Manager** tools associated with floating licenses are available from Flexera at [www.keysight.com/find/fnptools](http://www.keysight.com/find/fnptools). You must use version 11.11.1 or higher.

FlexNet provides two different license server executables: `lmgrd.exe` and `lmadmin.exe`. You can use either one or the other.

**lmadmin Installation**

The following procedure describes how to install `lmadmin.exe` (server side):

1. Copy the `agilent.lic` file from the Keysight Licensing installation path (typically, C:\Program Files\Agilent\ACCL\Licensing\bin or C:\Program Files (x86)\ACCL\Licensing\bin) into the licensing folder. (The license filename will change to `agilent0.00.lic` after successful installation.)

2. Determine whether the target system has Java installed, if not, install it from [www.java.com](http://www.java.com). The Java virtual machine is required to run the `lmadmin.exe` installer.

3. Run the `lmadmin.exe`. (Right-click the installer file and **Run as Administrator**.) During the installation:
1 Accept the default installation path.
2 Check the box to **Install Visual C++ 2005 SP1 Redistributable**.
3 On the **Service Configuration** page, enter the **HTTP Port Number** as ‘8090’.
4 On the **Service Configuration** page, select the check-box to **Run as Service**.
5 On the **Start the Server** page, select the check box to **Start server now**. If you don’t do it now, then you will need to start the **lmadmin** service before configuring the license server.

4 If the web browser does not shows the license configuration page, just exit the browser and reboot the PC.
5 After reboot start the browser and use the use following http://localhost:8090/ address again. Now you should see the web configuration page of the lmadmin.

6 However, if you see the message 'The page can’t be displayed …' again the firewall of windows has block the access. You may need to allow certain executable and/or the port number to go through the firewall. For firewall settings, refer to Firewall Configuration for Licensing on page 631.

7 In the login page, if you have not previously set up a login, sign in as “user admin” with password "admin". You will then be required to change the password.

8 Start the browser and use the use following http://localhost:8090/ address again.

9 The lmadmin is installed as service. To check the state of the service, right click on the Computer icon on the desktop and then select Manage. Click on Services and check if service lmadmin is started.
10 Login to the lmadmin web configuration page. Add the agilent.lic and the M8070A-0NP.

C:\Program Files (x86)\Agilent\ACCL\Licensing\bin\agilent.lic
...\1001562893_1166729.lic

11 On the client side, install the M8070A software on the client PC.
12 Install the edited license M8070A-DNP on the client (import license in the Keysight License Manager).

13 In the Keysight License Manager, verify by opening the 'Licenses list' and 'Feature Detail' view. The following illustration displays the 'Licenses list' view.

![Image of Keysight License Manager]

14 Start the M8070A software. From the menu bar, select Utilities > Licenses. The M8070A license dialog will display the installed licenses.

![Image of M8070A license dialog]

15 Request a floating license. For details, refer to Acquiring Floating Licenses on page 640.
Lmgrd Installation

The following procedure describes how to install lmgrd.exe (server side).

1. Copy the agilent.lic file from the Keysight Licensing installation path (typically found in C:\Program Files\Agilent\ACCL\Licensing\bin or in C:\Program Files (x86)\Agilent\ACCL\Licensing\bin) into the licensing folder. (The license file name will change to agilent0.00.lic after successful installation).

2. Copy the appropriate version of lmgrd.exe (32-bit or 64-bit, depending on your operating system) to the target system. It is recommended to put lmgrd.exe in the Keysight Licensing installation path (see step 1 for path information).
3 Install floating licenses to the licensing folder, \texttt{C:\Program Files\Agilent\Licensing}.

4 Open a DOS prompt and change directory to the location of lmgrd.exe.

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{dos_prompt}
\caption{DOS prompt window with directory changed.}
\end{figure}

5 Launch lmgrd.exe with the following command:
\texttt{lmgrd.exe -z -c "C:\Program Files\Agilent\licensing"}

6 If the license server is running (lmgrd.exe) you will see the licenses in the \textbf{Keysight License Manager} on the server.

7 On the client side, install the edited license M8070A-DNP (import license in the \textbf{Keysight License Manager})

8 In the \textbf{Keysight License Manager}, verify by opening the ‘Licenses list’ and ‘Feature Detail’ view. The following illustration displays the ‘Licenses list’ view.

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{license_manager}
\caption{Keysight License Manager - Licenses list view.}
\end{figure}

9 Start the M8070A software. From the menu bar, select \textbf{Utilities} >> \textbf{Licenses}. The M8070A license dialog will display the installed licenses.
Acquiring Floating Licenses

1. Contact your Keysight Technologies representative to purchase licenses for your software. You will receive an order number and certificate number, which you will use to request a license file in step 3.

2. Select and configure your license server machine as described above. For more information, refer to the Flexera Software License Administration Guide. You must install Keysight Licensing on the license server computer, as described in Creating a New License Service using lmadmin.exe on page 642, before requesting a license file in step 3.

3. Request a license file for your license server machine:
   1. Determine the hostname and serial number (10-digit alphanumeric sequence, which is the second component of the host ID) of your license server from Keysight License Notifier's About box.
   2. To display the About box, right-click the Keysight License Notifier icon in the notification area (bottom right of your screen) and click About Keysight License Notifier.
   · You will need the highlighted items shown in the following figure:
Visit the **Keysight Software Manager** website to request a license file.

4 When you receive your license via e-mail from Keysight Technologies, carefully read the instructions sent with the license. If the license is a "served" or "floating" license, put it in the directory `C:\Program Files\Agilent\licensing` on the license server.
Creating a New License Service using lmadmin.exe

Follow the given steps to create a new license service using lmadmin.exe:

1. To access the lmadmin license server management interface, open a web browser and navigate to http://<server>:8080, where <server> is the name of the computer on which the license server is running. For this first-time configuration, you need to be logged on to the license server computer, so that you can simply navigate to http://localhost:8080.

2. Select the Administration tab.

3. Log in. If you have not previously set up a login, sign in as “user admin” with password “admin”. You will then be required to change the password. Don’t forget this password.

4. Select the Vendor Daemon Configuration tab.

5. Select Import License.

6. Browse to the new floating license file. You can only choose one file at this step, so if you have more than one license file, then pick one of them, and click Import License.

7. An Import Error and an Import Warning will be displayed indicating that it can’t find the Agilent.exe file. Click OK.

8. Select the “Agilent” vendor daemon and click Administrate.

9. Change the License File or Directory to “licenses\agilent” instead of the file you specified above. This will enable you to easily add more license files.

NOTE
If the browser cannot find the web page, then the lmadmin service may not be running on the server. Go to Start > Control Panel > Administrative Tools > Services, find “lmadmin” and start the service. After starting the service, refresh, or try navigating the browser to the web page again.

NOTE
To add more license files, follow the procedure below.
10 Change the **Vendor Daemon Location** to the location of the Agilent.exe file:

1. For 32-bit Windows, enter "C:\Program Files\Agilent\ACCL\Licensing\bin\Agilent.exe".
2. For 64-bit Windows, enter "C:\PROGRA~2\Agilent\ACCL\Licensing\bin\Agilent.exe".

**NOTE**
For 64-bit Windows, the file is in "C:\Program Files (x86)\", but the Web page does not allow you to enter a file path containing an open or close parenthesis, so you must instead enter the short file name “C:\PROGRA~2” of the path.

11 Click **Save**.
12 Start the daemon by pressing **Start**.
13 To verify the status of the server, select the **Dashboard** tab and click the **Concurrent** button. Wait for the Web page to refresh. If the “Agilent” daemon is not selected in the vendor drop-down list in the upper right side of the Licenses page, then select it by clicking **Select**.
You will now see the list of floating licenses that are managed by *lmadmin.exe*.

Installing and Setting up Client PC Floating Licenses

The following procedures show how to install and set up client PC floating licenses. Repeat this procedure for each client PC.

1. Ensure that you have the Keysight Licensing Services and the M8000 software to be installed on the client PC.
2. Create the Client floating license files.
   The Client floating license files redirect licensing requests to the license server. Only one client floating license file needs to be created. This client floating license file is copied and re-used by each client PC.
   Make a copy of the original license server floating license file. Remove all line entries except these three lines, which you must modified as shown.
   - "SERVER" line: Keep original text
   - "VENDOR" line: If the optional VENDOR line "port" number is included in the original server license file, remove the optional "Vendor" daemon TCP/IP port number from the line
   - "USE_SERVER" line: Keep original text
3 Install the client floating license files.
   1 Start the Keysight License Manager by double clicking the Keysight License Notifier icon or click Start > (All) Programs > Keysight License Manager > Keysight License Manager.
   2 To install the license file, drag and drop the license file onto the Keysight License Manager “License Features” window. Alternatively, you can click the Keysight License Manager menu File.
   3 Install and follow the prompts to install the license file. The license files are stored in different folder locations depending on whether the license Server and client reside on separate PCs or the same PC:
      - License Server and Client reside on separate PCs: C:\Program Files\Agilent\licensing
      - License Server and Client reside on same PC: C:\Program Files\Agilent\licensing\Remote Licenses
   4 Verify the client PC configuration is correct.

When the license file is successful installed, the client floating licenses that are available on the license server are listed in the Keysight License Manager “License Products and Features” window. To view the available licenses, select the Localhost tree, Remote Licenses node. Ensure that your licensed options and features are shown.

Installing Module Licenses (not required for M8020A-BU1 and M8030A-BU1)

Module licenses enable specific features in the modules of the M8020A/M8030A system. Once a module license has been installed using the Keysight License Manager, the next time the M8070A software and M8020A/M8030A hardware are started, the license is recognized by the M8070A software and compared to the module’s serial number. If the PC Host ID and serial number match, the EEPROM in the module is programmed and the feature is enabled. Even if the M8070A software license is transported to another host computer, the module feature will remain enabled.

The following procedure shows how to redeem and install a module license.
   1 Locate the Software License Entitlement Certificate.
   2 Follow the instructions on the Software License Entitlement Certificate to redeem your license.
   3 You will receive a license file (in an email). The file has the suffix .lic.
   4 Follow the instructions in the email to complete the installation of the license file.
5 In the M8070A software interface, verify that the license has been installed by selecting Help > Licenses then viewing the license status in the Installed column.

Transporting an M8070A License

Transportable licenses are licenses that can be moved from one host controller to another using the Keysight License Manager.

If you need to download and install the Keysight License Manager, go to the following Web page:

http://www.keysight.com/find/LicenseManager

1 Start the Keysight License Manager by double clicking the Keysight License Notifier icon or click Start > (All) Programs > Keysight License Manager > Keysight License Manager.

2 In the Keysight License Manager, click on Help > Keysight License Manager Help and perform the procedure in the Transporting Licenses help topic.
11 Appendix

Basic Troubleshooting / 648
M8070A Factory Patterns / 649
Basic Troubleshooting

Updating software components

Updated versions of the M8020A, M8030A, M8040A and module specific software components are available on the Keysight website.

These software components are available as .EXE files. To download a software upgrade:

2. Click the Technical Support tab.
3. Click Drivers and Software.
4. Type the model number of the instrument module for which software update is needed and click Find. Model number is located on the front panel of the module.
5. Click the Driver & Software link on the module page.
6. Download the required software update from the list of available updates.

The chassis does not power up

If the chassis or a module does not appear to power up, check the following:

• The circuit breakers at the rear of the chassis are set to the right, which is the ON position.
• The AC power cords are connected to a working power source.
• The electrical circuits are not overloaded. Check the combined power requirements of all equipment on the same circuit.
• There are no empty slots in the chassis. Leaving slots empty can overheat the inserted modules, causing them to shut down.

Module is exceptionally hot

• Check that the vent holes on the chassis are not blocked.
• Check that a filler panel module or an instrument module is installed into empty slots on either side of an instrument module.

Contacting Keysight Technologies

To locate a sales or service office near you, go to www.keysight.com/find/contactus.
M8070A Factory Patterns

The M8070A System Software provides a set of example factory supplied standard patterns. These patterns mimic real data packets and standard stress patterns.

**NOTE**
Please note that these patterns are read only and cannot be modified. However, if you modify these patterns, you will have to save them with different name at different location.

### CEI

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CEIstress_bit</td>
<td>CEI Stress pattern</td>
</tr>
<tr>
<td>CID_bit</td>
<td></td>
</tr>
<tr>
<td>QPRBS13-CEI_bit</td>
<td>This QPRBS13-CEI pattern is defined by OIF CEI-56G VSR Chapter 16.C.3.1 Draft 13. The quaternary PRBS13 test pattern is a 4-level pattern created by encoding a repeating PRBS13 pattern using Gray code and PAM4 encoding. Each cycle of QPRBS13-CEI is 8191 symbols long. To get correct output symbols the respective generator needs to have Gray Coding selected.</td>
</tr>
</tbody>
</table>

| SSPR_bit      |                                                                             |
| SSPS-16_bit   |                                                                             |
| SSPS-64_bit   |                                                                             |

### DisplayPort

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>D24.3_b8b10</td>
<td>contains D24.3 symbols; pattern type is B8B10</td>
</tr>
<tr>
<td>DP-TS1_D10.2_b8b10</td>
<td>part of trainings sequence; pattern type is B8B10</td>
</tr>
<tr>
<td>DP-TS2_b6b10</td>
<td>part of trainings sequence; pattern type is B8B10</td>
</tr>
</tbody>
</table>
### Pattern Description

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HBR2_SR-BF-BF-SR-256_CompEyePattren_b8b10</td>
<td>DP test pattern, see file name for details; pattern type is B8B10</td>
</tr>
<tr>
<td>HBR2_SR-BF-BF-SR-7796_CompEyePattren_b8b10</td>
<td>DP test pattern, see file name for details; pattern type is B8B10</td>
</tr>
<tr>
<td>HBR2_SR-BS-BS-SR-256_CompEyePattren_b8b10</td>
<td>DP test pattern, see file name for details; pattern type is B8B10</td>
</tr>
<tr>
<td>HBR2_SR-CP-CP-SR-256_CompEyePattren_b8b10</td>
<td>DP test pattern, see file name for details; pattern type is B8B10</td>
</tr>
<tr>
<td>TPS3_b8b10</td>
<td>part of trainings sequence; pattern type is B8B10</td>
</tr>
<tr>
<td>JBERT_CP2520.prm</td>
<td>DP test pattern</td>
</tr>
<tr>
<td>JBERT_TPS3</td>
<td>part of trainings sequence; pattern type is B8B10</td>
</tr>
<tr>
<td>JBERT_TPS4.prm</td>
<td>part of trainings sequence; pattern type is B8B10</td>
</tr>
</tbody>
</table>

### EAQuickStartGuide

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>burst_25_bit</td>
<td>burst length 25</td>
</tr>
<tr>
<td>burst_25B_bit</td>
<td>burst length 25</td>
</tr>
<tr>
<td>senetive_7_bit</td>
<td></td>
</tr>
<tr>
<td>senetive_7B_bit</td>
<td></td>
</tr>
</tbody>
</table>
FDDI

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FDDI_Jitter_bit</td>
<td>The Fiber Distributed Data Interface (FDDI) data dependent jitter test pattern is used for testing FDDI components or physical links. The pattern is 1280 bits long and is transmitted continuously during the test by repeating the pattern. The sequence causes a near worst case condition for inter-symbol interference and duty-cycle, baseline wander.</td>
</tr>
<tr>
<td>FDDI_Wander_bit</td>
<td>The FDDI baseline wander test pattern is used to test FDDI components for the effects of a change in the average DC level of the signal. The first 45,000 bits are of the code group (01010); the last 45,000 bits are of the code group (10101).</td>
</tr>
<tr>
<td>FDDI_Wander_b8b10</td>
<td>The Fiber Distributed Data Interface (FDDI) data dependent jitter test pattern is used for testing FDDI components or physical links.</td>
</tr>
</tbody>
</table>

FiberChannel/Gigabit Ethernet

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CJTPAT_b8b10</td>
<td>This Fiber Channel Compliant (JTPAT) pattern for jitter tolerance is packaged into a Fiber Channel frame.</td>
</tr>
<tr>
<td>CJTPAT_bit</td>
<td>This Fiber Channel Compliant (JTPAT) pattern for jitter tolerance is packaged into a Fiber Channel frame.</td>
</tr>
<tr>
<td>CRPAT_b8b10</td>
<td>This Fiber Channel Compliant (RPAT) pattern for jitter generation is packaged into a Fiber Channel frame.</td>
</tr>
<tr>
<td>CRPAT_bit</td>
<td>This Fiber Channel Compliant (RPAT) pattern for jitter generation is packaged into a Fiber Channel frame.</td>
</tr>
<tr>
<td>CSPAT_b8b10</td>
<td>This Fiber Channel supply noise (SPAT) pattern is packaged into a Fiber Channel frame for use in system level tests.</td>
</tr>
<tr>
<td>CSPAT_bit</td>
<td>This Fiber Channel supply noise (SPAT) pattern is packaged into a Fiber Channel frame for use in system level tests.</td>
</tr>
</tbody>
</table>
### Pattern Description

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>D21-5_bit</td>
<td>This pattern is used to test Fiber Channel and Gigabit Ethernet elements. It tests random jitter (RJ) and the symmetry of logic transitions. The pattern is composed of alternating logic highs and lows and is repeated continuously. Disparity rules are followed. 1010101010 1010101010 (binary)</td>
</tr>
<tr>
<td>JSPAT_b8b10</td>
<td>This Fiber Channel Compliant (JSPAT) pattern unframed using B8B10 format</td>
</tr>
<tr>
<td>JSPAT_bit</td>
<td>This Fiber Channel Compliant (JSPAT) pattern unframed using BIT format</td>
</tr>
<tr>
<td>JTPAT_b8b10</td>
<td>This is a Fiber Channel jitter tolerance pattern, used to test receiver CDR to large instantaneous phase jumps.</td>
</tr>
<tr>
<td>JTPAT_bit</td>
<td>This is a Fiber Channel jitter tolerance pattern, used to test receiver CDR to large instantaneous phase jumps.</td>
</tr>
<tr>
<td>JTSPAT_b8b10</td>
<td>This Fiber Channel Compliant (JTSPAT) pattern unframed using B8B10 format</td>
</tr>
<tr>
<td>JTSPAT_bit</td>
<td>This Fiber Channel Compliant (JTSPAT) pattern unframed using BIT format</td>
</tr>
<tr>
<td>K28-5_b8b10</td>
<td>K28.5 pattern, tests random and deterministic jitter.</td>
</tr>
<tr>
<td>K28-5_bit</td>
<td>K28.5 pattern, tests random and deterministic jitter.</td>
</tr>
<tr>
<td>K28-7_bit</td>
<td>This pattern is used to test Fiber Channel and Gigabit Ethernet elements. It has a large low frequency content that is used to test low frequency random jitter (RJ) and PLL tracking errors. The pattern is composed of five logic highs, followed by five logic lows. This is repeated continuously and disparity rules are followed: 11111 00000 11111 00000 (binary).</td>
</tr>
<tr>
<td>RPAT_b8b10</td>
<td>This is a Fiber Channel random data pattern.</td>
</tr>
<tr>
<td>RPAT_bit</td>
<td>This is a Fiber Channel random data pattern.</td>
</tr>
<tr>
<td>SPAT_b8b10</td>
<td>This is a Fiber Channel supply noise stimulus test pattern.</td>
</tr>
<tr>
<td>SPAT_bit</td>
<td>This is a Fiber Channel supply noise stimulus test pattern.</td>
</tr>
</tbody>
</table>
# PCI Express

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>compliance_b8b10</td>
<td>Compliance patterns</td>
</tr>
<tr>
<td>compliance_bit</td>
<td>Compliance patterns</td>
</tr>
<tr>
<td>test_payload_b8b10</td>
<td>Compliance pattern; pattern format B8B10</td>
</tr>
<tr>
<td>test_payload_bit</td>
<td>Compliance pattern; pattern format BIT</td>
</tr>
<tr>
<td>ts1_b8b10</td>
<td>part of trainings sequence; pattern format B8B10</td>
</tr>
<tr>
<td>ts1_bit</td>
<td>part of trainings sequence; pattern format BIT</td>
</tr>
<tr>
<td>ts1_skp1_b8b10</td>
<td>part of trainings sequence; pattern format B8B10</td>
</tr>
<tr>
<td>ts1_skp1_bit</td>
<td>part of trainings sequence; pattern format BIT</td>
</tr>
<tr>
<td>ts1_skp_bit</td>
<td>part of trainings sequence; pattern format BIT</td>
</tr>
<tr>
<td>ts1_skp_bit</td>
<td>part of trainings sequence; pattern format BIT</td>
</tr>
<tr>
<td>ts2_b8b10</td>
<td>part of trainings sequence; pattern format B8B10</td>
</tr>
<tr>
<td>ts2_bit</td>
<td>part of trainings sequence; pattern format BIT</td>
</tr>
<tr>
<td>ts2_skp_bit</td>
<td>part of trainings sequence; pattern format BIT</td>
</tr>
<tr>
<td>ts2_skp2_b8b10</td>
<td>part of trainings sequence; pattern format B8B10</td>
</tr>
<tr>
<td>ts2_skp2_bit</td>
<td>part of trainings sequence; pattern format BIT</td>
</tr>
</tbody>
</table>

# PCI Express 2

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compliance5G_b8b10</td>
<td></td>
</tr>
<tr>
<td>PCIe2_Compliance_b8b10</td>
<td></td>
</tr>
<tr>
<td>PCIe2_trainLB_1_bit</td>
<td></td>
</tr>
<tr>
<td>PCIe2_trainLB_2_bit</td>
<td></td>
</tr>
<tr>
<td>PCIe2_trainLB_3_bit</td>
<td></td>
</tr>
<tr>
<td>TrainLoopback5G_1_bit</td>
<td></td>
</tr>
<tr>
<td>TrainLoopback5G_2_bit</td>
<td></td>
</tr>
</tbody>
</table>
### PCI Express 3

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calibration/DMSI_CMSI_cal_BIT</td>
<td></td>
</tr>
<tr>
<td>Calibration/PCIe3_Compliance_lane0_BIT_8G</td>
<td></td>
</tr>
<tr>
<td>Calibration/RJ_SJ_cal_BIT</td>
<td></td>
</tr>
<tr>
<td>Calibration/Step_BIT</td>
<td></td>
</tr>
<tr>
<td>Calibration/TxEQ_cal_BIT</td>
<td></td>
</tr>
<tr>
<td>Test/PCIe3_modified_compliance_lane_0_CC_BIT_8G</td>
<td></td>
</tr>
<tr>
<td>Test/PCIe3_modified_compliance_lane_0_IR_BIT_8G</td>
<td></td>
</tr>
<tr>
<td>Test/PCIe3_modified_compliance_lane_0_SKPOS_filtering_M8046A_BIT_8G</td>
<td></td>
</tr>
</tbody>
</table>

### PCI Express 4

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calibration/DMSI_CMSI_cal_BIT</td>
<td></td>
</tr>
<tr>
<td>Calibration/PCIe4_Compliance_lane0_BIT_16G</td>
<td></td>
</tr>
<tr>
<td>Calibration/RJ_SJ_cal_BIT</td>
<td></td>
</tr>
<tr>
<td>Calibration/Step_BIT</td>
<td></td>
</tr>
<tr>
<td>Calibration/TxEQ_cal_BIT</td>
<td></td>
</tr>
</tbody>
</table>
### Appendix 11

#### PCI Express 5

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calibration/DMSI_CMSI_cal_BIT</td>
<td></td>
</tr>
<tr>
<td>Calibration/RJ_SJ_cal_BIT</td>
<td></td>
</tr>
<tr>
<td>Calibration/Step_BIT</td>
<td></td>
</tr>
<tr>
<td>Calibration/TxEQ_cal_BIT</td>
<td></td>
</tr>
</tbody>
</table>

#### PRBS

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRBS7_1-2_bit</td>
<td>PRBS 2^7 with a mark density of 1/2</td>
</tr>
<tr>
<td>PRBS7_1-8_bit</td>
<td>PRBS 2^7 with a mark density of 1/8</td>
</tr>
<tr>
<td>PRBS7_2-8_bit</td>
<td>PRBS 2^7 with a mark density of 2/8</td>
</tr>
<tr>
<td>PRBS7_6-8_bit</td>
<td>PRBS 2^7 with a mark density of 6/8</td>
</tr>
<tr>
<td>PRBS7_7-8_bit</td>
<td>PRBS 2^7 with a mark density of 7/8</td>
</tr>
<tr>
<td>PRBS10_1-2_bit</td>
<td>PRBS 2^10 with a mark density of 1/2</td>
</tr>
<tr>
<td>PRBS10_1-8_bit</td>
<td>PRBS 2^10 with a mark density of 1/8</td>
</tr>
<tr>
<td>Pattern</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>PRBS10_2-8_bit</td>
<td>PRBS $2^{10}$ with a mark density of 2/8</td>
</tr>
<tr>
<td>PRBS10_6-8_bit</td>
<td>PRBS $2^{10}$ with a mark density of 6/8</td>
</tr>
<tr>
<td>PRBS10_7-8_bit</td>
<td>PRBS $2^{10}$ with a mark density of 7/8</td>
</tr>
<tr>
<td>PRBS11_1-2_bit</td>
<td>PRBS $2^{11}$ with a mark density of 1/2</td>
</tr>
<tr>
<td>PRBS11_1-8_bit</td>
<td>PRBS $2^{11}$ with a mark density of 1/8</td>
</tr>
<tr>
<td>PRBS11_2-8_bit</td>
<td>PRBS $2^{11}$ with a mark density of 2/8</td>
</tr>
<tr>
<td>PRBS11_6-8_bit</td>
<td>PRBS $2^{11}$ with a mark density of 6/8</td>
</tr>
<tr>
<td>PRBS11_7-8_bit</td>
<td>PRBS $2^{11}$ with a mark density of 7/8</td>
</tr>
<tr>
<td>PRBS13_1-2_bit</td>
<td>PRBS $2^{13}$ with a mark density of 1/2</td>
</tr>
<tr>
<td>PRBS13_1-8_bit</td>
<td>PRBS $2^{13}$ with a mark density of 1/8</td>
</tr>
<tr>
<td>PRBS13_2-8_bit</td>
<td>PRBS $2^{13}$ with a mark density of 2/8</td>
</tr>
<tr>
<td>PRBS13_6-8_bit</td>
<td>PRBS $2^{13}$ with a mark density of 6/8</td>
</tr>
<tr>
<td>PRBS13_7-8_bit</td>
<td>PRBS $2^{13}$ with a mark density of 7/8</td>
</tr>
<tr>
<td>PRBS15_1-2_bit</td>
<td>PRBS $2^{15}$ with a mark density of 1/2</td>
</tr>
<tr>
<td>PRBS15_1-8_bit</td>
<td>PRBS $2^{15}$ with a mark density of 1/8</td>
</tr>
<tr>
<td>PRBS15_2-8_bit</td>
<td>PRBS $2^{15}$ with a mark density of 2/8</td>
</tr>
<tr>
<td>PRBS15_6-8_bit</td>
<td>PRBS $2^{15}$ with a mark density of 6/8</td>
</tr>
<tr>
<td>PRBS15_7-8_bit</td>
<td>PRBS $2^{15}$ with a mark density of 7/8</td>
</tr>
<tr>
<td>PRBS23_1-2_bit</td>
<td>PRBS $2^{23}$ with a mark density of 1/2</td>
</tr>
<tr>
<td>PRBS23_1-8_bit</td>
<td>PRBS $2^{23}$ with a mark density of 1/8</td>
</tr>
<tr>
<td>PRBS23_2-8_bit</td>
<td>PRBS $2^{23}$ with a mark density of 2/8</td>
</tr>
<tr>
<td>PRBS23_6-8_bit</td>
<td>PRBS $2^{23}$ with a mark density of 6/8</td>
</tr>
<tr>
<td>PRBS23_7-8_bit</td>
<td>PRBS $2^{23}$ with a mark density of 7/8</td>
</tr>
<tr>
<td>PRBS7_1-2_bit</td>
<td>PRBS $2^{7}$ with a mark density of 1/2</td>
</tr>
<tr>
<td>PRBS9_950_bit</td>
<td>PRBS $2^9 - 1$ with the polynomial $x^9 + x^5 + 1$</td>
</tr>
</tbody>
</table>

*Pattern Description*
### SAS

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JTPAT_b8b10</td>
<td>Jitter Tolerance Pattern (JTPAT) Minus</td>
</tr>
<tr>
<td>SAS_CJTPAT_Repeat_w_all_aligns_b8b10</td>
<td>CJTPAT framed for SAS; includes ALIGNs; uses B8B10 format</td>
</tr>
<tr>
<td>SAS_IDLE_CJTPAT_IDLE_ALIGN0_b8b10</td>
<td>IDLE, CJTAPT, IDLE framed for SAS; includes ALIGN 0; uses B8B10 format</td>
</tr>
<tr>
<td>scrambled_0-from-grex-demo-board_b8b10</td>
<td>Scrambled 0 pattern captured from G-Series scope demo board; uses B8B10 format</td>
</tr>
</tbody>
</table>

### SATA

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALIGN_b8b10</td>
<td>Align primitive as defined in SATA standard.</td>
</tr>
<tr>
<td>COMP-long-2.6spec_b8b10</td>
<td>Long COMP pattern starting with negative running disparity as defined in SATA standard version 2.6</td>
</tr>
<tr>
<td>COMP-long-framed_b8b10</td>
<td>Obsolete long framed COMP pattern</td>
</tr>
<tr>
<td>COMP-long_b8b10</td>
<td>Long COMP pattern starting with negative running disparity as defined in SATA standard version 2.5</td>
</tr>
<tr>
<td>COMP-short-2.6spec_b8b10</td>
<td>Short COMP pattern starting with negative running disparity as defined in SATA standard version 2.6</td>
</tr>
<tr>
<td>COMP-short_b8b10</td>
<td>Short COMP pattern as defined in SATA standard version 2.5</td>
</tr>
<tr>
<td>Framed_COMP_20070905_2ALIGNs_newLBP_92160_b8b10</td>
<td>Long framed COMP according to SATA standard version 2.6 with 2 ALIGNs</td>
</tr>
<tr>
<td>Framed_COMP_20070907_2ALIGNs_oldLBP_92160_b8b10</td>
<td>Long framed COMP according to SATA standard version 2.5 with 2 ALIGNs</td>
</tr>
<tr>
<td>HFTP_b8b10</td>
<td>SATA High Frequency Test Pattern</td>
</tr>
<tr>
<td>HFTP_w_align_b8b10</td>
<td>SATA High Frequency Test Pattern; includes ALIGNs; uses B8B10 format</td>
</tr>
<tr>
<td>HTDP_long_b8b10</td>
<td>SATA long high transition density pattern</td>
</tr>
<tr>
<td>HTDP_short_b8b10</td>
<td>SATA long high transition density pattern</td>
</tr>
</tbody>
</table>
### USB 3.0

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clock_bit</td>
<td>clk/2 pattern; uses BIT format</td>
</tr>
<tr>
<td>D0_SCRAMBLED_b8b10</td>
<td>scrambled D0; uses B8B10 format</td>
</tr>
<tr>
<td>K25_K27_2SKP_b8b10</td>
<td>debug pattern; uses B8B10 format</td>
</tr>
<tr>
<td>K285_D0_b8b10</td>
<td>debug pattern; uses B8B10 format</td>
</tr>
<tr>
<td>LFPS_BURST_1us_IDLE_9us_bit</td>
<td>part of trainings sequence; uses BIT format</td>
</tr>
<tr>
<td>LFPS_IDLE_9us_BURST_1us_bit</td>
<td>part of trainings sequence; uses BIT format</td>
</tr>
</tbody>
</table>
### XAUI

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LFPS_TRIGGER_bit</td>
<td>part of training sequence; uses BIT format</td>
</tr>
<tr>
<td>TS1_31_2SKP_b8b10</td>
<td>part of training sequence; uses B8B10 format</td>
</tr>
<tr>
<td>TS1_31_4SKP_b8b10</td>
<td>part of training sequence; uses B8B10 format</td>
</tr>
<tr>
<td>TS2_2SKP_b8b10</td>
<td>part of training sequence; uses B8B10 format</td>
</tr>
<tr>
<td>TS2_4SKP_b8b10</td>
<td>part of training sequence; uses B8B10 format</td>
</tr>
<tr>
<td>TSEQ_b8b10</td>
<td>part of training sequence; uses B8B10 format</td>
</tr>
<tr>
<td>BRST_2SKP_b8b10</td>
<td>part of training sequence; uses B8B10 format</td>
</tr>
<tr>
<td>BRST_4SKP_b8b10</td>
<td>part of training sequence; uses B8B10 format</td>
</tr>
<tr>
<td>COMMA_2SKP_b8b10</td>
<td>debug pattern; uses B8B10 format</td>
</tr>
<tr>
<td>COMMA_4SKP_b8b10</td>
<td>debug pattern; uses B8B10 format</td>
</tr>
<tr>
<td>CP0_2SKP_SCRAMBLED_b8b10</td>
<td>CP0 compliance pattern containing SKP doubles; pre-scrambled; uses B8B10 format</td>
</tr>
<tr>
<td>CP0_2SKP_for_SER_b8b10</td>
<td>CP0 compliance pattern containing SKP doubles; pre-scrambled; uses B8B10 format</td>
</tr>
<tr>
<td>CP0_4SKP_for_SER_b8b10</td>
<td>CP0 compliance pattern containing SKP doubles; pre-scrambled; uses B8B10 format</td>
</tr>
<tr>
<td>Clock16_bit</td>
<td>clk/16; uses BIT format</td>
</tr>
<tr>
<td>Clock8_bit</td>
<td>clk/8; uses BIT format</td>
</tr>
<tr>
<td>Clock4_bit</td>
<td>clk/4; uses BIT format</td>
</tr>
<tr>
<td>Clock2_bit</td>
<td>clk/2; uses BIT format</td>
</tr>
</tbody>
</table>

### XAUI

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CJPAT_bit</td>
<td>CJPAT; uses BIT format</td>
</tr>
<tr>
<td>CRPAT_b8b10</td>
<td>CRPAT; uses B8B10 format</td>
</tr>
<tr>
<td>CRPAT_bit</td>
<td>CRPAT; uses BIT format</td>
</tr>
</tbody>
</table>
## MPHY

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UniPro1-LaneCJTPAT_b8b10</td>
<td>Pattern used for M-PHY Rx jitter tolerance test for 1 lane UniPro (CJTPAT, 8b/10b encoded).</td>
</tr>
<tr>
<td>UniPro1-LaneCJTPAT_bit</td>
<td>Pattern used for M-PHY Rx jitter tolerance test for 1 lane UniPro (CJTPAT, bit pattern).</td>
</tr>
<tr>
<td>UniPro1-LaneCRPAT_b8b10</td>
<td>Pattern used for M-PHY Tx test for 1 lane UniPro (CRPAT, 8b/10b encoded).</td>
</tr>
<tr>
<td>UniPro1-LaneCRPAT_bit</td>
<td>Pattern used for M-PHY Tx test for 1 lane UniPro (CRPAT, bit pattern).</td>
</tr>
<tr>
<td>UniPro2-LaneCJTPAT-Lane0_b8b10</td>
<td>Pattern used for M-PHY Rx jitter tolerance test for lane 1 of 2 UniPro (CJTPAT, 8b/10b encoded).</td>
</tr>
<tr>
<td>UniPro2-LaneCJTPAT-Lane0_bit</td>
<td>Pattern used for M-PHY Rx jitter tolerance test for lane 1 of 2 UniPro (CJTPAT, bit pattern).</td>
</tr>
<tr>
<td>UniPro2-LaneCJTPAT-Lane1_b8b10</td>
<td>Pattern used for M-PHY Rx jitter tolerance test for lane 2 of 2 UniPro (CJTPAT, 8b/10b encoded).</td>
</tr>
<tr>
<td>UniPro2-LaneCJTPAT-Lane1_bit</td>
<td>Pattern used for M-PHY Rx jitter tolerance test for lane 2 of 2 UniPro (CJTPAT, bit pattern).</td>
</tr>
<tr>
<td>UniPro2-LaneCRPAT-Lane0_b8b10</td>
<td>Pattern used for M-PHY Tx test for lane 1 of 2 UniPro (CRPAT, 8b/10b encoded).</td>
</tr>
<tr>
<td>UniPro2-LaneCRPAT-Lane0_bit</td>
<td>Pattern used for M-PHY Tx test for lane 1 of 2 UniPro (CRPAT, bit pattern).</td>
</tr>
<tr>
<td>UniPro2-LaneCRPAT-Lane1_bit</td>
<td>Pattern used for M-PHY Tx test for lane 2 of 2 UniPro (CRPAT, bit pattern).</td>
</tr>
<tr>
<td>UniPro2-LaneCRPAT-Lane1_b8b10</td>
<td>Pattern used for M-PHY Tx test for lane 2 of 2 UniPro (CRPAT, 8b/10b encoded).</td>
</tr>
<tr>
<td>Pattern</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>JP03A_bit</td>
<td>IEEE802.3bj clause 94.2.9.1 for 100GBASE-KP4. The JP03A test pattern is generated prior to PAM4 encoding. JP03A pattern is a repeating (0,3) sequence.</td>
</tr>
<tr>
<td>JP03B_bit</td>
<td>IEEE802.3bj clause 84.2.9.2 for 100GBASE-KP4. The JP03B test pattern is generated prior to PAM4 encoding. The JP03B pattern is a repeating sequence of (0,3) repeated 15 times followed by (3,0) repeated 16 times.</td>
</tr>
<tr>
<td>PAM4_Linearity_Test_bit</td>
<td>IEEE 802.3bj clause 94.2.9.4 transmitter linearity test pattern. To get correct output symbols the respective generator needs to have Uncoded selected.</td>
</tr>
<tr>
<td>PRBS13Q_Lane0_bit</td>
<td>PRBS13Q Lane 0 pattern as defined in IEEE 802.3 clause 120.5.11.2.3. To get correct output symbols the respective generator needs to have Gray Coding selected.</td>
</tr>
<tr>
<td>PRBS13Q_Lane1_bit</td>
<td>PRBS13Q Lane 1 pattern as defined in IEEE 802.3 clause 120.5.11.2.3. To get correct output symbols the respective generator needs to have Gray Coding selected.</td>
</tr>
<tr>
<td>PRBS13Q_Lane2_bit</td>
<td>PRBS13Q Lane 2 pattern as defined in IEEE 802.3 clause 120.5.11.2.3. To get correct output symbols the respective generator needs to have Gray Coding selected.</td>
</tr>
<tr>
<td>PRBS13Q_Lane3_bit</td>
<td>PRBS13Q Lane 3 pattern as defined in IEEE 802.3 clause 120.5.11.2.3. To get correct output symbols the respective generator needs to have Gray Coding selected.</td>
</tr>
<tr>
<td>QPRBS13_Lane0_bit</td>
<td>QPRBS13 Lane 0 pattern as defined in IEEE 802.3 clause 94.2.9.3. To get correct output symbols the respective generator needs to have Gray Coding selected.</td>
</tr>
<tr>
<td>QPRBS13_Lane1_bit</td>
<td>QPRBS13 Lane 1 pattern as defined in IEEE 802.3 clause 120.5.11.2.5. To get correct output symbols the respective generator needs to have Gray Coding selected.</td>
</tr>
</tbody>
</table>
### USB3.0_LTSSM

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BRST_Bit</td>
<td>BRST</td>
</tr>
<tr>
<td>loopbackED_BB810</td>
<td>CP0 for ED</td>
</tr>
<tr>
<td>loopbackPG_Bit</td>
<td>CP0 for PG</td>
</tr>
</tbody>
</table>

### USB3.1_LTSSM

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP9_BLOCK_ANALYZER_B128B132</td>
<td>CP9 for ED</td>
</tr>
<tr>
<td>CP9_BLOCK_GENERATOR_B128B132</td>
<td>CP9 for PG</td>
</tr>
<tr>
<td>IDLE_B128B132</td>
<td></td>
</tr>
</tbody>
</table>

### CCIX

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calibration/DMSI_CMSI_cal_BIT</td>
<td></td>
</tr>
<tr>
<td>Calibration/RJ_SJ_cal_BIT</td>
<td></td>
</tr>
<tr>
<td>Calibration/Step_BIT</td>
<td></td>
</tr>
<tr>
<td>Calibration/TxEQ_cal_BIT</td>
<td></td>
</tr>
<tr>
<td>Test/CCIX_modified_compliance_lane_0_CC_BIT_20G_25G</td>
<td></td>
</tr>
<tr>
<td>Test/CCIX_modified_compliance_lane_0_IR_BIT_20G_25G</td>
<td></td>
</tr>
<tr>
<td>Test/CCIX_modified_compliance_lane_0_SKPOS_filtering_M8046A_BIT_20G_25G</td>
<td></td>
</tr>
</tbody>
</table>
Index

Numerics
5-Slot AXIe Chassis, 33

A
AC Coupling, 258
Adjust Output Levels, 265
Agilent License Manager, 628
Agilent License Service, 629
Alignment BER Threshold, 326
Amplitude, 256, 272
API Details, 581
API Summary, 579
Auto Alignment, 323
Aux Clk In, 43, 50, 53
AXIe chassis, 33, 37

B
BER, 607
Bias Tees, 258
Bit Rate Range, 277
Bounded Uncorrelated Jitter, 303

C
Calculated Results, 465
CDR Setup, 320, 321
CDR Spread Spectrum Clocking, 320
CEI-56G standards, 26
Changing the Output Levels, 256
Channel Settings Tab, 603
Clean Clk Out, 53
Clk In, 50, 53, 54
Clk Mod In, 43
Clk Out, 43, 50, 53, 54
Clock Data Recovery, 318
Clock Divided by n, 283
Clock In, 251
Clock Rate Indicators, 281
CMI In, 53
Common Mode Interference (CMI), 294
Common Pitfalls when Working with COM Ports, 577
Communication with the M8070A Instrument Layer, 578
Compare Mode, 313
Compatible Plug-ins, 607
Compatible plugins, 607
Confidence Levels, 473
Copy Measurement History Properties, 484
Crossover, 257, 273
Crosstalk, 511
Ctrl In A, 44
Ctrl In B, 44
Ctrl Out A, 44

D
Data Center Alignment, 325
Data In, 43, 47, 54, 66, 67
Data Inverted, 316
Data Mod In, 43, 47
Data Out, 43, 47, 54
Data Polarity Inverted, 274
De-Emphasis Signal Converter, 266
Delay, 257
Differential Mode Interference (DMI), 295
Display Settings Tab, 603
DMI In, 53

E
Electrical Idle In, 53
Embedded Controller Module, 35
Embedded System Module, 34
Error Insertion, 288
Error Ratio Measurement, 467
ESM, 34
Estimated Total Jitter, 482
External Clock Divider, 281
External Clock Source, 277
External Jitter Source, 306
External PLL Clock Divider and Multiplier, 281

F
False Synchronization, 348
Fast Total Jitter Measurement, 483
Features
M8061A, 48, 51
Filters, 182

G
Global Jitter State On/Off Switch, 296

H
High Frequency Jitter (HF Jitter), 296
High Voltage, 273
host PC, 35

I
Impairment Setup View, 175
In-Compatible Plug-ins, 607
In-Compatible plugins, 607
Incorrect Terminations, 258
Insert Single Bit Error, 288
Insert Single Bit Stream, 288
insertion/extraction handles, 52, 61
Index

Install, 608
Install a Plugin, 608
Interference, 294
Intersymbol Interference, 509, 510
Jitter Calculation, 480
Jitter Configuration, 297
Jitter Setup, 296
Jitter Sweep, 300
Jitter Tolerance Characterization, 101, 508
Jitter Tolerance Compliance, 101, 508
Jitter Tolerance Measurement, 508
Jitter Tolerance Template Editor, 522
LAN connection, 39
    LEDs
      Access, 52, 61, 65
      Aux Clk In, 42
      Aux In, 61
      Aux Out A, 42
      Clk In, 61
      Clk Out, 42, 61
      Ctrl In A, 42, 61
      Ctrl In B, 42, 61
      Ctrl Out A, 61
      Data In, 42, 61, 65
      Data Mod In, 65
      Data Out, 42, 61, 65
      Delay Mod, 42
      Delay Mod In, 62
      Fail, 52, 61, 65
      Ref Clk In, 42, 61
      Ref Clk Out, 42, 61
      Sys Ctrl In A, 42, 62
      Sys Ctrl In B, 42, 62
      Sys Out A, 42, 62
      Sys Out B, 42, 62
Trig Out, 42, 61
Level Noise, 509
License, install M8070A-0TP, 631
Licenses window, 104, 105, 601
Not Loaded, 608
Logger Window, 605
Loop Bandwidth, 319
Low Frequency Jitter (LF Jitter), 296
Low Voltage, 273
M8000 Modules, 32
    M8020A user interface, 83
    M8030A Modules Arrangement, 58
    M8041A, 36
    M8041A components, 42
    M8041A features, 40
    M8045A Module Components, 60
    M8045A, M8046A and M8057A configuration, 27
    M8046A Module Components, 64
    M8051A components, 64, 67
    M8051A features, 45
    M8057A Remote Head Components, 67
    M8061A components, 52
    M8061A features, 48
    M8062A, 51
    M8062A Configuration, 169
    M8062A Integration, 169
    M8062A Module Components, 52
    M8070A-0TP license, 631
    M8092A
    M9502A
    M9505A
    M9536A
    M9536A AXIe Embedded Controller, 69
    Measurement Graph, 464
    Measurement History, 463
    Module Insertion/Extraction Handles, 46, 49, 65
N
    Not Loaded, 608
    NRZ, 26
O
    Offset Voltage, 273
    OOS, 42, 43, 44, 46, 47, 49, 50
    Output Level Parameters, 255
    Output Protection Circuit, 254
    Output Timing Measurement, 99, 479
P
    PAM-4, 26
    Pattern Synchronization, 344
    PCIe, 34
    PCIe connectivity, 37
    Periodic Jitter 1, 300
    Periodic Jitter 2, 300
    Phase Locked Loop, 318
    Plug-in States, 608
    Plugin States, 608
    Pod labels, 43, 47, 50
    Post-cursor, 267
R
    Random and Deterministic Jitter, 481
    Random Jitter, 304
    Ref Clk In, 43
    Ref Clk Out, 43
    Ref Clock In, 251
    Retaining screws, 46, 49
    retaining screws, 52, 61, 65
S
    safety summary, 3
    Sampling Point Setup, 323
SCPI Basics, 588
SCPI Editor, 104, 588
Scripting Runtime, 571
Settings window, 105, 602
slots, 33
Software, 609
Spectrally Distributed Random Jitter, 305
Spread Spectrum Clock, 297
Spread Spectrum Clocking, 279
Supported Modules
  M8041A, 32
  M8051A, 32, 36
  M8061A, 32
Sync In, 44, 47, 66
Sync Out, 44
Sys In A, 44
Sys In B, 44
Sys Out A, 44
Sys Out B, 44

T
Termination Voltage, 317
Test Times, 473
Threshold, 316
Threshold Center Alignment, 324
Transition Density, 319
Trig Out, 43

U
Uninstall, 609
Uninstall a Plugin, 609
Update, 610
Update a Plugin, 610
USB connectivity, 37
Useful Code Snippets, 574

V
Version In-Compatible, 608
Voltage Controlled Oscillator, 318

W
Writing a Script Code for DUT Control Interface, 571